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Introduction 

W bile writing this book, I frequently found myself overwhelmed by just 
how much the Internet has changed - and just how much the phenomenon of 
the World Wide Web has contributed to that change over the last few years. 

When I made my first Internet connections about four or five years ago, 
Internet use was dominated by electronic mail, search tools-like Archie and 
Veronica-and ftp. You searched the documents and files on the Internet, found 
whatever it was you were looking for, and retrieved it. Practical, useful ... 
and, for most non-computer types, it was boring. Incredibly boring. 

My first encounter with the World Wide Web really didn't promise that 
much of a change, either: the first sites I visited were text-only, with the same 
dry technical information I had seen elsewhere on the Internet. The idea was 
neat, of course, but no one I knew could afford to run their own page, and this 
new technology seemed to be just another research tool. I promptly forgot 
about the Web for a few months. 

Suddenly, I got the same tip from my editor, my friends, and the computer 
magazines I read (a simultaneous marvel, by the way, that has never hap
pened since): a new browser had captured the attention of everyone on the 
Internet, and I was told I had to check out this new software. The URL was 
www.netscape.com, and like the rest of the planet I learned what the World 
Wide Web was really all about! Suddenly, the Web was alive, personal and 
corporate pages appeared like ants at a picnic, and here we are today with. 
e-mail and Web addresses as important as your telephone number. 
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So, in retrospect, we all can see that the World Wide Web was the force be
hind today's popularity of the Internet ... but what was the force behind the 
Web? What one aspect of the Web transformed it, and propelled it into success? 

The answer is right before your eyes ... images. Online images converted 
the Web into more than text, and they still provide the visual interest - the fun 
- that separates a winning Web site from a lackluster competitor. My favorite 
sites on the Internet are more than just "electronic billboards" where I find 
interesting content; their graphics make them unique! Some are works of 
fancy, others of humor, and some qualify as honest-to-goodness works of art. 
The images build the environment. 

And the natural progression for images on the Web? From static image to 
action and motion ... animation. There are a number of methods that can be 
used to create animation for your Web pages, and that's what this book is all 
about: I'll show you the tools and take you step-by-step through the p rocess of 
building your own animation. 

While writing this book, I also kept two important criteria in mind: First, 
we want animation now, not three months from now! That means no pro
gramming, no extensive art training, and no assumptions that you, the reader, 
have a degree in graphic design (or are the slightest bit interested in obtaining 
one). Secondly, I'd rather do the same job for 30 dollars than three thousand 
dollars ... how about you? Our tools need to be kept as inexpensive as possible. 
If more sophisticated and complex tools are available, I' ll mention them as 
well, but why pay a fortune for today's latest and greatest software behemoth, 
only to find out that a shareware tool can do the same job just as well? 

With our two criteria in mind -quick and cheap-we're ready to add action 
and motion to your pages! 

Who Can Use This Book 

This book is aimed at anyone who is reasonably familiar with HTML and wants 
to add animation to Web pages. No prior experience with graphics is assumed. 

If you're running Windows, here's what you need: 

• A 486-66 or better PC with a t least 16MB of RAM and Windows 95 or 
Windows NT installed. 

• 24-bit color. 

• Depending on the programs you install from the CD-ROM, anywhere 
from 5 to 40 megabytes of hard drive space. 

• A CD-ROM drive. 
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If you're running a Macintosh, here's what you need: 

• A Macintosh 68020 running System 7 or higher, or a more current 
Macintosh PowerPC or Power Macintosh, with at least SMB of RAM. 

• 24-bit color. 

• Depending on the programs you install from the CD-ROM, anywhere 
from 5 to 40 megabytes of hard drive space. 

• A CD-ROM drive. 

How This Book Is Organized 

Chapter 1, "Designing Graphics for Your Page" introduces you to the basics 
of animation for your Web page, including the pros and cons of animation and 
how to design both static and animated images for your page. 

In Chapter 2, "Finding Images to Animate," you will learn where to look 
for images for your pages and how to obtain them. We'll search the Internet, 
discuss image and video capture technology and resources for clip art. 

Chapter 3, "Editing Images for Your Animations," introduces you to the 
basics of image editing with Paint Shop Pro and Adobe PhotoDeluxe. 

In Chapter 4, "Creating Simple Animated GIFs," you'll build your first 
animated GIF with GIF Construction Set or Giffiuilder, and I'll also introduce 
you to other GIF animation programs that are currently available. I' ll also 
show you how to test your animation and how to compress it for the shortest 
possible download time. 

Chapter 5, /1 Advanced Image Editing," introduces you to the fun and 
advanced effects available within Adobe Photoshop. You'll also learn a sec
tional animation technique that can trim over 40 percent off the file size of 
your finished GIF animation. 

We'll jump into one of my favorite hobbies in Chapter 6, "Creating 3D Web 
Graphics," where I' ll show you how to use programs like Pixel 3D and Sculpt 
3D to create your own state-of-the-art 3D logos and objects for GIF animation! 

Chapter 7, "Creating Morphing Web Graphics," helps you bring a bit of 
Hollywood special effects to your Web animation! You'll learn how to use 
tools like Kai's PowerGoo to turn one image into another. 

Chapter 8, "Java Animation 101" introduces you to the Java language and 
how you can use it to create animations - but instead of programming, you'll 
use applications that generate Java applets automatically. 
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Finally, in Chapter 9, "The Ultimate Animation," I'll discuss three "leading 
edge" forms of advanced animation that you can add to your page: server 
push animation, digital video, and third party animation plug-ins. 

Are you ready to animate? Then let's get in motion! 



CHAPTER 1 

Designing 
Graphics for 
Your Page 

DK, admit it- you' re hooked! Perhaps you first encountered the World 
Wide Web doing research, looking for a particular piece of information among 
the uncounted bytes of data on the Internet. You might have been sucked into 
Web surfing by the media, after innocently reading a computer magazine or 
idly watching television .. Maybe a friend introduced you to the joys of 
Netscape navigating by letting you roam free for a few minutes on Yahoo! 
However you began, you 've reached the advanced stage of Web conscious
ness, and now you're publishing your own pages on the Web, or you're run
ning an entire site. 

How can you add interest and fun to your pages? You've probably heard 
many times that the success of the World Wide Web is due to its graphical 
nature, and that's true; although the written content of a Web page is its heart 
and soul, images and graphics provide the personality that you find on the 
best-designed Web pages. 

Why Animate? 

Today's jaded Web surfer demands something more ... s tatic pictures can 
only take your page so far. Why settle for a simple picture when your title 
image can move-or, for that matter, dance or spin or even walk off the page? 
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That's where animated graprucs come in, and that's the reason behind the 
explosion in popularity of animated images on the Web. Make no mistake 
about it, your site will receive more hits with animation, and you can use 
animated images to help: 

• Draw the eye to a particular area, button, or section of text on your page; 
for example, if you're the Webmaster for a furniture store, and the store 
is holding a special sale, a spinning arrow might point to the hours the 
store is open during the sale. Although the sale is not your primary 
content, an animation will help your visitors notice it. 

• Identify a part of your page for a specific target audience-for example, a 
bouncing apple might direct Macintosh visitors to a Mac-specific link. 

• Entice your visitors to spread the word about what you have to offer-"! 
saw this great animated Web site for the furniture store downtown . .. " 

• Create a unique design for your page that sets it apart from thousands of 
others on the Internet. After all, if your page is dull or boring, it simply 
becomes another billboard on the-you guessed it-Information Super
highway. (Shudder.) 

• Take advantage of the powerful features available in today's browsers, 
like Netscape Navigator. After all, most Webmasters are addicted to 
technology-why not use some of those new HTML tags? 

• Express your artistic side--or, if you' re like me, "Mr. Stick Figure," you 
want to pretend you have an artistic side! 

Whether you're creating them or viewing them, animated graphics are just 
plain fun! That's the entire idea behind this book: I'll show you how to add 
many different types of animated graphics to your Web pages as inexpen
sively and as quickly as possible. 

What's Necessary for Animation? 

Animation is no longer just the realm of Walt Disney-or, for that matter, those 
kids that used to sit behind you in junior high that d rew pictures throughout 
every class. Instead, the tools that we have today allow anyone to create ani
mation, without any talent as an artist or a cartoonist. 
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Most of the tools we'll use in this book are shareware or inexpensive com
mercial programs, and your raw material-the images themselves-can be 
drawn, extracted, scanned, or copied from all sorts of sources. As we begin to 
cover specific techniques and the different types of animation that you can 
produce for your page, I'll introduce you to my favorite software tool that's 
specifically designed for the task at hand, and in most of the chapters, I'll also 
mention other programs that can perform the same work. 

I'll also discuss the computer hardware that will come in handy while 
creating your own animation, like scanners and digital cameras. Such equip
ment isn't a requirement for animating images, but you' ll find they can help 
save you time and trouble. 

Although this book was written for both Windows and Macintosh users, 
the Windows platform has somewhat of an advantage. Currently, there are 
more low-cost shareware and commercial tools for animation, rendering, and 
morphing available for Windows 95 than Macintosh. Where possible, how
ever, I've used tools that can be obtained for either computer, or provided a 
second tutorial using a Macintosh program. 

Pros & Cons of Animation 

It's true, every silver lining does have its cloud, and animated images are no 
exception. There are disadvantages to using animation; knowing what they 
are before you start creating images or adding them to your page can make the 
difference between a work of art and a disaster of epic proportions. 

Therefore, let's take a moment to review the good points and the bad points 
of animated graphics. 

Appearance 

As I mentioned, the addition of graphics can make the difference between a 
boring page and a page that really draws attention; however, like too much of 
a good thing, too much animated flash can draw your visitor 's focus away 
from your message. For example, consider the page illustrated in Figure 1-1 
that I encountered recently on the Web. 
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IN llllll>l 11 Alf f1f I You .tt1e enlr11n11 Hll' 11111H·<1el OAICAVCI 

Figure 1-1: A Web page suffering from graphic overdose. 

It's no coincidence that a good rule of thumb in print advertising usually 
applies just as well to Web publishing. For instance, if you're advertising a 
product or service that doesn't have tremendous name recognition like 
McDonald's or Coca-Cola, your reader is interested more in the features and 
benefits of your product, and if you don't present that information quickly, the 
reader moves on. With that in mind, is it easy to determine exactly what the 
purpose of this page is within five seconds or so? 

Besides distracting your visitors from your message, a bad animation deci
sion can have other effects: 

• Wrong tone or atmosphere. Select the wrong image, and you can detract 
from the atmosphere you intended to create. One Webmaster might 
depict the theme "Christmas" by animating a single flickering candle, 
while another uses busy, blinking lights; the subject is the same, but the 
mood is quite different. Just because an animated image fits your topic 
does not mean that it also fits your page. 

• Sexism or racism. I've actually seen animated graphics that illustrate 
either males or females or any one of a number of different races in a bad 
light-and in most cases, I don' t think it was the Webmaster's intention 
to offend! Remember, you never know who is connecting to your Web 
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site. Whether accidental or intentional, your message will suffer if your 
graphics are personally offensive to your visitors. 

• Substitution for content. A page like the one shown in Figure 1-1 often 
results if you don't have enough text content or material to create a 
substantial site. Unless the focus of your Web site is online graphics in 
one form or another, don't fall into the common trap of: "Well, it looks 
good, even if I don't have anything to say." Your visitors will pick that up 
in a heartbeat. 

On the other hand, the restrained use of animated graphics underscores the 
message of your page and-depending on the placement-can draw attention 
directly to specific portions of your page. For example, Figure 1-2 illustrates a 
section of a page from my Web site, where I use a spinning movie reel to draw 
attention to the text. This animated reel "spins" around, in keeping with the 
subject of movies, and leads the reader's eye directly to the text. Many devel
opers that distribute shareware or demonstration versions of their commercial 
software over the Internet use the same technique; your visitors want that file, 
and they want it now, so why not point to the link with a spinning arrow? 

Figure 1-2: Animated images can attract attention to specific portions of your page! 

Interaction is Everything 

The moral of this story? If your page is overloaded with animated graphics or 
animated applets, you' ll likely draw the eye away from the content on the page, 
or-in the worst case scenari~rive away more viewers than you attract. Re
member, your visitor arrived at your page ready to interact, not to sit back and 
watch a visual light show. 
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As we cover all of the different images you can create in later chapters, keep 
this essential rule in mind: Pick and choose your images carefully when de
signing your page. 

Speed 

You've reached a few of "those" sites before; you know, the Web pages where 
time seems to stand still while the graphics are loading, and you eventually 
get up for a soda (or simply hit Stop and move on). Honestly, I can't under
stand why the person responsible for one of these pits of quicksand would 
assume that I have my own direct Tl connection to the Internet-I don't, by 
the way, but donations are gratefully accepted. The sad truth of today's World 
Wide Wait-whoops, sorry, I meant "Web" -is that you often spend more time 
waiting than you do reading because most of those who are creating Web 
pages these days have no idea how to reduce loading time. 

No matter how wonderful an animated graphic, it's important to remember 
that it will take time to download, and the more complex it is, the longer your 
visitor will wait. The average Web surfer is still using a 14.4 bps modem over a 
dial-up connection, and it's impossible to tell at any time how many addi
tional bottlenecks stand in the way of your page: an overloaded service pro
vider, perhaps, or a Web server taking a large number of hits. 

What can you do to combat this lethargy? Keep these guidelines in mind: 

• Restrict the number of animated images on your site. The best use of 
animated graphics is as a seasoning, not a main ingredient. If a static 
image works, use it unless you have a real need for an animated image 
and you'll save download time. 

• Reduce the size of your animated images. In Chapter 4, we'll discuss 
the complexity and the number of frames you'll use while designing an 
image; for now, just remember that the simplest animation is the fastest 
to download. In the case of static images, their physical size and color 
depth determine the time it will take to download them. 

• Provide a text mirror. If your page must include a large number of 
graphics, a text mirror is a convenience that many of your visitors will 
really appreciate if they're using slower equipment or a slower connec
tion. In essence, a text mirror is a separate set of HTML files that dupli
cates the contents of your site without graphics; if you must use a large 
number of images (animated or not), allow your visitor to easily "tum 
them off" by using the mirror instead. If you do offer a mirror, please 
make the link to it the first thing a visitor sees-I've actually loaded 
several flashy pages that stuck the link at the bottom. 
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• Figure 1-3 shows a favorite site of mine that features a large number of 
animated graphics and includes a text mirror; the text site link is where it 
should be, on the first line of the page. 

----ii 

Figure 1-3: An example of a site with a separate text mirror. 

In fact, there are certain applications where animated graphics should be actively 
avoided altogether. The most common example is an intranet file transfer or data
base quen; page, where the appearance of the page is much less important than fast 
access; if you're loading such a page, your interest lies not in Janet; graphics that 
take time to load (or even reload), but in retrieving a specific company document or 
searching for specific data. 

Striking the correct balance between your artistic flair and your visitors' 
load time is not an easy task, but there are tricks you can use to help develop a 
sense of the proper number of images: 

• Use your favorite pages as examples. Take a cruise through your Navi
gator bookmark list and examine your favorite pages-you know, the 
ones that have the most to offer and load at the fastest speed. How many 
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graphics do they use on a single page? How many of those images are 
animated? As an example, try one of my favorite sites for the latest 
computer gaming news, www.gamesdomain.com (Games Domain). 

• Test your page. Software developers use a technique called "usability 
testing" to determine how easy their interface is to use and understand. 
If you're considering using animated graphics and you're concerned 
about download time, add the graphics and ask a few friends with 
widely differing systems to connect and critique your page. Naturally, 
the person using a 56K ISON line isn't going to complain about load 
times, but you can still ask for an opinion on the appearance of your 
page. The lucky friend using the 14.4 bps modem is a better candidate to 
quiz about speed. 

• Calculate download time. We'll cover this process later in Chapter 4; it's 
also a part of the usability testing phase. Calculating download time will 
give you a good approximation of how long it will take your browser to 
load a graphic at any common speed. 

Browser Compatibility 

It's a fact of life: most of us who compute on a budget aren't always using the 
latest and greatest in technology. For me, it's utilities; I tend to continue using 
older, familiar versions of utility programs rather than buy an expensive 
upgrade to the latest version, which often has nothing new but fancier graph
ics. Unfortunately, for many visitors who will reach your site, their legacy 
software will be their browser program. 

Although just about every browser I've seen that's been released in the last 
two years has support for animated graphics, earlier versions of the most popu
lar browsers like Netscape Navigator did not support animation. This typically 
will not be much of a problem, Unless the animated graphics that you've created 
contain information that's not available anywhere else on your page. 

For example, a friend of mine using an older browser recently called me on 
the phone, complaining that he couldn't find the Web page download area for 
the sound card he had just bought. I fired up my Netscape Navigator 3.0, 
connected to the same site, and there it was: a big, animated button with a 
starburst graphic that cycled through the following words: "Click here for free 
software!" I told my friend (who was still on the phone) that I could see the 
download prompt with no problem, and it took us a few minutes to figure out 
that his browser was only displaying the word "click." Without support for 
animation, the rest of the message never appeared in his browser. 
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For this reason, it's a good idea to use your animated graphics only to 
attract attention and provide visual interest, not to communicate any critical 
information; that way, if your visitor is using an older browser, nothing impor
tant on your page is missed. This same rule also holds true for future graphic 
technology on the Web. Not everyone is on the leading edge of technology-in 
fact, most of us aren't, which is why it's an "edge" in the first place. 

Designing Your Page & Images 

Unfortunately, like most things in life we must start at the beginning. Most of 
the people creating personal Web pages today have no training in visual 
layout, and they have never created their own graphics especially for use on a 
Web page. What's worse, the same is true of many Webmasters who have been 
forced into creating pages for their company's commercial site. Of course, you 
can pick up a basic feel for Web design simply by surfing, but it may take 
quite a while-and you can't really learn how to create animated graphics 
without some knowledge of how images are effectively placed on a page. 

In this section, I'll provide you with a quick refresher of the basics of de
signing graphics, both static and animated, to fit the content and style of your 
pages. Note that I didn't say graphic design; we're not going to be studying 
"white space" or "stark primitive late-twentieth-century angles," but rather 
how you can design both static and animated graphics to fit the content of 
your page. 

Whoa! Are we crossing that neutral zone into graphic design? Not really, 
more like interior design; after all, a successful Web page involves the arrange
ment of content, too. Your choice of font attributes are like the colors you 
choose for your furniture, and your images on a Web page are like the pictures 
you hang on the walls of your home. 

The Design Process 

At this point, I'll assume that you've already determined the content of the 
page and any necessary HTML features that will be included, like links or a 
mailto statement. To drag my poor analogy just a little further before it keels 
over, you've already chosen your furniture and arranged it, and now you'd 
like to add visual interest to the walls. There are other books available that 
teach basic and advanced HTML-my favorite is Official HTML Publishing for 
Netscape (Ventana 1997). I'll take it for granted that you already know your 
way around an HTML editor, so that we can start the good stuff right now. 



~ 

10 CrFlCIAL NETSCAPE GUIDE TC WEB ANIMATION 

There are a number of considerations involved in designing a Web page 
and the images it will include, and I suppose you could consider them "steps"; 
they can, however, be performed in any order. Furthermore, it doesn't matter 
whether you draw the image you design yourself or find a suitable substitute 
somewhere on the Internet and simply download it. Planning the graphic 
makeup of your page is the process of determining: 

Iii The number of graphics that belong on your page. 

ii The size of the graphics. 

ii Where they should be placed for maximum effectiveness. 

Iii What colors they should use. 

liJ The subject of your graphics and the theme you wish to enhance. 

II The correct balance between complexity and download time. 

Before we jump into designing your graphics, let's create a hypothetical 
Web page so that you can see how the process works. For this section, we'll 
assume you're working for a company that manufactures pianos, and you've 
been asked to design the company's home page. This page will include links 
to product descriptions, sound files of the various pianos, and a price list. 
However, your company's server is overworked, and your visitors may expe
rience quite a few pauses, so you must design the page to transfer and load 
quickly as well as attract business. 

If you're following along with your own project in mind, grab a notepad 
and pen-or, if you're in a symbiotic relationship with your computer like I 
am, open up your favorite text editor and jot down your choices as we move 
through the design steps. Keep the pad handy because by the time you're 
done, you'll have a complete sheet of specifications on your graphics. 

Color & Palette 

To demonstrate that these steps can be performed in any order, let's start with 
color and palette. The Internet began as a text-based system, so you'll find that 
there really is no set standard for colors other than the named colors recog
nized within HTML, as listed in Table 1-1. As a general rule, your graphics 
(including background graphics and text) should use these colors from the 
standard HTML palette whenever possible; this will help ensure that visitors 
still using 16-color systems will still be able to view correct colors. If you use 
custom colors that aren't directly supported within the standard 16- or 256-
color drivers, your visitors might experience dithering (that awful grainy effect 
you often see when you display a 16-million color image on a 256-color system); 
dithering is caused by incompatibilities between palettes and color depth. 
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Standard HTML Colors 

Black 

White 

Red 

Green 

Yellow 

Blue 

Cyan 

Magenta 

Table 1-1: Standard HTML color names. 

How can you be certain you're using pure colors? Most paint programs 
either display a palette in which you can select standard colors, or you can 
reduce the color depth to simple colors through a menu command; for ex
ample, Paint Shop Pro includes both. Figure 1-4 illustrates the main window 
from this great program, and you can see the 256-color palette displayed along 
the right side. You'll learn much more about this program and all of its fea
tures in Chapter 3. 

• 

Figure 1-4: The Paint Shop Pro main window includes a full color palette. 
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Speaking of Color Depth 

With the explosion of inexpensive, quality video cards and the dramatic drop in 
RAM prices over the last couple of years, it's now easier for most Web surfers to 
display 16 million colors, and more and more sites are now assuming that your 
system is capable of display at that color depth. The JPEG image standard, which 
is the primary image format on the Web, also provides 24-bit color at a very 
small size, but JPEG images are not currently used in animation. 

However, 256 colors is still a better standard for now since the difference to the 
viewer is often slight, and you can practically guarantee that your viewers will be 
using at least a 256-color mode. Also, most animated GIF images are 256 color. 

Since speed is of the essence here, I would recommend that you use a stan
dard color background instead of a tiled background graphic because you' ll 
save loading time. White is a natural choice; it makes a great background for 
our images and text looks clearer on white as well. Black would p robably be 
our second choice, but text is a little harder to read . 

If you look at a number of the successful pages on the Web, you'll see that many of 
them use a simple white background, like Yahoo! Although many people may consider 
white boring, it's still the best choice as a background for images, and simple white 
still has a classic appeal. After all, this book uses white paper for a reason. 

OK, we've selected a white background. Next, look at the colors listed in 
Table 1-1 and select additional colors for your graphics; usually, there's at least 
one or two colors tha t are either included in a company's logo, associated with 
the subject, or just appeal to your eye. For our example, we' ll add black, red, 
and yellow, which are complementary, and we'll use black text. Finally, we'll 
use a 256-color palette for all of our graphics for the best compatibility. 

Selecting a Subject 

Next on our design list is the subject of your graphics and what is actually 
going to appear in your Web image. If you 've done any Web surfing at all, I'm 
sure you 've encountered more than your share of shocking, inappropriate, and 
sometimes just plain puzzling graphics on the Internet. If your site will rely on 
pure shock value to attract attention, then please download the worst of these 
images to your hard drive, stop reading here, and skip to the next section. 
Your visitors have my p ity. 
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Still here? Good! That means that you' re interested in designing graphics 
that will enhance your page instead of overwhelm it. You're looking for visual 
interest, not visual chaos. 

Depending on the theme of your page, the subject of your image may be 
obvious; in the case of our example page, it's a safe bet we'll use a piano itself, 
but there's no reason you can't design graphics that take a new angle on even 
the oldest of subjects. For example, consider these guidelines for your subject: 

• If you're limited to your company's logo, consider a 30 version in mo
tion; you 'd be surprised how interesting that familiar 20 object is when 
it's rendered 30. For example, check out Figure 1-5. 

Figure 1-5: Rendering a subject makes it stand out. 

• Use images of objects or symbols that are related to your subject; for 
instance, our page could use a G clef or quarter notes instead. 

• If a subject isn't apparent, consider animated text. 

• One trick I've used often is to cut several pieces from a familiar image 
and re-assemble them, as in Figure 1-6; you end up with a slightly 
skewed (yet attractive) image that really grabs the eye. There are all sorts 
of effects available in Adobe Photoshop that can accomplish the same 
task; we'll be using this great program later in the book. 
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Figure 1-6: An interesting treatment of a common subject. 

• Along the same lines, you can also focus on a specific portion of an 
image; for our example, you could use just the keyboard, which would 
naturally make an excellent animated image. For instance, if your site 
concerns automobiles, let a spinning tire or a windshield wiper carry all 
the "weight" of the entire car behind them. 

As you consider your subject, remember that we'll be discussing size in the 
next section, and the smaller your subject, the less time required to download 
it. Of course, if you've selected an elephant as your subject, you can use a small 
elephant-I'm a nice guy, I'll let you do that-but wouldn't a huge peanut be 
more visually interesting? I feel the best Web graphics tend to be thin and long 
(which are perfect for titles, borders, and text separators), or rectangular and 
relatively small. Why rectangular and small? Because rectangular images are 
easier to resample to a standard dimension in pixels, like 320 X 200, and any 
text that wraps around your image will wrap more neatly around the straight 
edges of a rectangle. As for the smaller size, we mentioned that earlier: the 
smaller the graphic, the faster it loads. 

What about availability? Naturally, the more common an image is, the easier 
it will be to find. If you're a flop as a freehand artist, you'll have to locate your 
image somewhere on the Internet or use a clip-art library; also, if you have rights 
to a printed image or a photo you've taken, you can scan it in and use it. This is 
why many Web design consultants pack a digital camera with them so that they 
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can capture images of a subject directly without worrying about copyright 
issues; we'll discuss copyright law a bit further in Chapter 2. Of course, if you 
are an electronic artist, then you have my sincere admiration, and it'll be much 
easier for you to entertain and create your wildest flights of fancy. 

Also, if your graphic will be animated, consider how easy it will be to create 
the animation, and try to select a subject that moves naturally. Our keyboard 
will be a snap, since we can make the keys move up and down as they natu
rally do in real life. 

We'll use a piano keyboard as the subject of our principal image, then, 
because it matches several of the characteristics of a good subject: 

II It suggests the entire piano without requiring that your page be loaded 
down with an actual image of one. 

• It's visually interesting. 

• It's easily animated in a familiar motion. 

• It's the right shape for use as a title or separator. 

• Finally, it's a graphic that you can likely find on the Internet or in a clip 
art library. 

Size, Placement & Number 

"How many graphics should I place on my page, where should they go, and 
how big should they be?" As you might have guessed by my earlier comments 
on "chaotic" pages, I'm more of a minimalist when it comes to adding graph
ics to a page. My favorite designs usually feature: 

• A title graphic. I strongly recommend you steer clear of a standard 
HTML text title unless you're interested in reducing loading time to a 
bare minimum. If your main page starts with a text heading, it'll fall 
short of the graphic punch that most of today's Web surfers are looking 
for, and many of your visitors will simply assume that you didn't take 
the time to create your page properly or that you're a novice with HTML. 
I know that sounds harsh and it may not be true, but today's Web is a 
fiercely competitive graphic medium, and your title helps create a first 
impression, good or bad. Figures 1-7 and 1-8 illustrate two good ex
amples of title graphics; the first is a drawn image, while the second is 
the rendered 30 title from my site. 
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Figure 1-7: The title bar from one of my favorite sites on the Web. 

Figure 1-8: The title bar from my site. 

The next time you pick up a printed newspaper, consider what drew your eye first: 
I'll bet it was the paper's masthead. Just like the title graphic on your Web page, the 
signature name and the surrounding graphics at the top of a newspaper create a 
memorable first impression. For example, close your ei;es and see if you can picture 
the masthead for USA Today, the Wall Street Journal, and the New York Times. 
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• A pleasing background texture. Please note that I said a pleasing texture; 
some of the backgrounds I've seen recently are so harsh they're like 
sandpaper to the eye! Your foreground text should be easy to read, 
muted in colors, and the image you use for your background should tile 
in a regular pattern. 

There are exceptions to this rule; for example, on the page on my site de
voted to the classic '60s TV series Batman, I use a tile background with an 
image from the show's title. Although this makes the text a little harder to 
read, the background represents the campy graphics of the TV show and it · 
works. (I can only imagine what a site devoted to Laugh-In would look like!) If 
you do decide to use an image as a background, make sure that it tiles evenly, 
and try to use a highly contrasting color for your text. 

In addition, I'd recommend using the same texture for every page on a 
specific site; this serves to tie your pages together into a cohesive whole and 
avoids the "eye shock" one experiences in moving from, say, a black back
ground to a red one. My personal favorites include textured paper, a light 
marble, or granite. 

As mentioned earlier, a solid color background works almost as well, 
and it will load Jaster. 

• Text separators. Text separators enhance both the look and the readabil
ity of your page. However, it's a good design rule to stick to only one or 
two images for all of the separators throughout your site; if you use a 
different image for each separator, you're once again introducing too 
much visual feedback. For example, a computer software manual may 
use the same set of standard icons throughout to guide the reader and 
provide variety. Like the printed pages of such a book, using the same 
incidental graphics throughout your Web site will help to provide a 
visual "anchor" for the eye. You should also be careful to avoid adding 
too many separators, which can force your visitor to scroll when it's not 
really necessary. 

• Icon buttons. Figure 1-9 illustrates the use of icon buttons down the left 
side of a page; another popular place to display icon buttons is directly 
under the page's title graphic. Wherever you decide to place them, it's 
standard practice to place the same icons at the same position on each 
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page on your site so your visitors will always know where the "navigation 
controls" are anywhere on your site. Icon buttons provide the same func
tionality as a text link; click on one to download a file, jump to another 
page, or activate a search, for instance, but they're much more interesting 
visually. The same rules we listed for text separators apply to icon buttons 
as well; in addition, it's very important to make certain that the meaning of 
each button will be clear to all of your visitors. Remember, your site is "on 
the air" around the world; if you're expecting a large number of foreign 
visitors, use a set of icon buttons that's suitable for international commu
nications. Alternately, many large companies offer completely separate 
p ages in different languages. 

·····~The l•tttt news •nd lnfomwitlon In the computor book lnduury 

Evory week. Studio B will bring you the latest news and mfomwion in the industry. We worlt hard to 
stay up·to·date so you don~ have to. Bookmark tins page now so you don~ get lefl belmd. 

·····~Join our populor m""lnf llsf tolllld 11111111ff toyoar:qundon' 

JOU\ the Studio B m to bep up wilh the Compuler book pu'ohshlng uidustry. Post yoW' 
questions here to have them'"answered bJ indwlly eitpefll B~selli:\g authors and leadm& pubhshers 
are on OW' mailing list • are you?~ todtto--

·····~looking for• frttloncudltorl Writer I Cff<kno further-

Check out the Computer Book Tradms Post. This IS a great way to trade computer books with others 
in the mdustry. For a limited tune only, Studio Bis offeriiia ruthors, booksellers. editors, and 
pubhshers the opporturu!y to hst classified advertisements for free You can advertise a JoO po1111on. or 
let people know you're available for work. ~to find out how 

·····~ EYerythlng you nffd to know to publl>h beSU<!li.rs ' '. 

Figure 1-9: A good example of the proper use of icon buttons. 

• A footer graphic. Although not as important as the good first impression 
provided by a title graphic, a footer graphic adds a professional touch to 
a page by ending it with a flair; often, the footer is a smaller version of 
the title graphic, or it's complementary in some fashion. It's also stan
dard operating procedure to include items like your content copyright, a 
mailto link to the Webmaster, and any awards your page might have won 
as a part of the footer graphic. Figure 1-10 illus tra tes a footer graphic. 
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• Root 61e. Mi:mrwm l sector 
• Path Tables: Minimum 2 sectors 
• Primary Volume Descriptor: 1 sector 
• Volume Descriptor Set Tennmator. l sector 
• The first 16 sectors are also reserved for system use. 

More sectors may be needed to store the Path Tables. or the root directory if its size eKceeds one sector as files are added. All 
this adds up to some space which will not be available for your appKcations and files, a fact which you must keep in mind when 
deten's1inin8 how much information you can fit onto the CD. 

Rerum to CD-Recordable Software Solutions page 
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Figure 1-10: Adding a footer graphic lends a professional touch to your page. 
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Some page designers prefer to place their icon buttons for links in the footer graphic 
as well; however, if your page contains a lot of infonnation, it's better to place your 
links at the top or along the side so that your visitors don't have to scroll through 
all of the contents to reach them. 

Now let's consider the size of your graphics. Nothing personal, you under
stand, this is strictly in the interest of design-but most novice Web designers 
naturally believe that bigger is better. In some cases that's true; for example, a 
title graphic should certainly stretch across most of your page. If your com
pany logo is well-recognized, it's to your benefit to display that image in a 
large size (perhaps in a watermark style, or as an image map with links to 
other pages); in fact, it could replace the title as a menu centered in the middle 
of the page. However, we immediately face that same familiar tradeoff be
tween loading speed and our artistic sensibility. 
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The best way to determine the optimal size for your graphics is to consider 
the subject of your page and the equipment being used by your average visi
tor. If your page centers around professional ·multimedia, digital audio, or 
digital video, you can probably assume that a large percentage of your visitors 
are going to be using high-speed connections provided by their companies; in 
this case it would be appropriate to pull out all the stops and use large graph
ics, complex animation, and the latest in browser plug-in technology. If, how
ever, your page centers around a special interest like cat juggling (thanks, 
Steve Martin!), your visitors are more likely to have that 14.4 bps dial-up 
connection I mentioned earlier, and you should place a reasonable limit on the 
number and size of your images. 

Also, keep in mind that the larger your graphics, the less space you'll have 
for text on your page. If your visitors must scroll through successive screens of 
a single page to read a small amount of text sandwiched between large graph
ics, their interest in your topic will naturally decrease. 

Your visitors also impose another limiting factor on the size of your graph
ics; those pesky surfers may not be using the same screen resolution on their 
system, and what looks wonderful onscreen at 1024 X 768 may not even fit in a 
640 X 480 screen! Of course, Navigator will wrap text, but it certainly won't 
look like you intended. 

The standard screen resolution these days is usually considered to be 
800 X 600, but it's a good idea to connect to your page at 640 X 480; in fact, 
the 'usable' or 'viewable' area of your browser window can be considerably 
smaller than the screen resolution. At 800 X 600, a maximized Netscape win
dow contains an area about 780 X 415. At 640 X 480 the area is about 615 X 300. 
If you're lucky enough to design your pages on a 17-inch monitor, make a 
mental note to check their appearance on a smaller 14-inch monitor as well; 
although the size of the monitor won't change the physical appearance, you 
may be surprised to see that your design simply "looks" better or worse on a 
smaller. screen. 

I use a simple rule of thumb on my pages; other than the title graphic, I 
limit the maximum size of my images to one-third of an 800 X 600 screen in 
both the vertical and horizontal dimensions. Remember, that's a maximum 
value for the size of an image; any graphic that takes up that amount of space 
on a page should be very important to your discussion. For example, a page 
that critiques a particular painting or photograph would probably use a 
graphic of that size, and perhaps even make it a download link for a larger, 
full-screen version of the same image. This rule holds for animated graphics as 
well, but remember that most animated images are considerably larger in file 
size than a static image of the same dimensions. We'll discuss more techniques 
on reducing the file size of your animated images later in the book. 
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If you must provide larger images online but you'd rather not slow down your 
page, consider adding image thumbnails. If your visitor can use the larger version 
of the image, a simple click on a thumbnail can download it directly to their com
puter at the fas test possible speed! 

Let's apply all this for our example: 

• Our graphics will center around a piano keyboard theme. 

• The piano keyboard image will be integrated into the page's title 
graphic, footer graphic, and used as a text separator. 

• Our graphics will be black, red, and yellow on a white background. 

• We' ll use a title graphic that includes our animated keyboard and the 
name of the page. 

• We'll use a series of small icon buttons for links and place them under 
the title. 

• We'll add a smaller footer at the bottom of the page that contains your 
e-mail address and copyright. 

• Finally, we'll create our page at 800 X 600 resolution for compatibility 
with the browsing public. 

As I said at the beginning of this field trip through page design, you 've 
gained a good working knowledge of how images are selected for a page, and 
we even have a fairly complete specification for our graphics. Of course, we're 
not done yet; we'll use this same specification that we've just designed to search 
for images in Chapter 2, and we'll actually create the images in Chapter 4. 

Moving On 

In this chapter, you were introduced to the importance of graphics for your 
Web site, as well as the advantages and disadvantages of adding animation to 
your page. We also covered the design criteria that will allow you to find or 
create the graphics you need for your page. 

In Chapter 2, you 'll learn more about where to find suitable images for your 
page and how to obtain them. 
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CHAPTER 2 

Finding Images 
to Animate 

DK, so you've designed your graphics and you ' re ready to place them on 
the page-but where the heck do you get these images (besides drawing them 
by hand, of course)? 

As I mentioned in the last chapter, I have all the artistic talent of a bottle of 
ketchup. However, this hasn 't stopped me from creating my share of Web pages 
with spectacular graphics, including custom-animated images that I've built 
myself. How do I do it? It's not by hiring an expensive professional artist
although that is one method-nor do I spend hours in a drawing package. 

Instead, like Radar O'Reilly in the classic TV series M*A *S*H, I'm a "master 
of acquisition"! There are so many image sources available today that I've 
never failed to find something that couldn' t be edited to fit my requirements. I 
find my images in a number of places: 

• From other Web pages. As long as you 're not infringing a copyright held 
by another person, you can capture and save images from other pages 
that catch your eye. Copyright law applies to any image (including those 
that you create yourself), and I'll be mentioning it throughout this chapter. 

• From other programs. You can capture full-screen graphics from other 
computer programs and edit them for use within your own pages. 

• From electronic documents. Do you have a graphic you'd like to use 
from a report or a company document? If it's in electronic format, you 
can convert it for use in animation. 
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• From film photographs. If you own the rights to a photograph, you can 
scan it and feature the electronic version on your page. This is also true 
for other printed graphics. 

• From commercial clip art. Royalty-free clip art can provide the perfect 
image for your page, including animated images. 

• From digital photographs. If you own one of the new generation of 
digital cameras, you can capture your own images for your page without 
scanning them, just like snapping photos with a film camera! 

• From videotape. If you have the copyright to the contents of a videotape, 
you can use one of several devices to create still images. 

In this chapter, we'll cover every thing you need to know to get started in 
the "acquisition" business yourself, including many examples of the most 
popular hardware devices and software programs used by professional Web 
designers. You'll learn how to search for specific images throughout the entire 
Internet as well. With a resource base so broad, you'll be surprised at the 
downright strange images you can find with a little digging! Finally, I'll touch 
on the legal side of copying images from the Internet. 

Of course, you can also acquire animated images directly from the Internet, 
which would save you the time and trouble of the animation process, but if 
you're using a specific subject-such as your company's logo, for instance
it's usually next to impossible to find an animated image that matches it ex
actly (or, for that matter, even comes close). Keep in mind that all animated 
images are built from static images, so if you can't locate a suitable animated 
graphic, later chapters will teach you how to build your animated image using 
whatever static images you find. 

Legal Issues 

Before we dive into the image resources available to you, let's start this chap
ter by discussing some of the legal issues surrounding copyrighted material. 
First, I'd like to make it perfectly clear that I am not a lawyer, and what follows 
are common sense rules to help you stay on the right side of the law; if you 
have a specific question about the legality of copying a certain image, consult 
your attorney! 

With that said, here are some general guidelines that may help you as you 
hunt through the electronic jungle for your images: 

• Permission must be obtained for each and every image you use! Just 
because the artist has previously given you permission to use copy
righted images before is no guarantee you'll automatically receive per
mission to use that latest image as well. 
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II What constitutes "use"? Any duplication or distribution on your part is 
considered use, including the act of scanning an image or posting an 
image on a BBS, an Internet newsgroup, or your Web site. 

Ill Availability is not permission! Even though you got an image from a 
newsgroup or found it on a Web site, that doesn't mean that it has been 
released into the public domain-explicit permission from the owner is 
required. Often an image that doesn't carry a copyright line is immedi
ately assumed to be in the public domain; however, that assumption can 
be dead wrong, since copyright is automatically granted upon creation of 
the original. 

II Non-profit use is no shield against a copyright violation. If you use a 
copyrighted graphic without permission, it doesn't matter whether you 
charged for access to your Web site or not. 

II Distributing a "backup" copy is a contradiction in terms; archival copies 
cannot be distributed. 

Ill Editing or altering an image-for example, cropping it, changing its size, 
or changing its color palette-does not invalidate the copyright nor does 
it result in a new original image. Your new image is still directly derived 
from an existing copyrighted image, and you're still in trouble. 

Iii Copyright extends to both the electronic and printed form of an image, so 
you also don't "remove" the copyright from a printed image by scanning it. 

You may ask, "So do I really need to copyright an original image that I 
create?" As I mentioned, copyright is granted upon the creation of the original, 
so technically you no longer need to add a copyright line to original images 
that you've created yourself. Many images are too small to carry a copyright 
line, and because the line must appear within the body of the image, this often 
isn't practical. 

However, if your image is large enough and you're sufficiently proud of it, 
adding a copyright line reminds others of your legal right, and it reinforces 
your position should you ever have to defend that right! You can use Paint 
Shop Pro to add text to any image, so follow these steps: 

1. First, open Paint Shop Pro and select Open from the File menu. Browse 
through your system and load your image. 

2. Next, click the Text button on the toolbar under the menu (it's marked 
with a bold letter A). Your cursor turns into a crosshair. 

3. Now move to the bottom left corner of your image and click the left 
mouse button. Paint Shop Pro displays the Add Text dialog, as shown 
in Figure 2-1. Select an easy-to-read font that you prefer and then select 
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a font size that's large enough to be easily read without spoiling the 
image. Your default text color is black. If you like, select the bold style, 
but avoid any text effects or italics, since these will diminish readabil
ity. Finally, enter the following text into the Enter text here box at the 
bottom of the dialog: Copyright (year) by (your name or a business 
name), All Rights Reserved. 

Substitute the current year and your name or a business name as 
indicated, and then click on OK. 

FortatbiUat=--=~--~~~~----~-==i 

,_.x-_____ ...., ... s111a ...... __ __, 
CreOl>l'___ !Bold 

·-~.-i .. ~ ... ~ Regular OelaRobbia BT ltolc 
Desdemona 
Ecipse 
ElegoGormnd BT 
Elementory Heovy SF 

]:' Elementor SF • 

Copyright 1997 by M.,k L Chombets. AI Rights Reserved 

OK Cancel I .u~ 

Figure 2-1: Selecting text attributes for our copyright line. 

4. The text should appear in the area you specified, but it may not be 
aligned as you like; to change the position of the text, move your mouse 
cursor over the text until it changes shape into a movement cursor. Click 
and drag the text to the exact spot. 

5. Save your image! 

Figure 2-2 shows you how the finished copyright notice appears on one of 
my original works-remember, I told you I was no artist when we met! 
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0 lmJgc7" (1 2 ( J!IJl-1 ~ 

Copyright 1Wl by Merk L Chambers, Al Rights Rt~Md. 

Figure 2-2: A finished copyright line (on an image that doesn't really need one). 

Using Images From the Internet 

The easiest method of acquiring images to animate is to take them directly 
from other Internet sources. Why? 

• You won't need additional hardware or software to copy these graphics. 
Most can be downloaded directly using Netscape Navigator! 

• These images will already be in the accepted GIF format, so you may be 
able to use them directly without any conversion. 

• The sophisticated search engines available on the Internet make it easier 
to locate images related to a specific topic. 

• Most pages offer links to related pages, making it easy to check for im
ages. For example, if you don't find the right image of a yellow-bellied 
triple-crested sapsucker on one bird watcher's page, you can jump to 
other pages that are linked to it and continue your quest. 

• Web surfing is generally more fun than traveling to your local library or 
digging through a collection of images on CD-ROM. 
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In this section, we'll search for the piano keyboard graphic we designed in 
the last chapter, and you'll use Netscape Navigator to save the image to your 
hard drive for later use. 

Searching for Existing Images 

Our first step is to locate existing Web pages and FTP sites on the Internet that 
might have graphics we can use. There are three methods of searching the 
Internet for graphics-we'll use the easiest first. 

Searching on the Web 
I personally think that searching on the Web is easy and fun-OK, so I'm a 
technoid, but after we're done I think you'll agree with me. We'll look for our 
image using my favorite Internet search engine, Yahoo! (As you probably 
know, the exclamation point is part of the name, but I do tend to wax enthusi
astic about this service, so it works out!) Follow these steps: 

1. First, open Netscape Navigator. If you're running MacOS or Windows 95 
and using a dial-up connection, this should automatically dial your 
modem and connect you to your Internet service provider. Once the 
Navigator main window has appeared, click in the Location field, enter 
www.yahoo.com (the address for Yahoo!}, and press Enter. 

2. The Yahoo! home page will appear, as shown in Figure 2-3. Most of us 
old-timers are very familiar with this screen; I've started many a night's 
surfing with a single search on a single keyword. In this case, we're 
looking for a piano keyboard, so click in the text entry field next to the 
Search button and enter piano graphic. Click the Search button to begin 
the search process. (See Figure 2-4.) 
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~ ......... 'YJlSoOf~ .... 
Yahoo! Atlanta EiET~T'taJWAHT. ~ 

~OW1"i.•.,._,.1111a1 cZ 

• Arts and Humanities 
~~L.lmllln-

• Business and Economy £Xtr:a1l 
~ iln'.ullAr. !JwlliW. Itw 

• Computen and J.nte.met (Xll:JJl 
lolmlll. l?iMIY. ~ ~ 

• Edncation 
Uniu11iti11 K:Jl. CqR1n fnkmn 

• Entertainment CX&D1] 
~ M.Rliu. ~ lllARl 

• News aod Media lXIDlJ 
CIMJIAI Ern!lt MumJ,rl. ~ 

• Recreation and Sports lXi:aJJ 
~ QtlW. IW.tJ. ~ Qiilllw.t 

• Reference 
L.'btwiu, ~ fhont HucQb111 _ 

• Scie.nce 
Cl!. Bio!osv ~ Eoiilam 

• GnvPmmPrit • Snr.:iAI Sdpnr.f\ 
CiiiUOiiit Omo 

Figure 2-3: The Yahoo! lrome page, where you can searclr for subjects. 

Categones - Sites - Alta Vina Web P ... s I Head!mes I Net Even1s 

Found 0 C ategory and l Stte Matches for piano anphic 

Yahoo! Site Matches ( t . 2or2) 

Entertainment" MUStc Instruments Piano Du-ectoncs 

• Piano Parlor - b:iks to many piano-related web Slles by cateaones mcludz:ng competmoru. educan.on. festivals, 
8'•phiu. mailing hsu. perfonnance. scores. sollware and sounds 

Figure 2-4: The site matches found for piano graphic. 
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Narrowing Your Search 

~N9w. w .. ~h .. a~ec,ond,MarkL..l've Lu~e,fVahopfa:milJl9h time.$tc>o~ butldon't:.un- \ 
- . - -. .. ' y -. - . . - . ' .. .• •.• . . . ., 

d·t$t~n(f why you .u~ed wowords jnster1ctofjustsearchin9,onpiano. Whatgiv~s?"· 
1 

Good question,trn .glad.you·askei:f fThe te~Jon Js.~simple: whenypu're·using : 
a·search e1,1gine on a·re$.b.urc~·~as QF.()ricf:~~t•'.d 9p·mple>.<'~@s the. Internet, a single 
word will return a huge number·of,.hfts.," an.Cfn1~rw ofthemwiU be sites that 
are completely unrelated tq yout$ubject~-WheliEJV.erpossible, ~arrO.w your search 
by µ~dog nmltiple worcls, ·and Y;C>ti'U,,·be muon more likely to display sites that 
conta.in the right information. You·may·wanttochedkt~e search·tules on the 
particular search p~ge; ju$t t.o· m~k~.·$Ure tba,tr,TlultiPl.e .. vvorc:f$.~re combined to~ · 
getller to narr()w the search py default,Jike upiano'.'(ANDl graphic;, rather than 

. "'piano (OR) graphic". 
Tec.hnicaUy, you will g~t the mos.t ¢prnr:>reb(:thS.iYE:l ~Qf:lr:<:h res.ufts by using 

· poly 'O..f)e kevword. However, if;yout su.bjectds well~krtown or popular, you'll 
save:.yourself minutes orey~n hours offruitle~s,surfil'.lgby intf.)Oigently narrow;. 
ing ;Y<>Ur sea.rctl,I · 

- While we're on the subject, here's a trick I use whenever I'm searching specifically 
for a graphic: I first try a search that includes the keyword graphic, as we did in 
·our example. Since many Web pages specialize in graphics related to a specific 
topic-I like to call them Web page "libraries" -my search will usually return one 
of these sites. Some of these libraries are even dedicated to providing you with 

[

1 
· graphics especially designed for Web use. If your first search doesn't return a 

match, then try removing the word graphic and searching again. 

3. Bingo! Our trick of including the keyword graphic in our search string 
has paid off. Yahoo! returns with two entries, the first of which looks 
perfect for our needs. Off we go to the Piano Parlor-click on the title of 
the first entry to jump to the page. As you can tell from Figure 2-5, this is 
an attractive, well-designed site specializing in everything you might 
possibly wish to know about the piano, including an entire section de
voted to piano clip art and graphics! 
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<Piano <Paifor 

Figure 2-5: The home page of the Piano Parlor Web site. 

We'll stop here and return to the Piano Parlor site later in the chapter. 
Of course, you don' t have to limit yourself to Yahoo! for Web-based 

searches. There are a number of other search engines that you can use as well. 
Table 2-1 is a list of the best-known and most popular search engines: 

Mark's Favorite Search Engines 

WebCrawler - www.webcrawler.com 

Alta Vista - www.altavista.digital.com 

Excite - www.excite.com 

Lycos - www.lycos .com 

The Open Text Index - index.opentext.netj 

Table 2-1: Popular Web search engines. 

These sites operate very similarly to the Yahoo! search engine, so you can 
follow the same steps. Although you can use an advanced search syntax on 
these sites, I don't think I've ever needed it; just enter your keywords sepa
rated by spaces. 
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Automating a Search 

If I need a quick and simple search on a topic, I'll pull down my Bookmark list, 
jump to Yahoo I, and follow the procedure wejustcovered. But what if you'd like 
to use all of the search engines in Table 2-1 without retyping and jumping around 
from site to site? 

I'm a big fan of automation whenever possible (read that " I'm lazy whenever 
possible") so for in-depth research I often use Quarterdeck's WebCompass, one 
of the new generation of automatic Web search programs. WebCompass will 
search all of the sites, summarize each in a paragraph or two, and even allow 
you to jump directly to the site using Navigator! Figure 2-6 shows the results of 
a search I did while researching an earlier book. 

E.c<eUve NMI o Sports Scmu o l oc:MWNlhe. :JJ 6 Ede 
DA.U12« DA.U12« S'1gje CO-ROM D1MI OR . 29 6 11 L)ocos 
CO-ROM Ol.llel'o Cauloo by Tile B BLADE FORCE by :l>O : 46.95 (Plod~- 26 SJ 31 

..., __ 
Dina Tel< 6 Speed CO-ROM Q..,. F0t F.n. Wom--. cal COMDEX/. 2< 0 0 y-
New S•Speed 6 •CO-ROM DIMI Tt. COS656 eo<snol CO-ROM ..... c... 21 10 1 y-

~ 9adu.c> to CO ACO-AOMcanholdthe...,,llenlol ... 21 13 Ede 

~i 
Eda Tcua EdeSeeriglcu1isJIO&ashortCIA lo._ 19 •s •5 Ede 
O,.,.Vote Undo< CoNlruciion 50llJI ... don' ...... mo,rch l,.,.,.,q,i 18 15 2 Ede 
VAWE CO BXPNPWSB16Sf'l(AS SWB l'locb:l.VAWECDB<PNPW/SB16- 17 50 2• t»JN ... 
INT EANAlCO ADM ORM KJT 6 X 650 KB ... ,,,_, INTEANAl CO ROM ORM ... 16 50 2• y-
NewQuad-SoeedCO-AOMOriveF0tM1crlL tod'Ol~theaddbonol o _ _ I< 1D y-

: CO-Cabr> CO ADM V""" Access HMMVltwlaccmto .. dJO.tCDR_ l .t Ede 
CO-ROMO..., Rl.n'WlgcnanATAPI rterfeee. ctndi..... 1' 1 l)'CO< ..... ctl-AOMOIAlel'sc.tologbyTileL UDAOSOF TAN TRAZZ AETAILbyA. .. 13 55 2• 

..., __ 
RoW .. lldCO-AOMO-lm T-><M·S. Re.W-CO-AOMO-l0tTosh .. 13 9 0 l)'CO< 
CO ROM DAM CLEANING KJT Boolunoli<lhs0o00for'""*f\ue14> 12 JB 20 y-
CO-ROM Ol.llel's c.tolog by Tile E ELITE MODELS 2RTL byOIGITALP 11 SJ JI 

..., __ 
ReW..,edCD-ROMd'Mll fCI' T~XM·S. , Re· Warted CO-ROM d'iv.:il for l oshi ... 10 0 Ll<OS 
Howlo~a~ When .....-..ct. !tis docunn"""' ... 5 

..., __ 
A>n!,D~, .. ~~ y;,., fri• 

Figure 2-6: Tile results screen from a search made with WebCompass. 

Searching With Archie 

CO-AO• 
CO-AO~ 

CO-AO• 
CO-AO• 
CD-AO• 
CO-AO• 
CO-AO• 
CO-AO• 
CO<flO• 
CO-AO• 
CO-AO• 
CO-AO• 
CO-AO• 
CO-AO• 
m-Ao • • 

No, we're not talking the red-headed kid you know from the comic books who 
can never decide between Betty and Veronica! On the Internet, Archie is some
thing else en tirely; it's an index service you can use to search all of the anonymous 
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FTP sites for a particular file. Although searching for and acquiring images via 
FTP isn' t as easy as it is on the Web, you have access to an incredible number 
of files around the world that you couldn't reach otherwise. 

In the old days-I'm talking at least three years ago-Archie used to be one of the 
primary reasons why you'd use the Internet. With the explosion in popularity of 
the Web, it's taken a back seat, but millions interested in research and downloading 
still use Archie every day-it's one of my favorite Internet resources! 

Unlike a Web search engine, Archie uses the filename as a search target 
instead of keywords. However, you can still use it to go "fishing" even if you 
don't know the exact name of an image file. To illustrate, let's perform the 
same search for a piano keyboard image through Archie. Follow these steps: 

1. Open Netscape Navigator. Once the Navigator main window has ap
peared, click in the Location field, enter www-ns.rutgers.edu/htbin/archie 
and press Enter. The Archie Request Form appears; you've connected to 
Rutgers University. The Archie Request Form is shown in Figure 2-7. 

Archie Server to use: I a:rchie .rutgers .edu 3 
Search by: 

C Lookin8 for Search Tenn in File Names 08Jiore UPPERJ!owercase) 
0 Lookin8 for Search Tenn in File Names (Pay attention to UPPERJ!owercase) 
(' Lookin8 for Search Term in File Name• using Regular Expressions 
0 Lookin8 for Exact Match 

Priority:~ 3 
Search Term: ,_ ____ __, 

Please note thar. lhs Archie s.rvtr may takQ s.wzra/ minuJ.es to compl•l• ils search. 

Figure 2-7: Ready to enter our Archie search form. 
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2. Scroll down the page until you see the Search by section. Select Looking 
for Search Term in File Names (ignore UPPER/ lowercase). 

3. Click in the Search Term box and enter the string piano. (See Figure 2-8.) 

4. Now click the Start Search button. In a few moments, the Archie Search 
Results page appears (see Figure 2-9). Notice that while there are many 
FTP sites listed, no descriptions appear. Depending on how popular your 
subject is, you could scroll through and look for interesting filenames, or 
you can select Find from the Navigator Edit menu and look for the target 
strings GIF and JPG to jump directly to image files. You can download 
any file that has a link on the result page by clicking on the link, jus t as 
you would download a file from a Web page. 

Archie Server to use: I archie rutgers.edu 8 
Soarth by: 

I'" Looking for Search Term 111 File Names (Jiinore UPPERllowercase) 
0 Looking for Search Term in File Names (Pay att<nlion to UPPERllowercase) 
0 Lookin8 for Search Term in File Names usin& Regular Exprm ionr 
0 Looking for Exact Makh 

Priority: lurgenl a 
Searth Term: ,_lP_ia_na ____ _, 

Figure 2-8: Using the Search Term on the Archie Request form. 



~ 
Chapter 2: Finding Images to Animate 35 

)t RutgeFs U.l:if,;e,-s-fty NeliwaFh 8eFf>iees 

Archie Search Results 

Results from &Jbstring search on archill.1Ulg1rs.1du for fJUJJW: 

suphys.physics.su.oz.au 

• Directory /FreeBSD/FreeBSD-CVS/src/games/piano 
o Last Changed: 1997 Apr 06 12:58:00 GMT 

ntuix.ntu.ac.sg 

• Directory /pub/fag/news answers/musidpiano 
o Last Changed: 1997 Mar23 15:3l:OOOMT 

• Directory /publfaglrec answers/musidpiano 

Figure 2-9: The Archie Search Results page. 

Searching With Veronica 
Yes, I understand you see a pa ttern developing here, but I promise you, there 
is no Jughead! Veronica is actually quite similar to Archie but to keep them 
separate in your mind, think of Veronica as a high-powered Archie search that 
delivers more information. Plus, you can limit your search to locate only 
graphic files! 

To demonstrate, let's look around the Internet using the same file specifica
tion that we used before. Follow these steps: 

l. Open Netscape Navigator. Once the Navigator main window has ap
peared, click in the Location field, en ter gopher:// 
dragon.dgsca.unam.mx:2347/7/ and press Enter. The Veronica Search 
Form appears (see Figure 2-10). 

2. Click in the keyword box and enter the s tring piano -tlg (your search 
form should look something like Figure 2-11). The argument following 
the keyword piano instructs Veronica to display only graphics files, 
which will save you a tremendous amount of scrolling! Press Enter to 
begin the search. 
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gopher://dragon.dgsca.unam.mx:2347/7/ 
Gopher Search 
Tus is a searchable Gopher 10dex. Use the search funcbon of your browser to enter search ttrms. 

This is a searchable index. Enter search keywords: 

Figure 2-10: We're ready to search with Veronica. 

gopher://dragon.dgsca.unam.mx:234717 I 
Gopher Search 
This is a searchable Gopher index. Use the tearth function of your browser to enter search terms. 

This is a searchable index. Enter search keywords: Jp1ano -~Io 

Figure 2-11: Entering the search keywords. 
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3. In a few moments, the results appear (see Figure 2-12). Notice that this 
page contains only graphic files because of the limiting keyword we 
added. Just as with an Archie search, you can download any file that has 
a link on the result page by clicking on the link. 

Gopher Menu 
un J.pr 6 18:59: 15 C5T 1997un J.pr 6 18 : 59:30 CST 1997@ p1ano .qU: 

~ p1ano.Jpq 

~ Piano Git [28KBJ 

~ PU.NO.GIT 

~ Tom Link.er CP1ano and Synt b.es1:terJ , Pon .rait. by Cceq !:d•ard.3 (2K) 

~ Still Life on a i":.a.no 

~ piano.git: 

~ llozart. Plano Test..qit 

~ lloz:art Piano restZ.oit: 

~ piano.ou c 18 - Jun-1991, 11.1KBl 

~ df9S0112. j pq Piano Le s ions 

~ piano 

Fig11re 2-12: Tire results page, containing only graphic files. 

Copying Images From Other Pages 

Once you've located an image you'd like to use on a Web page, you can re
trieve it in two different ways: 

• If the page includes a download link for the image, you can simply click 
on it to retrieve the file; you're actually receiving the file as a download. 

• If there is no download link for the image, you can use Navigator to save 
it to disk. In this case, you're not downloading the image-you're simply 
telling Navigator to make a copy of the image on your hard drive. 

Either method works fine, but remember, no matter which method you 
use, you' ll still require permission from the copyright owner to use the 
image on your own page! 
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Let's assume that we've looked through the Piano Parlor Web site for an 
image of a piano keyboard, and we've found it. As a matter of fact, I did find 
it, as you can see in Figure 2-13! As you can tell, the designer of this page has 
made it easy for me to download a copy of the image, piano.gif, by providing 
a link right underneath the image. Typically, these clip-art sites have a stated 
policy that grants you permission to use the artwork on your own page. 

hLo8.aj! 
7h:71 

307'71a1 

r-----r-(From--... -~--...--(From--... -..--- -
m..- t4.• r ... _., Viola Society) _ R!~od. 

Figure 2-13: Our piano keyboard graphic. 

However, what if there had been no convenient link? You can still copy an 
image from an existing Web page using Netscape Navigator. Follow these steps: 

1. Move your mouse cursor over the image you'd like to capture and right
click. Navigator displays the menu shown in Figure 2-14. 

2. Select the Save Image As item from the menu. 
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Figure 2-14: Navigator displays this menu when you right-click on an image. 

3. Navigator displays a standard Save As file dialog; the Windows version 
is shown in Figure 2-15. Move to the folder where you would like to 
store the file and enter a filename into the File name edit field. If your 
operating system recognizes the file as an image, the correct format 
should already be displayed in the Save as type field, so leave it as it is. 
Click Save to complete the process and save the image to your hard drive. 

Web Graphics 

Figure 2-15: This dialog allows you to save an image anywhere on your system. 
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That's it! You're now the proud owner of a GIF or JPEG image that you can 
use as the foundation for your own animated graphic. Remember, if your 
image is in JPEG format, it will eventually be converted somewhere in the 
animation process into a GIF, since only GIF images can be animated. 

Using Images From Other Programs 

Next, let's discuss how you can use graphics displayed in other computer 
programs. Naturally, you won't be using Navigator to capture images from a 
company presentation, the latest game, or an educational program; instead, 
we'll use the powerful screen capture feature built into Paint Shop Pro, one of 
my all-time favorite shareware programs! Paint Shop Pro is a real Swiss Army 
knife when it comes to any job involving graphics, which is why it's included 
on the companion CD-ROM. And later on in the book, we'll be using it for 
image editing as well. 

Generally, you'll find it much easier to capture screens from Windows or 
Macintosh programs. DOS capture programs do exist; however, since you 
can't multitask under DOS, your screen capture program must reside in 
memory as a TSR (or Terminate and Stay Resident) program, which often leads 
to incompatibilities that prevent them from coexisting with the other program. 
If you must use a DOS screen capture program, you'll probably be able to find 
one on the Internet if you search the larger shareware library pages; as a rule, 
though, always capture graphics from a Windows program whenever possible. 

As an example, let's suppose that you need to capture the image of the back 
of a playing card. Remember those time-gobbling Solitaire games? It's part of 
a world-wide conspiracy, you know; these programs are mind-numbing, 
insidious exercises in brainwashing, and I'm hopelessly addicted to them! 
However, they do feature some very nice playing card backs-see where I'm 
going with this? We'll use the Solitaire game that comes with Windows, but 
Macintosh owners can use any card game on their system. 

Bill, Don't Sue! 

We're only capturing a graphic from Windows Solitaire as an example) The 
card images supplied with the game are, of course, copyrighted-remember 
how I told you that you must be eternally vigilant against copyright infringe
ment? We wouldn't be able to use the captured graphic on a Web page without 
permission. Luckily, a playing card back is a common image, and you'd prob
ably find a royalty-free clip art image easily on the Internet. 
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To capture a graphic with Paint Shop Pro, follow these steps: 

l. First, run Paint Shop Pro and select Setup from the Capture menu. The 
Capture Setup dialog appears, as shown in Figure 2-16. 

Figure 2-16: The Paint Sfzop Pro screen capture setup dialog. 

Since you 'll likely use this powerful feature often in the future, let's 
take a moment to discuss all of the settings you see: 

• Capture. The Capture setting determines what portion of the screen 
you wish to record; I typically use either Full screen or Window to 
capture the entire screen or just the active window, respectively. You 
can also select Area, which will let you draw a rectangular box 
around the desired part of the screen; Client Area, to capture just an 
input area; or Object, to capture a part of the interface like the toolbar. 

• Activate capture using. This setting determines how you will trig
ger the capture. You can capture with a right mouse click, with a hot 
key that you specify, or a delay timer that will trigger the capture 
after the specified time has elapsed. 

• Options. Under Options, you can choose to include the cursor in 
your screen capture with the Include cursor check box. You can also 
specify whether to redisplay the Paint Shop Pro window after ·a 
single screen capture, or whether to keep it minirnized so tha t you 
can continue capturing screens. 

2. In this case, we'll select Area for the Capture setting, set a hot key of F12 
and disable the Multiple captures checkbox under Options. Once you've 
made those selections on the Setup dialog, click Capture Now. Paint 
Shop Pro automatically minimizes so that you can use the other pro
gram, but it's waiting for you to press the F12 key. 
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3. Open the program containing the graphic- in this case, Windows Soli
taire. Once the image you want to capture has appeared, press Fl2. You'll 
notice that the mouse cursor changes into a crosshair. 

4. Move the crosshair to the top left comer of a playing card back and click 
the mouse once to set an anchor, then drag the crosshair down to the 
lower right comer of the card . You'll see that Paint Shop Pro draws a 
rectangular box showing you the area that will be captured, and it also 
provides you with the physical dimensions of the rectangle in pixels. 

5. Once you've surrounded the area you want to capture with the rectangle, 
click again on the mouse, and Paint Shop Pro reappears with the cap
tured image in its main window, as shown in Figure 2-17. 

We'll cover cropping an image later in the book; for now, let's just save 
the image to disk, even if there's a little extraneous material surrounding 
the card back. 

x 

• • 

Figure 2-17: Our Windows Solitaire card back in Paint Shop Pro. 

6. Select the Save As item from the File menu. Paint Shop Pro d isplays the 
Save As dialog shown in Figure 2-18. Give your image a name in the File 
name field, or use the default name supplied by the program. In the Save 
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as type field, select GIP - CompuServe, and in the Sub type field, select 
Version 89a - Noninterlaced. Click on Save to save the image to your 
hard drive. 

Save As (lf3 

Filll)lllll« caidback ===-___:====· S-atM>e; l_GIF · CompuSetve 8 Cancel 1 
H• I 

J!! ~-1 
Figure 2-18: The Paint Shop Pro Save As dialog. 

Well done! You've captured an image, and it's ready to animate. 

Using Images From Electronic Documents 

If you'll be creating animated images for a company Web site, you'll probably 
be handed a floppy disk one day and told to "put the chart that appears in this 
report on our Web site." Other images that often show up on company 
intranets include organizational charts, logos, pictures of products, and photos 
of employees. How do you extract those images from an existing document so 
that you can use them? 

There are a number of possible methods, and the one you pick depends on 
the program in which the document was originally created. I'll cover the two 
that work with most of the programs I've used, and remember, if all else fails, 
you can always use the screen capture method that you learned in the previ
ous section to make a copy of the image! 

The Clipboard Method 

Both Windows and Macintosh owners can cut and paste images between 
applications. First, let's use the Windows Clipboard to temporarily hold an 
image until we can paste it into Paint Shop Pro. For this example, we'll use 
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Microsoft Word, which fully supports the Windows Clipboard; if you're using 
the Macintosh version of Word, the steps are basically the same. 

1. First, open Paint Shop Pro and minimize it. 

2. Next, open the document using the parent application and display the 
image you need to extract. Click on the image to select it; as you can see 
in Figure 2-19, Word automatically places a frame and handles around 
the image to indicate that it has been selected. 

Thu u • documtns. W\th an embtddtd gnphic:t , 

Figure 2-19: Selecting an image to extract in Word. 

3. Select Copy from the Edit menu to copy the selected graphic to the 
Windows Clipboard. 

4. Use the s tandard Alt-Tab sequence to switch to Paint Shop Pro and select 
Paste from the Edit menu. The graphic appears within the Paint Shop 
Pro main window, as shown in Figure 2-20, where you can edit it and 
save it in any form you like. 
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Figure 2-20: Copying our extracted image into Paint Shop Pro. 

The Separate Save Method 

Many Windows programs don' t fully support the Windows Clipboard, so the 
first method won't work. However, if you can select the image, you may be 
able to save it separately from a menu command or by using the drag and 
drop standard. 

l. First, open the document using the parent application and display the 
image you need to extract. Click on the image to select it, which should 
either frame the image or highlight it. 

2. Next, check the File menu to see if the program can export the selected 
graphic. Look for a command like Export Image or Save Image; if you 
can export the image, you should be able to save it either as a Windows 
bitmap or a GIP image file. 

3. If there is no command to export the image, run Paint Shop Pro and try 
dragging the selected image from the program window to the Paint Shop 
Pro main window. This sometimes works if the program supports drag 
and drop. 
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Using Clip Art 

Let's consider another popular source of static images. I've observed a strong 
disdain for prepackaged artwork among many of my friends and associates 
who professionally practice the arcane magic of graphic design- "Face it," 
they tell me, "even the term 'clip art' has a rotten connotation! It makes you 
feel cheap for just considering it as a source of images, and everyone who sees 
your work will know that you had to resort to-(gasp)-dip art." 

Well, partner, I'm here to proclaim the truth: I absolutely adore clip art, and 
so do many designers of the best Web sites around the Internet! If a particular 
piece of clip art fits your design and it's truly royalty-free, slap it on your page 
and save yourself a night's work. Or, if it's something close to what you need, 
spend a few minutes modifying it and consider yourself ahead of the game. 
There are tons of free images from several sources: 

• The Internet features hundreds of huge Web libraries that specialize in 
free Web graphics. 

• You can purchase one of dozens of CD-ROMs that are filled with color 
and black-and-white images. 

• Professional Web-ready art collections can be purchased online. 

• Many programs used by artis ts and Web designers are accompanied by 
their own clip art libraries. 

Don't Be Fooled! 

Most of us think the phrase uroyalty-free" means that we can use clip art in any 
of our own work without worrying about copyright or asking permission. It's 
important to note that this phrase can be misleading, so take a second to exam
ine the documentation or legal license that came with your clip art. If you're 
creating an image with clip art that's labeled royalty-free, you should always 
determine whether or not you're allowed to use those images through an elec
·tronic medium. Remember how easy it was to copy graphics from another page? 

Generally, if you're not allowed to redistribute royalty-free material or you're 
not given permission to use the images in electronic form, you should avoid 
using material from that clip-art library on your Web page. Many clip-art col
lections that have appeared recently are meant especially for the Web or give 
you specific permission to use them on the Web, so naturally these collections 
are ideal! 
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Is there actually any reason not to use clip art? Not really, but keep these 
guidelines in mind if you do: 

• Don't settle for the first piece of artwork that matches your subject. 
There is a practically endless selection of clip art available from these 
sources, and you're likely to find several pieces of similar artwork if 
you continue digging. 

• Avoid mixing artwork styles on your page! Nothing looks worse than a 
cartoon pencil on the same page as a serious business silhouette of a 
meeting in a conference room. If you're looking for only one graphic for 
a page, this is no problem, but if you'll be adding more than one piece of 
artwork, try and take them from the same collection by the same artist. 

• Avoid the "heady rush" of clip art! Just because you found twenty im
ages of people eating watermelon, don' t add all twenty to your page! 

Finding Clip Art on the Web 

Locating free clip art on the Web is essentially the same as locating an indi
vidual image; you'll use the same Internet search engines that I described 
earlier, but enter a broader set of keywords. As an example, try these search 
strings on Yahoo! the next time you're surfing: 

• Web graphics clip art 

• Computer clip art 

• Cartoon clip art 

You get the idea! Of course, you can also add keywords to limit the search 
to just about any subject, as we discussed earlier. Remember, some search 
engines match any of the search terms instead of combining them, so check 
the online instructions for your favorite search page. 

Get Coordinated! 

During my research for this book, I stumbled onto the track of one of the best free 
graphics pages on the Internet: Jelane Johnson's Free Web Graphics site 
(www.erinet.com/jelane/families/). What makes Jelane's site so wonderful? It's 
because all of the graphics on the site are coordinated into families, just like the 
expensive Web clip-art collections you can buy elsewhere on the Web. A family of 
Web graphics on Jelane's page includes an edge background, bullets, a horizon
tal rule, and various buttons, all matching and ready to add to your page! Their -
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appearance and design are as professional as the work I've seen on major cor
porate sites. As you might guess, it takes much less time to add an image family 
to your page than it does to hunt down individual graphics on ten different Web 
library sites and then match their palettes and add transparency! Figure 2-21 
illustrates a family Jelane designed for a white background. 

There's much more to this great site, though: 256 color families, families 
designed especially for white or dark backgrounds, experimental images of all 
kinds, and even hints and tips on Web design to help you learn to achieve the 
same effects. I give my highest rating to Jelane's Free Web Graphics sitel 

AD of the graphics are saved 11 JPG files Thoy are desii!Jied to be wed with a while back8round. 
• Graphics 

• Copying Graphics 
• Indenting Teict 

• ii e911a1t• I St 
~ You can we a paint projpm like Pmnt Shop Pro to add your own texl to !his blank 

~button. 

Figure 2-21: One of the great free clip art families available from felane's Free Web Graphics site. 

Most of these free online clip art libraries simply display as many images as 
possible on a single page; to download a specific image using Netscape Navi
gator, follow the procedure I outlined earlier in this chapter in the section 
titled "Copying Images from Other Pages." Figure 2-22 illustrates a typical 
online Web library containing a number of beautiful balls for use as buttons or 
bullets. Two fine examples of online libraries with Web-ready graphics free for 
the downloading are Over the Rainbow (www.geocities.com/ Silicon Valley I 
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Heights/1272/rainbow.htrnl) and Langley Computer Services 
(www.langley.co.uk/web_free.htrn). I also recommend the Clip Art Connec
tion (www.ist.net/clipart/ index.htrnl), which includes dozens of links to the 
best clip art pages on the Internet. 

Tht:se orbs can be used u bullets or to attn.ct attention to a particular area of a page. These were aD 
created by Langley Computer Services. 
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Downlood a ZIP file of free BT!Plncs from tins Pue (541ch) 

DO NOT LINK DIRECTI.Y TO ANY GRAPIDCS ON TiilS SERVER. PLEASE COPY THE 
GRAPIDC TO YOUR OWN SERVER. 

Figure 2-22: A typical Web page clip art library. 

Who provides these free library pages? Friendly graphic artists and 
Webmasters who appreciate that all of us can use a graphical "helping hand" 
from clip art. To show your appreciation, feel free to leave the Webmaster a 
"thank you" email message! Some sites also offer inexpensive collections of 
their clip art, which can save you considerable time in downloading all of 
those images. 

Using Clip Art on CD-ROM 

Speaking of saving time and clip art collections, there are CD-ROMs full of clip 
art available at most computer stores, and a little comparison shopping can 
usually supply you with a "ready-made" clip art collection that you don't even 
have to be online to use. When you're shopping for a clip art CD-ROM, make 
sure that the images it contains can be saved as Windows bitmap, GIF, or JPEG 
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format. Many of these collections are intended only for printed material, and 
the images are in Windows metafile format or Macintosh .TIF forma t. Metafile 
images are much harder to edit and convert to a form that can be used on the 
Web, so steer clear of them. 

Needle in a Haystack 

I also recommend that you avoid buying a clip art collection that doesn't include 
some sort of preview interface. Many collections come only with a thumbnail 
index, and they're not arranged in any order-try to find an image of a sports 
car among ten thousand images, and you'll know what I mean! The best collec
tions have a program that acts as a front end; with an interface like this, you can 
search for a specific image by its description or view all of the images in a par
ticular category to look for the right one. Figure 2-23 shows a preview interface 
from one popular clip art CD-ROM, showing a directory of more animal images 
than I'm likely to need for the rest of my life! 

Figure 2-23: Looking for an animal image on a clip art CD-ROM. 
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Using Professional Web Clip Art 

Although it's much more expensive than searching for a particular image in 
the free online libraries, there's certainly something to be said for buying a 
professionally made collection of clip art that's been created especially for Web 
pages. As I said, you can often ·order a complete collection from some of the 
free Web image libraries; these complete collections often arrive as one gigan
tic ZIP file in your e-mail or on a number of floppy disks sent to your home. 
Some commercial clip art collections are even maintained online; once you've 
paid the purchase price, you're given a user ID and password to access the full 
site and all the graphics! 

When buying a professional art collection, keep these guidelines in mind: 

II Look for a complete collection that has all the elements you'll need to 
create a page, including bullets, separator bars, backgrounds, titles, and 
buttons. 

Ill Make sure that all of the graphics included in the collection are indeed 
actually "Web-ready"! Buttons should already be transparent, for ex
ample-we'll talk about transparency later in the book-and background 
texture tiles should flow seamlessly to create a smooth visual effect. After 
all, part of the value of a professional clip art collection is that you can 
begin using the images immediately, with no editing required. 

" Remember that most of the professional Web clip art collections available 
today are not designed around a specific subject-in other words, don't 
expect a huge selection of sports images in a Web collection! Instead, 
Web clip art collections tend to center around the image design elements 
we covered in the last chapter, such as backgrounds, separator bars, 
buttons, and icons. There are exceptions to this rule, however, most of 
which center around cartoon and business images. 

Figure 2-24 displays a sampling of the contents of a typical professional 
Web collection-this one is from Little Men Studios (members.aol.com/ 
lmenstudio/index.html), who specialize in Web-ready and EPS (short for 
encapsulated Postscript) graphics. You can download the entire collection from 
their Web site; once you've purchased the collection, you receive a password 
to unlock the protection. 
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Back&roonds and Arrows 
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Figure 2-24: Sample images from one of the Web-ready clip art collections available from Little 
Men Studios. 

Using Application Clip Art 

Our final source of clip art may be sitting on top of your desk: it's the artwork 
that's often included with applications! If you've recently bought a commer
cial Web design package, check and see if the manufacturer included any clip 
art (often, free artwork is added to CD-ROMs to "fill out" the disc, but it's not 
mentioned on the box). Other candidates for application clip art include word 
processors, desktop publishing packages, and even banner and greeting card 
software. As an example, Corel's Web.Graphics Suite comes with some of the 
professional clip art you see in Figure 2-25. 

Speaking of Corel, I'm a big fan of their Professional Photos CD-ROM 
series, and they make a great source for stock photos (otherwise known in the 
"biz" as clip art) on a particular subject. Each disc holds 100 huge, high-resolu
tion color images on a subject; for example, Figure 2-26 shows a sample image 
from their WWII Aircraft disc. Other subjects include everything from insects 
to windsurfing to Hollywood models. If you're lucky enough to find a Profes
sional Photos disc that covers the same subject as your site, you've discovered 
a gold mine! 
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Figure 2-25: An example of the free clip art included with Corel Web.Graphics Suite. 

Figure 2-26: This Corel Professional Photo disc includes 100 images of World War II 
fighter aircraft. 

.. 



~ 

54 OFFICIAL NETSCAPE GUIDE TO WEB ANIMATION 

{ ___ ] Scanning Images From Printed Material 

Now let's turn to another source of images for your Web site: the printed page. 
Illustrations from books and magazines, personal photographs, technical 
drawings, promotional materials-even product boxes and packaging-can be 
scanned directly into your PC for editing. 

To scan printed ma terial, you 'll need a scanning device and a program 
capable of image acquisition. Let's discuss the hardware first! 

Adding a Scanner to Your System 

There are four major types of scanners available today: 

• The flatbed scanner. This is the familiar full-page unit that most people 
think of; its scanning bed closely resembles the scanning surface of a 
copy machine. Books and magazines can be laid flat on its surface, and 
it's very easy to use. Because the material doesn't move, flatbed scanners 
can handle much higher resolutions as well. Flatbed scanners were very 
expensive until recently, but their prices have dropped below $500. 

• The hand scanner. Once an inexpensive alternative to a flatbed scanner, 
hand scanners have all but disappeared due to the drop in flatbed prices. 
A hand scanner must be rolled slowly over the material to be scanned, 
which often results in distortion; the scanner head should be rolled 
forward in one smooth motion, and that's often a problem with a book. 
Since most hand scanners only have about a four inch scanning width, 
you must often make multiple passes over a book or magazine page, and 
the software automatically "stitches" the separate passes together into a 
single image. This has worked for me in the past, but many people have 
told me that they've never been able to successfully graft separate scans 
into a seamless, complete image. 

• The sheetfed scanner. A sheetfed scanner most closely resembles a fax 
machine, and it operates something like one as well; you feed a single 
sheet of paper through, and the scanner draws it in and scans the con
tents automatically. This is a little less than perfect, however, if you're 
trying to scan a photograph or another image that's less than 8.5 inches 
wide; typically, you must tape the photo on a piece of paper and feed 
the entire sheet of paper through to make it work. Also, you' re limited 
to a single page, so be prepared to start tearing pages from your books 
and magazines! 
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• The photo scanner. The ultimate in scanner specialization! A photo 
scanner can accept only photographs developed from a film camera, but 
it handles them automatically and the results are usually very good. If 
your material is larger than a standard photograph, forget it: you'll have 
better luck scanning anything else with a waffle iron. 

Are you in the market for a scanner? I would highly recommend a standard flatbed 
model; it's the most versatile, and now that prices have fallen so dramatically, most 
of us can afford one! 

Color Depth & DPI 

If you're shopping for a color scanner, there are two other criteria that will help 
you make a decision: the scanner's color depth support and its dpi rating. Sim
ply put, a scanner's color depth refers to the number of bits used to store color 
data for each pixel, and the more bits the better. Most color scanners today offer 
24-bit color, and the better, more expensive models offer 30-bit color. 

On the other hand, the dpi rating indicates the resolution of the scanner in 
dots per inch-again, the higher the dpi rating, the better. You should note that 
some scanner manufacturers actually use two different numbers when describ
ing dpi; always look for the "raw" scanning quality, not an "optimized" value 
that may be a result of software. 

Today's scanners also use one of two interfaces: 

• Parallel Port. These are the easiest scanners to connect. No need to re
move your computer's case or install additional adapter cards; the scan
ner simply plugs into your PC's standard parallel printer port. If you 
already have a printer, it usually plugs into the scanner-a system that 
computer old-timers like me {who not only remember the Atari 400/800 
line of home computers, but still have one or two!) call daisy-chaining. 

The vast majority of printers work well connected to parallel port devices, but it's 
still a good idea to contact the manufacturer of your printer to make sure you can 
use it with a parallel port scanner. The company's technical support group should 
be able to advise you on compatibility. 
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• SCSI. Scanners that use the SCSI interface are much faster than their 
parallel port cousins, and if you already have a SCSI adapter card in your 
system, you probably won't have to open your computer. Macintosh 
owners can simply skip to the next section, since Macs have always used 
SCSI! However, if you don't already have SCSI on your PC, even the 
simplest SCSI installation is roughly akin to running barefoot across hot 
lava. First, make sure that the scanner comes with its own SCSI card; if a 
card isn't included, you'll have to buy one separately. Also, check the 
instructions: the manual should lead you through the installation step-by
step. If you've never installed an adapter card, you can also take your PC 
to a local computer shop and pay them to install and test the equipment. 

At the time of this writing, the street price for a 600 dpi, 24-bit parallel-port 
flatbed scanner was about $250, while a 1200 dpi, 30-bit SCSI scanner typically 
started at about $600. 

Using Scanning Software 

Now let's consider the scanning software you'll use. Every scanner worth its 
salt should come equipped with at least two pieces of software: 

• A driver program. Since the Macintosh has always used SCSI and Wm
dows 95 now has direct support for SCSI devices, it's much easier to install 
a scanner these days - but your scanner must still be able to communicate 
with your acquisition software, which is the task performed by your 
scanner's driver software. For this reason, all good scanners today con
form to a driver standard called TWAIN, which applies equally to Wm
dows and Macintosh computers. If your scanner uses TWAIN, all you 
need to do to make certain that any software you buy will work with 
your scanner is to make sure that it's TWAIN-compliant. 

• An image acquisition program. You must also be able to configure and 
control your scanner from your computer, and in tum your computer 
must be able to display and store the images you scan; your image acqui
sition program will take care of this job. 

Both of these pieces of software should be included with any scanner you 
buy, but most manufacturers also throw in goodies like image editing software 
and an OCR.program (short for Optical Character Recognition). 

The best solution to the headaches caused by all these separate programs? 
How about combining the image acquisition and editing programs together? 
Guess who comes to the rescue again ... our familiar Swiss Army knife, Paint 
Shop Pro! Yes, you can acquire images from TWAIN-compatible scanners 
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directly into Paint Shop Pro, where they can be edited to your heart's content 
and saved in any format the program supports. Figure 2-27 shows an image 
acquired within Paint Shop Pro. 

Figure 2-27: Images can be read directly from a scanner using Paint Shop Prof 

Capturing Video 

···-• 

There's one last source for graphics you can use on your page that we need to 
cover: digital imaging. Just like image scanners, the technology behind digital 
imaging has become more commonplace, and prices have dropped for this 
equipment in a similar fashion. 

There are two sources for digital images: 

• Digital cameras. If you're interested in image editing and graphics, the 
digital camera is probably the most useful piece of hardware to arrive in 
the last 5 years! Imagine a camera that looks something like a "point and 
shoot" film camera, but it contains no film. Instead, a tiny video camera 
inside the unit takes the "snapshot," which is then stored in the camera's 
RAM until it can be downloaded to your computer. Most of these cam-
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eras also feature a built-in LCD viewing screen, so you can actually see 
your pictures immediately after you take them. If you find yourself 
running low on digital "film," you can delete any selected image from 
memory to free up the RAM for another picture. 

These cameras vary in video resolution and the number of images they can 
hold, but prices now start at about $400 on the street, and those prices are sure 
to come down as they become more popular. 

• Video capture hardware. Video capture adapter cards have been around 
for many years now. Video from a television, VCR, or laserdisc player is 
fed into the card, which transforms it into .AVI or .MOV format digitized 
video. Of course, live video isn't suitable as a basis for still images, but 
these cards can capture individual "frames," which can then be saved as 
static images. 

Recently, a number of new products have surfaced that allow video 
capture without requiring you to install an adapter card. For example, 
the Snappy video capture system uses a parallel port connection! Figure 
2-28 shows a still image captured from an old commercial advertising the 
classic Batman TV series; I used the Snappy and a standard VHS VCR as 
a source. 

Figure 2-28: A still image digitized from a TV commercial using the 
Snappy parallel port device. 
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Neither of these digital sources will provide you with the same quality 
image as a flatbed scanner, but if your subject material centers around photog
raphy, film, or television, you 'll still appreciate the chance to add digital im
ages to your Web page! 

Moving On 

In this chapter, you learned where to look for images for your Web page and 
how to obtain them. I started the chapter with some warnings about copyright 
law and an example of how you can add a copyright notice to your own 
original work. We searched the Internet, captured screens from other pro
grams, used clip art, scanned images, and even explored the newest in video 
capture technology! 

Coming up in Chapter 3, I'll introduce you to the basics of image editing 
using a program that's rapidly becoming an old friend of yours: Paint Shop Pro. 
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CHAPTER 3 

Editing Images 
for Your 
Animations 

S o, now you find yourself sitting on top of a gold mine of images ... but 
before you animate your first pixel, I have a quotable quote you should re
member: There is no such thing as a perfect image! 

That may not seem like an earthshaking proclamation, but it provides the 
solid foundation upon which the rest of this chapter squarely sits. Let me 
explain: in our last chapter, you learned how to acquire images from a wide 
variety of sources, and of those sources the Internet proved to be the easiest to 
use. However, whether you find an image on the Internet for free or you buy 
an expensive clip art package, the images you'll end up with are rarely exactly 
what you need. Something is missing, or something needs to be altered before 
you can use it. 

This is especially true for animated images, which are built from indi
vidual frames-each image frame in your animation must be subtly different 
from the others to create the illusion of movement, so you'll find yourself 
adding or subtracting details in each image. We'll cover the animation pro
cess in the next chapter. 

Since animated images are larger in file size-the actual number of bytes in 
the image file-than their static counterparts, I also typically resample or crop 
my images to a smaller size before I begin the animation process so that the 
finished image doesn't take minutes to load. 

In general, the modification of a picture to correct shortcomings or to make 
it fit a particular use is called image editing, and if you look at any recent mail 
order software catalog, you'll see that many companies charge hundreds of 
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dollars for the best image editors.You've probably done some image editing 
already for the existing graphics on your pages, but even if you're an old hand 
with your editing application I'm sure you'll find new techniq~es in this 
chapter that will help you in the future. 

In this chapter, and throughout much of the book, we'll be relying on the 
Paint Shop Pro image editor. Paint Shop Pro is one of those classic success 
stories of the shareware world; in fact, in the beginning, the program was 
available only as shareware.You could download it from any BBS (remember, 
bulletin board systems were around for ten years before the Internet arrived), 
and you could use all of its features without encountering a slew of crippled 
features and then register it if you liked the program. Today, Paint Shop Pro is 
one of the best-known image display, image editing, screen capture, and 
painting programs around, and it's still available as shareware. However, you 
can also find it on retail shelves as well. 

Paint Shop Pro is distributed by JASC Inc. and the shareware version is 
included on the companion CD-ROM; you can also check their Web site at 
www.jasc.com for the latest version of the program. If you like what you see 
and all the powerful functions it offers, help support its continued develop
ment by registering it online. If you're a registered owner of Paint Shop Pro, 
you can also download updates from the JASC Web site. 

Since Paint Shop Pro is not available for the Macintosh, I've also included a 
section later in the chapter on basic image editing using Adobe PhotoDeluxe, 
which can perform most of the same functions. In this chapter you'll see how 
to use Paint Shop Pro to put your "raw" images through one or more modifi
cations so that they can be used as animations on your Web pages. I've ar
ranged these techniques in alphabetical order as a quick reference to make it 
easier for you to locate a particular editing function. 

II Borders. If you'd like to add a finishing touch to an image and help it to 
stand out on a page, add a border. 

Ii Brightness/contrast. Unless you like the images on your page too dark 
and hard to identify-or too washed out-you may have to make 
changes to the brightness and contrast ratio. 

l!!I Colors. "OK, how can I give this image that cool Andy Warhol look?" 
With Paint Shop Pro, you can change the color levels in your image and 
add just a hint of Pop Art! 

Iii Color depth. As I mentioned earlier in previous chapters, a 16 million 
color image can be reduced to 256 colors, making it more attractive for 
more of your visitors. The image's palette may also need to be changed 
to use Windows standard colors. 
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II Crop. This is an old journalism term for removing extraneous material 
from a photograph. If you only need one section of an image or you need 
to separate one object, you'll crop it. 

II Cut/Copy/Paste. With the Cut, Copy, and Paste commands, Paint Shop 
Pro allows you to selectively move or remove portions of an image or 
add objects from other images. 

• File conversion. You've got the perfect image, but it's in something 
called "PCX" format. Help! Paint Shop Pro can convert individual im
ages, or you can convert an entire directory of images automatically in 
batch mode. 

• Flip/mirror. If an image isn't "pointing" in the right direction, it may 
need to be flipped, or you may need to create a mirror image copy. 

II Gray Scale. Paint Shop Pro makes it easy to remove all colors from an 
image to create a gray scale graphic. 

Ill Image Compression. Both the GIF and the JPEG image standards used 
most often on the Web include compression-you'll save your visitors 
loading time by compressing the images you use on your pages. You can 
alter the compression level of JPEG images within Paint Shop Pro. 

Iii Interlacing. By adding interlacing to your GIFs, your visitors can watch 
as the images on your page are slowly "built" right before their eyes
it's a neat effect you've seen many times. Although interlaced GIFs are 
rarely used in animation, they are useful in reducing the perceived load 
time for a GIF image. 

• Resize/resample. Resizing involves changing the entire size of the im
age; this can either alter the appearance of the image or simply enlarge or 
shrink it. Resampling is a more sophisticated method of resizing that 
usually produces better results. 

Ill Rotate. Often you can add a tremendous visual appeal to an image by 
simply rotating it! 

II Transparency. There's nothing more aggravating than finding that the 
image you want to use on a white background has a black square sur
rounding it! By adding transparency to an image, it can be made to 
appear as if it were floating above any color background. 

In this chapter, I'll show you how to apply all of these finishing touches to 
your images. Once you're experienced in image editing, you will actually be 
able to say that you have the perfect image for your page-and mean it! 
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Borders 

A common image editing chore is the addition of a border to a graphic that 
deserves special attention. Typically, the border wiJI be a complementary color 
to your background, but, then again, neon green or shocking pink does make a 
statement. 

The important thing to remember about borders is tha t they actually be
come a part of the image, and therefore contribute to the total file size. If 
you're adding a border to a Windows bitmap file, take note: the larger a bor
der you add to an image, the more time it will take to download. However, if 
you stay away from bitmaps, there's no need to be quite so vigilant. Paint 
Shop Pro creates a border of a solid color, so compressed GIF and JPEG format 
images won't grow significantly in size. 

Paint Shop Pro can produce two types of borders: a symmetrical border 
that's equal on all sides or a border with custom dimensions that you specify. 
To add a border to an image, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. We need to specify the color to use for our border. Move the mouse cursor 
over the color palette display at the far right side of the window; you'll see 
that the cursor changes into an eyedropper, and the color display changes 
to reflect the color that's underneath the eyedropper. When the display 
contains the desired color, right-click to pick up that color. 

3. Select Add Borders from the Image menu to display the Add Borders 
dialog, as shown in Figure 3-1. 

Figure 3-1:The Add Borders dialog. 

4. If you need a symmetrical border, enable the Symmetric check box. 
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5. Use the scroll buttons at the right side of the Top field to select a positive 
value in pixels; if you selected a symmetric border, you'll see that all of 
the other fields automatically take the same value. You can also double
click on the current figure and type a new number directly into the field. 
If you're not creating a symmetrical border, enter the values for the 
bottom, left, and right edge of the border as well. 

6. Click OK to make the change or click Cancel to back out without chang
ing anything. 

Figure 3-2 illustrates our piano keyboard with a 50 pixel symmetrical border. 

Figure 3-2: The addition of a border will help draw attention to our image. 

Borders & Icon Bars 

As I mentioned earlier in the book, many sites use an icon bar image map as 
their navigation controls. Such a bar might include a Home button, a button for 
each page, and a button for a search engine. You can use the Add Borders com
mand to create the background for an icon bar by creating a custom border 
around a single icon. 

To do this, load bne of the icons you'll use, disable the symmetric feature, 
and specify 5 or 10 pixels for the Top and Bottom values, then specify 200 pixels 
for both the Left and the Right values. Figure 3-3 shows the result: a long, thin 
bar background that's just the right size, and it already includes one of your icon 
buttons! Once you've saved this new image, you can place the other icons on 
top of the bar with Paint Shop Pro, and voilal a custom icon bar. Of course, you 
can use different values for the Left and Right fields if you need a longer or 
shorter background bar. 
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Figure 3-3: A custom icon bar built with the Paint Shop Pro Add Borders command. 

Brightness/ Contrast 

Often you'll find graphics that will work well on your page, but you can't 
really make out the detail you'd like to see in the image. For example, our 
piano keyboard image in Figure 3-4 is too dark to see, while the same image in 
Figure 3-5 is too washed out. This is a problem that occurs often with images 
you've scanned from a magazine or book. 

Figure 3-4: An example of a brightness problem. 
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Figure 3-5: An example of a contrast problem. 

Paint Shop Pro allows you to adjust the brightness and contrast for a spe
cific image, much like you'd adjust your computer's monitor for the best 
picture under new lighting conditions. Follow these steps: 

l. Select Open from the File menu, browse through your system, and load 
your image. 

2. Select Adjust from the Colors menu and then select Brightness/Contrast 
from the submenu, or use the Shift+B key sequence. Paint Shop Pro 
displays the Brightness/Contrast dialog, as shown in Figure 3-6. When 
you first display the dialog, both values are set at 0%, and either value 
can be set to a positive or negative percentage. 

~~ a-.- I 
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Figure 3-6: The Brightness/Contrast dialog. 

3. If you'd like to brighten or darken the image, use the scroll buttons at the 
right side of the % Brightness field to select a positive (brighten) or 
negative (darken) value. You can also double-click on the current figure 
and type a new number directly into the field. The maximum value is 
100%, while the minimum is - 100%.You'll see that the thumbnail image 
changes automatically to give you some idea of how your change will 
affect the image. If you'd like to apply the change to test it, click the 
Preview button and the actual image will be changed. However, you can 
undo the effect of your preview by clicking Cancel to exit this dialog. As 
I mentioned before, you can also select Undo from the Edit menu if you 
accidentally accept a change. 
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4. You can change the contrast of the image in a similar manner by chang
ing the % Contrast field. 

5. Once you've achieved the desired effect, click OK to make the change or 
click Cancel to back out without changing anything. 

Colors 

This function will come in handy if you'd like to modify the three primary 
color levels that appear in an image; color level refers to the amount of red, 
green, and blue color in an image (as you may know, these three colors are 
combined together to form different colors of projected light). You can easily 
increase or decrease the level of red, green, or blue throughout an entire image 
to create a very interesting effect. Nothing quite like a purple sky to attract 
attention! 

To adjust the red, green, or blue levels in an image, follow these steps: 

l. In Paint Shop Pro, select Open from the File menu, browse through your 
system and load the image. 

2. Select Adjust from the Colors menu, then select Red/Green/ Blue from 
the submenu-or use the Shift-U key sequence. Paint Shop Pro displays 
the Red/Green/Blue dialog shown in Figure 3-7. 

Figure 3-7: The Red/Green/Blue dialog. 

3. If you'd like to increase or decrease one of the color levels in the image, 
use the scroll buttons at the right side of the corresponding % field to 
select more or less of the color value. You can also double-click on the 
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current figure and type a new number directly into the field . The maxi
mum value is 100%, while the minimum is -100%.You'll see that the 
thumbnail image changes automatically to give you some idea of how 
your change will affect the image. If you'd like to apply the change to 
test it, click the Preview button and the actual image will be changed. 
However, you can undo the effect of your preview by clicking Cancel to 
exit this dialog. 

4. Once you've achieved the desired effect, click OK to make the change or 
click Cancel to back out without changing anything. 

Just the Facts 

If you need the facts about an image, select Image Information from the View 
menu or use the Shift-I key sequence to display a dialog with complete informa
tion about the current picture. This includes the color level, the file type, and the 
subtype. Figure 3-8 illustrates the data for a JPEG image. If you've loaded an 
image into Paint Shop Pro, the program also provides the image size and color 
level at the lower right corner of its window in the status bar. 

Figure 3-8: Image infonnation for a JPEG graphic. 
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-- Color Depth 

Color depth is a term you're likely to encounter often in discussions of com
puter graphics, so let me define it here; the color depth of an image refers to 
the maximum number of individual colors that can be represented in an 
image. For example, an image with a color depth of 16 can include a maxi
mum of 16 different colors, while an image with a color depth of 256 can 
include a much wider variety of colors. Generally, the larger the maximum 
number of colors, the better-looking the image. 

"If I have the capability to display 16 million colors, then why not use 
them?" As I mentioned earlier in the book, you should certainly take advan
tage of today's advances in displaying true photographic color on your moni
tor. For a Web page, though, 16 million colors is usually not a smart move 
because many of your visitors will not be able to display 16 million colors. · 
This is a color depth known as True Color-and True Color images take much 
longer to download. 

For example, let's consider the transfer of a standard 640 x 480 Windows 
bitmap image using 16 million colors over an average 28.8 kbps connection. 
It's likely to be more than a megabyte in size, and since Windows bitmap files 
aren't compressed, the download will take over 8 minutes. If we reduce the 
number of colors in the image to 256, the file size drops by over 50 percent to a 
little over 350K, and the same image will take less than 4 minutes to download 
over the same connection! 

There will be times, however, when you need to expand the color depth of 
an image rather than decrease it; for instance, it's a requirement that you 
increase the color depth to 16 million colors before resampling an image. 
Typically, you'll also decrease the color depth back to 256 colors after the 
resampling process is over. Some image filters also perform better in 24-bit (or 
16 million) color (we'll be covering image filters later in the book). 

Follow these instructions to alter the color depth of an image: 

1. In Paint Shop Pro, select Open from the File menu, browse through your 
system, and load your image. 

2. Select Decrease Color Depth (or Increase Color Depth) from the Colors 
menu, and then select the desired color depth from the submenu. If 
you're decreasing the color depth, Paint Shop Pro displays the Decrease 
Color Depth dialog, as shown in Figure 3-9. 



~ 

Chapter 3: Editing Images for Your Animations 71 

Figure 3-9: The Decrease Color Depth dialog. 

3. Paint Shop Pro gives you the option of an optimized or standard palette. 
I always use the Optimized palette because it usually results in a better
looking image (especially when you're drastically cutting the number of 
colors in the image). 

4. Next, always select Nearest color as your Reduction method. If you 
select Error diffusion, your image may be dithered and grainy in appear
ance, so avoid this for Web pages. 

5. Finally, always select Include Windows' colors, which will ensure that 
Paint Shop Pro includes the standard Windows colors in the image's 
palette. This will allow any visitor to your Web site to view your images 
using a standard 256-color driver. 

6. Click OK to make the change or click Cancel to back out without chang
ing anything. If you choose OK, Paint Shop Pro will display a progress 
bar within the status line at the bottom of the window to let you know 
that it's working. 

7. Don' t forget to save your image or, if you'd like to keep the original 
image unchanged, select Save As from the File menu. 

To increase the color depth of an image, follow the first two steps above. As 
soon as you indicate the new depth for the image, Paint Shop Pro will imme
diately process the image. 

Count the Colors 

It's time to clear up a common misconception that I've read many, many times 
on the Internet-the idea that a 16-million-color JPEG image actually has 16 
million distinct colors. It just isn't so-the common color depths of 16, 256, 32,000, 
64,000, and 16 million indicate the maximum number of colors the image can 
contain at that color depth, and most images rarely reach even a fraction of 
those larger numbers. 
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For example, I selected a typical JPEG image with a color depth of 16 million 
from my collection, but the actual number of distinct colors in the image turned 
out to be only 29,501. What a rip-offl Now of course, there are images out there 
on the Internet that actually reach several million distinct colors, but they're 
several megabytes long, and you' ll probably never see one unless you actually 
dig through some of the fine art libraries on the Web. In fact, most Web surfers 
are still more than satisfied with a measly 256 colors. 

How do I know exactly how many colors are in an image? Easyl Load the 
image you'd like to check in Paint Shop Pro, and then select Count Colors Used 
from the Colors menu. As shown in Figure 3-10, the program will return in a few 
seconds with a dialog displaying the exact color count. 

So, the next time you overhear someone boasting about color depth at a party, 
you can claim a social coup with a simple correction. Sure, it could happen .. . 

Figure 3-10: Paint Shop Pro can count the number of colors in an image. 

As a general rule, then, it's best to reduce the color depth of all your Web 
images to 256 colors using this process. Your visitors will thank you. 

Crop 

Figure 3-11 shows an image that will make a perfect example for several tasks 
within this chapter-just pretend that it's your Uncle Milton, crazy vacuum 
cleaner salesman, from last month's family reunion! Good thing you had that 
digital camera with you. 

Suppose you really like the face in this image, and you'd like to place it at 
the comer of your page dedicated to famous salespeople in your family, but 
you don' t need the vacuum cleaner he's holding. Also, you like the white 
background, but you'd like to center the attention on his face, and that door 
hinge at the right side of the picture has got to go. Resizing or resampling the 
image won' t help; how can you reduce the image to just his face? 
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Figure 3-11: An image flint needs to be cropped to remove unneeded material. 

Time to crop the image. Follow these steps: 

1. In Paint Shop Pro, select Open from the File menu, browse through your 
system, and load your image. 

2. Click the Selection icon on the toolbar; it looks like a rectangle made of 
dotted lines. You'll notice that your mouse cursor becomes a cross-hair 
with a tiny rectangle attached to indicate that you're in Select mode. 

3. Move your mouse cursor to the top left corner of what will become your 
new image; for example, I would start at the top of the graphic to the left 
of the face. · 

4. Now click your mouse button and drag the selection frame to the lower 
right corner of what will be your new image; you'll notice that the frame 
follows your cursor. Once you've reached the lower right corner, release 
your mouse button, and the solid frame turns into a snazzy animated 
dotted line, as shown in Figure 3-12. At this point, you've indicated to 
Paint Shop Pro the portion of the image that you want to keep. 
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Figure 3-12: A portion of the image has been selected, and it's ready to crop. 

5. To perform the actual cropping, select Crop from the Image menu, or use 
the Shift-R key sequence. The result is shown in Figure 3-13. 

Figure 3-13: After cropping, you're left wit/1 a new image that you can save under a new name. 
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···-· I've always found it a good idea to save a cropped image separately from the origi
nal, since there's no telling when you might need that full image. After you've 
cropped the image to your satisfaction, select Save As (or press F12) from the File 
menu and save it under another name. Do not simply select Save; remember, the 
cropped version still has the same name, so you could overwrite the original image! 

Cut/Copy /Paste 

Of course, you're probably familiar with the Three Stooges of Windows appli
cations-after all, without the cut, copy, and paste commands, I can guarantee 
you that this book could never have been finished. I just don't have the pa
tience for a typewriter anymore! 

However, we're going to cover some of the specific differences between 
these commands in a standard Windows application and their implementation 
within Paint Shop Pro. I think you'll be pleasantly surprised by the flexibility 
this program offers in selecting objects within your images. 

For a complete discussion of the selection modes available within Paint 
Shop Pro, see the next section, "Selections." 

Using the Cut Command 

The Cut command removes the selected portion of your image and stores that 
portion in the Windows Clipboard for later use. The area that was occupied by 
the cut portion is automatically filled with the current background color. 

You can cut a selected area by selectmg Cut from the Edit menu, clicking 
the Cut icon in the toolbar, or by pressing the Ctrl-X key sequence. 

Using the Copy Command 

The Copy command copies the selected area to the Wmdows Clipboard for 
later use. The image remains unchanged. 

You can copy a selected area by selectmg Copy from the Edit menu, clicklng 
the Copy icon ill the toolbar, or by pressing the Ctrl-C key sequence. 
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Using the Paste Command 

The Paste command copies the contents of the Windows Clipboard to the 
Paint Shop Pro window. The contents can be used in four different ways: 

• As a new image in a separate window. 

• As a new selection within the current image. 

• As a transparent selection within the current image. In this mode, the 
pixels of the image in the Windows Clipboard that match the back
ground color are automatically made transparent. 

• As a replacement for the current selection within the current image. In 
this mode, the contents of the Clipboard replace the area currently se
lected within the image. 

You can paste by selecting Paste from the Edit menu, clicking the Paste icon 
in the toolbar, or by pressing the Ctrl-V key sequence. 

Selections 

Paint Shop Pro has a number of tools for selecting the portion of an image to 
which you wish to apply a command; most of the commands mentioned in 
this chapter can be applied to both the image as a whole or the portion that's 
currently selected. 

Using the Select Shape Tool 

Paint Shop Pro provides a Select Shape tool that allows you to select one of 
four types of geometric shapes: a rectangle, a square, an ellipsis, or a circle. 

To use the Select Shape tool: 

1. Click the dotted square on the toolbar; your mouse cursor will turn into a 
crosshair with a tiny rectangle attached. 

2. Move the crosshair to the edge of the desired area. 

3. Click and drag the mouse to enlarge the shape until it covers the area 
you wish to select. 

.4. Once you've encircled the selection, release the mouse button, and 
choose the action you want to perform. 

To change the shape of the selection tool, choose the desired shape from the 
Selections type drop-down list box on the Style Bar. If the Style Bar is not dis
played, you can toggle it on by selecting the Style Bar item on the View menu. 
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Using the Lasso 

The Paint Shop Pro Lasso is more formally called the Freehand Selection tool, 
and it's used to select an area of the screen by drawing around it. Of course, 
the larger the object or screen area, the less attractive this is, but if you only 
need to crop, copy, or cut a small portion of an image, then the freehand 
method often proves the best. 

To use the Freehand Selection tool: 

1. Click the lasso on the toolbar; your mouse cursor will turn into a 
crosshair with a tiny lasso attached. 

2. Move the crosshair to the edge of the desired area. 

3. Click and drag the mouse to draw the selection line around the area, just 
as if you were drawing in a painting program. 

4. Once you've encircled the selection, release the mouse button and choose 
the action you want to perform. 

5. Figure 3-14 illustrates a completed Freehand selection-in this case, your 
Uncle Milton's head from the reunion picture. Believe me, this kind of 
work is much, much easier with an artist's computer drawing pad-for 
freehand selection, a mouse or a trackball just doesn't cut it. 

Figure 3-14: A selection made with the Freehand tool. 
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Using the Magic Wand 

What could be better than a lasso? How about a magic wand? The Paint Shop 
Pro Magic Wand tool is used to select regions within an image that match a 
color, a specific hue, or a brightness level. This makes it easier to select an 
object that stands out from the background or other objects in the image with
out having to "draw" around it with the Lasso tool. When you use the magic 
wand, Paint Shop Pro will automatically select as much of the object as it can. 

To use the Magic Wand tool: 

1. Click the wand icon on the toolbar; your mouse cursor will tum into a 
crosshair with a tiny wand attached. 

2. Move the crosshair to the edge of the desired area. 

3. Click the mouse on the area you'd like to select. This generally takes a 
little experimentation, especially if you're working with a 16 million 
color image. If necessary, you can adjust the match tolerance or choose 
between color, hue, or brightness matching from the Style Bar. To display 
the Style Bar, toggle it on from the View menu. 

4. Once you've selected the proper portion of the image, choose the action 
you want to perform. 

5. Figure 3-15 illustrates a completed Magic Wand selection base4 upon 
color-this time, we've selected the white portions of your Uncle 
Milton's head from the reunion picture. Rather a ghostly effect, don't you 
think? Imagine adding just that white outline to your site on Halloween! 

File Conversion 

Since GIF and JPEG images are your two primary choices for Web graphics, 
you'll often be converting Windows bitmap files to one or the other format, 
and you can even import existing clip art from your WordPerfect days or 
image files from that old Amiga system you just threw out! 

There are two methods of converting image files within Paint Shop Pro
you'll use one method for converting a single file and the second method for 
converting multiple files. 
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Figure 3-15: A selection made with the Magic Wand tool. 

Converting a Single File 

To convert an existing image file in one of the formats supported by Paint 
Shop Pro, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
the image. Remember, your file will not appear in the list unless you've 
selected the proper file type or if you've selected the All Files type to 
display everything. 

2. Select Save As from the File menu and select the desired file type. Usu
ally the default file subtype is correct, so you'll rarely have to change it. 

3. If you'd like to save the converted file in a new directory, select it now by 
navigating through your system with the standard browse controls. 

4. As I've demonstrated with earlier functions, you can also set a number 
of options for most file types by clicking the Options button. Again, 
the default settings are fine for most applications, so this usually isn't 
necessary. 

5. Click Save to save the image to your hard drive. 
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Converting Multiple Files 

To convert several files in one of the formats supported by Paint Shop Pro, 
follow these steps: 

l. Select the Batch Conversion item from the File menu to display the Batch 
Conversion dialog, as shown in Figure 3-16. 

Iii S.ml1 

01-07wa 02-07wa 
01-0ew. 02-0llwa 

01 -03w• 01-09..a 02-03wa 02-09..a 
01-04wa Ol·Hlwa 02-04wa 02·10wa 
01.ffiwa 01·11wa 1102.asw. 02·11 wa 
01 -0liwa 01·12wa 02-06wa 02·12wa 

Figure 3-16: The Paint Shop Pro Batch Conversion dialog. 

2. Within the Output settings section of the dialog, set the file type and 
subtype for the finished files, and select any format-specific options that 
may apply by clicking the Options button. For example, you may want 
to select a JPG file type with a compression level of 25, and all of the 
finished files will be in that format with that compression level. 

3. Next, type in the destination path for the new files in the Output folder 
field at the bottom of the dialog. You can also navigate to the desired 
directory by clicking the Browse button (where you can also create a new 
directory to hold the files). 

4. Now select the directory containing the files to be converted in the list 
box at the top of the dialog. 
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5. Select the files that will be converted. You can select files by clicking on 
them in the standard Windows fashion (don't forget to hold down Shift 
to select ranges of files or Ctrl to select non-contiguous files). 

If you're like me, you'll be converting several files of one type to another type. To do 
this quickly, enter a DOS wildcard in the File name field, like *.BMP or *. TIF. If 
you select a specific file type, you can also use the Select All button to select all files 
of that format automatically. 

6. Click Start to begin the conversion! 

Flip & Mirror 

Flip and Mirror are close relatives of the Rotate function (see "Rotate" in this 
chapter). As shown in Figure 3-17, selecting Flip from the Image menu (or 
pressing Ctrl-I) will tum your image upside down. As shown in Figure 3-18, 
selecting Mirror from the Image menu (or pressing Ctrl-M) will create a mirror 
image of your graphic. These commands come in handy when you need to 
change the direction of an arrow graphic or some other image that has a defi
nite direction to it. 

Figure 3-17: The effects of the Flip menu command. 

Figure 3-18: The effects of the Mirror menu command. 
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Gray Scale Conversion 

Strangely enough, another method of drawing attention to your favorite 24-bit 
color image is to remove the colors! Just like many photographers who prefer 
black and white for portraits, some Webmasters appreciate the impact of gray 
scale images. Using Paint Shop Pro, you can easily convert images to 256 
levels of gray without losing detail. Follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. Select Gray Scale from the Colors menu. Paint Shop Pro displays a 
progress bar in the status line at the bottom of the window. 

3. Once the image has been converted, select the Save As command under 
the File menu and save it under another name. 

Image Compression 

Luckily, there's another trick that can help you save downloading time and 
reduce the length of your images: several picture formats that are popular on 
the Internet allow you to compress the data in your image without losing too 
much detail! 

For example, the standard GIP 89a format is already compressed at an 
average of 3:5 to 4:1, depending on the variance in color and detail. This is one 
reason why GIFs have been the standard for Internet and Web use since the 
beginning-and it's also the reason why they don't compress as well as text or 
programs when you're using PKZIP, ARJ, or any other popular compression 
scheme. In fact, the overhead introduced by trying to compress GIP images even 
further usually makes the .ZIP archive slightly larger than the original GIP. 

The JPEG format is generally considered to be the king of image compres
sion, since it was designed from the very beginning to produce highly com
pressed, 24-bit images with little loss in detail. Paint Shop Pro allows you to 
control the compression rate when you save a file in JPEG format. 

!Afz "up-and-coming" alternative to JPEG and GIF has been getting quite a bit of 
·attention on the Internet lately . . PNG format, short for Portable Network 
Graphics, has a number of advantages that may make it a formidable contender for 
future Web images .. PNG images allow progressive display (much like interlaced 
GIFs), lossless compression on the order of JPEG quality, and more control over 

. gamma correction, but they do not support animation. 
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To adjust compression on a JPEG image, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
the image. 

2. Select Save As from the File menu. Again, make sure you've selected the 
JPG - JPEG - JFIF compliant file type, with a sub type of Standard encod
ing, then click the Options button to display the JPEG File Preferences 
dialog shown in Figure 3-19. 

Figure 3-19: The JPEG File Preferences dialog. 

Be careful-you can easily get the JPG file type mixed up in Paint Shop Pro 
with another format called JIF (they're right next to each other in the File Type 
drop-down list box). JIF is significantly different from JPEG, and it's not handled 
by most browsers. 

3. The first option, DP! to be saved, is typically used in desktop publish
ing and word processing programs, and I usually leave it at the default 
value of 300. 

4. The default compression level is 15. Setting this value higher will in
crease the compression and shrink the file length at the expense of detail; 
for example, Figure 3-20 shows a typical JPEG image at the standard 
compression, while Figure 3-21 shows the same image at a compression 
level of 80-not really all that much different in detail, are they? In file 
sizes, though, there's a major difference: the image saved with the com
pression level of 15 is 37,287 bytes long, while the image saved with the 
compression level of 80 is only 10,680 bytes long! In my experience, most 
Web surfers would be content with an image with a compression level of 
60 or below. Click OK to save the new compression value. 
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5. Finally, specify a new filename for the file, and click Save to save it to 
your hard drive. 

Figure 3-20: A JPEG image at compression level 15. 

Figure 3-21: The same JPEG image at compression level 80. 
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What's Progressive Encoding? 

There are two subtypes for JPEG images: one of them, progressive encoding, 
allows JPEG images to "fade in" much like an interlaced GIF. Since JPEG im
ages are typically compressed to a smaller size, showing a hazy version of the 
picture that grows in detail isn't as much of an advantage as it is with GIF im
ages-also, older browsers will stubbornly refuse to load progressive JPEGs. 
For these reasons, I currently avoid progressive encoding to ensure compatibil
ity and use the standard encoding instead. 

Interlacing 

Interlacing is one of the oldest tricks in the Webmaster's collection, but it only 
works with GIF images. By storing the data that makes up the image in alter
nating lines instead of in sequence, interlaced GIFs appear to "fade in." First 
you see the outline of the image and a suggestion of the detail, then another 
layer of detail and so on. From your visitor's standpoint, this is definitely 
preferable to waiting for the full image to inch downwards ... "Is it a dolphin? 
That looks like a fin ... no, it's a .. . well, actually, it might be a periscope ... ". 
You get the idea. 

The slower the connection to the Internet, the better interlaced GIFs be
come. A visitor connecting to your page via a direct Tl line or a fast 33.6 kbps 
dial-up connection can endure the wait for non-interlaced images to load, but 
the visitor with a 14.4 dial-up connection will probably stick around much 
longer watching your interlaced images appear. Actually, the two images take 
the same amount of time to load over the same connection, but at least inter
laced images give you something to look at while you wait! 

To add interlacing to a GIF file, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. Select the Save As command under the File menu. To add interlacing, make 
sure the File type is set to GIF, with a sub type of Version 89a - Interlaced. 

3. Finally, specify a new filename for the file, and click Save to save it to 
your hard drive. 
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Resizing/Resampling 

Probably the most common image editing task is resizing, which involves 
shrinking or expanding the physical size of the image to match the size you 
need for your design. Since it's very rare that you happen upon an image that 
fits that space you've set aside, I end up resizing just about every graphic I use 
on my Web pages. When you resize an image with Paint Shop Pro, the pro
gram copies or deletes pixels (a pixel is one individual dot that makes up the 
image); this expands or shrinks the image, respectively. 

~ mentioned in Chapter 1, resizing an image to a smaller size will reduce its 
length and the time required to download it. There's a reason why most pages don't 
display huge, full-page images-would you be willing to wait three or four minutes 
for a Web page to load? 

But wait- there's an even better alternative to resizing! Think of resampling 
as resizing's "smarter brother," and use resampling whenever possible. Al
though the two are quite similar-they even use the same dialog-resampling 
uses a smart interpolation algorithm to reduce the chunky, blocky look you 
sometimes get with resizing. Images almost always look better at their new 
size if you resample; as a rule, the larger the change in size, the more benefit 
you 'll receive from resampling over resizing. 

if':ike resizing, however, resampling can only be applied to images with more than 
256 colors (or shades of gray for grayscale). If your image is only 16 or 256 colors, I 
suggest that you temporarily increase the color depth to 16 million colors (see 
"Color Depth" in this chapter), perform the resampling, and then decrease the color 
depth back to its original state. 

To resample an image with Paint Shop Pro, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. Select Resample from the Image menu to display the Resample dialog, as 
shown in Figure 3-22. 
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Figure 3-22: The Paint Shop Pro Resample dialog. 

3. The column of radio button options down the left side of this dialog is a 
"quick pick'! list of the most common image sizes. For example, 800 
pixels horizontally by 600 pixels vertically, which is a standard desktop 
size. If your image should be resampled to one of these standard resolu
tions, click the desired size. 

If you'd like to set a custom size, click the Custom size radio button, 
and enter the horizontal and vertical dimensions for your image. 

4. The Maintain aspect ra tio field is very important when resampling an 
image. If you leave this feature enabled, Paint Shop Pro will make sure 
that your new image is not distorted by using the same aspect ratio. If 
you disable this feature and make a dramatic change in the horizontal-to
vertical ratio of your image (for example, custom resampling an image 
from 800 x 600 to 400 x 700) you're going to create an unusual look in
deed, and you probably won't even be able to recognize the subject! 
Figure 3-23 gives you some idea of what turning off the Maintain aspect 
ratio field can do; this poor image used to be an image of the U.S. flag 
with an aspect ratio of 1 to l, until I forced it to 700 x 100! 

Figure 3-23: An image resampled without maintaining the correct aspect ratio. 

Many professionals use this trick to create wonderful images- for 
instance, a skinny elephant or a real stretch limousine! Unless this is the 
effect you' re looking for, leave the Maintain aspect ratio field enabled. 
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If you've resampled to a custom size and you maintain the aspect ratio for your 
image, Paint Shop Pro can calculate either the correct vertical or horizontal dimen
sion for you! Enter the value you do know into the custom size field and press Tab. 
The program will automatically fill in the other dimension to maintain the correct 
aspect ratio. 

5. Click OK to make the change or click Cancel to back out without chang
ing anything. 

Let's Tall< Undo! 

This is probably a good time to mention that Paint Shop Pro features an Undo 
command that will reverse the effect of your last action; if you make a grave 
mistake while editing an image, select Undo from the Edit menu immediately 
afterwards and try again. 

Several dialogs also display the effects of the change to a thumbnail copy of 
your image automatically (which is both really nifty and a real convenience).You 
can also click the Preview button to apply the change to the image itself; if you 
don't like the appearance of the change, you can click Cancel and exit the dialog, 
which also cancels the effect of whatever change you made. 

Rotate 

Now let's return to our piano keyboard, as shown in Figure 3-24; it's currently 
a horizontal graphic, so it's well-suited for use as part of a page title or as a 
horizontal separator. 

llllllfillmlllllllOJ 
Figure 3-24: Our piano keyboard graphic in its original horizontal alignment. 
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But wait-a sudden flash of inspiration hits! How would it look if you were 
to run the keyboard as an edge graphic down the left side of the page? This 
produces a seamless ''border" for your page-in fact, some of the best-designed 
pages on the Web use this trick. Unfortunately, you couldn't use your keyboard 
for this effect in its current alignment, since these edge graphics are vertical. 

How can you change the alignment of an image? Follow these steps: 

l. In Paint Shop Pro, select Open from the File menu, browse through your 
system, and load your image. 

2. Select Rotate from the Image menu or use the Ctrl-R key sequence. Paint 
Shop Pro displays the Rotate dialog, as shown in Figure 3-25. 

Figure 3-25: The Paint Shop Pro Rotate dialog. 

3. First, select whether your rotation should be toward the right or left. 
In this case, we' re looking for a left edge border, so choose the Left 
radio button. 

4. Next, choose the degree of rotation. The most common alignments have 
their own radio buttons, but you can also choose the Free option and 
enter a specific degree of rotation. For our edge example, we'll pick 90 
degrees for a vertical alignment. 

5. Click OK to make the change or click Cancel to back out without chang
ing anything. 

Figure 3-26 illustrates the new image, which you can save separately for 
later experiments! 
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n 
Figure 3-26: The image with its new alignment, ready for use as an edge border! 

Transparency 

You've probably noticed that I mention transparency quite a bit throughout 
this book because it really is that important to the proper display of your 
image on your Web page. Transparency will allow you to "float" GIF format 
images above just about any background by specifying one color within the 
GIP as transparent. Figure 3-27 illustrates an image tha t could benefit from 
transparency on a white background-it's that spinning animated movie reel 
from my Web site. 
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Figure 3-27: Without transparency, t/1e black border on this image stands out like a sore thumb. 

Unfortunately, the word on transparency really hasn ' t made it to everyone 
yet. In fact, many Webmasters seem to covet the entire process of adding · 
transparency like it was some sort of magic trick. "If we tell them how we did 
this, then it won' t be magic anymore." 

Well, I've got sad news for these "Web magicians"-adding transparency 
to any GIP file is not ha rd to do. Follow these s teps and learn a little magic 
for yourself: 

1. Before we begin, make sure your image is a GIF file, with a sub type of 
Version 89a - Noninterlaced . If your image isn't in this forma t, use the 
Save As command under the File menu to convert the file into this for
mat and save it under another name. 

Normally, I'm a Jan of interlaced GIFs on Web pages, as you remember from the 
section titled "Interlacing" in this chapter- but some older browsers don't handle 
interlaced GIFs with transparency very well. Therefore, for the best compatibility, 
make sure your transparent GJFs are non-interlaced. 
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2. Once your image is ready, select Open from the File menu, browse 
through your system, and load it. 

3. Click the Eyedropper button on the toolbar; your mouse cursor becomes 
an eyedropper, and you can pick up colors directly from your image. 

4. Move the eyedropper over the portion of the image that needs to disap
pear. In this case, it's the black background, which is typically the reason 
why you apply transparency and right-click to pick up that color. You've 
now selected that color as the background color for the image. 

5. Paint Shop Pro sets transparency from the Save As dialog, so select Save 
As from the File menu. Again, make sure you've selected GIF file type, 
with a sub type of Version 89a - Noninterlaced, then click the Options 
button to display the GIF File Preferences dialog shown in Figure 3-28. 
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Figure 3-28: The GIF File Preferences dialog. 

6. Select the third option, Set the transparency value to the background 
color, and click OK. 

7. Finally, specify a new filename for the file and click Save to save it to 
your hard drive. 

Figure 3-29 shows our image on the same background after adding trans
parency-quite a difference! 

Figure 3-29: With transparency added, our image looks much better on a white background. 
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You can also paste the contents of the Windows Clipboard into the current 
image and automatically force transparency on the pasted image. From the 
Edit menu, select Paste, and then select As Transparent selection from the 
submenu; the pixels that match the background color of the image in the 
Windows Clipboard are automatically made transparent. 

Image Editing With Adobe PhotoDeluxe 

PhotoDeluxe can be considered the "younger brother" of Adobe's Photoshop. 
The Macintosh version requires a minimum of a 68040 processor with 8 mega
bytes of RAM (or a Power Macintosh with a minimum of 12 megabytes of 
RAM) and 45 megabytes of hard drive real estate. Figure 3-30 shows the 
PhotoDeluxe main window. 

Figure 3-30: The Adobe PhotoDeluxe main window. 

To load or acquire your image, select Get Photo. PhotoDeluxe can import 
pictures from a wide range of sources, including hard drive, Kodak PhotoCD, 
a digital camera, and a scanner. If you use a camera or scanner, it must either 
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be TWAIN-compatible or you must install an Adobe Photoshop-compatible 
plug-in to support it. 

PhotoDeluxe provides a large number of Guided Activities which will lead 
you step-by-step through most of the tasks we performed manually with Paint 
Shop Pro-they correspond to the Wizards available in many Windows pro
grams. For example, to resize an image, rotate it, or flip it, you would select 
the Guided Activities button from the main window, click the Touch Up Photo 
button and then click the Size/ Orientation icon from the Touch Up tab. 
PhotoDeluxe displays an example and a number of numbered tabs that corre
spond to the steps in the process, as shown in Figure 3-31. To begin, click on 
the Step 1 tab and follow the onscreen directions; once you've completed it, 
continue to Step 2 and so on. The onscreen help is both well-written and 
comprehensive, making this program a great choice for the graphics novice. 

~ me Edit --- Size/Orientation 

SIZEIDRIENTRTION 

~Use this project to straighten out your photos end to t rim 
away unwanted areas to focus In on your subject. 

Figure 3-31: Preparing to resize an image within Phot0De/11xe. 

You'll also use this tab menu system when you modify an image manually. 
Instead of clicking Guided Activities, click the On Your Own button, and then 
select Modify to display all of the command buttons. The commands are 
grouped into four major types: Orientation, Size, Quality, and Effects, and you 
can access any tab or command button in any order. 
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···-· So you'd rather work with traditional menus than the default tab menu system? No 
problem-from the File menu, choose Preferences and then select Long Menus. 
Photo Deluxe will display a standard pull-down menu. If you need to use a Guided 
Activity, however, you'll need to return to the tab menu system by selecting the 
Short Menus item from the File menu. 

PhotoDeluxe uses a set of selection tools similar to Paint Shop Pro. To 
choose a selection tool for manual work, click the On Your Own button from 
the main window and load your image. Next, choose Modify. Finally, under 
the Select tab, choose the selection tool you want to use and click New. 

Selection tools include geometric shapes (square, rectangle, oval, and 
circle), the Color Wand, the Polygon, and the Trace tool. 

To save your finished image within a Guided Activity, select the Save tab; 
from the On Your Own area, click the Save button, and then pick the Save 
command button. PhotoDeluxe displays a File Save dialog; type a name for 
the file, select a location, and click Save. Note that this command saves your 
file in Adobe PhotoDeluxe format. 

If you need to save the image in another format, you should select Export 
from the File menu. PhotoDeluxe can export files in PICT format, which is 
probably the best choice for use in GifBuilder; select PICT, type a name for the 
file, select a location, and click Save. 

Moving On 

In this chapter, you learned all of the basic skills necessary for image editing, 
and we practically memorized the insides of Paint Shop Pro! You probably 
noticed that Paint Shop Pro has a number of other tools designed to add image 
effects. If you like, you can explore these effects on your own, but we'll be 
using Photoshop in Chapter 5 to achieve many of the same results. We also 
discussed PhotoDeluxe, an image editing program popular on the Macintosh. 

Coming up in Chapter 4, we tum our attention to creating simple animated 
GIFs using a number of tools that are . .. well ... just plain fun! 
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CHAPTER 4 

Creating Simple 
Animated GIFs 

Saturday morning cartoons-that's what all this World Wide Web hub
bub over animated GIFs boils down to. Whether it was Daffy Duck, Scooby 
Doo, or Jonny Quest, we all grew up with Saturday morning cartoons. As a 
society, we want our images to run and jump and fly. After all, once you've 
spent a few formative years watching the Pink Panther saunter around getting 
into trouble, a static picture will never be quite as interesting as something 
that moves! 

In this chapter you'll be using the same techniques still used by many 
cartoon animators to add animated life. To begin, I'll explain what's involved 
in creating an animated GIF. Next, I'll introduce another favorite program of 
mine, GIF Construction Set from Alchemy Mindworks. Next you'll learn to 
use GIF Construction Set to create your first simple animated GIF both the 
easy way (using the Animation Wizard) and the hard way (manually). We' ll 
use the latest version of GifBuilder by Yves Piguet to create animated GIFs on 
the Macintosh. I'll also cover other programs that have recently appeared that 
can automate the animation process and save time to boot. We'll cover the idea 
of "usability testing" and how it can help you in fine-tuning your animated 
images. Finally, we'll end the chapter by discussing how you can save loading 
time by optimizing your new animated GIF. 
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So How Are Images Animated? 

Before we animate your GIF images, you've got to learn how the process works 
so let's take a moment or two and discuss the basics of the art of animation. 

At one time or another, you've probably seen the familiar series of pictures 
that illustrate how a horse gallops. Just to make things a little tougher on the 
line artist for this book, I' ll illustrate the same effect in Figure 4-1, where you'll 
see the wings of a gargoyle move up and down in a series of thumbnail im
ages. The path covered by the wings as they travel up and down is called the 
motion cycle; it starts as the wings start to travel and ends when they've re
turned to their original point. 
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Figure 4-1: This sequence of images illustrates the motion of a gargoyle's 
wings. It also illustrates my exceptional skills an artist! 
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To create an animated cartoon of the same gargoyle flapping its wings, the 
animator would place each of these images in this sequence on top of each 
other (rather like the old "flip books" we all used to enjoy as kids). Each im
age, or animation eel, is actually a slice of the entire motion cycle. Since most 
animation is done for film or video, the eel is created by placing the image on 
a transparent piece of glass or plastic and taking a photograph of it. Depend
ing on how long the subject is to stay in that pose relative to the rest of the 
action, the image is photographed a particular number of times, and each 
photograph becomes a distinct frame in a movie film strip. 

When this strip is viewed by the human eye, the separate distinct images of 
the motion cycle blur together to form a continuous motion, and voila!
we've created a simple animated cartoon. 

The larger the number of frames in the animation, the smoother it appears; anima
tors express this number as frame rate, and it's usually written as frames per 
second. Since frame rate has less meaning when animating GIFs, we'll simply refer 
to the total number of frames. 

Web images are animated in the same fashion except that our raw materials 
are separate GIP images, and they're bundled up into a single GIF animation 
file. The ability to add simple animation by layering multiple images within a 
single GIF has been a part of the GIP specification for almost 10 years now, but 
until the arrival of the Web, animated GIPs were quite rare (you might have seen 
perhaps one or two in a year of traveling between bulletin board systems). In 
just a couple of years, though, those animated GIPs have been transformed from 
simple oddities to the most popular visual elements on today's Web pages. 

Building the Movement Cycle 

If you remember our design from Chapter 1, our animated graphic will be a 
piano keyboard in motion, and we were able to locate an excellent clip art 
image from our Internet search. But now we run into the same problem that 
often faces the best cartoon animators: what type of movement should we add 
to this static picture? As I mentioned earlier, many images "suggest" their own 
simple movement cycle: a ball might rotate or bounce, a bird might flap its 
wings, a car's wheels might move. Other simple movements are based upon 
film techniques; for example, when a GIF image fades in to sharp focus and 
fades out until it disappears. Although it doesn' t look like movement, this sort 
of action is a movement cycle. 
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While I'm at it, several other film techniques that are popular in Web ani
mation should be mentioned: 

• Cross Fade. One of your images slowly fades in until it has completely 
appeared, then it fades out, only to fade in again with a different image. 
Figure 4-2 illustrates an example of this that would be appropriate for a 
Web page covering the stock market: a clip art image of a bull fades into 
view, fades out, and is replaced by a clip art image of a bear, which also 
fades in and out. This sort of animated GIF would likely loop, meaning 
that it would replay over and over. 
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Figure 4-2: A storyboard for a simple animated GIF movement cycle. Again, my true drawing 
skills shine through! 

• Dissolve. You've seen dissolve animation on the Web a thousand times 
!JVer. An image gradually disappears as random segments of the image 
fade away (thus the name of this technique). These images are built by 
creating a number of frames, each of which includes a larger and larger 
transparent area; they take a considerable amount of time to do by hand, 
but they're fascinating to watch! 

• Wipe. Wipes are another common technique where a geometric shape of 
some kind moves across the image, seeming to drag a new image into 
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place over the old one; shapes can include circles, logos, or any other 
object that touches the top and bottom edge of the image. The simplest 
wipe is a vertical line that travels from one end of the image to the other, 
changing the image "behind" it as it moves. Wipes were often used in 
silent films, and they were also a staple in classic TV shows like Batman 
and The Addams Family. Again, the frames necessary to produce a wipe 
take work, but it's a very effective movement cycle. 

• Color Change. Another animation movement cycle that's simple and 
straightforward, yet magic to the eye is a color change. In this technique, 
a color within your image changes to another color. For example, one 
of the most attractive animated GIFs I've encountered in all my surfing 
started as a simple set of black and white lines that crossed the page-I 
was singularly unimpressed, until the plain lines suddenly burst into 
colors and became a rainbow! This effect is often combined with a wipe, 
so that the color change seems to move in a wave across the image. A 
color change movement cycle is quick, easy to create, and usually loads 
much faster than more complex animated GIFs where a portion of the 
image actually moves. 

II Morph. This animation movement cycle has been very popular in recent 
years on television and in the movies-one image or object appears to 
change shape into another. For example, a woman's face might turn into 
a cat's face. Chapter 7 is devoted to morphing, but no fair skipping 
ahead-we'll get there soon enough! 

Once you've selected an appropriate image, you need to determine an 
appropriate movement cycle. These guidelines will help you select a cycle that 
suits your image: 

• Pick a natural cycle. As I mentioned earlier, if a portion of your animated 
GIF must actually move through space, try to select an action or a move
ment that's naturally attributed to your subject. For example, a cat could 
twitch its tail, which is an excellent choice-the only portion of the 
image that moves is the tail, which reduces the size of the finished GIF, 
and it would be easy to build the individual frames. A movement cycle 
can also express the subject matter, whether it is natural to the actual 
image or not; for example, a dollar sign might shrink and grow on a page 
that gives tips on investing. 

• Limit the range of motion. It's always a good idea to avoid movement 
cycles that will travel more than an inch or so onscreen, especially if the 
original image is large or complex to start. For instance, it would cer
tainly be visually impressive to see an animated chimpanzee jumping 
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from tree to tree across the top of your browser, but I'd hate to be the 
poor surfer who has to download that image! Instead, pick a motion that 
will have the best visual impact on the viewer with the least distance to 
travel-why not have your chimpanzee hang from a vine and move up 
and down next to your page title? This is especially true for cycles that 
will cross the full length of your image, where the entire image changes; 
if you select a wipe for an image with large dimensions, for example, be 
prepared to pay the price in download time. 

• Limit the number of frames. Here's a very common mistake that's often 
made by novices designing Web graphics. It's certainly true that a larger 
number of frames will create a smoother, more lifelike movement in the 
finished image, but usually that image grows exponentially in size. 
Remember, each frame you create adds an additional layer to your GIF 
image, and it requires additional work on your part. For example, take a 
look at Table 4-1. I picked an animation from my collection, an inch
square globe that spins. Although the image only measures an inch on 
each side, nearly the entire area is animated. To experiment, I added 
frames to the animation in increments of 10. You can see the result in the 
final image size. Think of the additional time that image will take to load 
with a 14.4 kbps modem if you only double the amount of frames to 20. 
Also, remember that the source for this animated image wasn't particu
larly complex or large; if I had increased the size or detail of the source 
file, these file sizes would have been even larger. As a general rule, I try 
to use a maximum of 20 frames to animate an image of an inch or more 
(especially if the movement cycle includes a large portion of the image). 

Number of Frames: 10 

Size of Finished GIF: 82K 

20 

161K 

Table 4-1: The effects of additional frames on final file sizes. 

30 

245K 

40 

330K 

There are, of course, exceptions to almost every rule, and this one is no different. If 
your source image is very detailed or you really need a smooth effect-for example, 
a ballet dancer twirling in place-go ahead and pump up the frame rate. However, 
you should still keep in mind the cost in file size, and you might want to use the 
SuperCompressor option offered by GIF Construction Set, which we'll be talking 
about later in this chapter. 
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• Use sectional animation. If different parts of your image are moving in 
different ways-for example, your camel is walking while the rider is 
bouncing up and down, or your campfire is burning while a marshmal
low turns brown-save as much loading time as possible by using sectional 
animation. We'll discuss this advanced technique in the next chapter. 

Our piano keyboard example is very well suited to animation because the 
keys on the keyboard have only two positions, up and down, and it will be 
easy for us to modify the image to create the different layers. In fact, we could 
animate this keyboard with only two frames, but it would get very repetitious 
quickly. Therefore, I'll use four different frames, each of which will feature a 
different pattern of keys in the down position. 

Our next step in the process of creating a simple GIF animation is the prepa
ration of the individual images, which will make up the animation frames. 

Preparing Your Images 

Every animation motion cycle has a beginning and an ending point, and if 
you're designing a cycle that will loop, the ending image is often the same as 
the first frame. I prefer to use our old friend Paint Shop Pro to create the sepa
rate images that will make up the remainder of the frames, but you can use 
just about any image editor to perform the same job. 

Use a Single Source Image 

t strongJy· .r:e~ommen'd' that you use' .a1-sirf~h;,,':tma~.e; as,:aifounctation for your · 
framef!:itat_her th~n a ~eparate beginning. and ending ·image. DQ.i_ng se> will help 
you avoltf-pr:a,blems with palette matching, dratnatiQ diffE!rences'in brightness 
and contrast, differen~ image sizes, ,a.nd t~e :~r~a.c;fed ~TransJ>~re_QCY Terror" 
(whette-;some. of your image 'sdutc~J!hUSQr~'r-r:r$p~ten(N· an(t.'Qtll .. rs -~on'.t)_. Once 
you'~~~qr.,})ttt~ your first frame .. u~ing~Y,Qllf ,qtlg~:r:t~hifF$g_e =1;t$ .. a:foundation, use 
ttie newlfi":Clme as a basis for tht:t l)e~J,ra'me, an(t!:SQ-()n, This~:ensures that all of 
your fifilished frames wm ·took $eamless. aftedh'eyve been, aJ)irnated~ ·Mixing 
ima·ge;fiot;it¢tl9-<Jr even just starting .and en·dinJ ima'g~s--;almost always intro..: . 
dlic$s/s()m~: sort of problem that yo~tll have to 'take care of later. As always, 

, there,arEl;,exc:_~ptiqtts toJhis rule (like morphing, which-typi<::c.1llvrequires a differ.: 
' entst~~tting<'and ending image). . . 

Using the piano keyboard as an example, we need an additional three 
frames; the original image will act as the opening frame. You first need to 
open PIANO.GIF into your image editor-this will be your first frame. 
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If you're using another image editor besides Paint Shop Pro, here are the 
general steps you need to follow to build these example image frames: 

1. Open your editor and load the first frame; in this case, PIANO.GIP. 

2. Select a light gray color as your fill color. 

3. Fill the third key with the gray color so it looks as if it's being pressed 
down. 

4. Select another two or three keys to "depress" using this same process, 
and repeat steps 2 through 3 for each key. 

5. Save the new image to disk as PIANOl.GIF and reload the original 
PIANO.GIP. 

6. Select a different set of three keys to "depress," and repeat steps 2 
through 3 for each key. Save PIAN02.GIF and PIAN03.GIF using the 
same method. 

If you're using Paint Shop Pro as your image editor, follow these steps to 
build the images: 

1. Open Paint Shop Pro and load the first frame, PIANO.GIP, as shown in 
Figure 4-3. 

I•" 1m1n1 mmI!lliJj 

Figure 4-3: Our first frame loaded in Paint Shop Pro. 
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2. Click on the magnifying glass at the far left of the toolbar to activate the 
Zoom function. Move your magnifying glass cursor over a white key on 
the keyboard and click until the key fills the screen, as in Figure 4-4. As 
you can tell from the Zoom counter, we're now at 5:1 magnification. 

Figure 4-4: Zooming in to edit our piano keyboard image. 

3. Now move your cursor over to the color palette on the right side of the 
window; Paint Shop Pro changes the cursor to an eyedropper. Move the 
eyedropper cursor over a light shade of gray, and click the left mouse 
button to select it as your foreground color. 

4. Next, we'll fill the third key with the gray color so it looks as if it's being 
pressed down. Click on the dripping paint can on the toolbar to activate 
the Fill function. Move your paint can cursor over the third white key on 
the keyboard and click; Paint Shop Pro automatically fills the black 
outline of the key with the gray color, as in Figure 4-5. 

At this point, we'll move on to the other keys on the keyboard to 
continue our demonstration, but you could just as easily add a high
lighted line to one side of the key to emphasize the movement. 



OFFICIAL NETSCAPE GUIDE TO WEB ANIMATION 

Figure 4-5: The results of the Paint Shop Pro Fill function. 

Have Fun! 

As long as you save your work often, feel free to have fun and experiment. The 
movement within your animation is only limited by your artistic and image ed
iting talents (which is another reason why I recommend that you use a program 
like Paint Shop Pro often until you know it inside-out). For example, use the 
editing functions within Paint Shop Pro to incrementally move your subject, for 
example. If you make a mistake, simply use the Undo command on the Edit 
menu to reverse your last action. Remember that you're creating an individual 
frame of an animation, so avoid moving something dramatically; for example, 
if we were adding a twitch to a cat's tail, we would redraw the tip of the tail 
slightly higher than the existing tail. 

Even if you don't add movement, you can still animate everything from an 
apple to a zebra by simply changing colors, as we've done here. 

5. Select another two or three keys to "depress" using this same process, and 
repeat steps 2 through 4. Figure 4-6 shows our completed second frame. 
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Figure 4-6: Our second animation frame, ready to save to disk. 

6. Now let's save our second animation frame to your hard drive. From the 
File menu, select the Save As item. Select GIF - CompuServe as the file 
type, and select Version 89a - Noninterlaced as the sub type, as shown in 
Figure 4-7. As a general rule, I like to save the frame number as part of 
the filename to avoid confusion so let's name this frame piano2. Click 
Save to save the new image to your hard drive. 

Figure 4-7: Tire Paint Shop Pro Save As dialog, ready to save our 
second frame in1age. 
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l. Time to reload our original image so that we can create frame number 3. 
Since the piano2.gif image is still loaded, select Close from the File menu, 
and open the original piano.gif image. 

2. Repeat steps 2 through 6 twice more to create two more frames-don't 
forget to choose a different set of keys to fill for each-and save the 
images as piano3.gif and piano4.gif. 

That's it! You've successfully saved all four frames of a simple animated 
GIF to your hard drive, and you 're ready to work magic with GIF Construc
tion Set (if you are a Windows user) or GifBuilder (if you work on the Mac). 

Creating Animated GIFS With 
GIF Construction Set (Windows) 

With the popularity of GIF animation on the Web, it seems that every Tom, 
Dick, and Harriet has announced the arrival of the only tool you'll need to 
make those pesky GIF images move and dance. If it's not a brand new 
shareware offering, it's an upgrade to an existing image editing package that'll 
likely set you back three or four hundred dollars and take a degree in rocket 
science to learn. 

I'm here to set the record straight. Although I'll mention several excellent 
programs that show promise later in this chapter, for several years now the 
undisputed best tool for GIF animation has been GIF Construction Set by 
Alchemy Mindworks, and you'll only pay twenty dollars to register this 
jewel of a shareware classic. Currently, GIF Construction Set is available only 
for Windows; I'll describe GIFBuilder, a similar program for the Macintosh, 
in a separate section. 

The Windows shareware version of GIF Construction Set can be down
loaded from the Alchemy Mindworks Web site at www.mindworkshop.com/ 
alchemy I alchemy.html. 

For a quick preview of some of the magic you can create with GIF Construction 
Set, check out the demonstration page at www.mindworkshop.com/alchemy/ 
gcsdemo.html. 
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Before we go any further, go ahead and install either the 16-bit or 32-bit 
version of GIF Construction Set. Using the 32-bit version under Windows 95, 
here are the steps to run it: 

1. Click on the Start button. 

2. Select the Programs submenu. 

3. Select the GIF Construction Set 32 folder. 

4. Select the GIF Construction Set 32 icon to run the program. 

When you first run GIF Construction Set, it presents a rather plain-looking 
interface, as shown in Figure 4-8. Although the program has a standard menu 
system, common program functions are displayed in a row of convenient 
buttons along the top. The scrolling box on the left contains a list of all of the 
directories and GIF files available from your current directory; to move to a 
directory, double-click on it. To move one directory up, click on the[ .. ] symbol 
at the top of the list. You can also jump to another drive by scrolling to the 
bottom of the list, where you 'll see the drive letters on your system arranged 
in alphabetical order. 

(prelim) 
(Software) 
(Submit1) 
(Submit2) 
animpiano.gif 
piano.gif 
piano2.gif 
piano3.gif 
pianll'l.gif 
(·a-) 
(·t·) 
(·d-) 
(·&-) 
(-~) 

Figure 4-8: The deceptively simple GIF Construction Set main window. 
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Although GIF Construction Set only displays GIF files and the existing directories 
an each drive within the scrolling list on the main screen, you can also load image 
files of other types without converting them first. Select the Open item from the File 
command to navigate through your system, and change the Files of tt;pe field to All 
files . Now you can import several different image files: BMP, JPG, TIF, PNG, and 
PCX pictures. · 

We'll be covering the functions of most of these menu items and buttons 
later in this section, so I won' t describe each of them here. Just keep in mind 
that GIF Construction Set operates in two modes: manually, where you can 
customize and create without any help, and automatically, where you can 
choose one of the creative tools or the Animation Wizard to perform most of 
the work for you. 

Now that you've been introduced to our animation tool of choice, it's time to 
move to the first step of creating GIF animation: building the movement cycle. 

Animating GIFs With the Wizard 

As I mentioned before, GIF Construction Set's Animation Wizard is the "lazy 
man's method" of combining the separate images you've just created into a 
single animated image-and that's why I use it whenever possible. Why not 
save some work and hassle, especially when the results are typically just as 
good? Before you run the Wizard, simply make sure that your individual 
frames are ready to go. 

To run the GIF Construction Set Animation Wizard, pull down the File 
menu and select Animation Wizard or press Ctrl+A. The program displays the 
Animation Wizard welcome screen, as shown in Figure 4-9. 



Chapter 4: Creating Simple Animated GIFs 

Annn.llmn 'WtLdld 

~ Welcome to Animation Wizard. 

This feature Will walk you through Iha 
entire plllCllss of C18aling an enimated GIF 
file. When you're ready to proceed, er.ck 
on Next. 

Sack U Next I Cancel 

Figure 4-9: The Animation Wizard welcome screen. 

Follow these s teps to create you r animated GIF: 

~ 
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1. Click Next to advance to the next dialog, as shown in Figure 4-10. Natu
rally, we do want the final image for use on a Web page, so select Yes and 
click Next to continue. 

Animation \1117clld 

Do you want to create an animated GIF file 
for use with a Wolk! Wida Web jl8Qe? 

r:: Ves, forueewithaWebpage 

No, far uee •lsawhate 

Back l! Nag I 

Figure 4-10: Selecting Web-ready output within the Animation Wizard. 

2. From the next dialog shown in Figure 4-11, you ' ll specify whether the 
finished GIF should loop endlessly or animate a single time. I typically 
add a loop to the image, since your visitors might miss the animation if it 
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only plays once. If you've designed a simple and natural movement 
cycle, a looping animated GIF will not detract from the rest of the page. 
Our keyboard is a good example of this, so select the Yes option and click 
Next to continue. 

"Hey, Mark- what if I want to loop my animation twice, or perhaps three times?" 
You would be the inquisitive type, wouldn't you? Although GIF Construction Set 
doesn't allow you to select the number of iterations from here, you can do it after 
we've finished using the Wizard. Highlight the LOOP image command and click 
Edit to display the Edit Loop Block dialog, where you can specify the number of 
iterations. Adding additional iterations doesn't add additional bytes to the file size, 
so have at it! For many older browsers, remember that the iterations value has no 
effect; it's infinite loops or no looping at all. 

Figure 4-11: The Animation Wizard can loop your animation indefinitely if you like. 

3. The next dialog, shown in Figure 4-12, is a little trickier; it determines 
what palette scheme and color depth will be used in the finished image. 
If you're using scanned or high-resolution computer art with at least 256 
colors (or shades of gray) as image frames, select the Photorealistic option. 
If you' re using text or line drawings, select the Drawn option. If your line 
art or text uses only a 16-color palette, then choose the "Drawn in sixteen 
colours" option (love that King's English). Or select the default, "Matched 
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to first palette," if you used the first frame as the foundation for all 
succeeding frames; since that's what we did, that's what we'll pick. 
Select this and click Next to continue. 

Are the 1111191• for yaur'INmlttd GIF file 
drawn or photore•littlc? IJlle dmmlgs and 
teld coll9tHute draYm lm1991 Sclnilad 
plctum and computer-genenijed art m
photomlillic. 

fhotomhlio 

g,_, 

Drawn 111...,.c:olbu!) 

• Matched to ir1t palette 

Back H Next I Cancel j 

Figure 4-12: Specifying a color palette and color depth setting. 
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4. In our next Animation Wizard dialog, illustrated in Figure 4-13, you 're 
asked to specify a delay to be added between frames. Achieving the best 
results sometimes involves a little experimentation, but you can try the 
default level of 100 hundredths for simple animations like ours. Select 
the Yes option and click Next to continue. 

Haw much delay do you Wlllt belWlan 
frames? Thia value ii In 10'.llhe of• 
second. The default value •'-' here ls 
usually right for limple anlmatlon1. You 
can change thlt after your Glf fill le 
CIMl8d. 

Delay: 

10 hundredths 
20 hundredths 
50 hundredths 
75 hundredths 

C•netl I 

Figure 4-13: Specifying a delay between Jrqmes in hundredths of a second. 
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5. Now the Animation Wizard is ready to accept the filenames for each 
image frame, as shown in Figure 4-14. Click Select and then navigate to 
the directory where you saved the images. Holding down the Ctrl key, 
click on each of the four frame images in order: piano.gif, piano2.gif, 
piano3.gif, and so on. You'll notice that each filename is added automati
cally to the File name field. Once you've selected all of your files, click on 
Open to load them and return to the Animation Wizard dialog. If you 
add a file by mistake, click on it to highlight its entry in the Selected files 
list and click Delete. Once your files are listed in the correct order, click 
Next to continue. 

DtJel• I 

c.ac.1 ] 

Figure 4-14: The Animation Wizard file selection screen. 

6. Wow, that was pretty fast, even for a simple animation like ours! Actu
ally, the real processing hasn't occurred yet, but the Animation Wizard 
displays its completion screen anyway, as shown in Figure 4-15. You won't 
see your new GIF until you actually return to GIF Construction Set. To do 
so, click Done, and GIF Construction Set begins the real processing to 
create your image, and you'll see a status bar indicating its progress. Once 
the GIF has been created, the GIF Construction Set main window will 
reappear with your image commands loaded, as shown in Figure 4-16. 
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c.ICtl I 

Figure 4-15: Success! The Animation Wizard has completed your image. 

LOOP 
CONTROL 
IMAGE C:\ven1ana\Web Graphics\piano.gif 474 K 65, 256 
CONTROL 
IMAGE C:\ven1ana\Web Graphics\piano2.gif 474 x 05, 256 
CONTROL 
IMAGE C:\ven1ana\Web Graphics\p1ano3.gn 474 x 05, 256 
CONTROL 
IMAGE C:\ventana\Web Graphics\piano4.gn 474 x 05, 256 

G1F Conllructlon 
Sii (32-biQ 1 OP 

UNRl:GISTERB> 
COPY (JHdch 3) 

Figure 4-16: GIF Construction Set now displays the image commands for your new GIF. 

7. Would you like to view your finished GIF before you save it to disk? 

~ 

115 

Then click View on the GIF Construction Set toolbar. The program plays 
your animated GIF against a black background, as shown in Figure 4-17. 
To return to the GIF Construction Set main window, click the right 
mouse button. 
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Figure 4-17: Viewing our new animated GIF within GIF Construction Set. 

8. If you're satisfied with the animation, it's time to save it to your hard 
drive for later use. Select File I Save As to display a Save As dialog. Select 
GIF files as the file type and give the finished animation file its own 
name. Click Save to save the new animation file to your hard drive. 

No matter how many frames you've added or how large your source image, 
that's all there is to it. The process is the same, and the Animation Wizard will 
help make sure that everything is set correctly throughout GIF Construction Set. 

But what if you'd like more control over the entire process? Perhaps there's 
a special effect you need to add, or the delay between one or two frames needs 
to be longer than the rest of the movement cycle. In the next section, we'll 
create the same image manually, using nothing more than our bare hands and 
our superior willpower. 

Animating Glfs Manually 

Ready to go? Hang on a second ... before we get started, we need to get some 
information about your images that you'll enter during the animation process. 
Run Paint Shop Pro and select File I Open. Navigate to the directory where 
your first image frame was saved-for our example, we'd load piano.gif-and 
click once on the image itself to highlight it. Paint Shop Pro will display the 
size of the image in the Image information area at the bottom of the dialog; jot 
down the width and height information, click Cancel to exit without loading 
the image and close Paint Shop Pro. For piano.gif, the width of the image is 
474 and the height is 85; and, as I mentioned before, since we used the same 
image as the basis for all of our frames, there's no troublesome difference in 
image size halfway through our movement cycle! 
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If you have images of more than one size in your animation, 
write down the dimensions of the largest width and the 
largest height. 

To build the same image as we did in the previous section without the 
Wizard, follow these steps: 

1. From the GIF Construction Set menu, select File I New. The program 
creates a new image called untitled.gif and inserts the first image com
mand in the list, as you can see in Figure 4-18. You'll use these image 
commands to build your animation. GIF Construction Set calls these 
commands blocks. In this case, this first block identifies the image as a 
GIF file of the GIF89a subtype, and a default size of 640 X 480 is auto
matically assigned. 

There are five distinct types of command blocks: 

• IMAGE. This block represents an image frame you've loaded from 
your hard drive. 

• CONTROL. This block allows you to manipulate characteristics of 
images such as transparency and delay. They're p laced in front of the 
IMAGE block they control. 

• COMMENT. This block contains text that can be displayed from 
within most GIF viewer programs. Comment text does not appear 
in the animation. 

• PLAIN TEXT. This block displays text within the animation itself. 

• LOOP. This block allows your animation to repeat for a specified 
number of times. 
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Glr [onshur hon Set (unhtled 91fl "[il l:J 

I "1lw I 1n1a I E* I o.1e1e I Manage I 11bou1 I s.iup I & • 

GU' Con1truct1on 
Set (32-bh) 1.0P 

UNREGISTERED 
COPY (patch 3) 

Figure 4-18: The first block we'll use to build an animation. 

2. Whoops! As I said, GIF Construction Set has automatically assigned this 
image the dimensions of 640 X 480, and the dimensions of our actual 
image are only 474 X 85. We've got to fix that if we don't want a large 
blank border surrounding our GIF. Highlight the HEADER image com
mand and click the Edit button on the toolbar; GIF Construction Set 
displays the Edit Header dialog, as shown in Figure 4-19. Use the scroll 
buttons at the left side of the Screen width field to specify 474, you can 
also double-click on 640 and enter 474 directly into the field. Next, enter 
85 for the Screen depth in the same manner. To confirm your changes 
and return to the main window, click OK. 

[ d1I tlP<tdet I 1 lllocl~ s J 

Scrnnwidlh: ~ 
SclWllldeplh·~ 

BICkpncl: -

Palette 

r;; $11obal palette Load I 256 calou111 

r Sorted aalllle Save I ~ 

Figure 4-19: Specifying tlte exact width and deptlt of our first image. 
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3. From the toolbar, click on the Insert button. GIF Construction Set dis
plays the floating Insert Object toolbar, as shown in Figure 4-20, where 
you can select which type of block to add to the image. Click the Image 
button. Select the first frame of your animation (in our case, piano.gif) 
and click Open to load it. 

Figure 4-20: The floating Insert Object too/bar. 

4. Depending on the palette used in your first image, GIF Construction Set 
may display the dialog shown in Figure 4-21; this indicates that there are 
differences belween the default, or global, palette used by GIF Construc
tion Set and the palette used in your image. You'll either have to change 
the color palette for your images or modify the default palette used by 
the program. Your options are: 

• Use this image as the global palette. This is the option I usually 
select, since I want to preserve the palette used by the images, and 
(as in our example) all of my images are usually from the same 
source. This option is only available if you're adding the first image 
in a new animation. 

• Remap this image to the global palette. A good selection for line 
drawings and simple graphics, but avoid this option if you're work
ing with photographs or 256-color images. Some of the colors in 
your images might change slightly. 

• Use a local palette for this image. Avoid this option if your ani
mation includes frames from more than one source. In addition, if 
your finished animation will appear on your page with other 256-
color images, you might experience a color shift that will detract 
from the appearance of your page. I recommend you avoid this 
option altogether! 

• Use a local grey palette for this image. Although GIF Construction 
Set converts the image to grayscale, it still suffers from the same 
local palette problems as the previous option. 
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• Dither this image to the global palette. A good choice for photo
graphs and 256-color images that have been taken from multiple 
sources, but (as you already know) I'm not a big fan of dithering. 
You're likely to lose some image quality and detail this way. 

Remember how I mentioned earlier in the book that dithering is a taboo word? That 
still holds true here. Although dithering does help produce a more pleasing effect 
when you're adding several images to a single Web page, it increases your final 
image size, and it may not produce attractive results at a lower color depth. When
ever possible, use the same palette for all of your images by converting their color 
depth to 256 in your image editor, as we discussed earlier. Use the same options 
while reducing color depth, and make sure you include Windows colors. 

• Use it as is. Generally not a good idea if your images come from 
mixed sources, but if you know that the palettes are complementary 
and contain the same colors, this option will work. 

Select Use this image as the global palette. Click OK to continue, 
and you'll notice that GIF Construction Set has added the image 
block command for piano.gif after the HEADER block, as shown in 
Figure 4-22. 

Figure 4-21: Time to adjust the global palette to match your image. 
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Figure 4-22: Your first image has been added to the animation. 

5. In most cases, you'll want to add transparency to your animation be
cause you'll use it on top of a different colored background on your Web 
page. To start this procedure, we have to add a CONTROL block, and the 
CONTROL block must appear just before the IMAGE block. GIP Con
struction Set inserts commands just after the highlighted command. So, 
in this case, click on the HEADER block to highlight it. Then click Insert 
to display the Insert Object toolbar and click Control. A CONTROL block 
now appears, as shown in Figure 4-23. 
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Figure 4-23: We've added a CONTROL block to our animation. 

If you make a mistake and need to remove a block command from the animation, 
click to highlight the command and click Delete on the toolbar. GIF Construction 
Set also features some of the best online help around, which you can always reach 
by selecting the Help command from the menu. Most dialogs in the program also 
include a Help button. 

6. Now we must edit the CONTROL block to specify transparency. It's 
already highlighted, so click Edit to display the Edit Control Block dia
log, as shown in Figure 4-24. Enable the Transparent Colour check box 
and click the eyedropper button; we need to specify to the program 
which color should become transparent. GIF Construction Set displays 
the image; click on the color that should become transparent, and the 
program will return you to the dialog with that color already specified. 
Now that is neat! As a final step, set the Remove by drop-down list box to 
Background, and click OK to save your changes. 
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Figure 4-24: The Edit Control Block dialog. 

7. That's the entire procedure for one frame, so simply repeat steps 3 
through 6 for each image in your animation. Don't forget that the images 
need to be added in order! 

8. Remember how the Animation Wizard asked if we wanted our anima
tion to loop? If you would like your image to loop, that's the last block 
command you need to add. Click Insert and then click Loop. No matter 
which command was highlighted, GIF Construction Set adds the LOOP 
block command as the second command in the animation. 

9. You're ready to go! First, though, you can view your finished GIF before 
you save it to disk, just like we did after using the Animation Wizard. 
Click View. The program displays your animated GIF against a black 
background. To return to the GIF Construction Set main window, click 
the right mouse button or hit ESC. Figure 4-25 shows the commands that 
make up our finished animation. 
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Figure 4-25: Our animation is ready to save to disk. 

10. Finally, save your image. Select Save As from the File menu and select 
GIP files as the file type, and enter a new filename for the completed 
animation. Click Save to save the animation to your hard drive. 

The Wizard vs. the Manual Technique 

Now that you've done the same animation in two different ways-using the 
Animation Wizard and creating the animation manually-I think you'll agree 
with me that the Animation Wizard requires much less work and provides just 
about the same results! 

However, the Wizard does not allow you to specify a number of settings, 
such as the number of iterations an animation should loop, and it also doesn't 
allow you to add comments or plain text to your finished animation. The Wizard 
creates the simplest of animated GIFs, but GIF Construction Set has many addi
tional features. 

If you like, however, you can always make manual changes to your anima
tion after the Animation Wizard has completed, but before you save your new 
image to disk. This way, you get both convenience and fine control. The best of 
both worldsl 
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Other GIF Construction Set Features 

That's basically all there is to the creation of a simple animated GIF with GIF 
ConstrucQ.on Set; however, we haven't closed the goody bag quite yet. I'd like 
to take a few moments to cover a few features we didn't encounter while 
building our sample animated GIF. 

Adding Delays 
Many animated GIF images look better when you apply a slight delay some
where in the movement cycle; for example, an animated image of a baseball 
pitcher might pause for a second or two before the ball is thrown, or a rotating 
ball with a logo might pause to make the logo easier to see. Although GIF 
Construction Set adds a default delay of 100 hundredths of a second, you can 
add to this number to create a longer delay. You can add delays to your anima
tion by following these steps: 

1. First, add a CONTROL block in front of the IMAGE block where you 
want the delay to occur. Click on the preceding block in the list to high
light it, click on the Insert button, and then click the Control button. 

2. Highlight the CONTROL block and click the Edit button to display the 
Edit Control Block dialog. 

3. Add the delay by specifying a number in hundredths of a second. 

4. Click OK to save your changes. 

This may take a little experimentation on your part, so use the View feature 
to check out your animation with different delay values, and edit the CON
TROL block until you're satisfied. 

Creating Banners 
You've probably been on at least one Web site recently that has featured a 
moving text banner; I've used several on pages I've created, and they can 
really add visual impact. Also, banners are well-suited as announcements for 
new products or new features on your Web page: they draw the eye, and I 
thiilk we all pause just a second to see what message will eventually scroll 
across the page. GIF Construction Set includes everything you need to easily 
create these moving banners from a single dialog. 

First, make sure that you're starting from scratch by selecting the New item 
from the File menu; this will make sure that you can save the banner as a 
separate image when we're done. From the Edit menu, select Banner to dis
play the Edit Banner dialog, as shown in Figure 4-26. 
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Figure 4-26: You can create moving text banners from tit is dialog in GIF Construction Set. 

Now follow these steps: 

l. Firs t, click the Font button in the right section of the dialog. The program 
displays a fon t selection dialog, as shown in Figure 4-27. Keep in mind 
that the larger the font size you use, the larger your final animated image 
will be; I try to use a font size of less than 20. Since you're creating an 
animation, the font you choose doesn't need to exist on your visitor's 
computer, so feel free to pick whichever font you like! Once you've 
chosen your font, click OK to continue. 

font El 

,...fo_nt_· ------- ... Fo_n1_11 .... il_1: _ __ Size 

'
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Figure 4-27: Selecting a fon t for a text banner. 
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2. Click within the Banner text field and enter your message; in this ex
ample, I entered "Would you like to see a link to your page here? Please 
leave a message to me from the main page ... ". Naturally, the longer 
your message, the larger the final image. 

3. Specify the total number of frames in the Cels field. If your message is 
short, you can safely kick this value up to SO frames or so without creat
ing a gargantuan image, but otherwise I wouldn't recommend more than 
30 frames. Of course, the more frames you use, the smoother your text 
will scroll. 

There are no "right" values for the number of eels in a rolling banner and the delay 
between them; it all depends on the length of the message and the size of the font. 
Always tn; several different combinations to make sure you've got just the right effect! 

4. Add the delay between frames by specifying a number in hundredths of 
a second. Although a smaller number will result in scrolling text that 
stays visible for less time, it will make the text scroll more smoothly; I 
usually use a value of around 25 hundredths of a second. 

5. Now select an effect with the Type field; each value here will yield a 
different appearance to your banner. My favorites are drop shadow, 
backlight, and neon. 

6. Next, select your colors for the text, the background, and any shadow and 
backlighting you may have chosen. When you click on the appropriate 
button, a color palette appears and you can click to select your color. 

7. If you would like your animation to repeat, enable the Loop check box. 
For a scrolling banner, enable the Rolling check box; if you disable this 
option, your banner will be a static image with no movement. Also, I 
recommend that you enable the Compress palette check box which will 
reduce the color depth for your finished image to the smallest value 
possible. You can set a transparen t background for most of the effects. 

8. Ready to see the animation? GIF Construction Set provides a convenient 
Test button at the bottom of the dialog, so click away! After you've 
watched your animation, right-dick to return to the dialog. If something 
isn't quite right, you can change the settings and test the image as often 
as you like. Figure 4-28 shows my banner from the Test screen. 
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Figure 4-28: Testing my animated banner within GIF Construction Set. 

9. Once your banner is ready to save, click OK. The GIF Construction Set 
main window will return, but it will take a few moments for the program 
to build the commands for your image. Once the process is complete, 
you can save your banner just like any other animated image using 
File I Save As. 

Give this feature a try, and I'll bet you'll consider adding a banner to every 
page on your site .. . but remember the basic rules we discussed at the beginning 
of the book, and don't slow down your page traffic with too many graphics. 

Creating LED Signs 
When's the last time you stood in a line and watched one of those animated 
LED (short for Light Emitting Diode) signs at the supermarket-or, even worse, 
the bank-while the guy in front paid in pennies? Tune to take your revenge! 
Like banners, LED signs are scrolling displays, and they're excellent for high
lighting special features and hot news. GIF Construction Set comes through 
again in style, providing everything you need to create these popular animated 
displays for your pages. You can create these signs with Java as well, but ani
mated GIFs are recognized by many more older browsers than are Java applets 
(and they tend to load faster than applets), so I prefer to use this method. 

To begin, select File I New; this will make sure that you can save the LED 
sign as a separate image when we're done. From the Edit menu, select LED 
Sign to display the Edit LED Sign dialog, as shown in Figure 4-29. 
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Figure 4-29: This dialog allows you to create moving LED signs in GIF Construction Set. 

Now follow these steps: 

1. Select the width of your sign in columns; naturally, the wider the sign, 
the larger the finished GIF. I usually leave the Columns per frame field 
set to 1 since this setting helps to keep the size of the final animation to a 
minimum, but if you enable smooth scrolling, you may have to change 
this value. You can also set the delay, and it functions the same as it did 
for text banners. 

2. Next, enable the Loop check box if you'd like the animation to repeat; if 
you decide not to loop the image, the message will scroll once and the sign 
will remain dark thereafter. The Show dark pixels check box determines 
whether the unlit pixels will be visible; enabling this results in a neat 
look, but it can greatly increase the size of the GIF, so I leave it turned off. 

3. If you need the smoothest possible scrolling motion, enable the Smooth 
scroll check box, but expect the size of your final image to reach gargan
tuan proportions. I generally leave this off. The Compact sign allows you 
to specify whether your sign will use a small or larger frame; again, the 
larger the frame, the larger the final file. Finally, I recommend you leave 
the Compress palette option enabled; as with animated banners, this 
reduces the color depth to a minimum. 

4. Now you're ready to enter your text, which can consist of ASCII text and 
the space character; however, you 're limited to a total of 260 characters 
and that includes color codes. Oh, did I fail to mention that you can 
select from seven colors? You can embed color codes in your message in 
the form@? in which the? is replaced by the appropriate color character. 



@G 

@R 

@B 

@C 

@M 

@Y 

@W 
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Table 4-2 illustrates the different colors and their corresponding codes. 
For example, the color code @G in the following message would turn 

everything appearing after it to green: 

From @Ghere , everything is green! 

green 

red 

blue 

cyan 

magenta 

yellow 

white 

Table 4-2: The codes used to specifi; colors in your LED message. 

5. As usual, GIF Construction Set allows you to test the appearance of your 
image from the safety of this dialog. Click Test to display your anima
tion. After you've watched your image, right-click to return to the dialog. 
Feel free to experiment; you can change the settings and test the image as 
often as you like. Figure 4-30 shows the results of a simple LED sign. 

~---

1~--------___J 
Figure 4-30: Testing an LED sign. 

6. Once your sign is ready to save, click OK. The GIF Construction Set main 
window will return, but it will take a few moments for the program to 
build the commands for your image. Once the process is complete, you 
can save your sign just like any other animated image using File I Save As. 

Adding Custom Transitions 
Our final advanced feature within GIF Construction Set is the Transition 
function, which operates a little differently from the scrolling banners and 
LED signs you 've just created . Transition effects are applied only to a single 
image, so they are not multi-frame animations; however, they move, appear, 
and disappear in motion, so they can still be called animated images, and you 
have the same type of control over their characteristics. In fact, if you'd rather 
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not spend the time to create the separate frames for a full animated GIF but 
you'd still like to add an interesting visual effect to the display of an image, a 
transition may be the perfect solution. We'll mention transitional animation at 
other points in the book as well. 

From the Edit menu, select the Transition item to display the Edit Transition 
dialog, as shown in Figure 4-31. 

Figure 4-31: GIF Construction Set can add a transition effect lo a single image if you like. 

Now follow these steps: 

1. First, click Select and then select a source image from the dialog. Keep 
in mind that many of these transition effects can more than double the 
size of your image file, so choose your source image carefully. Click OK 
to continue. 

2. Next, in the Transition drop-down text box, choose the desired transition 
effect. Effects include the Adam Seven Interlace (which fades your image 
into view in order, one pixel at a time), vertical and horizontal splits 
(with two halves joining in the center), sandstorm (which fades your 
image into view randomly, one pixel at a time), raster (two halves "inter
lace" into one), tile (the image appears in small squares), and a number 
of wipes (where the image rolls in from one side). 

3. Specify the total number of frames in the Cells field. As usual, the more 
frames you use, the smoother your transition will appear, but it will be
come correspondingly larger. You can also set the delay, and it functions 
the same as it did for text banners. The Pause field determines how long 
the image will pause after the movement cycle in hundredths of a second. 

4. Now specify whether your image will appear or disappear, and whether 
the transition will loop; naturally, if you don't choose both an appear and 
disappear transition, a looping movement cycle will appear a bit strange! 
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5. If you like, enable the Transparent background for your image. I gener
ally leave "Remap to current default palette" enabled since this makes 
your completed images look better with other text and graphics on the 
page, but it may result in some dithering. As usual, you should also 
enable the Compress palette check box, which will reduce the color 
depth for your finished image to the smallest value possible. 

6. Finally, if you want your animation to pause after completing the move
ment cycle, enable the Pause after cycle check box. The length of this 
pause is determined by the value of the Pause field on the right side of 
the dialog. This is a good way to allow your visitors to get a good look at 
the image before it moves again. 

7. As usual, you can test the appearance of your transition with the Test 
button. Once you're ready to go, click OK to return to the GIF Construction 
Set main window, where you can use File I Save As to save your image. 
Figure 4-32 illustrates an animated image using a raster transition effect. 

Figure 4-32: An image enhanced with a raster transition effect. 

With that, we bid a fond farewell to GIF Construction Set for the moment. 
Of course, I didn' t cover every single feature of this great program, but we'll 
return once more in this chapter to discuss the SuperCompress option. I 
strongly encourage you to register your copy and experiment with every 
command-let your curiosity get the better of you with this program, and I 
promise that you won't be sorry. 
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Creating Animated GIFs With 
GifBuilder (Macintosh) 

GifBuilder is the best-known and most widely used "pure" GIF animation 
application for the Macintosh, and-surprise-it's freeware, and you'll find it 
on the CD-ROM accompanying this book! GifBuilder can import a wide vari
ety of files, including images in GIF, PICT, TIFF, QuickTime movies, Adobe 
FilmStrip, and even RGB and grayscale PhotoShop files, but it only outputs 
standard GIF89a images. It fully supports scripting, so it works seamlessly 
with other AppleScript applications. The latest version includes a frame dis
play, an Add Matte function, and the ability to crop animation frames. The 
program also offers an expanded selection of special effects, including four 
different types of transitions (dissolve, slide push, wipe, and peel). Color 
selection is easy as well, featuring direct drag and drop from a full palette. 
Unfortunately, the program doesn't have a wizard, but it's still easy to use. 
Figure 4-33 shows the GifBuilder interface. 
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Figure 4-33: The GifBuilder interface takes advantage of drag and drop. 

If your final animation takes longer to download than you originally wished, 
GifBuilder includes a Frame Optimization feature that can save you a considerable 
amount of download time. Frame Optimization is a variant of dirty rectangle 
compression, which we'll discuss at the end of this chapter in the section titled, 
"Optimizing Through Compression." 
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Animating a GIF 

Remember how we manually created our animation using GIF Construction 
Set? Let's create a similar simple animation using Giffiuilder, and you'll see 
how the program takes full advantage of the Macintosh system interface. 
Follow these steps: 

1. Create your animation frames using an image editor as we discussed 
earlier in this chapter. Giffiuilder can import GIP, PICT, or TIP. For conve
nience, save these images in the same folder. In fact, for this example you 
can use the same four GIF frames we prepared for use with GIF Con
struction Set (see "Preparing Your Images" earlier in this chapter). 

2. From the Giffiuilder menu, select File I New. You should see the Frames 
window, ready to receive your images; if it's not open, toggle it on by 
selecting Window I Frames Window. 

3. Open the folder where you stored your images and drag them from the 
Finder into the Frames window. If you're not using Drag Manager under 
MacOS 7.5 or higher, you can add each frame individually by selecting 
File I Add Frame. 

4. If the Preview window isn't open, toggle it on by selecting Window I 
Preview Window. You'll see that the first frame listed in the Frame win
dow appears in the Preview window as well. 

5. Within the Frames window, drag and drop the image files until they're in 
the proper order. If you've saved them with the same name and a unique 
number, you can also sort them automatically by selecting all of the 
images and then choosing Edit I Sort ~election. 

6. Let's add a loop command. Select Options I Loop, and select the Forever 
option. Remember, older browsers may not recognize a specific number 
of iterations for a loop command, so I generally choose Forever. Click OK 
to accept your changes. 

7. As in GIF Construction Set, Giffiuilder allows you to set delays between 
specific frames of your animation. To do this, select the frame (or frames) 
that require the delay and then select Options I Interframe Delay. 
Giffiuilder allows you to set a delay in one hundredths of a second. Click 
OK to accept your changes. 
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Although you can select your own palette for use in GifBuilder, I recommend the 
6x6x6 Palette option because it will prevent dithering for most browsers under both 
Windows and Macintosh. To use this palette, select Options I Colors and pick it 
from the submenu. 

8. That should do it. Time to save our animation. Select File I Save and enter 
a new name for your animated GIF, then click OK. 

Adding a Transition 

GifBuilder also provides four types of transitions, the most exotic of which is 
the Peel transition-it appears as if layers of each frame are being peeled back 
in the direction you specify. To add a Peel transition, follow these· steps: 

1. Within the Frames window, select two adjacent frames as the starting 
and ending frames for the transition; generally, this is the first two or last 
two frames, depending on where in the animation you would like the 
transition to appear. 

2. Open the Effects menu, select Transitions, and then select Peel. 

3. From the Peel dialog, specify the total number of frames to use for the 
transition in the Number of steps field. Click on the option buttons 
arranged in a square to indicate which direction the peel will move. 

4. Click the Color button to select a color for the back of the peeled layers. 

5. Click OK to accept your changes and generate the transition frames. 

Other GIF Animation Tools 

In this section, I'd like to discuss a number of other popular programs that are 
available for animating GIF images; some of these applications are newcom
ers, while others already have a dedicated following. I'm happy to report that 
the most you'll pay for any program in this section is a whopping thirty dol
lars, once again proving that you can create the best animated GIFs for your 
Web site without spending a fortune! 
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Each of these applications offers something that stands out from the others, 
so if you're especially interested in a particular feature, you may want to 
install the trial version of that program and try it out for yourself. 

Photolmpact GIF Animator 

You may already be familiar with the Photolmpact image editor by Ulead, 
which is the "big brother" of GIF Animator. Photolmpact ranks along with 
Paint Shop Pro as another very popular Windows shareware image editor 
widely used by Web artists. GIF Animator can be registered separately or 
purchased along with Photolmpact. 

Like the GIF Construction Set interface, the GIP Animator main window 
includes a command and image list on the left, but the design similarities end 
there. As illustrated in Figure 4-34, the program also features a preview win
dow on the right that displays the selected image, and all of the settings that 
are included in dialogs in GIF Construction Set can be reached in GIF Anima
tor from a single window. This layout makes it very easy to build a GIF anima
tion in the smallest amount of time. GIF Animator also features a standard 
Windows toolbar, which many users will probably prefer over the simple 
button bar in GIF Construction Set. 
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Figure 4-34: The GIF Animator main window. 
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The GIF Animator banner feature allows you to add borders and shadows 
to your banner to give the finished animation a more 30 look, and you can 
include an image within the banner. GIF Animator also includes its own set of 
transition effects like horizontal and vertical blinds, wipes, and a particularly 
nifty spiral transition, and unlike GIF Construction Set the effect is previewed 
on a thumbnail before you create it so you can see what the transition will look 
like. GIF Animator also offers a spinning effect that really looks great on a Web 
page; the image (see the example in Figure 4-35) appears to "tumble" in the 
direction you specify. 
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Figure 4-35: Creating a spinning cube animation within GIF Animator. 

Adding image frames within GIF Animator is as simple as dragging them 
from the Windows Explorer window and dropping them into the program's 
workspace, or you can browse for them as well. You can zoom the display of 
images in or out, and GIF Animator allows you to move forward or backward 
through an entire movement cycle, frame by frame. Once you've completed 
your animation, you can use the GIF Optimization feature, which operates in 
much the same way as the SuperCompress option within GIF Construction Set. 

And here~s a real treat: GIF Animator also makes it incredibly easy to add 
color change animation to an image. With the unique palette display shown 
in Figure 4-36, you can select individual colors or an entire range of colors 
within your image and animate them in any order, all by simply pointing 
and clicking. Like GIF Construction Set, you can also preview the effect from 
within the dialog. If you prefer color change animation, this is the most 
intuitive interface I've seen. 
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Figure 4-36: GIF Animator's exceptional Add Color animation dialog. 

Although it lacks one or two features, GIF Animator's easy-to-use interface 
and its support for color changing animation are very strong positives indeed! 

VideoCraft GIF Animator 

Much like the Photolmpact GIF Animator, the Windows program VideoCraft 
GIF Animator from Andover Advanced Technologies is a direct descendent of 
an older graphics program-in this case, PhotoMorph- and it's the only 
animation application in our lineup with native support for morphing. I'll be 
talking about this technique in greater detail later in the book in Chapter 7, but 
for now, a quick definition is sufficient. Morphing is a form of animation where 
one image turns into another by slowly changing the shape and color of the 
objects in the first image to match the second. You've seen this technique in a 
number of big budget films; for example, if a human actor "melts" into a 
dragon, the effect was probably achieved through morphing (more practical 
than the alternative, which involves a great deal of "Dragon Chow" and a 
huge birdcage). 

Depending on how you look at it, the VideoCraft GIF Animator interface 
either benefits or suffers from its ties to PhotoMorph. It uses a specialized 
editor that's typically used in morphing programs and multimedia authoring 
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packages, as shown in Figure 4-37, where you have a start frame and an end 
frame. If you're primarily interested in GIF animation using the morphing 
technique, that's a big advantage (as you'll see in Chapter 7). However, this 
start and end frame interface can be confusing to the novice and it's much 
harder to structure, view, and edit all the frames in a larger animation. Person
ally, I prefer the GIF Construction Set interface, or perhaps the convenience of 
the Photolmpact GIF Animator toolbar; this program uses a widely different 
approach, looking more like a specialized digital editing program than a GIF 
animation application. There's also no built-in preview mode, so you have to 
save your animation and load it in your browser. 

Figure 4-37: Tire specialized VideoCraft GIF animation project editor. 

As you might imagine, the VideoCraft GIF Animator excels at special ef
fects; besides morphing, you can choose from a large number of image filters 
like colorizing, blurring, and embossing. Transition effects include curtain (a 
standard wipe), explode (the image seems to "shatter"), meltdown (progres
sively darker areas of the image fade away), and slide (the image simply slides 
out of view). The program provides complete control over each of these ef
fects, and most have more than one variant-make no mistake about it, this is 
a very powerful effects program with its own built-in image editing tools! 
Figure 4-38 illustrates the Transition Editor-compare this with the transition 
dialog within GIF Construction Set. 
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Figure 4-38: Tlze Transition Editor provides complete control over transition effects. 

Another plus for VideoCraft GIF Animator is its almost terrifying support 
for imported images, including BMP, GIF, JPEG, DIB, PCX, TGA, RAS, and 
TFF formats-you can even import PCD images from Kodak PhotoCDs and 
WordPerfect graphics. AVI movies can also be imported. If you need to pull 
your source frames from a wide variety of platforms and sources, you' ll ap
preciate this program. 

If we were discussing power tools, VideoCraft GIF Animator would be that 
complex handsaw that only professional carpenters would use, but if you're 
willing to learn it, this program can create animated GIFs with effects that not 
even GIF Construction Set can touch. 

Animagic GIF 

The last program in our review of GIF animation software is probably the 
simplest to use, and for a good reason: Animagic GIF for Windows offers the 
minimum features required for GIF animation. That's not to say that this is a 
bad program; in fact, it offers a few functions that aren 't provided in any other 
application I've used, but it's definitely not a "power user's" application. 

Figure 4-39 illustrates one of the sample animations provided with the 
program-an alligator twitches its tail and opens its eyes. As you can see, the 
frame lis t on the right is a no-nonsense list of images, but Animagic GIF does 
provide a palette window that you can use to manipulate colors. If Animagic 
GIF excels at any particular function, it's probably in the control it gives you 
over the individual palette in each of your images and the global palette used 
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by the entire animation. You can load and store custom palettes and apply 
them, reduce the color depth of your images (saving you the step of loading 
them in an external image editor), convert frames to grayscale, and set trans
parency; there are a number of color optimization features as well. In fact, 
Anirnagic GIF provides more methods of optimizing GIFs than any other 
program I've used. 

Figure 4-39: A sample GIF loaded in Animagic GIF. 
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Anirnagic GIF also provides you with a number of standard transition 
effects like fade in and out, dissolve, wipe, and spiral, and as shown in Figure 
4-40 each effect can be modified. However, none of them offer the level of con
trol provided by GIF Construction Set, much less VideoCraft GIF Animator. You 
also won't be creating any banners or LED signs with this program. If you're 
looking for those special features, you'll have to choose another application. 
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Figure 4-40: Tlze Transition Effects dialog from Animagic GIF. 

Animagic GIF is a relative newcomer, but it provides all the basic features 
necessary for GIF animation; in fact, it reminds me of the first few versions of 
GfF Construction Set. With continued development and a larger feature list, its 
simple commands and easy-to-use interface may very well become its stron
gest advantage! 

Testing Your Animation 

At this point, you've completed your animated image and saved it to disk. Now 
you can slap it on your Web page, smile at yourself in the mirror, and let the 
teeming millions of Netscape owners out there enjoy your handiwork. Right? 
Wrong. In fact, quite the opposite. Although novice and amateur Webmasters 
can build animated GIFs, a true professional who cares about the appearance 
and load time of his site would never simply dump a large animated image 
onto a page and walk away. If you've created a spinning bullet that's 6K long, 
you can probably get by with a quick test using your own browser. On the 
other hand, the larger the image, the more important it is to test your anima
tion. And remember, what looks good within your animation program or on 
your local computer may not immediately work well on your page. Only a 
round of proper testing can ensure that your animated GIP is really ready for 
the general public. 

In this section, we'll discuss a proven procedure called usabilihJ testing that 
you can follow to evaluate everything from a new animated GIF to an entire 
site. Most major software developers are already familiar with usability test-
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ing, as it helps determine whether a program is easy or difficult to master 
under real-world conditions. In our case, "real-world conditions" means 
everything from: 

• a 14.4 kbps modem to a Tl line. 

• a 16-color driver to a 16-million color driver. 

• the latest browser to a version that's three years old. 

Step 1: Creating a Test Page 

Your first step in testing your animation involves the creation of an invisible 
test page on your site. My test page is not connected with any other page on 
my site and carries a somewhat unusual name. It includes a color palette and 
three different background blocks of black, white, and neutral gray so that I 
can try the image on different backgrounds if necessary. 

I use a test page because I often complete animated images before the final 
page content is ready; of course, if you've already completed the full page, you 
should use that for testing instead. 

If the final page will feature several animated GIFs, static images, sound files, or 
Java applets, make sure your test page reflects this. Add an equal number of similar 
images so that your load times will more accurately reflect the final page. 

Step 2: Selecting Test Machines 

Next, pull out your trusty address book and call a few friends that also surf 
the Web and are willing to spend a few minutes online to help you. You're 
looking for a range of test machines that are running a wide variety of proces
sors, video drivers, modems, and browsers. Table 4-3 gives you some idea of 
three machines I would look for to help me test. 

Machine 1 

Machine 2 

Machine 3 

486-33 

386-33 

PowerMac 

256-color display ISDN or T1 

16-color display 14.4 modem 

16-milllon color display 33.6 modem 

Table 4-3: Three recommendations for testing machines. 
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In an office environment, you may be tempted to find a number of different ma
chines with different capabilities, but remember that if they' re all running through 
the same Tl connection to the Internet you're not going to get a credible result. 

Step 3: Running the Test 

Once you've added your new animated image on the test page, you're ready 
to run your test. For the worst possible stress-test scenario, have your friends 
connect with your site during your busiest hour. Make sure they write down 
the following information: 

• Total loading time. How long did the entire page take to download from 
the moment the connection was made to your server? 

• Loading time for the image. How long did the image itself take to down
load? nus figure may be harder to determine on some browsers, but you 
can usually get an estimate by watching the program's status bar. 

• Quality of the animation. Did your image correctly follow its movement 
cycle, including any delays you might have included? Was the frame rate 
acceptable? 

• Positioning. Did your image appear in the proper position? 

• First impressions. Was your animation fun to watch? Could it have been 
improved in some way? 

• Potential problems. Was the image dithered? Did it fail to animate at all? 
Was the transparency correct? 

Of course, only you can determine the "optimal" load time. As I mentioned 
earlier, if your site offers animated clip art or your company specializes in 
digital video and Web special effects, an image that takes over a minute to 
load probably wouldn't bother your visitors; they're expecting your site to 
take longer. On the other hand, if you find yourself with an image that didn' t 
animate smoothly on at least two of your test machines, it's probably time to 
add or modify frames. Likewise, if you're offering a simple personal home 
page to the public and your new animated image took 3 minutes to load on a 
14.4 kbps connection, it's back to the drawing board! 

Testing may not be a requirement for every image, audio clip, or plug-in 
that you add to your page, but I've found time after time that it never hurts to 
check your site if you add anything substantial. 
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Optimizing the Results 

"OK, Mark, I tested my new animated GIF of the Titanic sinking and it's too 
doggone big. Does that mean I have to start over?" I suppose you could if you 
like, but there are steps you can take to reduce the size of your image without 
losing all of that work-why not try optimizing your GIP animation? Before 
you start over at frame 1, consider the alternatives in this section. 

In fact, optimizing all of your animated images-no matter what their size-can 
dramatically speed up the overall loading time for your page. I generally optimize 
all of my animated GIFs immediately after the1/re created. 

Optimizing Through Compression 

Several of the GIF animation programs we've discussed in this chapter include 
built-in optimizing functions. For example, GIP Construction Set offers the 
SuperCompress feature shown in Figure 4-41, Photolmpact GIP Animator has 
a multi-stage GIP optimization feature, GifBuilder offers Frame Optimization, 
and Animagic GIP has several types of optimization that can be applied while 
you're saving your image to disk. 

Supe1comp1cssmn 

Sllp8tl:OlllpmSIOll wil analyze your GIF ile and apply a number of 
tachnlquet to II to atoll II In 1-bytes. SMnll oUllewwiD dw 
Ilia lmagu in your tilt - it's racommended that you keep your 
ariglnll file under anolher n1me. 

Status 
Searching ... 
No local..E_alelles found. 

Figure 4-41: The GJF Construction Set SuperCompress dialog. 
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In general, these optimization functions use one or more of these methods 
to shrink the size of your image: 

• Palette compression. The program will examine each of the individual 
frames in your image and determine which colors from the palette are 
not being used and remove those unused colors. This can have the same 
effect as reducing the color depth of your image so each pixel requires 
fewer bits for storage, and yet when properly done, your visitors will be 
unable to see the difference. 

• Drop comment and plain text blocks. The program strips all of the 
comment and plain text blocks in your file. The image is unaffected, but 
you'll lose the information that was stored in these blocks. Copyright 
information is often stored in comment blocks, so be careful and check 
the contents before you optimize the image to avoid removing the copy
right notice. 

• Dirty rectangle compression. This function is the specialty of Animagic 
GIF and GifBuilder, but it doesn't work well with animated GIFs that use 
transparency, and all of the frames in your image must have the same 
border. As an example, a human figure running in a blue rectangle would 
be a good candidate for dirty rectangle compression. If a frame has the 
same pixels as the frame underneath it, the identical portions of the image 
are cropped and the cropped image is aligned over the previous frame; in 
effect, the background from the previous image "shows through" the 
current layer. To the human eye, there's no difference, but significant 
savings can result if your animation contains a large number of frames. 

• Transparency. Transparency compression is similar to dirty rectangle 
compression; however, instead of cropping the identical portion of the 
frame altogether, the identical portion is tagged as transparent. The 
image with the transparent area is sure to be more compressible than the 
original image. 

Is Compression Worth It? 

How well does compression wo'rk? Here's an example: GIF Construction Set 
was able to reduce a monster 515K animated GIF in my collection to 495K using 
the SuperCompress feature. Figure 4-43 shows the resuJts from Photolmpact 
GIF Animator after I used its GIF Compression feature on the same image. That 
may not sound like a tremendous amount, but this was a very large animation 
built from an AVI movie with over 40 frames, and the frames were not suitable 
for the dirty rectangle technique. Other images I tested lost anywhere from 10 
to 25 percent of their total length after compression. 
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Figure 4-42: Optimization results from 
Photolmpact GIF Animator. 

~ 

147 

You can even compress your images without one of these GIF animation 
applications! All you need is Netscape and an Internet connection. Simply 
enter the URL www.webreference.com/ services/ gw I and you'll arrive at one 
of the neatest Web utilities available: the GIF Wizard online compression page, 
as shown in Figure 4-43. This service is provided by webreference.com, a 
fantastic site especially devoted to Webmasters. 

home I services I ptwhard 

Shrink your OIF file size up to 90% with GIF \Vlz.anl: 

Enler tht URL oft.be OlF or th• ptg• you want. io 1brink. 

Step la: p;;:;:;:;;:::;-. ...... ,.;;;-- -
GIF Wiardl 

OR ... 

Brrnc Lo n ltc\ atil• onyourhttd dlJk(WOtb 1"".hN1t.sc:ap• Vunon 2 & 3') 

Step lb: lll9Wii.: 

Step 2, Select the background color of your web ptgt. •No• colon an non.&Uuring. 

(op•..,.i) Red~ ND '.!) Gretn §204 i'tii03 Blue Ice =2~ 

Subscnbe to the GIF Waard Email ~'.'.::l"'.:"~.:;;,"k on subscnbel r-Sabsalbe---. 

Figure 4-43: The GIF Wizard page. 
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To use GIF Wizard, you can either enter the URL that corresponds to your 
image (if it's online), or you can browse your hard drive if you're using Net
scape and upload the image. Figure 4-44 shows an image from my page tha t 
was compressed automatically by GIF Wizard; notice that it provides you sev
eral choices, and once you decide which level of compression you want you can 
download the image directly from the results page. Life is definitely good! 

212 Color Pilette 
20,619 Bytc1 
0% llccluctioo 
Pa!eae Si'P'P" 

I
Po!e!!e ElgV .... 1 
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Con Sm... so 02 

48 Color Pilette 
11,999Bytcl 
41 % Rccluotion 
PllegeSummNy 
PDHsVM 
Pa!eae Bil!oarF 
COil Sm!11 S 53 33 

Clean GIF Fonnat 

.- . .,,,,,-

·. ' ~ -- -~ - ~- - r -, 

; - - - ....... -.....___· - '<:" .. 

Example Optimized Version 
Sec the PlllCI below for 1cva.I more vcnioml 

- - . : - ~ . 
- ' ~ ·. ....... -~ : - ' . =-- - , ... 

- --- - - ........ - .....__.. . ' -

Figure 4-44: The title from my site after compression on the GIF Wizard page. 

If All Else Fails .. . 

Many programs also p rovide a function called posterizing, where unique colors 
tha t are close to each other on the palette are dropped in favor of one specific 
color for that entire range; if you're in a desperate fix, you can always sacrifice 
some of the color in your image to gain space. For example, an image that 
might have had 200 colors would drop to 125 colors. Unlike color reduction, 
posterizing will result in a visible reduction of detail within your image, and 
it's generally considered in ferior due to the reduction of color depth as we 
discussed in Chapter 3. You'll learn more about this technique in our discus
sion of Photoshop in the next chapter. 
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Naturally, you can also reload your image and reduce the number of frames 
by pulling some of them out of your animation; this is probably the right 
method to use after your animation has been compressed and you still need to 
save additional loading time (I prefer it to posterizing because your images 
will keep their same detail and color depth). Often you can remove a number 
of frames without significantly affecting the appearance of your animation. 

Moving On 

In this chapter, you built your first animated GIF images using GIF Con
struction Set, and we tried a number of other great features offered by this 
program. Then I introduced you to the other best-known GIF animators 
available on the Internet. We also used GifBuilder to create animation on 
the Macintosh. You also learned how to test your finished images on a wide 
variety of machines and how to compress your finished GIF animations for 
the best possible loading speed. 

In Chapter 5, we'll use Photoshop to create animated GIFs with more 
advanced effects. 
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CHAPTER 5 

Advanced Image 
Editing 

In Chapter 3, you were introduced to the basics of image editing, including 
resizing, cropping, transparency, and a number of other techniques. These tools 
are the bread and butter of computer image editing; nothing fancy, but once 
you've finished with basic image editing, you've corrected any imperfections 
and your image is ready to become a single frame of animation. Since you now 
know the steps involved in combining image frames together to form animated 
GIFs, you're ready to start building your own animated Web pages- so why 
should we return to image editing again? 

I can sum up the answer in a single question: what if you want to go crazy 
with your image? 

What if you want to create an animation tha t will light up the imagination 
or perhaps portray something ordinary from a totally different angle? If basic 
image editing is akin to bread and butter, the advanced image editing ideas I' ll 
show you in this chapter are seafood gumbo and strawberry cheesecake! 
Instead of just manipulating the image or correcting problems, you'll actually 
be changing the entire look of the image ... you can take off in a dramatically 
different direction and allow your creative side to shine. 

To begin, I'll introduce you to one of the best-known advanced image 
editors ever written-Adobe Photoshop. Keeping in mind the simple anima
tion techniques you've learned, we'll discuss a ll of the spectacular image 
effects this program can produce, including image adjustments and filters, 
distortion, and layering. You can then use these effects to enhance the frames 
that combine together to form your animated image. At the end of this chap
ter, I'll also lead you through a technique that may help you shave 20-30 
percent off of the size of your animations. 
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Hey! Wait a Second! 

The entire idea behind this book is to produce the best animated images for the 
Web in the least amount of time and do it as cheaply as possible . . . and it's true 
that Photoshop is an expensive package that costs several hundred dollars. Why 
did I pick Photoshop7 

In part, because Photoshop is so well-known. This program has been in use 
for so long now by so many people that it's practically become the de facto 
standard among Windows and Macintosh owners alike. Also, Photoshop is a 
comprehensive package that covers the entire range of effects, so it makes a 
great program to use for demonstrating all of these techniques. 

However, if you'd rather not march to your local software dealer and shell 
out that kind of money for this juggernaut of a program, there is another choice: 
for Windows 95 users, it's Paint Shop Pro to the rescue yet again! Paint Shop 
Pro can perform many of the same tasks that we'll cover in this chapter, and it 
even supports both Adobe- and Aldus-compatible image filters. So rest easy, 
and register Paint Shop Pro-you'll still be able to follow along, and you'll be 
supporting shareware to boot. If you're running a Macintosh, you'll also find 
many of these same effects supported within Adobe PhotoDeluxe. 

Introducing Adobe Photoshop 

Tune to take charge of your creative energy with another tool! Adobe 
Photoshop contains just about every image enhancement feature known to 
modern man. As you can see from the main window, shown in Figure 5-1, the 
program interface relies on three sets of controls: 

• The Menu system. This is a standard Windows menu system with a 
huge number of selections, most of which are disabled until you've 
loaded your image. 

• The Toolbox. Initially, the Photoshop Toolbox is positioned at the upper 
left corner of the window, but you can move it anywhere you like. As 
you might guess from the name, this icon bar allows you to control most 
of the drawing and editing tools at your disposal. 

• The Palettes. These control windows are not to be mistaken for the color 
palettes that are common in image editing programs (although one of 
them does actually control the color palette). In Photoshop, a palette is 
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one of those stacked windows on the right side of the screen; each win
dow contains a different set of controls, and you can arrange them any 
way you like. You'll also notice tha t some palettes have more than one 
tab, so you can display different information depending on the tab 
you've selected. 

Figure 5-1: The Adobe Photoshop main window. 

As you might imagine, there's much more you can do with Photoshop
enough, in fact, to fi ll several books bigger than this one. I'm not even going 
to attempt to teach you how to use it all in a single chapter. In fact, many of 
the effects that we'll cover are available in other image editors like Paint 
Shop Pro and Adobe PhotoDeluxe, so you can use the same techniques with 
another application. 

Instead, my goal in this chapter is to provide you with ideas for your own 
creative imagination, no matter which tool you use. Concentrate on the result 
rather than the steps involved-that way, if you don't have Photoshop you can 
still enjoy yourself. 

Enough talk ... let's rock! 
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Image Adjustment Effects 

First, let's cover some of the effects available under Image I Adjust. I typically 
use these effects for: 

• Creating strange-looking background tiles from familiar textures. 
These backgrounds are later used for Web pages or animated images. 

• Creating negative images for use in "flash" animation, where a 
positive and negative image appear in rapid succession to create a 
strobe light effect. 

• Creating startling black-and-white, high contrast images. 

One Photoshop feature I use all the time is the Duplicate Image command, which 
you can find under the Image menu. When you duplicate an image in Photoshop, 
you effectively copy the entire image into memon; with another filename, where you 
can try all sorts of effects and experiment to your heart's content without modifying 
the original image on your hard drive. If you have the memon; to use this feature
and I personally wouldn't run Photoshop on MacOS or Windows with less than 32 
megabytes of memory-it can save you a tremendous amount of time in reloading a 
source image! If all else Jails, don 't forget the trusty Undo command under the Edit 
menu, or you can use the Revert command under the File menu to reload the image. 

Inverting an Image 

The Inversion command produces an effect like a photographic negative, as 
shown with the still life in Figure 5-2. If you experiment somewhat with this 
command, you can create an inverse background for a familiar object. For 
example, an inverse leaf would be an intriguing background for an animated 
worm or butterfly. As a friend of mine is fond of saying, "That's weirdness." 
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Fig11re 5-2: Flowers and fruit take a macabre look with the Inverse command. 

To invert an image, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. Select Adjust from the Image menu and then select Invert. 

As you might guess, a series of frames that alternate back and forth be
tween a normal image and its inverted version can produce a very effective 
animation! I wouldn't loop this one, however, since it would distract from the 
rest of your page after a few seconds. 

Creating a High-Contrast Image 

Photoshop's Threshold command is one of my favorites, and you see high 
contrast images created with this technique everywhere on the Web these 
days. In effect, the Threshold process converts all the pixels in your image to 
either black or white, based upon a luminance threshold (hence the name). 
Figure 5-3 illustrates the effect on our still life, while Figure 5-4 demonstrates it 
on that picture of your Uncle Milton-imagine an animation built from frames 
like these! For example, your animation might open with a regular color 
image, then switch to a low luminance threshold and slowly increase the 
threshold over ten frames or so. The effect will remind you of a camera flash 
suddenly turning everything to stark black and white. I wouldn't loop a high 
contrast animation, however; it would probably be too distracting to the user. 
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Figure 5-3: Our still life after treatment with the threshold fu nction. 

Figure 5-4: Uncle Milton in stark black and white. 

To create a high contrast image, follow these steps: 

l. Select File I Open, browse through your system, and load your image. 

2. Select Image I Adjust and then select Threshold. Photoshop displays 
the Threshold dialog shown in Figure 5-5. 
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Figure 5-5: The Threshold dialog. 

3. The dialog displays a "cross-section" (commonly called a histogram) of 
the luminance levels within the image of Uncle Milton; each line in the 
histogram graphically displays how many pixels in the image match 
each specific luminance valµe. The Threshold Level represents the mini
mum luminance value that determines whether a pixel will be black or 
white. If you'd rather not mess with all these image design terms, then 
just do what I do and experiment! Click the sliding pointer to move the 
threshold left and right; if you've enabled the Preview check box, you'll 
be able to see the effects of different levels reflected in the image, in real 
time. You can also click in the Threshold Level field and enter a lumi
nance value directly. 

4. Once you've achieved the desired effect, click OK to confirm the change. 

Posterizing an Image 

Many Photoshop users are familiar with the Posterize function as an alterna
tive method of reducing the color depth in an image for display on a Web page, 
but its main purpose is to alter the look of an image. Generally, when I'm reduc
ing the color depth of an image for Web page use, I don't want the viewer to be 
able to tell any difference between the original and the converted image. 

The Posterize function allows you to reduce the brightness levels in your 
image to the number of levels that you specify. Photoshop will alter the bright
ness level of each pixel in the image to match the closest level. In Figure 5-6, 
you can see the ''banding" effect produced on an image by posterizing it down 
to 3 brightness levels; values can range from 2 to 255. 
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Figure 5-6: The Posterize function can be used to reduce color depth. 

To posterize an image, follow these s teps: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. Select Adjust from the Image menu and then select Posterize. Photoshop 
displays the Posterize dialog shown in Figure 5-7. 

Posle1ur. £] 

Cancel 

Figure 5-7: The Posterize dialog. 

3. Click in the Levels field and enter a value directly for the total number of 
brightness levels for the image; if you've enabled the Preview check box, 
you' ll be able to see the effects of different levels reflected in the image, 
in real time. 

4. Once you've achieved the desired effect, click OK to confirm the change. 
Click Cancel to exit the Posterize dialog without saving your changes. 
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Using Image Filters 

Adobe Photoshop is well-known for its filter support. That statement is 
roughly akin to "Those Ferrari cars are fun to drive." In fact, image filters are 
such a popular function in Photoshop that mariy small companies make a 
decent profit just selling custom filters to layout and publishing professionals, 
and often you'll find a professional graphic designer has just as many plug-ins 
for Photoshop as different fonts! 

But what is an image filter? The technical answer is that a filter is a "plug-in" 
code module that extends Photoshop with one or more new effects; the simple 
answer is that at least one more magical effect is added to your toolbox every 
time you install a new image filter. Once installed, filters are displayed in the 
menu system just like the original filters included with the program. 

The standard image filters available within Photoshop are divided into the 
following major groups shown in Table 5-1, each of which appears as a 
submenu under the Filter menu. 

Artistic 

Blur 

Brush Strokes 

Distort 

Noise 

Pixel ate 

Render 

Sharpen 

Sketch 

Stylize 

Texture 

Video 

Other 

Table 5-1: The major image filter groups available in Photoshop. 

Unfortunately, these groups are somewhat arbitrary; for example, don't 
automatically assume that the effect of one Texture image filter is similar to 
another. If you don' t know the effect you're looking for, 1 recommend that you 
check the Photoshop Filter Sample Gallery in the online help system; it takes a 
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lot less time to display the different effects there than actually applying each 
one to your image. The longer you use Photoshop, however, the more familiar 
you 'll be with these effects-many of the Web professionals that I know have 
most of them memorized! 

Installing a New Filter? 

In this chapter, all the image filters I'll mention are included as standard equip
ment with version 4.0 of Photoshop, but if you have a third-party filter you'd like 
to try out, it's very simple to install it within Photoshop. 

If you're using Windows, use the Windows Explorer to copy the module into 
the Plugins subdirectory in the Photoshop directory. 

If you're using a Macintosh, copy the module by dragging it into the Plug-ins 
folder in the Adobe Photoshop folder. 

Applying Filters 

All image filters within Photoshop are generally applied in the same manner: 

1. Select Open from the File menu, browse through your system, and load 
your image. 

2. If you're going to apply the filter to a portion of the entire image, use one 
of the selection tools at the top of the Toolbox icon bar to select the de
sired area. 

It's a Reunion! 

You may be saying " Geez, Mark, I've already learned how to select different 
areas in Paint Shop Pro . . . do I have to learn a different set of controls?" Nega
tive I Welcome back your old friends, the rectangular selection tool (called the 
Marquee selection tool in Photoshop), the Lasso, and the Magic Wand I They all 
work very similar to their counterparts in Paint Shop Pro, so if you're used to 
them in one application, they' ll be familiar in the other one as well. 

3. Pull down the Filter menu, select the desired submenu, and click on the 
effect name. If further user input is required, Photoshop will display a 
dialog prompting you for whatever choices or data are needed. For 
example, Figure 5-8 shows the dialog from the Accented Edges filter, 
complete with preview image. 
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Accenled Cdc1es f3 

Figure 5-8: A typical image filter dialog. 

Notice the"+" and"-" keys under the preview image; these are Zoom 
In and Zoom Out keys, respectively, and they allow you to move closer 
to your image or pull back If you move your mouse cursor inside the 
preview window, it turns into a hand; you can click and drag this hand 
to move the preview window over any specific part of the image. 

Some filter effects also have Preview buttons; you can click the Pre
view button to view the effect on the full image, but it may take some 
time, depending on the size of the image and the complexity of the 
filter's operation. 

4. Click OK to start the process. You'll see a progress meter in the status bar 
at the bottom of the Photoshop window. 

Mark's Filters of Choice 

Although we don't have the space to talk about every filter available within 
Photoshop, I've found some of them especially helpful in creating Web graph
ics. In this section, I' ll demonstrate six of my absolute favorites, each of which 
is ideal for a specific task. 

Paint Daubs 
I like to call this Artistic filter my "instant Van Gogh processor" because it's 
perfect for creating a convincing oil painting from any image. Naturally, the 
still life image I've been using as an example really shows this one off-check 
out Figure 5-9! 
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Figure 5-9: With the Paint Daubs filter, l suddenly have artistic talent. 

As illustrated in Figure 5-10, the Paint Daubs dialog allows you to modify 
the brush size and the image sharpness. You can also choose from a number of 
different brushes. One nice animation you can create with this filter is to add 
sharpness with each frame which produces a "living painting" effect and ends 
your movement cycle with the untouched original. 

Figure 5-10: The Paint Daubs dialog. 
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Motion Blur 
What better effect for an animated GIF than motion blur, which naturally 
you'll find under the Blur group. I've seen animated banners on Web pages 
that use this filter for everything from moving baseballs to accelerating cars 
(and even a flying hamburger)! Figure 5-11 shows a great example of an air
plane that's suddenly been propelled into overdrive thanks to this filter. 

/ 

Figure 5-11: An airplane accelerates with help from the Motion Blur filter. 

Figure 5-12, which illustrates the Motion Blur dialog, gives you some idea 
of the real power of image filters. Notice that both the angle and distance of 
your motion blur can be controlled; this means that the subject of your image 
can be "moving" in any direction, and the larger the distance value, the faster 
the apparent "speed" of the object. 

Figure 5-12: The Motion Blur dialog. 
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Crystallize 
This great Pixelate filter is most often used for custom-made animated transi
tions, with each frame in the animation using a smaller cell size ("cell" refers 
to a group of pixels with nearly the same color values). This filter divides the 
image into a number of individual cells. Such an animation would resemble a 
stained-glass image fading away. In Figure 5-13, you can see the effect of the 
Crystallize filter on our still life image. 

Figure 5-13: The Crystallize filter preserves a surprising amount of detail. 

Sharpen Edges 
You'll find the Sharpen Edges filter in the Sharpen group-no great surprise 
there-but this filter will definitely surprise you with its ability to rescue 
blurry, out-of-focus original images! I don't use this filter to create a motion 
cycle, but if you'd like to enhance the detail in your images before creating 
animation frames, I highly recommend this process. The Sharpen Edges filter 
works by increasing the contrast of your image at the pixel level. Figure 5-14 
illustrates the effect of the Sharpen Edges filter on a grayscale JPEG image; 
notice how the duplicate image in the foreground seems to contain more detail 
than the original image in the background. The texture of the stone is easier to 
see and the outline of the hands are much clearer. 
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Figure 5-14: The Sharpen Edges filter at work on a grayscale image. 

Wind 
Another great filter for simulating motion is the Wind filter, which you'll find 
under the Stylize menu. As you can see in Figure 5-15, you can choose from 
three wind "strengths," and you can specify whether the Wind effect should 
originate from the left or right side of the image. However, since the effect 
cannot be controlled as precisely as motion blur, the Wind effect is better used 
as a constant effect throughout a motion cycle. 

For example, if you have a cartoon racehorse that will speed across the top 
of your page without stopping or varying its speed, Wind is probably the 
better effect to use. On the other hand, if your animated horse starts the ani
mation standing still and then starts running, you'll need the gradual control 
offered by the Motion Blur filter. 

Remember that the Wind effect can only be controlled in a left or right direction (90 
or 270 degrees), while the Motion Blur effect can "move" an image at any angle. 
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Wind E'.l 
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Figure 5-15: Tile Wind dialog and its controls. 

Figure 5-16 illustra tes an image with a wind entering from the left side of 
the dialog. 

Figure 5-16: A Wind effect can also suggest motion. 

Texturizer 
The final effect I'll mention is the Texturizer, which you'll find under the 
Texture submenu. This is the perfect effect if you'd like to simulate a texture 
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underneath your image-for example, if the frames of your animation should 
look as if they're taking place on a piece of cloth or burlap. 

Let's suppose you'd like to animate a piece of graffiti on the side of a build
ing coming to life-no problem, as you can see in Figure 5-17. Use the Brick 
texture and specify Top for the Light Direction field in the Texturizer dialog, as 
shown in Figure 5-18. Other textures include burlap, canvas, and sandstone, or 
you can select a custom texture. 

Figure 5-17: And you thought you needed a spray can for graffiti! 

1 catu11.1e1 E3 

• T.,._ lil!l!!!!!IB---, 
._... ID 
RM ~ 

IJdil Diecliart IT op El 
a.,_ 

Figure 5-18: The Texturizer dialog settings I used. 
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Distorting Images for Animation 

If you're interested in animation-and I think we can safely assume that-one 
particular group of Photoshop image filters deserves special coverage. The 
Distort family of image filter effects are very popular tools for creating ani
mated GIFs; they're roughly akin to the old "circus mirrors" that you can still 
find tucked away in one section of every traveling carnival. All of these effects 
perform some sort of geometric contortion on your image, which often be
comes a unique and very eye-catching movement cycle. 

I generally separate these distortion effects into two categories: 

• Object distortion. This type of distortion changes the shape of the image 
(usually it's an object that's being changed; for example, a car is pinched 
in the middle, or a computer floppy disk is sucked down a drain). 

• Surface distortion. Unlike object distortion, the surface of the image 
itself seems to be changed, as if you're viewing the image through a 
specific texture. 

I'll cover both categories in this section by discussing several Distort filters 
that are especially well-suited for animation, as well as examples of how each 
can be applied. 

Pinch 
You've seen this object distortion effect a thousand times on the Web; an 
animated object seems to bulge toward you in three dimensions, or perhaps 
it appears to be pulled backward like it's being sucked into a vacuum cleaner. 
The Pinch filter can create both effects! You can specify a maximum "bulge" 
of -100 and a maximum "pinch" of 100 using the slider in the Pinch dialog, 
as shown in Figure 5-19; the 3D wireframe matrix below the slider gives you a 
visual preview of the effect. Figure 5-20 shows an image that has encountered 
an unexpected pinch! 
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Ill 
Figure 5-19: The Pinch dialog with its 30 wirefra me model. 

Figure 5-20: An image after it's been pinched. 

I've found that the Pinch filter produces the best results on less complex 
images, especially if they have a single-color area. A good example for anima
tion would be a person wearing a solid color T-shirt; each frame would apply 
an increasing amount of bulge to the model's stomach, ending in an animated 
fitness nightmare. 

Glass, Ripple & Ocean Ripple 
I' ll combine these three separate surface distortion effects into one discussion 
for our purposes, since their effects are very similar. These filters overlay a 
specific transparent texture on top of your image. (This differs from the 
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Texturizer filter we discussed in the previous section, which placed the speci
fied texture under your image). You can simulate rippling water, several 
different kinds of glass, and even load textures of your own. 

Figure 5-21 illustrates the Glass dialog, which offers more control over this 
distortion filter than most of the other filters available in Photoshop. Figure 
5-22 is a good example of the effects of the Glass filter using a low distortion 
level and the Frosted texture. 

Figure 5-21: The Glass filter dialog offers a number of controls. 

Figure 5-22: An interesting effect obtained with the Glass filter. 
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The Glass filter can be used to create a sophisticated rippling dissolve by 
increasing the distortion and smoothness levels by a value of 1 for each succes
sive frame; the best way to describe this effect in print is by saying it will remind 
you of a bowl of Jell-0 beaming aboard the Enterprise in an episode of Star Trek! 

Shear 
Speaking of Jell-0, you've seen the Shear effect often on both TV and the 
Web-an object can be bent, twisted, and elongated with this filter, pulling 
your image around as if it were a piece of taffy or a rubber band. To control 
this effect from the Shear dialog, you click anywhere on the vertical center of 
your image to add a handle, and then drag that handle anywhere in the con
trol box to perform the same distortion on your image. The farther away from 
center you drag your handle, the greater the distortion, and you can move the 
handle up or down to distort the image at an angle. For an animation move
ment cycle-a cartoon image on a black background, for example-I usually 
select Repeat Edge Pixels for the Undefined Areas field. This prevents your 
image from "wrapping around," which would ruin the effect of motion. 

If you decide the effect isn't quite what you wanted, click the Defaults button to 
return the preview image to its original position. 

You can select multiple handles as well, so your Shear effect can even 
take off in multiple directions! Figure 5-23 illustrates the Shear dialog with 
two handles selected, while Figure 5-24 shows the result of two Shear points 
moving in opposite directions. 

Figure 5-23: Selecting multiple directions fo r a Shear effect. 
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Figure 5-24: A typical result of a Shear filter. 

ZigZag 
Now here's a great object distortion filter effect that's just crying out, "Animate 
me! Animate me!" And, in fact, Web artists have heard that call, and you've 
seen animation using ZigZag on everything from banners to buttons. This 
filter can produce three different styles using the same controls: Around Cen
ter, Out from Center, and Pond Ripples. To tell you the truth, I personally 
consider Out from Center to look just as much like the ripples in a pond as 
the Pond Ripples style; for example, Figure 5-25 illustrates an image dis torted 
in this style. 
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Figure 5-25: Doesn't this look like the ripples i11 a pond to you? 

However, I didn' t write the program, so I don' t get to name the effects. All 
three of these effects can be set to anything from a hardly noticeable smudge 
to a full-fledged trip back to the '60s, so you have great control over the level 
of distortion. Figure 5-26 illustrates the ZigZag dialog, which also features a 
30 wireframe preview. 
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Figure 5-26: The ZigZag dialog. 

Twirl 
Our final distortion effect is perfect for that work that belongs "down the 
drain"-or, for that matter, down the black hole! If you look at Figure 5-27, 
you get the idea; the Twirl effect is especially good for a "twist-untwist" ani
mation for a logo or a word you've rendered in 30. The more detail, the better 
the effect; add a loop and you've built an animation tha t can glue your visitor 
to your page, watching your image twirl back and forth. In fact, a warning 
about the dangers of hypnotism might be in order. 
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Figure 5-27: The Twirl Jilter produces an outstanding effect! 

Figure 5-28 illustrates the Twirl dialog. Although you only have one control 
to work with, you still have all you need to gradually increase the twirl angle 
for successive frames of your animation. 

J ..... 1::3 
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Figure 5-28: You only need one control to do the twirl! 

Now it's time to move on-there's much more ground we must cover in 
Photoshop that will be valuable to you as an animator! I'll close this section by 
again offering my best advice on image filters, no matter what editing soft-
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ware you use: experiment! Try each and every filter you can get your hands 
on. Of course, they're all nifty for creative work with static images, but while 
you're trying out a new filter, ask yourself, "Would this effect look good ani
mated?" The more experience you gain using these filters, the faster you'll be 
able to produce mind-blowing animation that will draw visitors to your Web 
site like bears to honey. 

Layering Images 

As we learned in Chapter 4, animated images are built from individual 
frames, each of which holds a "slice" of the movement cycle. When combined, 
your eye sees these frames as a single moving image. In Chapter 4, our piano 
keyboard example was animated in a series of four images using Paint Shop 
Pro, and each of those images was saved with a separate filename. 

You can perform these same steps in Photoshop as well, using its support 
for layered images. In effect, a layered image has "depth" as well. Depending on 
the total memory available to Photoshop within your system, up to 100 succes
sive layers can be added to a background, and you can alter the characteristics 
of any layer without changing the other layers in the image. Figure 5-29 illus
trates a cross-section of a layered image. Photoshop also provides an adjust
ment layer, which is a special layer rather like a control block in an animated 
image-you can use an adjustment layer to add some specific effects to all the 
layers below it. 

Background Layer 

Figure 5-29: A cross-section of a layered image created in Photoshop. 

So how are these layers finally combined into a single image? When you're 
satisfied with the final appearance of your image, you can use the Merge 
Layers command to lock everything together, and then you can save your 
completed image to your hard drive. 
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In this section, I'll show you how the layer support within PhotoShop 
makes it an ideal tool for creating animation frames. In fact, we'll re-create the 
frames necessary for our animated keyboard, so y.ou can compare the process 
against the steps we took in Paint Shop Pro. 

Which Is Better? 

"OK, if the techniques for creating animation frames I learned in Chapter 4 work 
fine, why should I use Photoshop instead?" Actually, you don't have to but you 
may find the Photoshop method faster. If you create animation frames com
pletely within Photoshop, you'll avoid loading other programs, and you can 
apply any of the image effects we discussed earlier directly to a layer. Also, 
creating your animation in layers allows you to "preview" the finished effect 
one layer at a time. 

To answer the question, there really is no "better" image editing program. 
As long as your editor supplies the filters and features that you use most often, 
select the one with the interface that you like the most! 

To build a layered image for animation, follow these steps: 

1. Select Open from the File menu, browse through your system, and load 
your image; in our case, we'll be loading our old friend piano.gif. 

2. We need to convert piano.gif to grayscale or RGB Color to add layers, so 
select Mode from the Image menu and then select Grayscale from the 
submenu that appears. Photoshop will prompt you for confirmation that 
you wish to discard color information from your image. Since our key
board is strictly black and white, we can do that and save bytes to boot! 

3. Next, add a layer to your original image by selecting Duplicate Layer 
from the Layer menu. Photoshop displays the Duplicate Layer dialog, as 
shown in Figure 5-30. 

Figure 5-30: The Duplicate Layer dialog. 
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Enter Layer 1 in the Duplicate As field and click OK to continue. You'll 
notice that your new layer now appears in the Layers palette at the right 
side of the screen, as shown in Figure 5-31. Your original image has 
become the background, but it doesn't get a layer number. 

Figure 5-31: A new layer appears in the Layers palette. 

New Layer vs. Duplicate Layer 

You may be wondering why we didn't create a brand new layer instead of dupli
cating the existing layer , .. good point! I usually select New Layer whenever I 
need to draw or import a different image as a basis for each frame (for example, 
the flames of a fire or a door opening and closing). Since a brand new layer starts 
as a blank, I can add only the part that moves (the flame or just the door), while 
the background stays the same (the fireplace or the door's frame). 

However, each frame of our piano keyboard is based upon the same image as 
the background, and the movement cycle is based on color changes rather than 
motion; so, therefore, we can save ourselves quite a bit of work by simply dupli
cating the background and making our changes! 

If you do need to create a brand new layer, select New from the Layer menu 
and then select Layer from the submenu that appears. Alternatively, you can 
click the New Layer button at the bottom of the Layers palette (Windows users 
should Alt-click, while Mac users should Option-click). The New Layer dialog 
will appear; you'll notice that the default values are fine for animation. In most 
cases, you'll want full opacity, and most frames should be created in normal 
mode. Click OK to continue, and you've created a new frame. 
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4. Now we'll add the gray keys to Layer 1 as we did in Paint Shop Pro. Select 
the Eyedropper tool from the Toolbox, and move your cursor over one of 
the shades of gray in the Swatches palette. Click to pick up the color as 
your foreground, and then select the Paint Bucket from the Toolbox. Click 
inside one or two keys at random, just as we did in Chapter 4, to fill them 
with the color. 

That finishes Layer 1! Next, let's add Layer 2. Select Duplicate Layer 
from the Layer menu. Photoshop displays the Duplicate Layer dialog; 
enter Layer 2 in the Duplicate As field and click OK to continue. 

6. Select the Eyedropper tool from the Toolbox, and move your cursor over 
one of the shades of gray in the Swatches palette. Click to pick up the 
color as your foreground, and then select the Paint Bucket from the 
Toolbox. Click inside one or two keys at random to fill them with the 
color-different keys, of course, than you picked for Layer 1. 

7. OK, Layers 1 and 2 are done. Now repeat steps 5 through 8 once more to 
create a total of four layers, including the background. Make sure that 
you click the Background layer on the Layers palette first, so that you're 
creating a duplicate of the original image instead of the last layer you 
made. Select different keys and specify Layer 3. 

It's a common enough scenario with any graphics application, including Photoshop. 
Let's say you've assembled an image with twenty layers, each of which will be a 
frame of animation, and you suddenly discover that you forgot to add some detail to 
layer 12. Don't panic-it's easy to edit an individual layer in Photoshop. 

8. If you'd like to try one of the image effects we covered earlier in this 
chapter, go ahead and apply the filter you'd like to try to one of your 
layers! Let's try adding a Crystallize effect to Layer 2, and I can show 
you how to edit an individual layer. 

9. Click the Layer 2 section on the Layers palette. Photoshop automatically 
displays that image layer. This activates the layer, and any change that 
you make is applied directly to this layer. 

10. Pull down the Filter menu, select the Pixelate submenu, and click Crystal
lize. Photoshop displays a dialog prompting you for the cell size, complete 
with preview image. Select a cell size and click OK to apply the effect. 
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11. To add a different amount of Crystallize to another layer, click to select 
the layer from the Layers palette. 

Setting Layer Options 

You can also set a number of options for the active layer by selecting the Layer 
Options item from the Layer menu. As shown in Figure 5-32, you can change 
the layer name, its opacity, and how it handles the display of pixels in layers 
underneath it. 

Most of these need no adjustment, but I do use the opacity control from time 
to time. Although we won't need to vary opacity with our piano keyboard, you 
can lower the opacity percentage to allow other image layers beneath to show 
through during your animation. This is especially convenient for frames with fog 
or smoke, where you want your movement cycle to include a swirling mist effect. 

~ 0 255 

Figure 5-32: The Layer Options dialog. 

12. At this point, you've built an entire image that-if we merged it-would 
show all of the gray keys at once. However, we can ' t actually animate 
these four different layers within Photoshop, so we need to save them as 
separate GIF images for use with GIF Construction Set. To do this, high
light each of the layers you've created one at a time (except for the back
ground, which is actually just piano.gif), and select Save a Copy from the 
File menu. Photoshop displays the dialog shown in Figure 5-33; select 
BMP format in the Save As field, enter a new unique name (usually with 
a number to indicate sequence) for this frame, and click OK to save it to a 
disk as a bitmap. Since our background remains piano.gif, there's no 
need to save it. 
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Figure 5-33: The Photoshop Save a Copy dialog. 

Now you have the same four images you had in Chapter 4, ready for GIP 
Construction Set (which can import bitmap files as well)! 

If you're like me, the method you choose to create animated frames will 
depend on the editing required for each frame; for example, if I'm animating a 
simple cartoon bird from a piece of clip art that needs to flap its wings, then I 
might use Paint Shop Pro. If I'm developing the title image for a Web page that 
includes more than one animation and I'd like to use one of the advanced 
filters I've mentioned, the choice is clearly Photoshop! If you have access to 
both programs, try animating an image under both applications and see which 
you prefer. 

Sectional Animation With Photoshop 

While we're here, I'd like to cover one more animation technique that 
Photoshop helps to simplify: sectional animation. In Chapter 4, you learned a 
number of rules, tips, and tricks that will help cut down the final size of your 
animated GIP images to a bare minimum-consider this to be a more ad
vanced method of compression! 

In section removal, a portion of the animation that does not change from 
frame to frame is removed-this is typically the background or some large 
portion of the image. I've also heard this technique called "keyhole" animation 
as well, since only the portion of the animation that changes is saved to each 
frame; in essence, this is the same technique as the dirty rectangle compression 
I mentioned in the last chapter. 

This technique can save a tremendous amount of space in your finished 
image, but it does take additional work, and it doesn't contribute at all to the 
final appearance of the image. Therefore, I use it only if an animation has 
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grown so large that it needs major surgery to correct. For me, that threshold 
occurs somewhere around 50-60K for larger images. 

Figure 5-34 shows a single image that I pulled from a clip art disc in my 
collection. Let's suppose that you need to animate the eyes on this image; we'd 
like for the lady to blink. If the final image is only an inch square, we're not 
talking a tremendous file size, and you could use the technique we covered in 
Chapter 4 to create several frames of animation. Suppose, though, that you need 
this image in a 4-inch square size for your page-now we're talking one huge 
animated GIF that will take a very long time to download using a 14.4k modem! 

x 

Figure 5-34: Our original image. 

Hang on a second-let's look at this image again. If all we're going to 
animate is her eyes, we can use the sectional animation technique. After all, 
the rest of the image won't change at all, so we can trick the eye by using 
transparency. We can do it with a combination of Photoshop and GIF Con
struction Set! 

Here's the steps we would follow: 

1. Select Open from the File menu, browse through your system, and load 
smile.gif. Convert it to RGB by selecting Mode from the Image menu and 
then selecting RGB from the submenu that appears. 
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2. Next, add a layer to your original image by selecting Duplicate Layer 
from the Layer menu. Enter Layer 1 in the Duplicate As field and click 
OK to continue. Your original image has become the background. 

3. Use the Zoom tool from the Toolbar to zoom in on our subject's eyes. 
Select the Eyedropper tool from the Toolbox, and move your cursor over 
her face. Click to pick up her skin color as your foreground, and then use 
the drawing tools to draw her lids as they start to dose, as shown in 
Figure 5-35. 

4. Now for a very important step: expand the image to full size, and use the 
Marquee selection tool to grab just the top part of the image that includes 
her eyes. Once the right section is selected, use the Crop command on the 
Image menu to reduce this image to just her head and eyes, as shown in 
Figure 5-36. 

Figure 5-35: Zooming in to animating our subject's eyes. 
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Figure 5-36: Cropping our image to a small animated section. 

5. Let's create the second layer now. Highlight Layer 1 in the Layers palette, 
and select Duplicate Layer from the Layer menu. Enter Layer 2 in the 
Duplicate As field and click OK to continue. Notice that we're now 
creating a duplicate of the last layer we made instead of the background; 
this allows you to draw the details necessary to create the animation as 
smoothly as possible, and your cropped area stays exactly the same size. 

6. Use the Zoom tool from the Toolbar to zoom in on our subject's eyes. Use 
the drawing tools to draw her lids down a bit farther. 

7. Next, repeat steps 5 and 6 twice more to create a total of four layers, 
including the background. 

8. Tune to save the top three layers of this image as separate GIF images so 
that we can use GIF Construc tion Set to build the final animation. To do 
this, highlight each of the layers you've created one at a time (remember, 
the background is smile.gif, so no need to save it), and select Save a Copy 
from the File menu. Select BMP format in the Save As field, enter a new 
unique name (usually with a number to indicate sequence) for this 
frame, and click OK to save it to a disk as a bitmap. 
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Now, exit Photoshop, fire up GIF Construction Set, and follow these in
structions: 

1. From the GIF Construction Set menu, select New from the File menu. 

2. Highlight the HEADER image command and click the Edit button on the 
toolbar; GIF Construction Set displays the Edit Header dialog. Use the 
scroll buttons at the right side of the Screen width field to specify the 
width and depth for the background image. 

3. From the toolbar, click the Insert button; GIF Construction Set displays 
the floating Insert Object toolbar. Click the Image button. The program 
displays a standard Windows File Open dialog. Select the first frame of 
your animation that includes the entire background (in our case, that's 
the original image, smile.gif) and click OK to load it. 

If necessary, you can position your smaller image in a specific location 
so that it's aligned with the larger image; for our example, this isn't 
necessary since the top sections of both images naturally match. How
ever, if you need to adjust the position of your cropped image, highlight 
the IMAGE block for each of your cropped frames and click Edit. From 
the Edit Image dialog, you can set the top and left side positions relative 
to the largest frame in your animation. 

4. If your image frames are using a palette that doesn't match your current 
global palette, it will be necessary to change the palette as we fully de
scribed in the section "Using the Animation Wizard" in Chapter 4. Select 
Use this image as the global palette and enable the Use this selection for 
subsequent images check box, so you won't have to go through this step 
for each image in your animation. Click OK to continue. 

5. For each frame after the first frame (which, if you remember, is our 
background image smile.gif), add a CONTROL block in front of the 
IMAGE block. Click the preceding block in the list to highlight it (in 
this case, the HEADER block), click the Insert button, and then click the 
Control button. The CONTROL block must appear right in front of the 
IMAGE block, and GIF Construction Set inserts blocks after the high
lighted command. 

Next, we must edit the CONTROL block to allow the lower portion of 
the head, neck, and shoulders from the first frame to remain visible. It's 
already highlighted, so click the toolbar Edit button to display the Edit 
Control Block dialog, as shown in Figure 5-37. There's no need to set 
transparency here or give it a value, since it's actually not necessary for 
sectional animation. Instead of transparency, sectional animation de
pends upon the Remove by drop-down list box, which we'll set to Back
ground. Click OK to save your changes. 
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When this frame is displayed, any areas that stick out beyond the bor
ders of the cropped boundary remain visible which, in this case, means 
that the lower part of the first image, smile.gif, will be visible throughout! 

I dll Conhol Bluel 

o:J21 

Set fllllll0¥I By to Back91QUnd for u.n~ 
anlmtlid GIF 111t1. 

Figure 5-37: Specifying our Remove by settings in tile Edit Control Block dialog. 

6. Now simply repeat steps 3 through 5 for each frame in your animation, 
loading each of them in order. 

7. If you would like your animation to loop indefinitely, click Insert from 
the toolbar, and then click the Loop button; no matter which command 
was highlighted, GIP Construction Set adds the LOOP block command 
as the second command in the animation. 

8. That's it! If you like, you can view your sectional GIF animation before 
you save it to a disk. Click the View button on the toolbar. The program 
displays your GIF and p lays it for you. To return to the GIF Construction 
Set main window, click the right mouse button. 

9. Finally, save your image. Select Save As from the File menu to display a 
standard Wmdows Save As dialog. Select GIF files as the file type. Don't 
forget to use a completely new name for your new animated GIP to 
avoid overwriting any of the existing components. Click Save to save the 
new image to your hard drive. 

How much download time will this technique save you? Of course, it 
depends on the size of the original image and the cropped section and the 
number of frames, but I've reduced some GIFs a third or more in total file size 
with sectional animation. 
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Moving On 

This chapter was all fun, as we explored some of the unique creative effects 
you can add to your animation frames with Photoshop. I discussed those com
mands and image fil ters which are commonly used for animated GIFs, and you 
learned more about how to use layers in Photoshop to create animation frames. 
Finally, we used the sectional animation technique to dramatically reduce the 
size of an animated image using Photoshop and GIF Construction Set. 

In Chapter 6, "Creating 30 Web Graphics," you'll enter a favorite world of 
mine, where your animated graphics will suddenly occupy three dimensions! 
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CHAPTER 6 

Creating 3D 
Web Graphics 

M ost of the pages I saw when I first started moving around the Web two 
or three years ago were static, and a great many were plain text. After all, the 
Internet was a research tool, and the Web at that time was a very, very small 
part of the network. Now, however, the standards for a professional looking 
page have advanced . To keep up with the rest of the Web community, you'll 
have to entertain with images ... and naturally, the more animation, the better. 

At this point, you've learned how to edit and animate images, and even add 
sophisticated image effects to your animation. Now we're going to enter another 
brand new world-a creative environment once populated only by Hollywood 
special effects wizards and owners of high-powered graphic workstations. 
We're going to create animated images that will impress even the most jaded 
Web surfer. Ladies and gentlemen, welcome to the world of three-dimensional 
animation, much like that used in the films Toy Stan; and Tron! 

"But wait. . .I thought I needed a Sun workstation to handle that kind of 
work, or a rendering package that'll set me back a thousand dollars!" Just a 
few years ago, you probably would have been right. With today's more pow
erful PowerMac and Pentium-based personal computers, though, you've got 
the power you need to produce the best results, and you can find inexpensive 
rendering and raytracing software-even shareware and freeware-for both 
MacOS and Windows 95. I first started rendering 30 images on an Atari ST, 
and even a 68040-based Macintosh or 486-33 PC can do the job (although it 
will take considerably longer). 
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In this chapter, I'll explain what you need to know about rendering and 
raytracing, and then I'll introduce you to my favorite shareware rendering 
program for Windows 95: Pixel 3D from Forward Design, which you'll also 
find on this book's Companion CD-ROM. I' ll provide you with a few pointers 
on what 3D features work (and which don't) when you 're creating an ani
mated GIF for the Web. We'll discuss a number of important elements in any 
3D design, such as texture and lighting. Next, you'll dive into the world of 3D 
as you use Pixel 3D to animate your name with the Logo Wizard. I'll give you 
a quick tutorial of some of the advanced features you'll find in Sculpt 3D, a 
program created by Byte by Byte for the Macintosh. Finally, we'll draw this 
chapter to a close with a discussion of several rendering programs for both the 
Mac and the PC that won't set you back a fortune. 

What Is Rendering, Anyway? 

At your first encounter with the term "rendering," you probably conjured up a 
visual image of a particularly busy tiger in the middle of a meal. Sorry. If that's 
what you're looking for, I would suggest a good wildlife documentary! In this 
chapter, the term describes the process of modeling a 3D object on your com
puter screen and applying a surface texture to achieve a realistic appearance. 

Notice that I used the word "modeling" there-unlike other methods of 
producing a frame of animation that we've discussed earlier in the book, 
rendering involves the creation of a model-typically a wireframe shape-that 
you can save to a disk and load whenever you like. Unlike two-dimensional 
animations, you're not simply changing the position or color of some part of 
the image; ins tead, applications like Pixel 3D store the shape of the model, and 
your animation frames are actually snapshots taken of this model as it moves! 
Figure 6-1 shows a wireframe model of an Egyptian pharaoh's mask, and 
Figure 6-2 shows the mask as a rendered solid object. 

Some rendering programs show you this model and allow you to modify it 
onscreen, whereas other programs simply store a sequence of points in space 
that represent the physical shape of the model. I've always preferred the 
former method, since I'm very much a WYSIWYG ("what you see is what you 
get") kind of guy. Regardless of how you manipulate the model, after you've 
gained experience with a rendering program, you can envision the object in 
your mind, and making changes to your model becomes second nature. 
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Figure 6-1: A wireframe model as it appears within Pixel 30 . 

Figure 6-2: The same wireframe model after it's been rendered. 
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,_........,..,.:'%ln Then What Is Raytracing7 

One common misconception about 3D modeling is that raytracing is the same 
as rendering. This is definitely not the case, but you often see these terms 
being used interchangeably on Internet newsgroups and in the news. So, if 
you hear someone talking about a new raytracing package on the market, he 
or she is probably talking about a rendering program. 

In fact, raytracing is a feature offered by most high-end rendering packages. 
It allows your computer to actually trace the path of virtual light rays through 
(and reflecting off) your 3D model (hence, the name). This capability allows 
you to add incredible realism to your images. Raytracing is used to generate 
accurate shadow effects, transparent surfaces, and reflections in your final 
image, and it can make the difference between "Isn't that a pretty computer 
picture?" and "Is that real? That is real, isn't it?" 

As an example, Figure 6-3 shows a 3D object that I created in Pixar's 
Typestry, one of my all-time favorite rendering programs. Unfortunately, this 
superb program is no longer available for purchase, so we won't be covering it 
in this chapter. Pixar's Toy Story was so successful that the company no longer 
develops software for sale. I use this image as a background under Windows 
95. If you saw this image elsewhere, you might be fooled into thinking that it 
was a picture of a metal sculpture! 

Some of my best rendering work includes highly reflective gold, silver, and chrome 
company logos. If your animated images will include metallic surfaces, precise 
lighting, shadows, or reflected light, you're cheating yourself if you don't use a 
rendering program that supports raytracing! 

Although Pixel 3D doesn't support raytracing in this version, Sculpt 3D 
does-and I've also created a number of original sample images especially for 
this book's Companion CD-ROM. These examples demonstrate the effects of 
different lighting, textures, and raytracing. 
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Figure 6-3: A rendered 30 object that demonstrates raytracing. 

Rendering for GIF Animation With Pixel 30 

Trme to introduce you to another of my favorite animation tools: Pixel 3D is a 
Windows 95 shareware rendering program that includes all the basic functions 
we'll need in this chapter, and you can use it to create images for animation. 

···-· Macintosh owners, don't go away! We'll also cover a number of basic rendering 
tenns and concepts that apply to all programs, no matter what platform, so you 
should read this section as well. 

Although not as powerful as some of its counterparts, Pixel 30 is also much 
easier to learn than most of these other programs. Some of the more expensive 
programs don' t even have a standard toolbar, and one very powerful freeware 
rendering program doesn' t even have a menu system at all! Most important, 
Pixel 30 has something unique that should appeal to every GIF animator 
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around: a Wizard especially designed to create 30 logos and impressive 30 
text! Most companies demand that the pages on their Web sites feature the 
company logo, and Pixel 30 recognizes this need by calling itself "30 Object 
and Logo software." 

Let's take a quick tour around the Pixel 30 interface, and I'll introduce you 
to some terms we'll use throughout this chapter as well. Figure 6-4 illustrates 
the Pixel 30 main window, complete with a wireframe model of a train en
gine. As you can see, the surface supporting this model-I suppose you could 
call it a "floor"-is actually a grid of squares. This floor helps to maintain a 
sense of depth and perspective while you're creating your model. 

Figure 6-4: A wireframe model loaded in Pixel 3D. 

After you've loaded or created your model, you can actually "move" 
around it by using your mouse. Most rendering programs assign you one or 
more cameras, which you can position at different angles and distances away 
from the subject. If this sounds very similar to still or motion picture photogra
phy, you're definitely barking up the right tree. All the basic elements are here: 
lighting, camera angle, and position~ven different color masks and gel 
filters are available on some rendering programs! 
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With an image-editing program such as Paint Shop Pro or Photoshop, you 
create or modify images by drawing with a virtual pencil, paintbrush, or spray 
can. In a rendering program, however, you build your model instead. For 
example, under the Edit menu in Pixel 30, you'll find three different sets of 
basic building blocks for any image: low, medium, and high-resolution geo
metric shapes. These simple shapes are typically called primitives in rendering 
applications. Figure 6-5 shows three of these common shapes: a sphere, a 
cylinder, and a torus (the fancy rendering name for a doughnut). 

Figure 6-5: Three basic building blocks you can use to make 3D models. 

Sometimes, you can create an entire project out of primitives without any · 
extra work, but usually you will need to make changes to the surface of a 
primitive to add something; for example, you might add windows or an 
antenna array to a 30 model of a satellite. Some rendering programs also 
allow you to manipulate specific points of the model, which means you can 
twist, sculpt, and add detail to your model in countless ways. 
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···-· Before you decide to become a Master Renderer and toss away your Paint Shop Pro 
or Photoshop, remember that the final output of a rendering program is, in most 
cases-you guessed it-an image! You'll still need your image-editing software for 
the techniques you learned earlier, just as you still need GIF Construction Set or 
GIFBuilder to create your animated images. Consider your rendering program as 
another tool in your animation toolbox-rendered animation is certainly not 
appropriate for every occasion. 

As you can tell from the basic shapes in Figure 6-5, we're still missing 
something important: none of these objects look like anything, except perhaps 
pieces of white plastic. At this point, textures enter the picture. A texture is 
actually a picture of a surface that can be applied to your objects in your ren
dered scene. Common textures that you see used all the time include chrome, 
wood, several different types of marble and granite, and metallic finishes such 
as gold and silver. Let's work a little magic with textures. As you can see in 
Figure 6-6, now we have wood, marble, and metal objects! 

o PJ11rl 0 lltl-113 

Figure 6-6: With the addition of textures, our objects look much better. 
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You can also add detail to the surface of your objects, too-rather like the 
brick or ripple effects we added to images with Photoshop in the previous 
chapter. For example, with Pixel 30 you can add a rough, wrinkled, or eroded 
finish to the surface of your objects. Generally, the larger the object, the easier 
you can see a surface finish. You can also enhance the appearance of a surface 
finish by carefully positioning a spotlight. 

Speaking of spotlights, let's not forget the importance of lighting in 30 
images! Lighting can add realism, depth, and drama to a rendered object. Pixel 
30 allows you only a single light source, but you can move it to any one of 
nine different positions. Other rendering programs provide you with multiple 
lights of different luminance levels, so you can achieve the precise shadow 
effect you need. 

Finally, Pixel 30 allows you to add a background to the final image. I almost 
never use this function while creating rendered objects for animated GIFs. 
Usually, I want to create a specific rendered object like a logo or a word with a 
transparent background rather than create an entire scene, which would create 
an animated GIF of monstrous proportions. Use backgrounds for static scenes 
you render, but avoid them when building image frames for GIF animations! 

Now you've completed your "two-page training" in basic rendering 
concepts! Next, let's turn our attention to selecting the proper material for 
30 GIF animation. 

Rendering for GIF Animation 

Now that you're more familiar with what rendering is, let's take a minute to 
identify the design elements of 30 objects and what features and materials are 
best-suited for rendering them for use in GIF animation. As a basic rule, avoid 
most of the bells and whistles offered by your rendering program. As you 
might expect, a number of features available on most rendering programs can 
actually do more harm to your animation frames than good. 

In particular, avoid rendering image effects. Many high-end rendering 
programs can add special image effects like motion blur, but I generally avoid 
actually rendering image effects as part of an animation frame. As you learned 
in the preceding chapter, Photoshop can do an impressive job of adding mo
tion blur, and by adding the effect there, you have more control over the 
amount and direction of blur for each frame in your animation than you 
would if you rendered that same effect. Also, the amount of time it takes to 
render image effects like fog or blur is roughly equivalent to a mile's worth of 
glacier movement! Therefore, create your animation frames without image 
effects, and then add them later on a frame-by-frame basis in Photoshop. This 
way, you'll save lots of time and a few gray hairs to boot. 
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If your rendering software supports anti-aliasing, always use it! Anti
aliasing is a common technique for smoothing the jagged edges of comers and 
straight lines within your image by mixing colors along the edge. In fact, your 
computer probably uses it to make your screen fonts easier to read. Using anti
aliasing will lend a cleaner, sharper look to your final animation frames, 
which, in turn, will result in a better-looking GIF animation. I can think of only 
one drawback to anti-aliasing. Like most good things in life, rendering your 
image with anti-aliasing turned on takes considerably longer, since your 
computer must redraw the image multiple times; however, the visitor who 
eventually views the image incurs no extra time. 

Once again, consider the finished size of your image when creating 3D 
objects for GIF animation, and don't render your model to fill the entire 
screen! Notice, however, that I did not say "reduce the detail." In fact, the 
more detail in your model, the better it will look, no matter what the fin
ished size. If you're creating a giant walking robot, add all the nifty details 
you like, but reduce the scale of the final rendered image down to two or 
three inches. That way, you keep the detail, but you don't end up with an 
animated GIF the size of New Orleans. 

"Couldn't I just resample the image down to a smaller size later?" You could, but 
you'll get better results if you render the image at the actual size you need it. 
Resampling is a powerful tool, but it can't match an image that was rendered at the 
proper size! 

Design Elements of 30 Objects 

In this section, I'll discuss four important design elements of a rendered object: 

• Object 

• Angle 

• Lighting 

• Texture 

Each of these elements can be modified or selected for the express purpose 
of producing a better animated GIF. For our sample 3D logo, we'll use your 



,r'\ 
Chapter 6: Creating 3D Web Graphics 199 

first name. If any of these elements are completely off-base, then your 30 
image will be useless, so it pays to design your objects before you spend a lot 
of time rendering them. 

Selecting an Object 

Primitives are the basis for most of the advanced rendering work you've seen, 
but you can also use individual characters or a word from a standard font. 
Let's look at both of these approaches to selecting an object for rendering. 

Objects Built From Primitives 
Building an object from primitives is closely akin to those games you probably 
played as a child where you had to create as many objects as you could from a 
box of simple shapes; for example, a circle on the end of a long, thin cylinder 
became a lollipop, and two triangles placed together at the tip became a but
terfly, and so on. However, in a rendering program, your shapes are not static; 
you can stretch or mold primitives to change their size or alter their form. In 
this way, you can form joints between pieces or extrude a simple triangle into 
a long triangular tube. 

Although every rendering program uses a different method of altering 
primitives, the idea of building an object remains the same: copy the basic 
shape of the object using several primitives and then make changes to the 
individual primitives to bring them more closely in line with the form of the 
actual object. Within Pixel 30, for example, a cone with a sphere balanced on 
its tip becomes a world globe. 

Unless you're trying to model something that's extremely simple in design 
or has actual facets-for example, a baby's rattle or a big diamond-I recom
mend you use high-resolution primitives whenever possible. Although high
resolution primitives do require more time for rendering, colors and textures 
will always look their best on a high-resolution shape because the surface of 
the primitive is much smoother, and your object will animate much more 
smoothly. Of course, if I were rendering a lighted disco ball from my high
school years, a medium resolution sphere would be perfect. .. and I could add 
a tiny John Travolta. On second thought, forget it. Anyway, Figure 6-7 illus
trates a low-resolution primitive on the left and a higher-resolution primitive 
on the right for comparison. 
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Figure 6-7: A comparison between /ow-resolution (left) and high-resolution (right) rendering 
primitives. 

Objects Built From Fonts 
If you do quite a bit of publishing work, writing, or graphic design, you prob
ably have hundreds of fonts on your computer. I admit it- I'm a font pack rat! 
You probably wonder which one of these fonts is best-suited for rendering and 
GIF animation? 

Often, if you're rendering a logo, selecting a font isn' t an issue. Perhaps 
your company already has a logo available in several formats. (I know of some 
companies that even have logo wireframes already prepared for rendering.) 
Or, if you're creating a logo from scratch, your company may require a specific 
font for use on company communications ... no decision necessary there! 

However, if you're building a text object from scratch, and you have the 
leeway to select any font you like, you can still consider a number of criteria to 
help you choose the right font: 
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• Readability. When you're creating a 3D font for GIF animation, remem
ber that your visitor may have only a second or two to read your logo if 
it's spinning or moving across the Web page, so the choice of font is very 
important to make sure your message gets through. I generally avoid 
"handwriting" or "script" fonts for GIP animation, as the front of each 
character is too thin to be easily read while moving. For the same reason, 
even the best textures tend to "disappear" on letters with thin faces. 
Likewise, you should avoid complex fonts like Old English if your image 
will be animated. 

For example, look at the two fonts I've used for rendering in Figures 6-
8 and 6-9. Which would you consider easier to read, especially if both of 
them were spinning around in a circle? 

c 1'1.wl JO Ptl-U::i 

Figure 6-8: A font suitable for an animated logo. 
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Figure 6-9: A font Jar from suitable for an animated logo. 

Avoiding special attributes like bold, italic, or strikethrough when designing 3D 
text is generally a good idea. Fonts are designed for readability with normal at
tributes, and you'll often find that italicizing or balding a font will actually reduce 
the readability of a font. 

• Impact. The best 3D logos you've seen have real visual impact, and that 
generally means a strong, thick character. I prefer sans serif fonts for 
rendered logos, since they typically appear bolder and stronger to the 
eye than serif fonts. You can also use a special font that suggests a 
theme-for example, a stencil font for military use or a varsity font for a 
college alumni logo. Even the Optical Character Recognition font used 
for computer scanning can work well as a logo font for a computer firm. 

• Symbols. Some of the best fonts I've ever used for creating objects in 
Pixel 3D don't even include characters from the alphabet! They are 
symbol fonts, such as Wingdings and Dingbats, or specialized character 
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fonts such as PC Keys (which resemble the keys on a keyboard). These 
symbol fonts are great time-savers-after all, would you rather assemble 
a 30 model of a telephone icon by hand or press a single key in a symbol 
font? Generally, you can simply extrude a symbol character to give it 
depth. "Extrusion" is a rendering term for extending the back of a primi
tive to enhance the illusion of depth. Figure 6-10 shows a good example 
of extruded text. 

Figure 6-10: By using extrusion, these cl111rncters suddenly seem huge! 

Selecting Angle 

Once again, we'll dip slightly into graphic design to discuss proportion and 
angle as they relate to rendered objects. Most rendering programs allow you to 
set any viewing angle between your 30 model and the camera, which enables 
you to create impressive effects with proportion easily. Remember the grid 
that Pixel 30 uses as a floor for objects? One of the reasons that it's there is to 
help you determine proportion; however, proportion typically isn't as impor
tant when you're creating frames for an animated GIF, since you'll usually 
have only one object with no background. Proportion brings more of a sense 
of realism to an entire scene. 
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What's more important for us in creating animation frames is the viewing 
angle. For example, in Figure 6-11, we're viewing this rendering from the left, 
and the text is almost parallel to the direction of the camera. If you're as big a 
fan of the classic British TV series Monty Python's Flying Circus as I am, you'll 
recognize this camera angle as the "Mighty Stone Letter Effect"! It is one of my 
favorite effects for static Web page titles, but as you can imagine, it's not quite 
as effective for animation-the title is so long that moving this entire image 
smoothly in any c;lirection will involve a large number of frames and a huge 
movement cycle. 

Figure 6-11: A gorgeous visual effect, but don 't try to animate this image! 

Generally, the most popular camera angle for 30 GIF animation is a cen
tered camera pointed directly at the object. From time to time, I'll vary this 
angle by moving the camera slightly to the left or right for an entire animation. 
This way, I can display more of the extrusion, which can include some very 
interesting detail if your object has a jagged edge. However, the farther you 
arrange your camera angle to the side, the harder it will be to distinguish 
details at the "other end" of your model. Remember, the movement cycle is 
usually a function of the object, so your camera will be stationary. A motion
less camera lends stability to your finished animation, instead of the camera 

I 
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moving around a moving object. I know it's a temptation for experienced 
artists to render entire scenes with a moving camera, but imagine George 
Lucas re-creating Star Wars in a 40K GIF file, and you can appreciate the sim
plicity of a motionless camera! 

However, proportion also comes into play if you have more than one ren
dered object in your animated GIF-not something that happens often, but I 
have seen effective GIF animation in which one shape rotates around another 
(much like an electron around a proton). If they don't have visual cues, those 
people viewing your GIF animation are likely to become confused as to which 
object is in the foreground or which object is larger. Again, this problem crops 
up when your camera is shooting from an extreme angle. Probably the best way 
to counteract this problem is to use the familiar centered camera pointed directly 
between the objects. Your eyes naturally provide proportion at this angle. 

Selecting a Realism Level 

Often, the only way to find the proper combination of font, proportion, lighting, 
and texture for a 3D object is through experimentation. Unfortunately, each ex
perimental rendering you run can take several minutes if you use the highest 
realism level available. On slower machines, you could be waiting half an hour 
for a full scene I Fortunately, all rendering programs have different levels of real
ism, and the lower the level, the shorter the rendering time. For example, Pixel 
30 has three different levels of realism: Flat shading, Gouraud shading, and 
Phong shading, in order of increasing realism. 

For your finished work, you'll almost certainly want to invest the time to use 
Phong shading. But for experimenting with lighting, proportion, font, and tex
ture, I strongly recommend that you use one of the lower levels of realism. For 
example, I use Gouraud shading when I'm building an image; it takes half as 
much time (or less) to render. If you like, you can also speed the process by 
turning off anti-aliasing until you're ready to create the final image. 

Selecting Lighting 

Ahh, lighting ... if Mozart had been as passionate about 30 rendering as he 
was about music, he would have found his greatest joy in selecting lighting! 
As I said earlier, raytracing produces the best lighting effects; although it 
requires much more time for your computer to process an image, I definitely 
recommend that you use it if your rendering softvvare supports this feature. 
For example, look at the atmosphere created from these three different types of 
raytraced lighting: 
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• In Figure 6-12, which was taken from one of my personal Web sites, 
rendered text is highlighted with a bright backlight using a blue filter. In 
color, this effect produces an eerie blue glow from behind each charac
ter-unsettling, mysterious, and dark. 

Figure 6-12: An example of backlighting with a blue Jilter. 

• In Figure 6-13, we take a different approach. A gold metallic object is 
rendered with two small white spotlights at the left and right edges of 
the image. These raytraced spots bring out the detail at the same time 
they provide strong front lighting. Plus, your eye can distinguish be
tween the two light sources, so the image frame has extra realism and 
visual interest. The end result is a strong, vibrant image, perfect for use 
as a logo (except, of course, for the fact that no one uses 360K floppy 
disks anymore). 

Figure 6-13: Two spots in front really show off this gold texture. 

• Our final illustration, Figure 6-14, includes a shadow mask, which exactly 
corresponds to the cardboard masks that still photographers place in 
front of their spotlights to create shadow effects. This feature is harder to 
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find than simple spotlighting in less expensive rendering software, but as 
you can see it's well worth the search! This time, our ancient floppy disk 
object was shot with a bright top left spot through a lattice mask. 

Figure 6-14: A lattice mask on our spotlight adds a neat shadow to the image. 

i= urally, the shadow will not move even if the object moves, so you suddenly have 
ther opportunihj to animate another type of movement cycle! Simply turn your 

object the same amount for each frame image and put GIF Construction Set to work. 
Your final image will feature a rotating logo with an eye-catching, realistic shadow. 

As you can see, lighting can produce a seemingly infinite number of effects, 
but here are a few guidelines for using lighting on objects destined for GIF 
animation: 

• Use strong lighting. Dim lighting works great when you're rendering an 
entire scene or a light source is actually rendered within the image (for 
example, a lamp on a table). When you're rendering an object for use in 
animation, however, it has to stand out and be easy to see on its own, 
and often you won't know exactly whether you'll have a solid color or 
tiled image background on the finished page. In most cases, using strong 
lighting is best. You can always use multiple spots, as we did earlier in 
Figure 6-13, but their combined luminance must be enough. 

• Use colored filters. Talk about a neat effect! If your 30 object is made of 
shiny silver, don't just experiment with white spots; if your rendering 
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package supports them, try out a complementary colored filter such as 
red or blue. Unlike a white spot, a spot with a colored filter highlights 
with a mood! 

• Angled or head-on lighting? I always make this decision after I've 
completed the 30 model, since the correct choice depends on the model. 
As I mentioned earlier, if your object has a surface finish-for example, 
pits or ridges-angled lighting is important because you want to bring 
out as much of that surface detail as possible. The same holds true for 
some textures; for example, I think a wood texture looks better with 
angled lighting. 

However, if you'd like to light a wider object or logo uniformly, 
angled lighting won't do it; you need at least three light sources, placed 
at the two outside edges and one in the center. Figure 6-15 illustrates an 
object incorrectly lit by a single angled spot, and Figure 6-16 illustrates 
the same object lit by three light sources. You can tell that the logo lit by 
multiple spots looks better and will be easier to read no matter what 
motion cycle is used for your animation. Unfortunately, Pixel 30 doesn't 
support multiple light sources at this time, but you can still position your 
light at the center to cut down on the shadows. Sculpt 3D, however, does 
support multiple light sources. 

Figure 6-15: Incorrect lighting makes it hard to read this 30 object. 

Figure 6-16: The same object lit by three spots. 
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• Use static lighting. As you 'll learn later in this chapter, lighting your 
model correctly to bring out the detail in the final image is very impor
tant; however, avoid using "traveling" or "panning" light sources that 
move while creating frames for GIF animation. For full-screen Windows 
AVI (short for Audio Video Interleave) or AutoCAD FLI animation against 
a background that serves to anchor it, traveling lights can add incredible 
realism to an entire scene. For example, a spaceship can fly past a comet 
or a sun, and you' ll see the play of shadows and light along the surface 
of the hull. For an animated GIF without a background, though, this 
effect can be quite disorienting, and it tends to make the motion of your 
final anima ted -image seem choppy or unnatural. 

Me and My Shadow 

The correct use of static lighting can also create realistic, moving shadows that 
look great on a Web page with a white background! 

For this trick, you' ll need to select a pure white background for your 30 model. 
Position your virtual lights either in front or above the model-at the top of its 
arc of motion-so that the shadows will fall behind or directly under it. Then 
roughly crop the image frames to encompass the range of the shadow's move
ment through the cycle. When you generate the animated GIF, be sure transpar
ency is turned off; this ensures that the shadow will be visible. The animation's 
white background will blend seamlessly with the white background of the page. 

For a border that looks good with a white inset, consider a TV set clip art 
border. Use your image editor to paste each frame of the animation into the 
center of tpe TV border, and voila-you've got an animated television I 

Selecting Texture 

Avoid the use of complex textures and surfaces when rendering frames for 
animated GIFs. Believe me, I know how tempting it is to dive into an entire 
CD-ROM's worth of exotic textures and find that exact pattern that you've 
been dreaming about. My rendering dreams revolve around complex textures 
like mosaic tile and stained glass, but at other times, nothing works better than 
brass or airplane aluminum. 

Remember, though, that your final animation will use no more than 256 
colors. So a Grecian Marble texture that looks so good in your rendering 
program at 16 million colors might not measure up in 256 colors. I generally 
use simple shiny surfaces such as brass, silver, or gold and simple natural 
textures such as wood for objects I know are destined to become animated 
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GIFs. If you have the time, try generating single animation frames using 
different surface textures and reduce them to 256 colors to see which looks 
best at a reduced color depth. For example, if you're creating a logo for a bank, 
you can certainly use marble, but avoid a texture with heavy striations or 
flecks of color. For an animated GIF of an inch square, texture details like these 
are going to be too small to notice, but they will take longer to render. 

Although you can wait until the object has been rendered before you choose 
between angled and direct lighting, you must decide on any texture you use 
before you finalize the frames for your animation. If you've already designed 
your graphic-as we did in the first two chapters-you already know what 
color you'll be using for your background. A black logo spinning on a black 
background will do nothing for your rendering reputation, but a reflective 
copper logo lit by several spots spinning on that same black background may 
just get you a favorable mention at the next board meeting! 

iii-+ 

Most rendering programs allow you to use a default background of solid white or 
solid black, which usually means that you needn't worry about adding transpar
ency if you'll be using the same color background for your Web page. For example, 
if you're creating a Web page with a white background, and you're using a white 
background for rendering, creating your image frames for animation is typically as 
easy as resampling each image frame down to the proper size-no transparenC1J or 
image editing required. Any shadows you've created immediately around your 
object are captured intact by this process, lending a true photorealistic qualihJ to 
your animated GIF! 

If your rendering program doesn' t come equipped with a large number of 
textures, you can usually import simple bitmaps and store them as textures. 
This includes those GIF and JPEG background tiles you've been collecting 
while surfing the Web! Another great source of textures is your own photo
graphs, which you can scan and save as bitmaps. My collection of textures for 
TrueSpace, my favorite rendering program, is now so large I've recorded it 
onto a CD-ROM. 

Creating a 30 Logo With Pixel 30 

Time to get our hands dirty! In this section, we'll use the Windows shareware 
rendering program Pixel 30 to create a logo for GIF animation. Much like GIF 
Construction Set, Pixel 30 includes a Wizard. In this case, the Wizard helps 
automate the entire procedure of creating a font using characters from any 
font on your computer. 
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Note: If you' re using a Macintosh, you may wish to skip to the section titled 
"Rendering With Sculpt 30 ." 

To run the Logo Wizard from within Pixel 30 , follow these steps: 

1. Pull down the File menu and select the Logo Wizard ... command. The 
program displays the Build Text dialog box, as shown in Figure 6-17. 
Before the rest of the Logo Wizard can run, we need to specify our font 
and build the 30 model within Pixel 30 . 

Figure 6-17: The Build Text dialog box. 

2. Typically, you'll select the Installed Screen Font, which allows you to 
select from any TrueType font on your computer. Next, enter the text for 
your logo in the Text field. For our example, enter your first name. 

3. Click the Specify Font ... button to display the Font dialog box shown 
in Figure 6-18. For our example, select a strong, distinctive font
Braggadocio-with a regular style and a size of 20. Click OK to continue. 

Font '1 El 

ltaic: 
-I Bold 

Bold llaic 

Figure 6-18: Selecting the font we'll use for our 30 model. 
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4. Click the Build button to create your basic 30 model. Pixel 30 takes a 
second to calculate the outlines of your font, and then you'll see the 
model displayed on the grid, as shown in Figure 6-19. 

Figure 6-19: Pixel 30 displays your logo model. 

5. If you like, you could stop here and handle everything else manually, but 
I prefer to automate the remainder of the process (we'll do it manually in 
the next section). Click Yes to indicate that you do wish to use the Wizard 
to complete the logo. 

6. The Build Logo dialog shown in Figure 6-20 appears; I make the majority 
of my adjustments to the logo here. We'll start with the Extrusion option. 
As I said earlier in this chapter, extrusion looks great with text and logo 
objects, so select the Medium Extrusion option. 
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Figure 6-20: Tlte Logo Wizard displays the Build Logo d_ialog box. 

7. Select a bevel type and size for the edge of each character. Generally 
speaking, I use a flat, small bevel so that each character has a large face
this helps to maximize the appearance of the texture and makes the 
character more readable. 

8. Select a color by clicking the Specify Color button. You'll see in the next 
step that most of the surface textures offered by the Logo Wizard include 
the color you select here. The Logo Wizard displays a standard palette; 
for this example, pick neon green from the palette. 

9. Select the surface type. As you can tell from the variety of choices, you 
can pick a combination of three textures or a single texture for all sur
faces. If you pick a combination surface type, the firs t texture listed 
appears on the face of the letters, and the other two appear on the bevel 
and extruded surfaces. If you pick a single texture, that texture appears 
in the color you've selected across the entire model. For this example, 
pick a favorite combination of mine: Marble, Gold, Marble. Finally, click 
Build to confirm your selections. 

As you can see in Figure 6-21, the Logo Wizard has finished its job and 
handed control back to Pixel 30, and the extrusions and bevels have 
been added to your model. 
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Figlire 6-21: Tile model for your 3D logo is automatically generated in Pixel 3D. 

10. Now a ll that remains is to actually render the image. First, however, let's 
make sure that the most important rendering options are correctly set for 
the best results. Under the Draw menu, select the Anti-Aliasing item and 
then pick Medium Anti-Aliasing from the submenu (this level will take 
significantly less time than the highest level). Next, under the Draw 
menu, select the Light Position item and then select Center from the 
submenu. Last, enable Threshold Smoothing under the Draw menu. 

11. Let's do it! Under the Draw menu, select Phong Rendering-the highest 
level of realism-and sit back and enjoy! Pixel 3D will display the status 
of the rendering process in the status line at the bottom of the window. 
Your logo is divided into a number of "strips," and the rendering is 
performed in passes- this makes the procedure easier for the program to 
handle. The current strip number and the current pass are shown on the 
s tatus line, as well as the elapsed time so far. Figure 6-22 shows the 
rendering of my example logo in progress. 
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Figure 6-22: Pixel 3D cn11ght in the net of rendering a text logo! 

12. Once the rendering has finished-as illustrated in Figure 6-23-the 
message displayed in the status bar at the bottom of the window reads 
"Move Camera (TARGETED)", which means that you can now move 
your camera angle by clicking and dragging the 30 model. Alternatively, 
you can select Save As from the File menu to save this firs t rendered 
version of your logo. We're going to have a little more fun, so don't save 
your image yet! 
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Figure 6-23: Our initial rendering is complete. 

Before we continue, I suggest you pull down the Draw menu and select Gouraud 
shading-a lower level of realism-which will allow your computer to redraw the 
object much faster. You need to take the time with Phong Rendering only when 
you're sure that even;thing's perfect and you want to perform a final rendering. 

13. Position your mouse cursor over the center of your model, click, and 
move the mouse slowly to the right. Pixel 30 temporarily changes the 
image to a wireframe rectangle so that you can smoothly rotate the 
model, zoom in, or zoom out. After you release the button, the program 
will redraw your model, as shown in Figure 6-24. 
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Figure 6-24: The 3D logo example rotated to the right. 

14. To save a finished frame for animation, select Save As from the File menu 
to display the Save dialog box you see in Figure 6-25. Since you'll typi
cally be rendering a single object for GIF animation, the defaults of All 
Objects and Single File Save will usually be correct. Select a Save Format 
of JPEG Image, and click OK to save the frame. 

S-F-.t ffiiiijiMjimiijj~~~:!J:J ; '-......,OK___, 
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Figure 6-25: The Pixel 3D Save dialog box. 

That's all there is to it! The Logo Wizard and the simplicity of Pixel 30 
really do make the process much easier. 



~ 

218 OFFICIAL NETSCAPE GUIDE TD WEB ANIMATION 

Creating Multiple Animation Frames 

"But how do I take multiple images for my animation?" Most logo animation 
involves the object spinning around, and we already started the process with 
step 13 in the preceding section. Every rendering program I've ever used 
included some method of indicating the amount of rotation you apply to your 
model; some programs even feature separate controls to allow precise mea
surement. Pixel 30 provides three measurements at the right corner of the 
status bar marked X, Y, and Z. In order, these three figures represent the hori
zontal axis, the vertical axis, and the forward axis (which you might term 
"zoom in" and "zoom out"). You can use these measurements to move or 
rotate your image in equal amounts between each rendering, and then each 
rendering will be saved to a disk as a separate image. 

You may be wondering how you can rotate your model in exact increments 
along the X or Y axis. If you've tried moving your mouse, you've probably 
noticed that Pixel 30 initially allows you to move in any direction. Of course, 
we'd rather "lock down" the object so that it can only be moved in the desired 
direction. To do so, select the Axes item from the Options menu to display the 
Specify Axes dialog box, as shown in Figure 6-26. 

!Jpcc1fy Axes EJ 

r.1j X-HorilcrialAiit Movllg 
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P' Y.f'll:llA>ia Rotating 

P' Z.fln.Alil Rotating 
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~ Y"'...Uluil5coq 

P' Z.fonMldA>il So.Ing 

Figure 6-26: The Pixel 30 Specify Axes dialog box. 

Each of these check boxes controls whether your model can be moved along 
the corresponding axis. For example, if you wish for your model to rotate only 
around the center X axis, you would disable the Y and Z controls to restrict 
movement or rotation in those directions. 
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Depending on which rendering program you use, you may have more 
features to aid you in rotating or moving your model, but the creation of 
multiple animation frames remains the same: move your model a predeter
mined distance, render, save to a disk, and then move it again. 

Loading External Objects 

Another feature of most rendering programs is a wide range of rendering and 
wireframe file types that you can import as 3D models, including AutoCAD 
.DXF files, VistaPro .DEM files, and even encapsulated PostScrip t .EPS files. 

But what if you don' t have a wireframe version of your object especially 
made for rendering? You can always create sophisticated objects by combining 
primitives, but Pixel 3D offers a truly neat method of importing straight 
bitmap image files and automatically tracing them to create a basic 3D copy of 
the image. That's right-you can take 2D bitmap images that you've created in 
other programs and load them into Pixel 3D to build frames for GIF anima
tion, complete with the original colors! Life is good! 

As an example of how to perform this process, let's take the clip art image 
of the smiling woman that we used in the preceding chapter and make her 
into a spiffy 3D object for a magazine Web site, just as you might do with any 
2D drawing: 

l. Pull down the File menu and select the Open command to load your 
bitmap file. If you've forgotten what our image looked like from the 
preceding chapter, she appears again in her original bitmap form in 
Figure 6-27. 

Figure 6-27: A familiar bitmap portrait, ready to be made into a 30 object. 
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Can I Use Any Bitmap Image? 

Figure 6-27 has a number of characteristics that make it a good choice for trac
ing. In fact, they're the same characteristics you used to look for as a kid when 
searching for a picture to trace: 

• A bold, black outline. A tiny, detailed multicolor border isn't going to 
trace well. Look for well-defined edges in a solid black or dark color. 

• A solid, simple color scheme. Again, too much color will "confuse" the 
tracing algorithm, so fill your images with a solid color. If you're filling 
more than one portion of the image, use one or two colors, and the larger 
the area, the better. 

• A simple subject. This tool is not the one to use to render an image by 
Escher I 

Since most simple objects and logos that you'll want to animate for a Web 
page already fit this description, you're probably still happy. However, if you 
have an image that needs to be simplified in order to trace better, fire up your 
image editor and reduce some of the detail. 

2. Pixel 3D displays the Select Bitmap Background Color dialog box, as 
shown in Figure 6-28. In this dialog box, you can select the color that will 
be treated as the background in the image. The background will not be 
rendered because generally the background for a converted image is a 
square or rectangle that surrounds the actual image. Typically, Pixel 3D 
will select the correct background color by default (which it did for this 
image), but just in case you'd like to select another color, the program 
displays the number of pixels of that color that appear in the image. 
After you've selected the color, click Convert. 

PIXEL COUNT • 9m 

PIXEL COUtlT • 62 

PIXEL COUNT • 18283 

PIXEL COUNT • 17257 

PIXEL COUNT• 13167 

Figure 6-28: Since the bitmap background is not rendered, you can select the background color. 
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3. Next, you'll see the Smooth Converted Bitmap Object dialog box, as 
shown in Figure 6-29. From this dialog box, you can remove details and 
segments from your image; this can both help speed up the rendering 
process and create a "cleaner," more stylized 3D object. Once again, I've 
always used the default values that Pixel 30 selects here--we don't want 
to remove detail within our animation frames. However, I did enable the 
Spline Fitting option to make sure that the areas where separate splines 
join together are handled correctly. If you haven't heard the term before, 
a "spline" is an individual section of the image with at least one edge 
that meets another section. Click Smooth to continue. 

Fig11re 6-29: You can remove unnecessary detail from your image to smooth it. 

4. As you can see in Figure 6-30, Pixel 3D has drawn the outline of our 30 
object, and you're asked whether you'd like to continue by using the 
Logo Wizard. If you do, simply follow the instructions in the preceding 
section starting with step 5. Since we used the Wizard last time, let's do it 
manually this time. Click No. 
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Figure 6-30: Our bitmap has been converted to a basic, flat 3D model. 

5. Time to add extrusion to our model to enhance the 30 depth of the 
object. Select Extrude from the Modify menu to display the Extrude 
Polygons dialog box shown in Figure 6-31. For most objects, you'll keep 
the default values, but you can extend the extrusion if you like. For this 
example, let's experiment! The value is in pixels, so type 75 into the 
Extrude Distance field and click Extrude. The results of the extrusion on 
our 30 object are shown in Figure 6-32. As you can see, the object now 
has a real appearance of depth. If you want to extrude an entire object, 
select All Polygons as we did here; to extrude only the selected portion of 
your object, choose Selected Polygons. 

iii-+ 

The Static vs. Interactive option does not affect the image. 
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Figure 6-31: Adding extrusion to our 30 object. 
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Figure 6-32: Tile completed extrusion as seen in wireframe mode. 

6. Our next step is to add a bevel. It isn't a necessity, but I personally think 
that a 3D logo looks better with a beveled face. Select Bevel from the 
Modify menu to display the Bevel Polygons dialog box shown in Figure 
6-33. Again, the defaults will work fine for almost any object, so click 
Bevel to continue. 
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Figure 6-33: Adding a bevel to our 30 object. 

7. Since Pixel 3D's sketch function includes the colors of the original image 
as part of the object, you'll rarely have to select a different texture for 
your completed image-it's already in full color! Just to illustrate the 
wonderful effect of depth provided by the extrusion and beveling, how
ever, let's tum our smiling woman slightly so that you can see her from 
the side. Position your mouse cursor over the center of your model, click, 
and move the mouse slowly to the right to smoothly rotate the model. 

8. Just in case, check to make sure you've selected Medium Anti-Aliasing 
and enabled Threshold Smoothing under the Draw menu. Now you' re 
ready for your final rendering. From the Draw menu, select Phong 
Rendering and watch! Figure 6-34 shows a side view of our finished 
logo, which started as a bitmap image. Any company would be proud to 
display a spinning animated image of this quality on its Web site! 

Now you're ready to render as many frames as you need for your anima
tion; remember to turn the object in equal increments for each new frame if 
you're spinning it. 
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Figure 6-34: Our final product, created from a bitmap image. 

Of course, we didn't even touch a number of other features within Pixel 3D, 
but as you can see now, you don't need a degree in rocket science to build 
your own 3D images, and you don't need an incredibly expensive graphics 
workstation either! Today's entry-level rendering software like Pixel 3D is 
designed to be easy-to-use for today's home and office computers. Little or no 
knowledge of complex mathematics or previous computer-aided drafting 
experience is required. 

Rendering With Sculpt 30 

One of the best-known rendering programs for the Macintosh, Byte by Byte's 
Sculpt 3D, is a professionaJ rendering package that provides many more 
features than Pixel 3D. It costs considerably more as well. If you're not run
ning a PowerPC, Sculpt 3D requires a floating-point unit, and it also requires a 
minimum of 16 megabytes of RAM. Your Mac must be running System 7.1 or 
higher to use Sculpt 3D. 
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Sculpt 30 can create 30 terrain as well as text, but the real star of the show 
is its powerful animation features. Most people use this animation support for 
creating QuickTrme digital video, but the program can generate numbered 
frames for GIF animation as well. Images can be exported as PICT, TIF, 
QuickTrme, or several different 30 rendering file formats. 

Like Pixel 3D, Sculpt 30 includes Phong shading, extrusion, and bevels, but 
it also offers a full raytracing mode, with five levels of anti-aliasing. An unlim
ited number of lights can be used in a project, each with its own color. In fact, 
the program even features a virtual "Exposure Meter," just like a film photog
rapher uses! As you might expect from a professional rendering package, you 
can choose from a huge range of textures, as well as several surface effects and 
sky generation. Objects can be cut and pasted together to form linked hierar
chies. For example, an arm may consist of a hand linked to a forearm linked to 
an elbow, which is in turn linked to an upper arm. Whenever that arm moves, 
all the linked objects move with it, unless they are given a specific movement 
path as well. 

If you can afford it, this sort of power can produce incredible results. Plus, 
with the ability to generate the frames required for GIF animation automatically, 
you'll save yourself quite a bit of time that you would have spent moving an 
object by hand in Pixel 30 and saving each frame separately! 

In Sculpt 3D, you first build your model, set up your lights, and then you 
add surface color and texture in a separate step. If you haven't already in
stalled Sculpt 3D from the Companion CD-ROM, take a few minutes and do 
so now. Then double-dick the Sculpt 3D application icon to run the program. 

To render a 30 object, follow these steps: 

1. Pull down the File menu and select New Scene. The program interface 
appears, as shown in Figure 6-35. Notice that Sculpt 3D uses multiple 
windows to allow you to view your object from more than one angle at a 
time; if you're familiar with most computer-aided drafting (usually 
shortened to CAD) applications, they typically display an object this way 
as well. Sculpt 30 calls this a Tri-View window interface. On the left side 
of the screen, you'll see a familiar Tool Palette that contains all the selec
tion and drawing commands available in the program. 
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Figure 6-35: The Sculpt 3D interface, showing its multiple windows. 

2. Click on the Block icon on the Tool Palette to select the Block tool. Click 
your mouse cursor in the middle of the North view window, and drag to 
create the object. In the 30 world, you're looking "down" on the object. 
After you've created a rough block of about two inches on a side, release 
the mouse button. 

3. Add lighting. Select the Vertex pointer icon on the Tool Palette (it looks 
like a mouse cursor without a tail), and click in the North view to set a 
location near the object. Next, click in the West view to set a location 
close to the object from the side. The combination of these two points 
yields a three-dimensional location near our object. By default, Sculpt 30 
will automatically add a blue sky. 

4. Select Add from the Objects menu, and select Lamp from the submenu. 
The lamp object will appear, and you can move it with your vertex pointer. 

5. Time to add a color to our object! Select the Object pointer icon on the 
Tool Palette (it looks like a regular mouse cursor), and click the block 
object to select it. From the Render menu, select Apply Color & Texture 
to display the Color, Texture and Surface dialog box, as shown in Figure 
6-36. The fields on the right side of the dialog apply to the selected object, 
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so we'll use them. Click the Color square at the top right side of the 
dialog box to select a color for your block from a standard color palette. 
Click OK to accept the color and return to the Color, Texture and Surface 
dialog, where you'll see your selected color displayed. 

Select Oeselect Objects Scene Animate 

Untltled:Down 

Color TeHture and Surfoce 

Defoult Sllected faces 

D 0topy 0 
I Dull I 
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Number or selected fates: 

Figure 6-36: The Color Texture and Surface dialog box. 

6. We also need to add a surface texture-how about a metallic look? Click 
the Texture drop-down list at the middle right side of the dialog box to 
select a texture. Click metallic to select it, and click OK to return to the 
main interface. 

7. One final step before we render: a powerful package like Sculpt 3D will 
provide you with a number of settings that will control the final quality 
of the rendering. To display these settings, select Image Settings from the 
Render menu to display the dialog box shown in Figure 6-37. Make sure 
that you've selected Shaded as your Image Type, and set Anti-alias to 
Low. Click Set to return. 
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Image type Image Settings 
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Figure 6-37: The Image Settings dialog box. 

On the right side of the Image Settings dialog box, you'll see a number of fields that 
can greatly increase the realism of your scenes. For example, Sculpt 30 can gener
ate correct shadows and reflections because it supports true raytracing, as I dis
cussed earlier. However, don't enable these check boxes unless you have hours to 
spend because they'll take considerable time (even on the fastest Power PC Macs)! 
Of course, the image size you select on this dialog box also helps determine how 
long your rendering will take; the larger the image, the more time it will take to 
produce. Also, note that the demonstration version of Sculpt 30 included on the 
Companion CD-ROM cannot render an image larger than 640 x 480 pixels. 

8. Let's rock! From the Render menu, select Render Image. A standard 
Macintosh file save dialog box will appear so that you can name the 
image. Sculpt 30 will display a small dialog box with a progress bar and 
a thumbnail displaying the image as it's created. Once the rendering has 
completed, the program will display the full-size image. 

Let's draw this discussion of rendering to a close with a section on other 
rendering packages available these days. 
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r· 1 Other 30 Rendering Tools 

\ .s 

Welcome to Rendering Central! I'd like to introduce you to three other render
ing programs that can produce frames for GIF animation. One of these pro
grams will cost you several hundred dollars, but I've included it because-like 
Sculpt 30-it's much more powerful than its shareware counterparts. I'll also 
discuss a freeware rendering package for Macintosh and Wmdows that is 
probably one of the most powerful rendering programs currently available for 
standard Windows and MacOS. 

Each of these applications offers something that stands out from the others, 
so if you're especially interested in a particular feature, you may want to 
install the program and try it out for yourself. 

Font F/X (Windows 95) 

Font F /X from DCSI is another shareware package, and it's very similar in 
output to Pixel 30. Its primary job is the creation of 30 font images. The pro
gram runs under Windows 95. 

However, as you can see from Figure 6-38, Font F /X sports a much more 
integrated interface, more akin to Sculpt 30. Everything is available from the 
design screen, including the positioning of multiple light sources and the 
camera lens controls, which Pixel 30 doesn't offer. Textures and colors are 
displayed onscreen for your selection, too, so you can experiment more easily 
with different texture settings for your text. Font F /X comes with a much 
wider variety of textures, too. Although Font F /X doesn't include a Wizard, 
the creation of a new font model is very simple, and-as you can see in Figure 
6-39-selecting characteristics for your completed model is all handled 
through a set of simple tabbed dialog boxes. 

Font F /X can export both bitmap and GIF format files, with or without 
transparency, at up to 24-bit color . 
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Figure 6-38: The Font FIX main window. 
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Figure 6-39: Creating a 3D font object in Font F(X. 
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Unlike Pixel 30, Font F /X doesn't support any of the popular 30 rendering 
file formats, so you can't import 30 models you've created in other programs, 
and no auto-sketch function is available. Font F /X also doesn't perform anti
aliasing. Personally, I prefer Pixel 30, which offers a much larger workspace 
for your 30 model and saves you a great amount of scrolling. Font F /X uses a 
less complex rendering engine and therefore takes less time to create image 
files-but they're nowhere near the quality of the Phong rendering you can 
perform with Pixel 30. 

trueSpace (Windows 95) 

Caligari's trueSpace is probably the most popular and most powerful Wm
dows 95 commercial rendering program for under $1000, and judging from 
the animated images on their Web site, they've already recognized the value of 
30 GIF animation! I've been using trueSpace since version 1, when I was first 
attracted to the program by its easy-to-use, easy-to-understand 30 object view 
(a view that is actually similar to the large main window and its grid floor in 
Pixel 30). In trueSpace, you modify the surface of your model by clicking and 
dragging the wireframe in the desired direction. 

As you can tell in Figure 6-40, the trueSpace 30 view is familiar, but its 
menu system and interface are radical indeed! By default, both the complex
looking toolbox and the small menu system appear at the bottom of the 
screen, and many of the buttons on the toolbox tend to explode into additional 
Photoshop-style panes with more options when you click them. You can also 
see some of the extensive selection of textures available in the figure, as well as 
the selection of primitives at the bottom left. Finally, check out the giant walk
ing robot; the smaller screen is a second camera view that you can manipulate 
separately. 
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Just like Sculpt 3D, trueSpace is fully capable of producing television qual
ity animation, and it can automatically export slides for your GIF animation. 
The program also has full support for font objects, with beveling and extrusion 
similar to Pixel 3D, so it can produce logos and rendered text. trueSpace is 
capable of both Phong rendering and true raytracing. Unlike other packages, 
trueSpace supports Adobe Photoshop plug-ins, so you can render some effects 
directly. trueSpace also recognizes an impressive number of 3D object formats, 
and you can save images in bitmap or TGA format. 

Although Pixel 3D provides a great subset of rendering features especially 
suited to animated GIFs, trueSpace is a complete 3D modeling environment! If 
you need more horsepower and additional features, and you don't mind 
spending a few hundred dollars more, I can heartily recommend trueSpace! 

Persistence of Vision (Macintosh/Windows) 

Our last rendering program is not only powerful, it's free-and it's available for 
Macintosh, Windows, UNIX, and yes, even DOS! The Persistence Of Vision pro
gram (popularly known as POV or POV-Ray) has been around now for several 
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years; it's a group project, and the source code is freely available to anyone for 
the downloading. The official distribution Web site (www.povray.org) is well
designed and a pleasure to visit, as you can see in Figure 6-41. 

Figure 6-41: The official POV Web site, showing a typical image created with POV 

However, unlike any other rendering software I've mentioned, POV does 
not use 30 models, nor can you modify them within the program! Instead, 
you'll have to use one of the many shareware modeling programs that have 
been written to act as design "front ends" for POV. POV simply provides the 
rendering and raytracing engine, and you provide the program with a text 
"script" file written in the POV language that tells it what to do and which 
files to use for input. 

In fact, even the latest 3.0 version of POV still doesn't feature a fancy 
graphical interface-and this complexity has both a good and a bad side. Take 
my word for it, this program is nowhere near as easy as Pixel 30; you' re not 
going to p roduce anything but the sample images for the first several times 
you run the program. However, if you take the time to master POV, you can 
produce images that can put even trueSpace to shame! You'll have to learn the 
POV language-but once you're done, you 'll have a tremendous grasp of how 
rendering works and what effects you can produce. 
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Is POV really suitable for quickly producing image frames for GIF anima
tion? The latest version of POV does include support for multiple frame out
put, so it has suddenly become a real possibility for creating GIF animation. 
Until you're really good with this package, however, you won't be able to turn 
out a rendered object as quickly as Pixel 3D, and POV has no support for 
tracing a bitmap image. 

My recommendation is to try POV-after all, it's the best rendering soft
ware available that's completely free! If you're daunted by the excellent 
manual rather than intrigued, put it aside and return to shareware and com
mercial rendering programs ... but you may find yourself addicted to POV, or 
perhaps using it as your rendering engine of choice for future projects. 

Moving On 

In this chapter, I showed you how to create 3D frames for use in your ani
mated GIFs! First, we discussed how you can choose the right options for your 
3D model, including tips for selecting texture, lighting, and fonts. We used the 
fine shareware program Pixel 3D to build a 3D object, and we even created a 
3D object from a simple bitmap image. We rendered a basic 3D object using 
the Macintosh program Sculpt 3D. Finally, you learned more about some of the 
other freeware, shareware, and commercial rendering programs available today. 

In Chapter 7, you'll learn more about the sophisticated technique that 
Hollywood calls morphing, and we'll produce yet another type of advanced 
animated GIF! 
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CHAPTER 7 

Creating 
Morphing 
Web Graphics 

In the last chapter, you learned how to animate images in three dimensions. 
Just like the special effects wizards in Hollywood, you can now create convinc
ing images of objects that have never actually existed and make them move. You 
can now populate your Web page with spinning text, floating logos, and even 
an occasional solar system, complete with fiery sun and orbiting planets! 

Now let's change direction and explore a new type of animation that has 
also been used to create special effects for films and television: morphologic 
transformation (or, if you want to lead a normal life, morphing). Using this 
relatively new technology, you'll be able to mutate one image or object into 
another on your Web page or manipulate objects like they were clay or putty. 
Morphing is another magical effect that will draw the eye to your page and 
your visitors to your message. 

We' ll begin this chapter with a quick discussion of two different varieties of 
morphing. I 'll explain the characteristics of a good image for morphing anima
tion. Then we'll take a look at two very different programs: HiJaak Morph, a 
good program for creating transitional morphing, and Power Goo, a very 
popular program that creates images through alteration morphing. Finally, 
we'll create both of these two different types of morph animation, step by step, 
so that you'll be able to choose the type that you prefer. Once you've had fun 
with these programs, you may find yourself recalling the days when alche
mists said they could change lead into gold-or, in this case, turn your boss 
into a Mercedes! 
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Morphing Explained 

Transitional morphing involves the transformation of one image (called the 
source image) into a completely different image (called the target image). 
You've seen this effect when a character seems to magically change its form 
into something else, like a cat changing into a dog. Transitional morphing is 
accomplished by identifying similar characteristics in both the "before" and 
"after" images-for example, outlining the eyes or noses of two faces. Your 
morphing application will use these common points and lines to "anchor" 
certain portions of the image together while all the other features of the two 
images are changing shape. 

In alteration morphing, you change features of a single object by pushing, 
pulling, or smearing the image; when you're finished, your object might look 
superficially like another object, but only one original source image is used. If 
you're experienced with the image effects available in Photoshop, you might 
consider this procedure just another image effect, but I prefer to consider it a 
morphing action because you usually have much more control over the 
changes you make to an image than you do with a simple filter, and you also 
have a wider variety of tools to produce movement effects. 

How can you use this technique for animating GIFs? By using the same 
technique we used in 3D animation: taking individual frame images at regular 
points during the movement cycle, which we can plug into GifBuilder or GIF 
Construction Set. In fact, transitional morphing also requires you to build a 
"wireframe" of sorts, just like the 3D models in the previous chapter, and 
you'll have to wait for your computer to process the images before viewing 
your morph animation. 

With alteration morphing, however, we're once again making manual 
changes to the image with a selection of tools. I think you'll find the process 
somewhat akin to shaping clay ... and, best of all, you can see the result of 
your changes immediately rather than having to wait for the animated image 
frames to be created! 

If all this seems a little confusing, let me reassure you that the programs 
you'll be using will take care of all of the sophisticated calculations necessary 
to build your animations-all you need to do is concentrate on the creative 
design. I'll discuss each type of morphing step by step later in this chapter;. 
first, though, let's discuss the guidelines for selecting images for morphing. 
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Selecting Images to Morph 

Just like the 3D animation we discussed in Chapter 6, morphing can produce 
outstanding effects that can add tremendous visual interest to your Web page; 
however, there are guidelines that you should follow to help ensure that your 
final GIF animation is as small as possible and animates smoothly. 

For example, in film and television morphing usually involves altering an 
object while keeping the background of the object intact so that it seems to 
transform only the object. Building a GIF animation from a morphing se
quence with a background is certainly possible, but once again we run into the 
same problem as we did in the previous chapter: the more background you 
include while creating your morphing sequence, the larger your animated GIF 
will be, and the longer it will take to load. This is especially true if your back
ground is heavily detailed or includes separate movement of its own. 

This is just one possible problem area. To avoid these pitfalls, I urge you to 
select source and target images with the following characteristics: 

• Use plain backgrounds. I prefer plain black or white backgrounds for 
my images but whatever color or level of detail you select, make sure 
that both images share the same color background or that the colors are 
as close as possible. Even the two images in Figures 7-1 and 7-2 have this 
problem; one has a green background of trees and bushes and the other 
has a blue sky background-and they're included with HiJaak Morph as 
samples! If necessary, your object can certainly change color, but your 
background should remain as stable as possible; this focuses attention on 
the morphing object and helps enhance the illusion that it, and not the 
entire scene, is changing. Also, if your images share the same back
ground, you should be able to compress the final GIF animation using 
GIF Construction Set's SuperCompress option. 

Figure 7-1: A sample source image with a green background. 
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Figure 7-2: A sample target image with a blue background. 

If you are forced to use two images that have different backgrounds, there are ways 
you can minimize the distraction of a changing background. One way is to crop as 
much of the background from the finished animation frames as possible. Alterna
tively, you can create new source and target images: crop just the objects out of the 
original images and paste them onto identical white, black, or single-color back
grounds using your image editor. 

• Include details. When it comes to morphing, the more detail the better! 
Greater detail in both the starting and ending image gives you addi
tional points to map, and the more points you map, the smoother and 
more realistic your morphing animation will be! No need to worry 
about what I mean by mapping points just yet-just remember that 
detail is your friend. 

• Limit colors. Although you can morph images with a 24-bit color depth, 
we've already mentioned that 256-color frames are better for GIF anima
tion. You should reduce both your source and target images to the same 
palette using the same standard colors to avoid palette changes and 
dithering during the morphing process or during the GIF animation 
process that will follow. 

• Use similar angles. Look again at the two cars in Figures 7-1 and 7-2; do 
you notice that they were photographed from similar angles and dis
tances? This similarity is no accident- for the best morphing results, 
your objects should be close to each other in orientation and size. If your 
source image is a woman's face, for example, don't try to morph her into 
a full-length target image of a woman standing up-unless, of course, 
you want the source's chin to morph into the target's feet! 
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In our upcoming example, I'll be using two women's faces-one looking straight 
into the camera, while the other is looking at the camera with her head tilted. This 
sort of slight change in orientation is OK. In fact, I like the slight illusion of move
ment you get in watching the morph, as the woman's head moves into a tilt. 

• Use large images. For most morphing software, the larger the source and 
target images, the easier it is to determine details, map points, and curves 
in both images. It's easy to resize or resample the finished image frames 
to a smaller size later, if necessary, using your image editing program. Of 
course, you're not going to want any GIF animation on your page that's 
640 x 480 but trying to map points and lines on images the size of thumb
nails is more trouble than resampling later. 

Now it's time to introduce you to HiJaak Morph, the tool I'll be using to 
demonstrate transitional morphing. 

Introducing HiJaak Morph 

My favorite program for transitional morphing under Windows 95 is HiJaak 
Morph from Quarterdeck. Although there are more complex and powerful 
morphing applications available, this program offers a good balance between 
ease-of-use and professional features, plus it allows you to generate a single 
frame anywhere in your morphing sequence, which makes it ideal for creating 
images for use in GIF animation. To cap it all off, the file save options in 
HiJaak Morph are practically designed for GIF animation, as you'll see in our 
tutorial, so the finished images require little conversion or editing. If you 're 
using a Macintosh, the most popular transitional morphing program is Elastic 
Reality from Avid Technology (www.avid.com). 

As you can see in Figure 7-3, the HiJaak Morph interface wastes no space. 
As a matter of fact, it's probably one of the smallest application windows I've 
ever seen! The only menu items required are the various file loading and 
saving commands and the online help system. 

The remainder of the commands are accessed through icon buttons so once 
you know your way around Morph, you can generate images quickly. Plus, if 
you leave your cursor over an icon button for a few seconds, the function of 
the button will be displayed in a tool tip-a feature that really helps to remind 
you what everything is until you' re experienced with the program. 



,.-.-._ 
242 OFFICIA L N E T SCA P E G UID E T O WEB ANIMATION 

Figure 7-3: The Hifaak Morph main window. 

At the top of the screen, you'll see two windows that will display thumb
nails of your source and target images, as well as fields where you can specify 
the total number of frames in your morph sequence. Remember, you can 
reduce the size of your finished GIF animation by reducing the number of 
frames, so I try to keep this number as low as possible without affecting the 
smoothness of the transition. 

I'll explain the other buttons and their functions while we create a transi
tional morphing animation. 

Creating Transitional Animation With HiJaak Morph 

In this tutorial, I'll turn a familiar face-the smiling woman we used in the last 
chapter-into another person! No, there's nothing up my sleeve; instead, I'll 
use HiJaak Morph to demonstrate this visual magic. 

To morph two images with HiJaak Morph, follow these steps: 

1. Open the File menu and select the Open Source item, or click within the 
empty square that holds the source thumbnail. From the File Open 
dialog, select your image and click OK. HiJaak Morph supports all of the 
common image file formats, so you probably won't need to convert your 
source and target images before you start. Once you've selected your 
source image, the program will display it in a thumbnail view at the top 
of the window. 

2. Now load the target image. Open the File menu and select the Open 
Target item or click within the empty square that holds the target thumb
nail. Figure 7-4 shows both of our images loaded within HiJaak Morph. 
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Figure 7-4: Our images are loaded. 

3. Next, display both of your images at their full size by clicking the thumb
nails. If you need to increase or reduce magnification within these working 
windows, select the Zoom command to display the Set Zooming Scales 
dialog, as shown in Figure 7-5. If your images are particularly small, you'll 
appreciate this feature because you'll be able to zoom into your graphics to 
pick out small details. To reduce the zoom factor, enter a number lower 
than the current value; to zoom in closer, add to the current value. 

Figure 7-5: You can set the zoom factor for your images from this dialog. 

4. The real fun begins! It's time to map the similar points and lines within our 
two images. Click the Toggle Preview button at the top right (the first in 
the Lines section of the HiJaak Morph main screen, shown in Figure 7-3) 
to toggle it on. Move your cursor to a portion of the source image that has 
a corresponding point in the target image as well; for example, if you're 
morphing a tomcat into a tiger, you could select the tip of the nose 
(which exists on both animals). It's also a good practice to "border" the 
object within both images with points, which helps create the smoothest 
possible morphing effect. For our women, we'll select the tip of the 
chin-this is a definite location you can easily find in both images. Once 
you 're positioned on similar points in both images, hold down the Shift 
key and click. 
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5. A green dot will appear on the source image. This is your first point, as 
shown in Figure 7-6. However, look at Figure 7-7: the same point in the 
target image is located on the woman's lower lip! We need to indicate to 
HiJaak Morph the correct point on the target's chin so that when the two 
images are merged, the program knows where the same spot is on the 
target image. To do this, move your cursor to the Target window on top 
of the green dot until it changes shape, then click and drag it to the 
corresponding spot (in this case, the tip of her chin). 

Figure 7-6: We've set our first point on the source image. 

x 

Figure 7-7: Tlie corresponding point must be 
moved to the same area on the target. 



~ 

Chapter 7: Creating Morphing Web Graphics 2 45 

6. Now we'll repeat Steps 4 and 5 a number of times, matching ear to ear, 
the same spots on the nose, the eyes, and any other features that the two 
images share. Remember, mark as much of the border of the object as 
possible (in this case, the face and hair). Each time you mark a point on 
the source image, don' t forget to drag the green point in the Target win
dow to the corresponding location! Once you've added a new point, all 
the older points will turn blue-you can always tell the current point 
you're working with because it will be green. If you need to delete a 
point, move your cursor over it, and press the Delete key. The more 
points you are able to match between images, the smoother and more 
professional your morphing will be. 

Important note: A corresponding portion of either image need not be visible to be 
marked with a point! For example, the upper left part of the face in our source 
image is hidden by hair, but we can still place a point there that corresponds with 
the same spot on the target's face. As long as you can safely estimate the proper 
position for a point, it will help your finished animation. 

7. You can also draw a line that follows a path between two points. For 
example, the mouths of both of these images are fairly straight, and be
cause I've placed points at both sides of the mouth, I can draw between 
them. To draw a line, position your cursor over an existing point, hold 
down the Ctrl key and click, then drag the line that appears to the ending 
point, and release the mouse button. Lines aren't required, but they do 
help outline major sections of both images that should move together. 

Whoops-Doorbell! 

Doesn't it always work that way? You sit down, ready to design the latest 
morphing frames for your new GIF animation, and you've only been working 5 
minutes or so when the doorbell rings and your friends show up to drag you to 
dinner! You can't say no-especially if they're paying-so how do you save all 
those points you've been plotting? 
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Don't panic! You can save all of your points and lines within a file and overlay 
them onto the same two images later. Typically, all of the lines and points taken 
together are called a mesh. Click the Save Lines button on the right side of the 
HiJaak Morph main screen which looks like an arrow pointing to a floppy disk, 
and save it to disk under a unique name. When you're ready to resume your 
work, load the same two images as source and target, then click on the Load 
Lines button, which looks like an arrow pointing away from the same disk. If 
you like, you can even experiment with multiple mesh files on the same two 
images to see which creates the better effect. 

8. Once you're done adding points, you 're ready to experiment with your 
firs t morphing animation. To be safe, save your mesh (the lines and 
points you've mapped) in case you need to load it later. Click the Save 
Lines button on the right side of the HiJaak Morph main screen (that 
looks like an arrow pointing to a floppy disk), and save it to disk under a 
unique name. You certainly don' t want to lose all that work! Our finished 
mesh for the source side of our morph looks like Figure 7-8. Now set the 
Number of images in morph field to at least 10; any less would result in a 
jerky, unrealistic animation, while a number much larger than 15 or 20 
will usually result in a final GIF animation that takes too long to load. 

• Sou1ce • •do: (lllll:tJ ~r-Jf:l' 

Figure 7-8: Our finished mesh of lines and points maps the 
face in this source image with the target image. 



~ 

Chapter 7: Creating Morphing Web Graphics 247 

9. Next, set the Number to begin with field to 1, and type a new name of 8 
characters or less into the Name field-for our example, we'll use the 
name SMILE. You'll also want to see the frames as they're generated, so 
click on the Create Images button at the bottom center of the window. 
The button will remain depressed to indicate that it's on. 

10. As I said before, HiJaak Morph conveniently saves each individual frame 
of your morph to disk; however, we have to set up this feature before 
you morph. First, click on the Create Files button at the bottom of the 
window to enable it; a small checkmark appears on the icon, and the 
button will remain depressed to indicate that it's on. Next, click on the 
Save Options button to display the dialog shown in Figure 7-9. We need 
to save our output as images, so select GIF files (*.GIF) in the Save To 
field, and- voila! 

Save Ophons ~ 

S-To 
OK 

~- 1 

,, 

Fig11re 7-9: The Hifaak Morph Save Options dialog. 

Now here's a great set of features for GIF animation; check out these 
save options: HiJaak Morph allows us to select an 8-bit color depth, 
which will produce the 256-color frames we like to use, and it will build 
images with a common palette. And we can even optimize the palette by 
selecting our own maximum number of colors. Let's save ourselves some 
work: under Bits Per Pixel, select the 8 bits option and enable the Make 
common palette check box. Finally, click on Browse to select the location 
where the image frames will be saved; don' t forget to select GIF files as 
the File type. Click OK when you're done to save your choices and return 
to the main window. 
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11. Next, click on the Output Options button to display the dialog shown in 
Figure 7-10. From here, we can determine the size of the output frames 
and their width-to-height proportion (or aspect ratio, as it's called in Paint 
Shop Pro); the default is generally as close to 320 x 200 as possible, and 
HiJaak Morph will keep the proportions of the source image. The Quality 
field is very important as well because it determines the speed of the 
morphing process and how good the quality of the final frames will be. I 
always use the Best setting and give the program the time it needs to do 
the job well! Finally, always enable the Interpolate option which provides 
anti-aliasing like our 3D applications used in the last chapter. Click OK 
when you're done to save your choices and return to the main window. 

Although you can select a larger size for your output images, I strongly recommend 
you allow Hifaak Morph to generate them at the 320 x 200 default. Why? As I 
mentioned in earlier chapters, the smaller your finished GIF animation, the Jaster it 
will load. I can't imagine anyone ever creating an animated GIF with a finished 
size of 640 x 480! In fact, you may decide to generate your images at a smaller size 
than the default if your object need only be an inch square on your Web page. 

Figure 7-10: The Hifaak Morph Output Options dialog. 

12. All that remains is to click Go on the main screen. HiJaak Morph will 
display each image in a window as soon as it has been processed, and it 
will also save the images to disk as we requested. Figures 7-11 and 7-12 
are two representative frames from the Smiling Ladies morph. 
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Figure 7-11: The source image has just begun to morph 
into the target. 

Figure 7-12: Another image from the morph, this time 
toward the end of the animation. 
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If At First .. . 

Don't be disappointed if your first morphing attempt with a new set of images 
doesn't work quite as you imagined! Here are the most common methods of 
improving your morph animation to produce the results you need: 
Alter the number of frames. I would recommend 20 as a maximum for the 
number of frames. However, if you reduce the size of your object, you can take 
the additional space you save and add extra frames. As a rule, your morph 
animation will always benefit from additional frames. 
Add lines or points to your mesh. The more detailed your mesh, the better 
the appearance of your final morph I I typically add anywhere from 40 to 100 
points to the source image, with lines added wherever possible. 
Increase the default quality setting. To save time, HiJaak Morph uses a 
default quality setting of Good-change this to Best to improve your animation. 
Use interpolation. Although Interpolation takes additional time, the anti
aliasing it provides will enhance the appearance of your animation. 

Change one or two of these settings to experiment and try again. It usually 
takes me two or three attempts before I end up with the right look. 

Personally, I enjoy both 3D rendering and morphing so much they've be
come hobbies on their own-no need to limit your creative urges to just Web 
animation frames! 

Next, we'll ruthlessly turn the most well-respected lady in the art world into 
a clown, using nothing more than the considerable power of Kai's Power Goo. 

c=J Introducing Kai's Power Goo 

Now here's a program that was designed for fun from the ground up! I use 
Kai's Power Goo by MetaCreations Corp. (formerly Meta Tools) exclusively for 
alteration morphing, and since its release I haven't yet had to turn to another 
program to produce frames for a funny morphing animated GIF. It's no sur
prise that this great program was an instant hit. 

Power Goo is available for both the Macintosh and Windows platforms, but 
it needs ample horsepower to run; a Power Macintosh running System 7.5 or a 
Pentium running Windows 95 is recommended, with 24-bit color and at least 8 
megabytes of RAM. 
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This program features one of the easiest interfaces I've ever seen: it's fast, 
simple enough for a child to use, allows complete control over your editing, 
and it's even attractive to the eye. Changes that you make to your image are 
automatically displayed in real-time, and you have a wide variety of different 
morphing and transforming tools that you can use to apply just about any 
movement cycle you like to a static image. 

Menus within the program are presented as a series of nesting screens: for 
example, Figure 7-13 shows the main menu, while Figure 7-14 shows the main 
viewing and editing screen. The two palette icons at the upper left display two 
different sets of image and transition tools, while sliders allow you to display 
the animation frame-by-frame at whatever speed you like. The words In and 
Out represent your import and export commands, respectively. 

Figure 7-13: The Kai's Power Goo main window. 



~ 

252 OFFICIAL NETSCAPE GUIDE TO WEB ANIMATION 

Figure 7-14: Monn Lisa, prepare to be morphed! 

At the bottom center of the screen, a filmstrip holds thumbnails of each 
image that you can add to movies you produce; we won't be using this func
tion, though, since we're going to save individual frame images as usual. 

Let's see what visual mischief we can perform with Power Goo! 

Creating Alteration Animation With 
Kai's Power Goo 

In this tutorial, we' ll use alteration morphing to turn the Grand Dame 
herself-the Mona Lisa, who automatically appears- into a smiling clown 
(among many other things), and then back to her original beautiful self. 
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Altering Your Image 

To morph an image with Kai's Power Goo, follow these steps: 

1. From the main map, click on the In Room to display the screen shown in 
Figure 7-15. If you ' re going to work with an image from your hard drive, 
click on Get Image from File (but notice that you can also import images 
from a digital camera or the Snappy video capture device, two pieces of 
hardware we discussed in Chapter 2). From the File Open dialog, select 
your image, and click OK. Once you 've selected your source image, the 
program will move to the Goo screen, as seen in Figure 7-16. If you don't 
select a source image, the program automatically displays an image of 
the Mona Lisa. 

If you're running a Macintosh, Power Goo imports PICT, Photoshop 3, TIF, and 
PhotoCD formats. If you're running under Windows, you can load BMP, TIF, 
PSD, and PhotoCD formats. 

Figure 7-15: The Power Goo In Room, where you can load images for morphing. 
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Figure 7-16: The Mona Lisa, ready to undergo plastic surgery with Power Goo! 

Hey! What Happened? 

Let me guess-you loaded your prized full-length image of your pet snake Rollo 
taken with your panoramic digital camera, only to find that all you got was his 
midsection! That's because Power Goo's working window is a square shape, 
and any image that isn't close to a square shape is automatically cropped to fit 
within the window. 

The easiest way to fix this problem is to load your picture into an image 
editor like Photoshop or Paint Shop Pro and crop any unnecessary material 
until the original image has a square shape; however, this doesn't work on long 
rectangular pictures, like your snapshot of Rollo. Alternately, you can add a 
plain border around your image to give it a square shape and then remove the 
extraneous border from each animation frame afterward. 

By the way, Power Goo also resizes the image automatically if it's too big to 
fit within the window, but this usually isn't much of a problem. 

2. Forgive us, Mona Lisa! Let's load the standard morphing command 
palette, which appears in icon form directly under the word "GOO" in 
the upper left corner of the screen. Click the firs t semicircular palette 
icon, and Power Goo displays the buttons shown in Figure 7-17. Take 
special note of the Reset button at the top left; if you make a mistake, you 
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can always click this button to reset your image and start over. In a 
similar fashion, the UnGoo button at the top right removes the changes 
you 've made to just the area under the cursor, so you can selectively 
restore parts of the image to their original appearance. 

We' ll take you on a very quick tour of these buttons and show you 
their individual effects. Like any paint program, you can use different 
commands in any order you choose, but this way you can see what each 
does by itself. If you're following along, don't forget to click the Reset 
button at the top left to return the image to its original appearance after 
using each button! 

Figure 7-17: The standard Power Goo morphing palette. 

iii-+ 

Remember that each illustration here shows only one part of the movement cycle. If 
you create a looping animated GIF using frames from the entire cycle, the effect will 
be even better. 

3. First, we'll use the Grow / Shrink button. Click on it to illuminate it, then 
click and hold the mouse button while moving your cursor in a circular 
motion around the good lady's nose. You'll notice that this portion of her 
face shrinks in proportion, so you end up with an image like the one 
shown in Figure 7-18. 
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Figure 7-18: The effects of the Grow/Shrink button. 

4. Next, try the Move button. Click on it to illuminate it, then click and hold 
the mouse button while moving your cursor up and down several times 
along Mona's nose-the result is what I like to call "the Easter Island 
effect" illustrated in Figure 7-19, as portions of the image are moved in 
the direction of your mouse. Click the Reset button at the top left to 
return the image to its original appearance. 

Figure 7-19: The effects of the Move button. 
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5. The Smear and Smudge buttons are similar, although the Smear button 
has a more pronounced effect; both commands "pull" the image under
neath in the direction of the mouse movement. Unlike Move, however, 
each pixel will leave a trail behind it so that it appears you're stretching 
the existing image. Figure 7-20 shows the results of a Smear. 

Figure 7-20: The effects of the Smear button. 

6. The Nudge button is probably my favorite, as it allows you to make small 
changes to a part of your image without producing dramatic changes 
elsewhere. This makes it a good tool for creating animation frames as well. 
The command moves the pixels underneath in the direction of the mouse 
movement. Figure 7-21 shows the results of a Nudge ... suddenly, 
Mona's trademark smile is much more noticeable! 
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Figure 7-21: The effects of the Nudge button. 

7. The Mirror Toggle button produces an equal mirror image motion for the 
selected command. For example, a Nudge to the left using the Mirror 
Toggle would result in an equal motion in two opposing directions, to 
the left and to the right. Mirror Toggle is especially effective when you 
want to create a balanced effect. This button remains ON or OFF until 
you toggle it by clicking it. 

8. Finally, the Smooth button probably has the least apparent effect, but I 
typically use it after I've created another masterpiece; it smoothes surface 
detail, blending the colors and lines somewhat under the cursor. One or 
two quick moves with the Smooth button, and your image will usually 
look a little more lifelike. 

That completes the first command palette. Now click on the second palette 
icon underneath the first and Power Goo will display the second command 
palette. These commands are more similar to simple image effects, as you have 
no control over them. Also, they don' t seem to have any direct effect on your 
image when you select one because your original image becomes the exact 
center of the movement cycle for the effect you choose. To step through the cycle 
frame-by-frame, click and drag the slider bar at the lower left part of the screen. 

9. Figure 7-22 illustrates the Bulge transition at its maximum setting. At the 
other end of the movement cycle, it looks much like the Grow / Shrink 
effect from the first command palette. 
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Figure 7-22: The Bulge transition. 

10. The Twirl transition is shown in Figure 7-23. Not only is it disorienting, 
it's very popular as a GIF animation! 

Figure 7-23: The Twirl transition. 

11. The Rotate transition causes the image to "disappear" for a second or 
two, but it will reappear upside down. Figure 7-24 shows the results of a 
Rotate transition. 
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Figure 7-24: The Rotate transition. 

12. The Stretch transition is probably the simplest-it stretches the image 
from oppos~g sides. 

13. The Squeeze transition in Figure 7-25 can create the famous "Mona Ape" 
image! 

Figure 7-25: The Squeeze transition. 
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14. The Spike and Static transitions are similar, differing only in the amount of 
distortion they create. Spike results in large, jagged spikes, while static is a 
shimmering, translucent effect. Figure 7-26 illustrates the Static transition. 

Figure 7-26: The Static transition. 

That's a quick overview of the available commands within Power Goo. If 
you've used this program before, you 'll notice that I didn't mention Goovies, 
the animated movies you can create, or the AVT and MOV digital video output 
you can produce. Since these extra features have no connection to the single 
frame output we need for GIF animation, I decided to skip them, but I encour
age you to explore the other features of this great program at your leisure. 

Creating Animation Frames 

OK, now we know how to alter an image in Power Goo, but how do we create 
the image frames we need for GIF animation? Good question, I'm glad I asked 
it! To save the current image within Power Goo, follow these steps: 

1. Once you've completed your image, click the word "OlIT" in the lower 
right comer of the standard Power Goo Morphing command palette 
(Figure 7-17) which displays the Out Room, as shown in Figure 7-27. 
Click the Save Image icon. 
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Figure 7-27: The Power Goo Out Room, where you can save images after morphing. 

2. The program displays the Goo Image Output Size dialog seen in Figure 
7-28, allowing you to set the size of your image. By default, this size is 
360 x 360, but you can move the slider to figures over 4,000 x 4,000 if 
you have the memory! Set the desired output size and click the 
checkmark to continue. 

Figure 7-28: Setting the size of our output image. 
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The Output Size Dialog 

Power Goo will not display the Output Size dialog unless you set Power Goo for 
high-resolution. To do this, follow these steps: 

1. From the main map, click on the Options icon to display the screen shown in 
Figure 7-29. Under Output, click the High Resolution check box to enable it. 

2. Click on the checkmark icon to save your new settings to disk. 

The High Resolution setting is available only on the full retail version of 
Power Goo. 

The maximum size for your image depends upon the amount of RAM set 
aside for the program; if you're using a Macintosh, you can allocate additional 
RAM to the program. Follow these steps: · 

1. Click on your Power Goo icon to highlight it, and select Get Info from the 
File menu. 

2. Under Memory Requirements, allocate additional memory to the Preferred 
Size field. 

The maximum output size of 4, 128x4,128 requires approximately 70 mega
bytes of RAM, so if you need to create a really large picture, consider resampling 
a smaller size image within your image editor! 

Figure 7-29: The Power Goo Options screen. 
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3. From the File Save dialog, enter a name and select BMP format, and then 
click on Save to copy the image frame to disk. 

Unfortunately, this version of Power Goo has no support for saving mul
tiple separate image frames from a morph. However, since most GIF anima
tion uses a maximum of 10 to 15 frames, it's no big hassle to take the 
individual images. For the excellent visual results you can obtain from Power 
Goo, it's well worth the extra effort! 

Combining Two Images 

Before we leave the Power Goo premises, there's one other feature I'd like to 
show you: the program includes a Fusion Room, where you can select parts of 
one image and "graft" them onto another to create a brand new image! This 
doesn't result in a movement cycle, though, so it can't be directly processed 
into a GIF animation. However, you can use the image you create as the basis 
for more work within Power Goo, or you can save it for morphing use with 
HiJaak Morph. 

To combine elements of two images with Kai's Power Goo, follow these steps: 

l. From the main map, click on the Fusion Room to display the screen 
shown in Figure 7-30. 

Figure 7-30: The Power Goo Fusion screen, where features can be combined. 



~ 

Chapter 7: Creating Morphing Web Graphics 265 

2. Next, we need to load our own images. To load an imag~ from your hard 
drive into either window, click on the In button below the window; 
Power Goo displays a File Open dialog. Select your image and click OK. 

3. If you need to flip the image upside-down, click the upside-down F 
button. To reverse the image, click the backwards F button. 

4. Time to load one of the images into the center frame. Click on the arrow 
pointing from the image you want to use to the center window and 
Power Goo will load a full-size image. You'll use this image as the basis 
for your final picture. I' ll use the program default, a man's portrait, as 
the base for this example. 

5. From the other image, select a feature you'd like to add to your main 
image. In our example, we'll graft one of the young girl's ponytails onto 
the man's head! Click your mouse cursor on the base of the young girl's 
right ponytail; you'll see it turn into a crosshair, as in Figure 7-31, indicat
ing that you've selected the area around it. 

·Figure 7-31: Selecting a face for grafting! 
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6. Next, move your cursor over to the right side of the man's head. Click 
and hold your mouse button while you slowly move the cursor around 
in a small circle, and-voila! You'll see the young girl's hair literally 
being "painted" directly onto the man's image! Figure 7-32 illustrates 
our new creation. 

Figure 7-32: They say two heads are better than one! 

Of course, the possibilities for humor are endless! After you've ex
perimented with this a little while, you'll be able to control how precise 
a boundary you create, but, as you can imagine, it helps ·if both subjects 
are photographed against the same color background and the images 
are saved (or cropped) to the same size. 

7. To smooth any jagged edges or blend the boundaries of a grafted sec
tion, click the Smooth button to illuminate it, then click and hold the 
mouse button while moving your cursor over the boundary. This button 
works just like its counterpart on the first command palette. 

8. You can also adjust the boundaries of a grafted section with the Smear 
button. Move your cursor over the area that needs expansion, click and 
hold the mouse button while moving your cursor slowly in the desired 
direction. 

9. Finally, click the Move button to adjust the position of an entire grafted 
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area. For example, click on the man's ponytail, hold the mouse button 
down, and drag a person's entire head of hair to a new location .. . now 
that, my friends, is power! 

10. I think it's time to save this work of art! Once you've completed your 
image, click on the word "OUT" in the lower right corner of the screen to 
display a subset of the Out Room. Click Save Image. 

11. From the File Save dialog, enter a name and select BMP format, and then 
click on Save to copy the image frame to disk. 

Moving On 

In this chapter, you took your first steps into the world of morphing, where 
images are elastic putty at your disposal. You learned the basics of transitional 
morphing, where a mesh of points and lines links two images; in turn, this 
mesh allowed us to change an object in one image into another object by using 
HiJaak Morph. Then we used alteration morphing to reshape an image in a 
wide variety of ways in Kai's Power Goo. Finally, you learned how to combine 
features from two images to create a new object, once again using Power Goo. 

In Chapter 8, "Java Animation 101," you'll learn how to create Java applets 
that can enhance your Web page with animated graphics-without learning 
one single line of the Java programming language! 
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CHAPTER 8 

Java Animation 
101 

wt! Before you jump to the next chapter by reflex, this is not your aver
age chapter on writing Java. 

In fact, this chapter is designed to teach you how to add animation to your 
Web pages using applets: small, portable programs written in Java that run 
inside the user's browser. There are a number of advantages if you use applets 
rather than animated GIFs-well-written applets take only a fraction of the 
time to download compared to larger animated GIFs, and they can take 
advantage of sound. Most important, Java applets can respond to user actions 
like a mouse movement or a click. 

Do you have to know Java in order to write applets? Not in this chapter. 
We're going to "sidestep" the entire issue of Java and JavaScript; you'll enjoy 
all the benefits of adding applets to your Web pages, with none of the pro
gramming. I won't include a single line of code, and we won't be discussing 
the merits of different programming environments. You won't have to "declare" 
or "initialize" a thing. Instead, you'll use a shareware program that will write 
and compile various custom-animated Java applets to your specifications. 

This is not to say that I don't enjoy programming, but this book is designed 
to avoid time-consuming chores and expensive commercial software. And 
teaching yourself a new programming language from scratch involves both a 
considerable investment in time and at least a few hundred dollars for the 
required software tools. There are so many Java books in print now that you 
can hear the shelves creaking at your local bookstore, so if you decid e to teach 
yourself the language, you' ll have no problems locating the resources you'll 
need-we'll see you in a month or two (or more). 
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On the other hand, you can follow along with the step-by-step instructions 
in this chapter and add Java animation to your page in 15 minutes-quick and 
cheap. The choice is up to you! 

In this chapter, I'll start with a short introduction to Java and JavaScript, 
what they are and why you would use them in animation. Next, I'll introduce 
Hot Chilli, a Java code generator for Windows 95 that will serve as our ex
ample, and we'll create a number of professional applets for your page (I'll 
also discuss other programs for Mac and Windows that can generate Java 
applets automatically). Finally, I'll mention a number of sources for Java 
applets that you can use directly on your Web pages, free of charge. 

Why Use Java? 

Before we jump in and create a Java applet, let's take a few moments to review 
the language behind the myth; why has Java been such a success on the Web? 

Java was developed by Sun Microsystems in the early 1990s, and it has 
become one of the two or three required tools for developers of Internet soft
ware. However, Java was not directly designed as an Internet- or Web-specific 
language; its popularity on the Internet is due to a number of important ad
vantages it has over the older workhorse languages like C and C++. For 
example: 

• Java is a platform-independent language, meaning that your Java pro
grams can run on just about any popular computer and operating system 
available today with little or no modification. 

• The language is significantly easier to learn and use, with fewer com
mands and more automation. 

• Java requires fewer resources than most programming languages, includ
ing a small fraction of the memory and hard drive space requirements 
you've grown used to in today's graph ical operating systems. 

• Java is a modular, object-oriented language, which makes it easier and 
faster to create and edit stand-alone applications. 

JavaScript was developed jointly by both Netscape and Sun Microsystems 
specifically as an integrated tool for use within HTML pages, and it cannot 
operate outside of a Web page. Although similar in most respects, JavaScript is 
much less complex than Java, with fewer commands to learn, and it is de
signed to allow client computers to handle some of the tasks that used to be 
assigned to the Web server. For example, rather than bog down a Web server 
with a CGI script that performs mutual fund calculations, you can write a 
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JavaScript applet that allows your visitors' computers to handle the same 
function on their end-this frees up the server's resources. For this reason, 
most of the simple applets that you see on the Internet these days are written 
in JavaScript. 

End of the course: you passed with flying colors! Seriously, that's about all 
the background we need in Java and JavaScript; the applications I'll be dis
cussing throughout the rest of this chapter generate applets without any 
programming. The resources I'll list offer Java or JavaScript applets as 
freeware or public domain, so you won't have to write a single line of code. 

Using Hot Chilli 

It's time for me to introduce you to our shareware Java development program 
for Windows 95, Hot Chilli from Peter Zmijewski. Hot Chilli can create the 
following types of Java applets: 

II Scrolling LED messages. These look similar to the scrolling LED signs 
we created in GIF Construction Set, but this time they're fueled by Java 
instead of GIF animation. 

Iii Status Scroll messages. This neat effect scrolls a moving line of text 
across the status bar within any Java-capable browser. 

Iii Fading Scroll messages. The name of this effect is somewhat of a misno
mer; these messages fade smoothly in and out of view, but they don't 
actually move across your screen. 

fi Super Scroll messages. How about a spectacular text message that 
explodes as it scrolls? Or perhaps you'd like something in a sinuous sine 
wave? Hot Chilli can create these effects in seconds. 

II Pull menus. You've used a drop-down list box before, but imagine if you 
could add a drop-down list box to your Web page? Each entry in the list 
was a link to another Web site or resource, and selecting that entry 
would automatically jump to that resource? 

Ill Custom cool buttons. Hot Chilli can create a button with whatever text 
you specify that will display a message in your browser's status bar 
when the mouse cursor moves over it; for example, the button face may 
read "File Library l," but when the cursor moves over it the message 
"Browse through files from A to Ml" will appear in the status bar. 

Each of these applets can be previewed before you create the finished Java 
code, and the program includes a simple HTML listing window where you 
can insert and edit your new applet. 
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You can download Hot Chilli from the support Web site at 
www.ozramp.net.au/-maxzmije/index.htm. When you first install it, the 
program prompts you to select a browser that it will use for the Preview 
function; browse through your system to the directory that holds your 
Netscape executable and click on it to select it. The program then displays its 
main window, shown in Figure 8-1. 

Figure 8-1: Tlte Hot Chilli main window. 

You select which of the six Java applets you wish to create by clicking on 
the 6 buttons on the left side of the window, and the center tabbed dialogs will 
change to match the applet you chose. The large button bar across the top of 
the window allows you to preview the look of your finished applet, open or 
save an applet file, or build the Java applet and insert it into your HTML file. 

Let's create one of each of these applets, starting with the LED display. 

Creating an LED Display 
To create an LED display with Hot Chilli, follow these steps: 

1. Click the LED Display button; the LED Display Main panel appears. 

2. Select a font from the drop-down list box and specify the font size in 
points in the field next to it; you can also add bold or italic attributes by 
clicking the B or I buttons. To choose the color of the text, click the Font 
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Color button and click on the desired color, then click OK to accept your 
selection. You'll see that the Font Color button changes to reflect the color 
you've chosen. · 

3. Now we'll specify a starting and finishing action for our display; an action 
is similar to the transitional effects we've discussed before. As you might 
have guessed, the starting action determines how the animation will 
begin, and the finishing action determines the last animation you'll see. To 
see your choices, click on the Starting Action drop-down list box; I'll pick 
the default in which Text scrolls toward the left. For a Finishing Action, 
we'll do something a little more exotic-I'll select Text scrolls from the 
center toward the edges in a vertical direction. Hot Chilli automatically 
loops the animation endlessly. Our animation will scroll from right to left, 
pause in between actions, and then the top half of the message will scroll 
off the top of the display, and the lower half will scroll off the bottom! 

4. Now we should set the Delay and Flash sliders in the upper right comer 
of the window. The Delay value determines the delay between the start
ing and finishing action; in other words, the pause in the middle. A 
longer delay comes in handy if you would like your message to pause so 
that it can be easily read. I usually use the default of 200. The Flash slider, 
on the other hand, determines how often your message should blink on 
and off as it scrolls. The higher the value, the longer a Delay value you 
must set, so I generally either leave Flash set to 0, 1, or 2 (at the most). 

5. Next, let's add the text for our display. Click in the text box under the 
font that reads "Enter Text Here" and do exactly that. Use your Delete 
key to delete the default message text, and then type your own into the 
field. For our example, I'll enter "Who Needs to Program?" Once your 
message is complete, click the Add button to c_opy the text to the display 
window; you'll notice that Hot Chilli automatically adds a number of 
variables and values that will be interpreted later by your Java applet. 

6. Here comes the r~ally neat thing about Java LED displays as compared 
to animated GIF LED displays: you can repeat steps 2 through 5 several 
times! An animated GIF display with multiple messages would be far too 
large to download, but with a Java applet, you can build a sign that will 
cycle through multiple messages in multiple colors, each of which has its 
own starting and finishing action. To remove a message line, highlight it 
in the display window and click Remove; to clear all of the messages and 
start over, click Clear All. 
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7. You can also specify a number of options for the entire display; click the 
Preferences tab to display the panel shown in Figure 8-2. To set the over
all speed of the scrolling, type a number directly into the Speed field or 
move the sliding control. To specify the color for the LED background or 
the display border, click on the corresponding button and select the 
desired color from the color palette that appears. Finally, you can specify 
the size of each LED (each individual dot that makes up the letters in the 
sign) in pixels and the border width surrounding the display in pixels. To 
return to the Main panel, click on the Main tab. 

Figure 8-2: The LED Display Preferences panel. 

8. Time to preview your work. Click the Preview button at the top of the 
window. Hot Chilli will load Netscape, compile your Java applet dy
namically, and show it to you within the Navigator window. Figure 8-3 
shows you our example LED display. 
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Figure 8-3: Previewing our finished LED display. 

At this point, you can build the Java applet and insert it into your HTML 
file. We'll discuss this option in the section "Adding Your Applet to Your 
Page" after we've covered the other effects you can produce. 

Creating a Super Scroll Message 
To create a Super Scroll Message display with Hot Chilli, follow these steps: 

1. Click on the Super Scroll button; the Super Scroll Main panel appears, as 
shown in Figure 8-4. 
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Figure 8-4: Tire Super Scroll Main panel. 

2. To choose the color of the text, click Font Color and click the desired 
color from the palette, then click OK to accept your selection. You'll see 
that the Font Color button changes to reflect the color you've chosen. 

3. Next, select a style for the display: you can choose Sine-wave, Nervous, 
Explode, or None. The style you pick controls the independent move
ment of the characters as they scroll across your screen. 

4. Now set the Delay slider, which determines the delay between the start
ing and finishing action. The default of 20 usually works pretty well 
under most circumstances. 

5. As before, you should specify a s tarting and finishing action for our 
display. As you might have guessed, the starting action determines how 
the animation will begin, and the finishing action determines the last 
animation you ' ll see. In the case of this applet, you can only specify a 
movement direction and a style; for example, you could have a sine 
wave style applet with a starting action to the left and a finishing action 
to the right. The scrolling message for such an applet would have a 
"wavy" motion as it moved to the left, then it would reverse direction 
and move off the display to the right. 
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6. Next, let's add the text for our display. As before, click the field under the 
font that reads "Enter Text Here," use your Delete key to delete the 
default message text, and then type your own into the field. Once your 
message is complete, click the Add button to copy the text to the display 
window; you 'll notice that Hot Chilli automatically adds a number of 
variables and values that will be interpreted later by your Java applet. 

7. Once again, unlike a scrolling message in· animated GIF format, you can 
add multiple scrolling messages in the same applet, so repeat steps 2-6 if 
you like. To remove a message line, highlight it in the display window 
and click Remove; to clear all of the messages and start over, click Clear 
All. 

8. You can also specify a number of options for the entire display; click the 
Preferences tab to display the panel shown in Figure 8-5. Select a font 
from the drop-down list box and specify the font size in points; you can 
also add bold or italic attributes from the Style drop-down list box. To 
specify the height and width of the display window, enter new values in 
the fields at the right of the panel. You can also choose the color of the 
background; click the Background Color button and click on the desired 
color from the palette, then click OK to accept your selection. To return to 
the Main panel, click on the Main tab. 
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Figure 8-5: The Super Scroll Preferences panel. 
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9. To preview your display, click the Preview button at the top of the win
dow. Figure 8-6 shows you our example Super Scroll message. 

So 1dl l6ow Jlo ~ u. 
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Hello from Super Scroll! 

Figure 8-6: Previewing our finished Super Scroll message. 

At this point, you can build the Java applet and insert it into your HTML 
file. 

Creating a Fading Scroll Message 
To create a Fading Scroll Message display with Hot Chilli, follow these steps: 

1. Click the Fading Scroll button; the Fading Scroll Main panel appears, as 
shown in Figure 8-7. 
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Figure 8-7: The Fading Scroll Main panel. 

2. Select a font from the drop-down list box and specify the font size in 
points in the field next to it; you can also add bold or italic attributes by 
clicking the B or I buttons. To choose the color of the text, click the Font 
Color button and click on the desired color, then click OK to accept your 
selection. You'll see that the Font Color button changes to reflect the color 
you've chosen. 

3. Now set the Fade Speed slider in the upper right corner of the window. 
The Fade Speed value determines the amount of time it takes for your 
message to fade in and out, in seconds. 

4. Next, let's add the message text. As before, click the field under the font 
that reads "Enter Text Here," use your Delete key to delete the default 
message text, and then type your own message into the field. Click Add 
to copy the text to the display window. 

5. If you like, add multiple messages by repeating steps 2-4. To remove a 
message line, highlight it in the display window and click Remove; to 
clear all of the messages and start over, click Clear. 
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6. You can also specify a number of options for the entire display; click the 
Preferences tab to display the panel shown in Figure 8-8. You can choose 
both the color of the font and the background; click either button and 
click on the desired color from the palette, then click OK to accept your 
selection. To specify the height and width of the display window, enter 
new values in the fields at the bottom of the panel. 
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Figure 8-8: Tiie Fading Scroll Preferences panel. 

7. To preview your display, click the Preview button at the top of the 
window. 

At this point, you can build the Java applet and insert it into your HTML 
file. 

Creating a Status Scroll Message 
To create a Status Scroll message display with Hot Chilli, follow these steps: 

1. Click the Status Scroll button to access the Main panel, as shown in 
Figure 8-9. 
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Figure 8-9: The Status Scroll Main panel. 

2. Now set the Scroll Delay slider at the bottom of the panel. The Scroll 
Delay value specifies the delay in seconds between each display of the 
status line message. 

3. Next, let's add the message text. As before, click the field under the font 
that reads "Enter Text Here," use your Delete key to delete the default 
message text, and then type your own into the field. Once your message 
is complete, click Add to copy the text to the display window. 

4. If you like, add multiple messages by repeating steps 2 and 3. To remove 
a message line, highlight it in the display window and dick Remove; to 
clear all of the messages and start over, click Clear All. 

5. To preview your display, click the Preview button at the top of the win
dow. Your scrolling message appears w ithin the Netscape browser status 
line window, as shown in Figure 8-10. 

Figure 8-10: Previewing our finished Status Scroll message. 

At this point, you can build the Java applet and insert it into your HTML file. 
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Creating a Cool Button 
A Cool Button Java applet displays a message on the browser's status bar 
when the mouse cursor is on the face of the button. Clicking the button will 
take you to another URL. To create a Cool Button within Hot Chilli, follow 
these steps: 

1. Click Cool Button; the Cool Button Main panel appears, as shown in 
Figure 8-11. 
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Figure 8-11: The Cool Button Main panel. 

2. Enter the text you'll see on the face of the button. Erase the contents of 
the Enter text to be displayed on button field and type the text for the 
button. Hot Chilli provides a preview window that will show you how 
the button will appear; make sure your text for the button face is shorter 
than the button itself! 

3. Next, click in the Enter URL field . After the http:/ I prefix, type the Web 
URL that this button should access when it's clicked. 

4. Finally, move to the third field and enter the message that should appear 
in the browser's status line when the cursor moves over this button. 
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5. To preview your button, click the Preview button at the top of the win
dow. Your finished button appears within the Netscape browser status 
line window, as shown in Figure 8-12. 

Figure 8-12: Previewing our finished Cool Button. 

At this point, you can build the Java applet and insert it into your HTML file. 

Creating a Pull Menu 
To create a Pull Menu applet within Hot Chilli, follow these steps: 

l. First, click Pull Menu; the Pull Menu Main panel appears, as shown in 
Figure 8-13. 
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Figure 8-13: Tile Pull Menu Main panel. 

2. Next, set the background height and width for your applet in pixels. You 
can specify a color for the applet background by clicking the Background 
Color button-dick on the desired color from the palette, then click OK 
to accept your selection. 

3. Enter the text for one menu item. Erase the contents of the Description 
field and type the text to identify the entry. 

4. Next, click in the URL field. After the http: / I prefix, type the Web URL 
that this menu item should access when it's selected. 

5. Now move to the third field, Target Frame, and select the frame value. 
This field is only required if you're using frames on your Web site; other
wise, the value is ignored. If you are using Frames, indicate which frame 
should be targeted: _top, _self or _blank. 

6. Once your item is complete, click the Add button to copy it to the display 
window. 

7. If you like, add multiple items by repeating steps 2 through 6. To remove 
an item, highlight it in the display window and click Remove; to clear all 
of the items and start over, click Clear All. 

8. To preview your display, click the Preview button at the top of the win
dow. Your pull menu appears within the Netscape browser window, as 
shown in Figure 8-14. 
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Figure 8-14: Preuiewing 011r finished Pull Menu applet. 

At this point, you can build the Java applet and insert it into your HTML file. 

Adding Your Applet to Your Page 

Now that you've created each of the six types of Java applets available withln 
Hot Chilli, let's add an example to your page. Follow these steps: 

l. Click Open File on the toolbar. From the Open File dialog, browse your 
system and select the HTML file that should use the applet. 

2. The HTML file is displayed at the bottom of the Hot Chilli window, as 
shown in Figure 8-15. To display the entire editor window instead of the 
small scrolling box, click the Up button; to return to the Hot Chilli win
dow from withln the full-size editor, click on the Down button. 
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Fig11re 8-15: Displaying HTML code within Hot Chilli. 
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3. In the editor window, indicate the insertion point where the applet code 
should appear by moving the cursor to that point in your HTML file and 
clicking. 

4. To build and automatically add the applet code, click the Build Java 
button on the toolbar. 

5. Click Save File on the toolbar and save your modified HTML file to disk. 

That's it! You've just added Java functionality to your Web page. Now you 
can throw a party and announce to the world that you're an official Java 
developer, create your own start-up company, and make a billion dollars 
overnight. Or you can just enjoy those complimentary e-mail messages from 
the visitors to your page! 

Now that you've seen how easy it is to generate Java applets without cod
ing, let's look at three other programs that can help you create Java animation. 
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Other Java Animation Tools 

There's more than one way to generate a Java applet, and the commercial 
packages described in this section provide you with powerful tools to create 
more sophisticated animation (complete with sound). 

Each of these applications offers something that stands out from the 
others, so if you' re especially interested in a particular feature you may want 
to install the trial version of that program and try it out for yourself (if a trial 
version is available). 

Egor Animator (Win95) 

Egor Animator runs under Windows 95, and its interface is so simple that you 
might be fooled into thinking you' re using the tutorial. The program's mascot, 
a silly little mad scientist, is everywhere-and, I have to admit, I liked him and 
I can definitely see how he would make a beginner feel more comfortable. 
Every control and procedure within the program is described at length 
onscreen, so you' ll never find yourself lost within Animator. 

There's plen ty of power to spare here, though; you can assign actions, 
sound files, and even Web URLs to each frame of your animation. The pro
gram includes a number of transition effects, and you can completely control 
the movement cycle. Like Hot Chilli, you can preview your image in a 
Netscape window before you save it to disk, and the program compiles your 
Java applet for you. Like Hot Chilli, Animator is also limited to producing 
only Java output. 

If you experiment with Hot Chilli and you find that you like the easy inter
face, but you'd like to do more sophisticated animation using your own im
ages, I can highly recommend Egor Animator. 

WebBurst (Mac/Win95/WinNT) 

Originally available only for Macintosh, Web Burst from Power Production 
Software (www.powerproduction.com) is also available now for Windows 95 
and Windows NT. It offers basic functionality similar to Egor Animator; a 
frame from your Java animation can be linked to a sound file, for example, or 
automatically jump to a specific URL. Your animated objects can follow preset 
paths, complete with delays. 
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Web Burst goes farther, though, in terms of providing you with what I con
sider true drag and drop functionality: it can grab an image from a wide variety 
of supported formats (including sounds and animated GIF files) or pull in an 
entire library of sample graphics that ship with the program. You can build your 
own libraries of sounds and images as well. An easy-to-use Action Control 
panel lets you assign events and actions by simply clicking away. WebBurst 
can export compiled Java applets, static GIP images with transparency, and 
PICT files, and any sound files that you use in your Java animations are auto
matically converted to .AU format for you. The program also provides a basic 
set of drawing tools in case you have to add something to your frame, and you 
can even use Web Burst to create your own image maps with Java. 

If you do have some experience programming with Java, Web Burst has a 
number of features that will especially appeal to you. Since WebBurst applets 
can invoke other Java programs or classes, you can call on other applets and 
extend the functionality of your existing code. Web Burst also includes a series 
of simple programming features like variables, math commands like add and 
subtract, and IF /THEN, greater than/less than functions. Your Java applets 
can display text fields and accept information. 

Web Burst takes Java applet generation a leap beyond Egor Animator with
out adding a serious learning curve, yet professional Java developers can use 
it as well. I highly recommend it for Webmasters of every experience level. 

WebPainter (Mac/Win95} 

Totally Hip Software's WebPainter, available for both Macintosh and Windows 
95 at www.totallyhip.com, offers a wide range of output formats so you can 
consider it almost as much of a conversion tool as you can a Java generator. As 
you can see in Figure 8-16, the interface consists of a menu bar and a number 
of floating palettes that you can arrange any way you like, including a very 
familiar frame-by-frame storyboard editor. A little harder to understand and 
use for some novices, but experienced animators will find themselves right at 
home with this interface, and WebPainter features the most comprehensive 
online help of the programs I've covered. Since you can create standard ani
mated GIFs with WebPainter, you may find that this program can replace GIP 
Construction Set for many tasks. 
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Figure 8-16: Working on a project using WebPainter. 

Like Web Burst, this program includes a number of drawing and painting 
tools, so you can draw new images or modify existing images from within the 
program. Animation eels can be added or deleted at any time, and you can 
also add transparency or text to your image. The real star of the show, how
ever, is the output; you can select the company's Sizzler proprietary animation 
format as a Java applet (as shown in Figure 8-17), produce AVI and QuickTune 
movies, or build animated GIFs directly. Single frames can be output as GlF or 
Windows bitmap under Windows 95, while the Macintosh version can export 
image frames in PICT format. I also very much liked the Onion Skin feature, 
where light outlines of the previous and next frame allow you to more cor
rectly measure the movement cycle--it's very similar to the technique used in 
the older animated cartoons. 
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Figure 8-17: Creating a Sizzler applet with WebPainter. 

This is a powerful program, but it's not for programmers. Instead, 
WebPainter will appeal to those more interested in the animation process than 
how the final result is displayed on the Web. This is not a program for those 
who thrive on linking Java code or building extensive links and IF /THEN 
statements into a Java applet. In fact, as I mentioned earlier, you may just find 
yourself deciding that the classic animated GIF is a better medium for your 
work. And, if you're using WebPainter, you can actually take your pick of 
which type of animation you produce. 

Finding Free Java Animation 

Finally, I'd like to wrap this chapter up with a listing of my favorite sites on the 
Web for obtaining Java and JavaScript information, animation, and applets. 

• Netscape (www.netscape.com). If you're looking for the latest news on 
JavaScript, visit the Netscape home page. You'll also find developer 
information and technical data. 
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• Sun's Java Source (java.sun.com/). The official home of Java. Heavy with 
promotion and aimed primarily at developers, but you can still browse 
for freeware applets. 

• The Java Boutique (javaboutique.intemet.com/). A very p rofessional 
site with the latest freeware Java applets and extensive links to other Java 
resources. Figure 8-18 illustrates this fine site. 

• Gamelan (www.gamelan.com/). Gamelan advertises itself as the "Official 
Directory for Java." I believe it. You can search this repository of resources 
for specific keywords, or simply dive in-the featured applet is usually 
extraordinary (for example, at this writing you can try the Deep Blue 
Chess Viewer applet, which allows you to review the Kasparov vs. Deep 
Blue matches p layed in May of 1997, complete with expert commentary). 
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Moving On 

In this chapter, we built custom Java applets step-by-step without writing a 
single line of code, using the shareware program Hot Chilli. I also discussed 
three other commercial programs which offer more features and power (and 
require more experience and more work). Finally, I mentioned Web sites you 
can visit for free applets, code, and programming information. 

Whichever Java generation tool you pick, you can create professional re
sults on your own Web page-but remember, animated GIFs are accepted by 
more older browsers, so I still prefer an animated GIF whenever possible. 

In Chapter 9, "The Ultimate Animation," you'll learn about digital video 
and how you can add it to even the simplest Web page. 



CHAPTER 9 

The Ultimate 
Animation 

l:oughout the earlier chapters of this book, you learned how to add life to 
your Web pages with GIF animation. We've also explored how you can build 
animation using sophisticated image filters, 3D objects, and morphing, as well 
as applications that will build custom animated Java applets for you with no 
programming required! 

In this last chapter, however, I'd like to take you beyond the current forms 
of animation that are common on the Web to the leading edge, into a new 
world of "ultimate" animation: digital video, server push, and an ever-grow
ing number of third-party Netscape plug-ins. Each of these Web technologies 
promises something different from the GIF- and Java-based animation that 
you're familiar with, but these technologies still offer the same advantages to 
your Web site: they draw visi tors to your pages and showcase your content! 

However, as you move closer and closer to the "leading edge" of Web devel
opment, you also move further away from broad compatibility with current 
browsers and modem speeds. So, to be fair, I'll also mention some of the disad
vantages of each of these new developments along with the "gee whiz" side. 

Unlike the animation methods we've discussed in earlier chapters, these 
new technologies also tend to require considerable resources-in technical 
experience, time, and money-to implement on your site. So rather than 
provide tutorials for a specific software package, T'll introduce you to the 
basics of each of these Web technologies and point you to sources for more 
information on the Web. 
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Are these new Web technologies strictly "animation"? They do bring auto
matic movement to your page, including sound and interaction. I'll let you 
decide for yourself! 

Digital Video Basics 

In Chapter 2, we discussed a number of methods that you can use to create or 
obtain raw digital video footage. These methods include the following: 

II Digital video cameras. These cameras are available for Internet video 
conferencing in both black and white and color models. 

II Video capture boards. A video capture board can digitize incoming full
motion video from a standard video camera, VCR, or video disc player. 

ii Video export. Many of the programs I've discussed throughout this book 
support the export of animation in digital video format (usually Win
dows .AVI format or Macintosh QuickTime format), so you can create 
your own video even if you don't have a camera or capture board handy. 
For example, you can generate digital video with trueSpace or Sculpt 30 
using 30 objects you've created. 

II Video clip art. You can use a number of sources for royalty-free video as 
"video clip art" for your site; check the popular Web-related magazines 
on the newsstands these days for more information. 

Common Video Standards 

Although obtaining digital video is easy enough, not all digital video is cre
ated equal! Three popular video formats are currently being used on the Web, 
and before you add a video clip to your page, you should be familiar with 
each of them: 

II Microsoft .AVI. Short for Audio Video Interleave, this format is the 
Microsoft standard format for digital video, supported throughout 
Windows 3.1, Windows 95, and Windows NT. Within Netscape Naviga
tor, .AVI video has a MIME type of Video and a MIME subtype of 
msvideo or x-msvideo. 

Ill Macintosh QuickTime. The Macintosh standard for digital video, also 
well-supported in the PC world through cross-platform programs. 
QuickTrme video clips carry the extension .MOV. Within Netscape Navi
gator, QuickTime video clips have a MIME type of Video and a MIME 
subtype of QuickTime. 
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Iii MPEG. Short for Moving Pictures Experts Group. An international video 
standard, MPEG video is used throughout the Internet and on commer
cial CD-ROM games and educational titles. MPEG video clips carry the 
extension .MPG. They have a Netscape MIME type of video and a MIME 
subtype of MPEG. For everything you ever wanted to know about 
MPEG, visit the MPEG Archive at www.mpegl.de/intro.html and jump 
into their FAQ files, video clip archives, and MPEG CD-ROM listings! 

The latest release of Netscape Navigator, version 4.0, has built-in plug-in 
support for both Microsoft .A VI and Quick Tune .MOV video clips. Earlier 
versions of Navigator also support all three of these digital video formats, but 
you'll have to download the plug-ins manually. I'll list the Web sites for some 
of the popular digital video plug-ins later in this chapter. 

The Downside 

Since Netscape Navigator now supports embedded video, why doesn't 
everyone's site feature digital video? Of course, the biggest disadvantage to 
digital video over the Web is the sheer size of a video clip; even at 33.6 bps 
(the current throughput top speed for most dial-up connections), a mere 30 
seconds of average-quality digital video with mono sound will leave you 
staring at a download progress bar for 15 minutes. A direct network or ISON 
connection helps-as will the new crop of 56 bps modems-but even these 
high-speed links can't deliver the bytes fast enough to provide a decent frame 
rate for full-motion video. 

Also, many Webmasters are less than enthusiastic about requiring their 
visitors using older browsers to download a plug-in application to allow the 
display of digital video. Most plug-ins are several hundred kilobytes long, and 
downloading the plug-in can take longer than downloading the video itself! 

Finally, older hardware will not be able to display digital video, especially 
higher-quality video recorded in more than 256 colors. Displaying digital 
video properly (at a high color depth, with well-synchronized sound and no 
dropped frames) takes a more powerful computer than most Web surfers are 
using today, which is another reason that I almost always tum to GIP or Java 
animation rather than digital video. 

Compression & Streaming 

The download time for digital video can be reduced using two different meth
ods, and just about every site that offers digital video will make use of them. 

The first is compression. Most digital video is compressed using a codec 
(short for compress/decompress). In essence, a codec is a software algorithm 
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that compresses digital video while it's being recorded and then automatically 
decompresses it while you watch the clip. Some codecs are also licensed for 
use in hardware devices, which allows much faster processing than their 
software-only counterparts; however, you naturally need a computer with the 
same hardware support to decode the compressed video on the receiving end. 

Popular codecs available today for Macintosh and Wmdows include the 
following: 

II Indeo. Developed by Intel, lndeo is a popular royalty-free software 
codec often used for commercial CD-ROMs. 

II Cinepak. The codec in most common use today, Cinepak provides excel
lent compression with little loss of color and detail. 

II MPEG. The international standard MPEG codec is available in two 
flavors: MPEG-1 and MPEG-2. The latter has been receiving a lot of 
press lately as the codec of choice for the new DVD (Digital Video Disc) 
format due by the end of 1997. DVD is the "second generation11 of CD
ROM technology; a single disc can hold several gigabytes of data, and 
it is slated to replace VHS videotape movies eventually. Many of 
today's better video cards have built-in hardware support for MPEG-1, 
allowing full-screen playback of digital video. MPEG-1 provides the 
best compression rate. 

Naturally, the better the compression, the better-suited a video clip is for 
transmission over the Web, so it's no wonder that MPEG is such a popular 
format/ codec combination on the Internet! Most digital recording software 
supports one or more of these compression formats, and typically you can 
specify the color depth and compression rate for your finished video clip. 

In line vs. External Video 1 
How else can you reduce the wait time for a video clip on your Web page?. The 
other solution is to provide support for streaming video, in which the video 
actually begins to play before it has finished downloading! Naturally, this 
solution reduces the wait time, but there is no standard solution for over
loaded sites with poor transfer rates and slow response times. Once that video 
clip begins to play, your page must be able to deliver the rest of the file as fast 
as possible. Several companies have released plug-ins that support streaming 
video in AVI and MPEG format. Although this technology is nowhere near 
perfect yet, it's in a constant state of improvement. Figure 9-1 shows an inline, 
streaming MPEG video clip displayed by a Java viewer. 
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This is a demonrtralia!i of an inline player for MPEG files. It IS written as JAVA 
APPLET and worics m 3 steps: 

I. Loading and parsing of the MPEG-files; 
2. Reconstruction of the single frames; 
3. Playing of the frames as animalion in a thread; 

The decoding time is a bit disappomting I'm not sur< wheth" I'll lind a possibility ta accelerate the decoding process. Perhaps it is 
impossible in J•ya_-( 

Figure 9-1: A streaming video clip in MPEG fonnat. 

"Rather than force my visitors to watch inline video, wouldn't it be better to 
allow them to download what they want?" This argument is certainly valid, 
and most sites on the Web still offer digital video as a download file rather 
than a plug-in. In most cases, you can determine which is more valuable to 
your visitors-viewing the file online with streaming technology (perhaps 
after waiting for the plug-in to download first) or simply downloading the 
video clip as a file for later viewing. 

Adding Video to a Web Page 

Although editing and shooting a video production is far beyond the scope of 
this chapter, you can keep a number of general guidelines in mind when 
saving digital video for use on the Web: 

• Minimize frame size. This tip may seem obvious, but it bears repeating: 
as with animated GIFs, the smaller the frame size, the smaller the file 
size for the finished clip, and the less time it will take to download. 
Figure 9-2 illustrates the Movie options dialog box from Personal AVI 



. "' 
~ -

298 OFFICIAL NETSCAPE GUIDE TO WEB ANIMATION 

Editor, a Windows 95 digital video application. Note that the default size 
for a video clip in this program is 160 x 120. I recommend that you keep 
your video clips under 200 x 200 for fastest transmission. 
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Figure 9-2: Selecting digital video options within Personal AV! Editor. 

• Carefully select your frame rate. Once again, digital video closely paral
lels GIF animation. The lowest frame/second rate is rarely the best 
choice, so experiment with different frame rates for the same clip. Try 
them online, and stick with the minimum number of frames that pro
vides a smooth display. I suggest a maximum of 10 frames per second for 
video to be used on a Web page. 

• Use compression! Unless your Web visitors are frozen in cryogenic 
sleep , never use uncompressed video on a Web site! At a minimum, 
select lndeo or Cinepak compression; if your software supports it, select 
MPEG for the best possible compression. 

• Reduce color depth. If your video recording or editing software allows 
you to set a color depth, avoid 24-bit color unless the quality of the video 
clip is essential. The fewer colors in your video, the more likely it will 
look better on older hardware. 

• Use sound sparingly. Most editors give you a choice of whether to 
include sound with the video. If your Web site doesn't require the sound, 
you can save yourself a considerable number of bytes if you drop a ll 
sound within your video clip. If your clip does require sound, I strongly 
suggest that you avoid adding stereo, and keep the quality of your 
sound files at 11025 Hz. 
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Here's a hot subject for Webmasters everywhere. Although your average 
Cyberspace John Smith may not be familiar with server push, it's likely to 
have just as much of an effect on the Web as the development of Java and 
JavaScript. In fact, this concept will change the way your browser receives 
content from Web sites over the next few years. But would I recommend it for 
simple animation? Read on! 

What exactly is server push? Put simply, server push is a method of trans
mitting content to your Web browser and updating it automatically, without 
requiring you to request the transfer by selecting a link or clicking a button. 
The connection between your browser and the server is never broken, as it is 
when you' re surfing in the usual way and you move on to the next site. In
stead, the server periodically sends new material to your browser to update 
the information on your screen; typically, the time interval depends on a CGI 
(short for common gateway interface) script running on the server. 

What Is Client Pull? 

Client pull is somewhat similar to server push, in that it automatically retrieves 
and updates the information displayed in your browser. However, unlike server 
push, the browser running on your computer must automatically connect , poll 
the server to check for new information, and then disconnect. You can consider 
client pull to be more of an automatic connection and update feature for your 
browser; all the server knows is that your browser connects, retrieves informa
tion, and disconnects, so on the server end, you're just another visitor. 

Server push and client pull have both been hailed as the technology that 
will transform the Web into a medium similar to television, with favorite Web 
sites "broadcasting" new content-for example, news and sports information, 
stock quotes, and other timely data that needs to be updated on a regular basis. 

"OK, now I know what server push is ... ut what does it have to do with 
animation?" The answer is actually pretty simple; you can add an inline image 
to your page with a URL pointing to a CGI script on the server, as in the fol
lowing HTML statement: 

<I MG WIDTH=320 HEIGHT=200 SRC="http://animate.cgi"> 

This image s tatement would normally call an inline image from the server, but 
instead, we're calling a CGI script. The CGI script will use the same image 
frames we would use to create the animation, but they're simply read on the 
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server side and sent in sequence to the visitor 's browser using server push. 
The text content on the page doesn't change at all, but the inline image is 
automatically updated by the CGI script. 

The entire server push process is controlled by the server side, which is a 
definite plus for those Webmasters who wish to monitor and direct the distri
bution of content. 

The Downside 

As I mentioned earlier, server push requires a constant connection between the 
server and the visitor's browser-and, as you might imagine, this connection 
can lead to a significant drain on a Web server. The more open connections, 
the less responsive the server. For this reason, larger companies that plan 
''broadcast" sessions on the Web using server push tend to use multiple serv
ers connected together with a local area network. 

Server push also requires knowledge of the CGI scripting language. Al
though it's certainly not difficult, many ISPs do not support CGI scripting for 
the Web pages hosted on their sites, so unless you're running a dedicated 
server, you may not be able to provide server push. 

Finally, I believe that server push is perfect for the delivery of content, but I 
also think that this technology is definitely overkill if you're simply looking 
for a way to provide animation for your Web page! The time-honored GIF 
animation we've built in earlier chapters is just as good as the animation 
created by server push, and you don't need CGI scripts. 

For additional information on server push and how you can implement it 
on your site, check out the discussion of this process on the Netscape home 
site at http://home.netscape.com/assist/net_sites/pushpull.html. 

Using Third-Party Plug-ins 

Finally, let's talk about one other advanced method of bringing animation to 
your Web page: third-party plug-ins that enhance Netscape Navigator and 
provide you with additional features. With the latest version of Navigator, 
plug-in installation has become about as automatic as possible, and you will 
rarely have to exit Navigator to take advantage of the new plug-in! 

Here's a listing of the most popular plug-ins currently available to add 
animation and digital video to your page: 
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• Shockwave. A product of Macromedia, Shockwave has probably at
tracted the most attention in the last year or so as the best-supported 
third-party animation p lug-in for Netscape. Shockwave animations, 
movies, and content are created with the company's Director program, 
or you can also use Flash or Authorware from the same company. The 
newest version of Shockwave supports streaming transfer, so you can 
start watching an animation or a movie before it has been entirely down
loaded. Many of the best Web sites around now feature arcade games, 
custom animated controls, animated backgrounds, and titles that use 
Shockwave. The plug-in is provided free at www.macromedia.com/ 
shockwave/download/ (as shown in Figure 9-3), but it takes quite awhile 
to download, and some of the nonstreaming Shockwave animations I've 
encountered will take several minutes to download as well! Versions are 
available for both Windows 95 and Macintosh. 

llllllll m acromedla shockwave 
DOWNLOAD , 

Welcome to the Shockwave Download Center Shockwave lets you expericoce animaiion and 
Clllt'flainmcnt on the web Follow the simple steps below to get yotr free Shockwave pla)cr 

1. Enter your Name & Email Addreu 

Name· 

:::===============~ 

2. Download Shoclnnv• 

To make ttungs easy. weW aelec:ted the nght Shockwavt pf ayer for your 
web browser and operating system 

VISl! ShockZ<nel 
All<r you've Snished 
mstallmg Shockwave, 
check out the coolest 
Shockwave p:ace on the 
web 

Need a diffueni 
Shoc.kwave? 
Oth<r playen & beta 
vertions arc al.Jo 

x.ailabl 

Figure 9-3: The Slzockwave plug-in download page at the Macromedia site. 

• Flash. Flash is another Macromedia product. In fact, most Webmasters 
view Flash as a subset of Shockwave, although it uses a different technol
ogy for drawing images. Flash is suited to creating animated buttons, 
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advertising banners, cartoons, and interactive interfaces with Windows 
WAV and MacintoshAIFF sound support; you can even add simple color 
transitions like fading. Depending on the size of the image and the com
plexity of the animation, Flash files often download faster than an 
equivalent animated GIF-and, since they're streaming, the animation 
begins to display before it has been fully downloaded. The Flash plug-in 
is much smaller than the Shockwave plug-in as well. Versions are avail
able for both Windows 95 and Macintosh. At this point, Flash is still in its 
infancy, but Webmasters who don't require the power of Shockwave 
have great expectations for it. You'll find complete information on Flash 
at www.macromedia.com/software/flash/. 

• Sizzler. If you remember Totally Hip Software's WebPainter from Chap
ter 8, you'll also remember that I mentioned the program would output 
animation in the company's Sizzler format. Sizzler is well-suited for 
simple animation, and it supports both sound and streaming transmis
sion. You can import QuickTrme movies or AVI digital video, as well as 
PIC or DIB format still images. Plus, both the plug-in and the editor are 
freeware! Both the Macintosh and Windows versions of Sizzler are avail
able at www.totallyhip.com/Products/Products.html. 

• CineWeb. This Windows 95 plug-in from Digigami takes care of the 
streaming display of the top three digital video formats on the Web: 
QuickTrme, AVI, and MPEG. More information is available at the com
pany site at www.digigami.com/cineweb/. 

• Stream Works. Xing Technology is already well-known as a leader in 
MPEG software, and the Stream Works plug-in provides streaming 
MPEG-1 and MPEG-2 video display with CD-quality audio. 
Stream Works supports the Intel Pentium MMX processor. The 
Stream Works player is available for Windows 95, Windows NT, 
Macintosh, and UNIX. You can learn more about Stream Works at 
www.xingtech.com/products/sw _player.html. 

The Downside 

I can't really think of very many disadvantages to using third-party plug-ins to 
provide animation-but the two that I have encountered can be intimidating. 

One drawback is the cost and time involved in providing your own custom 
Shockwave animation. Director is a very expensive program, and even Flash 
will cost you somewhat more than the shareware and freeware utilities we've 
used to create GIF animation. Make no mistake about it: these programs are 
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fully featured, and learning them will take a considerable amount of time-and 
you'll spend much more time developing a Shockwave animation than you 
would a GIF animation. If you're looking for a way to add plug-in animation 
to your page quickly and as inexpensively as possible, I highly recommend 
the Sizzler format. 

Second, plug-ins must be downloaded separately, and many Web surfers 
are growing tired of proprietary plug-in technology. GIF and Java animation, 
on the other hand, is supported within Navigator, so you don't need to spend 
time waiting for a plug-in to download before you can really enjoy a site. 

Moving On 

In this final chapter, you learned more about digital video, server push, and 
third-party plug-in technology-three types of animation that are currently 
leading edge and beyond the reach of most Webmasters. But as time passes, 
we may see them become as common as animated GIFs. 

And there's a good phrase to draw this book to a close: "as time passes"! In 
six months, who knows what technology may appear to provide Web surfers 
with new forms of animation? Perhaps you'll be able to interact with others, 
playing a game, designing a cartoon, or lending a hand in a full graphic ad
venture in cyberspace. Or maybe the next advancement will be practical live 
action video from a personal Web page or your own news service with video 
contributed from sites around the globe! GIF animation will remain popular 
for years to come because of its simplicity, and Java will continue to grow with 
the popularity of the Web, but the future rests with new ideas that haven' t 
even appeared yet. 

Whatever the advancement, whatever new tools await you, here's one piece 
of advice I can give that will never grow outdated: Always make your next 
Web animation project better than your last! 
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APPENDIX 

About the Companion 
CD-ROM 

A 

'l:'e CD-ROM included with your copy of the Official Netscape Guide to Web 
Animation contains valuable software, including modeling, rendering, and 
animation tools. Author, Mark Chambers, has also included inspirational JPEG 
images from his extensive portfolio. 

-- To View the CD-ROM: 

• Macintosh PPC -Double-click the "Launch Mac PPC" file. 

• Macintosh 68K- Double-click the "Launch Mac 68K" file. 

• WINDOWS 95 / NT - If Windows "autorun" is not enabled, double-click 
the LAUNCH32.EXE file. Or, go to START I RUN and type d:\(where dis 
the name of your CD-ROM drive) launch.exe in the space provided. 

• WINDOWS 3.lx - Double-click the LAUNCH16.EXE file in File Man
ager, or go to FILE I RUN and type d: \(where d is the name of your CD
ROM d rive)launchl6.exe in the space provided. 

You will see a small menu screen offering several choices. They include 
quitting the CD-ROM, viewing the readme, or launching the installers. For 
more detailed instructions on how to use the author example files, consult 
both the vreadme View _Me.htm files in the root directory. 
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Software on the CD-ROM 

A complete listing of the products in the Software Folder on the companion 
CD-ROM follows in Table A-1. 

Program 

Adobe Acrobat Reader 

Cel Assembler 

Egor 

Font F/X 

Description 

The Adobe Acrobat Reader allows you to view, navigate, 
and print PDF files across all major computing plat- . 
forms. Acrobat Reader is the free viewing companion to 
Adobe Acrobat 3.0 and to Acrobat Capture software. For 
more information, visit http://www.adobe:com. 

Cel Assembler 1.2 for Windows 95 is· a graphical tool 
for building and animating GIFs. The interface allows the 
user to view all the Image frames at once and to move/ 
copy/paste them intuitively. The usercan also easily set 
delays/palettes/erasure methods as well as optimize 
the animation to reduce file size. A full-featured preview 
shows the animation in real time ora frame ata time, 
and can be viewed while:the:animation ts:,being:edited 
for immediate feedback~ Cel Assembler makes anima
tion building easy. To find out more, ylsit http:// 
www.gamani.com. 

Egor fs the world's first commercial Java animator 
application. Use Egor's simple frame-by-frame assembler 
lets you create your ownJava animaUQm;, add soun~s,, 
and ~ssooiate URLs wlth·~ach frame orWlth th~:Whole. 
animation. Egor is the simplest and most effective way to 
get your page moving and shaking with Java. For more 
information, Visit http://wvm.sausage.com. 
With Font F /X .. 30 Font Rendering Software, anyone can 
add dramatic 30 graphic impact with ·unbelievable 
phot0:-realism to Web pages, docum~nts, and business 
presentations in.minutes. Unlike difficult, expensive, 
and harcJ.t~learn 30 graphics programs, Font F/X is 
easy to use, renders quickly, and utilizes all of your 
existing TrueType fonts to create fantastic textJmag~s. 
This demo includes the main program, online. c;foclimen;. • 
tation, extensive help, a step-by-step tutorial, and the 
Font F/Xiemplate and rexture Pack I, wnlch includes 
over 20 additlon:aLfonts and symbols, 29 pre-built~D 
templatest and· over 80 textures. FOr more ·1ntormati6n, 
check out http:/ /www.dcsifx.com. 



Program 

GIFBullder 

Graphic Converter 

Hot Chilli 

Jase Media Center 

Kai's Power Tools 

~ 

Appendix A: About the Companion CD-ROM 307 

Description 

GIFBuilder is a Macintosh utility to create GIF files. 
Animattld GIF files are standard GIF files that contain 
several Images and timing information; they can be 
used -.ij)S inline movies in Web pages. GIFBuilder 
supports drag and drop, transparency,. any dl~posal 
method; interlacing, custom color palettes, and the 
looping extension block defined by Netscape. It can 
open anim'3ted GIF files and Quicklime movies, and 
play animations. It Is native and scriptable. Go to http:/ 
/ia\YWW~~pf).011/Staff/Yves.Piguet. 

This application will convert files between most 
formats. ltcan also be used to read, save, and prepare 
graphic files for distribution over the Web. Detailed user 
instructions for Graphic Converter are available. or:rthe 
Web at http:/ /www.pen.k12.va.us/Anthotogy/Help/ 
Mac/graphic.converter.html. 

Hot Chilli creates Java applets quickly by using a simple 
point-and-click interface which guides you through the 
creation process, writing all the code for you. HotCf:lilll 
contains .cool effects which can be used to jazz up your 
Web pages. For more information about Hot Chilli, visit 
http:/ /www.webcreations.com.au/hotchilli. 

Jase Mectia Center offers complete multimedia file 
management! Just a few mouse clicks Will catalog the 
sounds, animations, and images on your hard disk, 
removable storage media, network, or CDs. Works with 
video, photo, Image, sound, and music files. Includes 
slide show presentation features, image format 
conversioni and batch image manipulation. Visit http:// 
www.Jasc.com for more information about this and other 
Jase products. 

A demonstration version of MetaTools, Inc. 's Kai's 
Power Tools 3.0. KPT 3.0 is available as a 32-blt native 
application extension for the lntel-basedWlndows95/ 
NT platforms, as well as for the Apple Macintosh/Power 
Macintosh platforms. Kai's Power Tools 3.0 is a unique 
and powerful collection of extensions that expand the 
power of image-editing applications which supportthe 
Adobe plug-in specifications. Visit http:// 
www.metatools.com. 
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Program Description 

Paint Shop Pro 16- and 32-bit versions of Paint Shop Pro, a powerful 
and easy-to-use image viewing, editing, and conversion 
program that supports over 30 image formats. With 
numerous drawing and painting tools, this may be the 
only graphics program you will ever need! Visit http:// 
www.jasc.com for more information about this and other 
Jase products. 

Photolmpact GIF Animator An award-winning 32-bit GIF animation composition tool 
that provides an intuitive workspace for producing 
compact GIF89a animations. Photolmpact GIF Animator 
features advanced color palette and optimization 
controls, powerful design features, and special effects. 
GIF Animator offers nine transition effects, including 
blind, split, and spiral , which give you variations for 
starting and closing your animations. An Add Banner 
text dialog box lets you create scrolling text banners 
anywhere within your animation. Smart frame compari
son chooses the best options for reducing frame sizes, 
and auto palette optimization converts any local 
palettes and reduces the global palette to only the 
needed colors. 

Photolmpact GIF Optimizer A Web imaging tool, Photolmpact GIF Optimizer batch 
optimizes GIF files to produce savable reports listing 
before/after file sizes for each file optimized, plus the 
total savings per folder. Eliminates duplicate colors, 
pixels, and non-essential elements to ensure foolproof 
optimization of the exact same image quality. Only 
redundant pixels and colors are deleted. No need for an 
image editing application, GIF Optimizer automatically 
goes through an entire list of GIF files at the click of a 
button. Works on single files, folders, or entire Web 
sites to reduce bandwidth, lower storage, and improve 
Web site performance. 

Pixel 30 Pixel 30 offers a wide variety of 30 capabilities including 
30 rendering, 30 file format translation, 30 logo 
creation, and 30 object optimization. Pixel 30 requires a 
Win32s environment on Windows 3.11. To find out more ' 
about this and other products from Forward Design, visit 
http://www2.wavetech.net/-pixelboy. 

Sculpt 30 Sculpt 30 is a complete, integrated 30 modeling, 
rendering and animation environment for Macintosh and 
Power Macintosh. It features an extensive suite of 
modeling tools, powerful texturing and lighting controls, 



Program 

SiteFX 

SoftF/X Pro 

The Ultimate Texture 
Collection 

trueSpace3 

VideoCraft GIF Animator 
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Description 

and a super-fast raytracing engine that produces superb 
images and fly-through animations. In order to use this 
Sculpt 30 demo, you must have Apple 's QuickTime™ 
extension, which you can download directly from Apple 
at http://quicktime.apple.com. For more information 
about this product, go to http://www.bytebybyte.com. 

SiteFX is a collection of compact JavaTM-based 
applications, each of which performs its "specialty" 
very well. Thanks to the intuitive interface and superb 
built-in Help files, SiteFX is very user-friendly. In one 
handy bundle, SiteFX provides efficient tools that are all 
you need to bring your Web pages to life. Go to http:// 
www.sausage.com. 

SoftF /X Pro is an integrated 30 modeling, rendering, 
and animation system for Windows 95/ NT4. For more 
information, visit http://www.bytebybyte.com. 

A demo version of Auto F/X's Photoshop plug-in compat
ible graphic design product, including three sample 
textures and an example of a lighting tile. This is a 
full working demo and will fuse a texture like the full 
version, but it will only work with demo version textures. 
The full version will work with any texture file. Visit 
http://www.autofx.com for more information. 

Like its predecessor, Caligari Corp.'s trueSpace3 is a 
fully integrated, intuit ive, modeless interface that 
makes it easier to learn and become proficient in 30 
graphics and animation. This new version of trueSpace 
includes an exciting array of new animation, rendering, 
human engineering, and Internet tools. This application 
requires Microsoft Oirectx to function. Visit http:// 
www.caligari.com for more information and to acquire 
Microsoft Directx. 

VideoCraft GIF Animator features seven powerful effects 
editors to create stunning Web animations and video 
special effects. Besides animated effects such as 
morphing and distorting, VideoCraft can be used to 
convert existing files to GIF animations. Please note: 
Windows 3.x users will need Video for Windows 
(available from Microsoft) for VideoCraft GIF Animator 
to function. Check out http://www.andatech.com for 
more information . 

Table A-1: Software on the Companion CD-ROM. 
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The JPEG files in the CD-ROM Resource folder illustrate a wide range of 
graphics techniques, from lighting and shading, to font manipulation and cool 
special effects. Copyright © Mark Chambers 1997, All Rights Reserved. 

-- Technical Support 

Technical support is available for installation-related problems only. The 
technical support office is open from 8:00 AM. to 6:00 P.M. (EST), Monday 
through Friday, and can be reached via the following methods: 

• Phone: (919) 544-9404 ext. 81 

• Faxback Answer System: (919) 544-9404 ext. 85 

• E-mail: help@vmedia.com 

• FAX: (919) 544-9472 

• World Wide Web: http:/ /www.vmedia.com/support 

• America Online: keyword Ventana 

Limits of Liability & Disclaimer of Warranty 

The author and publisher of this book have used their best efforts in preparing 
the CD-ROM and the programs contained in it. These efforts include the 
development, research, and testing of the theories and programs to determine 
their effectiveness. The author and publisher make no warranty of any kind 
expressed or implied, with regard to these programs or the documentation 
contained in this book. 

The author and publisher shall not be liable in the event of incidental or 
consequential damages in connection with, or arising out of, the furnishing, 
performance, or use of the programs, associated instructions, and/ or claims of 
productivity gains. 

Some of the software on this CD-ROM is shareware; there may be addi
tional charges (owed to the software authors/makers) incurred for their regis
tration and continued use. See individual program's README or 
VREADME.TXT files for more information. 



Glossary 

access privileges A user's rights on a host. Typically users are allowed to create 
or edit files only in their home directories and its subdirectories, though they can 
run programs from public directories. 

account An agreement with an organization allowing you to take advantage of 
various services. For instance, an account on an e-mail server lets you log on to 
send and receive e-mail. Accounts are often protected by authentication, requiring 
that you type in a user name and a password. 

activate To make a window the active one by clicking on it. 

active window The window with the highlighted title bar, where the user is 
currently interacting with a program. 

ACU Automatic Call Unit. Fancy name for a modem. 

address area The area in Messenger's New Message window where you can 
edit your list of e-mail addresses. 

Address Book A Communicator feature that lets you store individual e-mail 
addresses and address lists. 

Address Book Card An electronic record of an individual's name, e-mail ad
dress, etc., often used in e-mail. Also known as a vCard. 

address list A list of e-mail addresses. The address list lets you send e-mail to 
many individuals at once without entering each address. 

addressing The assignment of unique names or numbers to every node on a 
network so that information doesn't get misdelivered. 
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agents Search tool that automatically seeks out online information based on 
your queries. Also called intelligent agents, knowbots, and droids. 

algorithm The step-by-step process a software program uses to produce its 
results. 

alias An alternate name used in place of a "real" one. Rather than using your 
real name to log in to a system, you probably use a shorter alias. Commands can 
also have aliases. For instance, you can create command files on a UNIX system 
so that instead of typing ls -al to see all the files in your directory, you could just 
typedir. 

American Standard Code for Information Interchange See ASCII. 

anchor In HTML, the target of a link, usually in the same document. It is some
times also used to mean any link. 

application protocol A protocol that "sits on top of" the underlying transport 
layer of a communications system. For example, FfP and Telnet are application 
protocols that format data in particular ways and use the services of the lower
level TCP/IP transport layer. 

Archie A network service used for locating files available at Ff P sites that 
accept anonymous logins. 

ARP Address Resolution Protocol. Protocol used on a network for mapping 
Ethernet addresses to IP addresses. 

ARPAnet A wide area network developed in the 1960s by the Advanced Re
search Projects Agency of the U.S. Department of Defense. It links government 
and academic networks around the world. 

ASCII American Standard Code for Information Interchange. This standard assigns 
a binary value to common text and control characters. ASCII is used for manipu
lating text in a program and for transmitting text to other devices or systems. 

ASCII file A human-readable file made up only of letters, numbers, and sym
bols. An ASCII file contains no formatting except tabs, linefeeds, and carriage 
returns. Also known as a text file. 

assigned numbers The usual port numbers for well-known Internet services 
such as Telnet, Ff P, and so on. For instance, hosts usually wait for Telnet connec
tions on TCP port 23, for World Wide Web connections on port 80, and for Usenet 
news connections on port 119. These assigned port numbers are how the host 
knows what kind of connection is being requested. 
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asynchronous transmission The transmission of data without special timing 
information. Each character you transmit is made up of several bits of informa
tion. In asynchronous communications, the characters are "packaged," usually 
by special start and stop bits, so that the receiving hardware or software knows 
when it has received an entire character. This way, the interval between characters 
doesn't have to be fixed, and information can arrive at any time. See also synchro
nous transmission. 

Attachment A text or binary file included with an e-mail message. 

attachment encoding The method used to encode an attached binary file so 
that it can be delivered to the recipient via any intermediary systems without 
being corrupted. 

attachments list The list of attached files that will be sent along with an e-mail 
message. 

attribute (text) The display characteristics of text. Text attributes include bold, 
italic, underlined, and so on. In World Wide Web documents, text may be tagged 
with a wide variety of attributes using HTML. 

AU sound Audio format developed by Sun and used for sound files on the 
Web. Netscape browsers play AU files using the helper program NAPLAYER. 

authentication The process of identifying a user to determine if he or she 
should have access to a particular computer system. Name and password 
prompts are a form of authentication. 

authoring software Any software that lets you create HTML or other multime
dia documents. 

AVI Video format developed by Microsoft and often used for digital video on the 
Web. The latest version of Netscape Navigator comes with support for AVI video. 

bandwidth The range of frequencies that can be transmitted over a network, 
limited by the hardware. Higher bandwidth allows more information on the 
network at one time. 

baud rate The number of signal changes per second as data is transmitted from 
one device to another. For instance, 110 transitions per second from a high fre
quency to a low frequency on a phone line would be 110 baud. Each signal 
change may signify one bit of data (for instance, high frequency to low could 
signify 1, low to high could signify O); if a signal changes in multiple ways (fre
quency, amplitude, etc.), it may signify multiple bits of data. In the first case, 
baud rate would equal bits per second; in the second case, bits per second would 
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be higher than the baud rate. The difference between baud rate and bits per 
second is a common icebreaker at nerd parties. 

BBS See bulletin board system. 

BCC Short for blind carbon copy. A copy of an e-mail message that does not 
include information about who the other recipients are. 

binary Numbers composed of combinations of two different digits, specifically 
1 and 0. In the context of this book, binary data means information that may 
contain the full range of combinations of binary digits in a byte, as opposed to 
information that contains only the limited range of information that is 
displayable as text. Bytes of ASCII text contain only seven significant data bits, 
as in 1011001, while programs, graphics, spreadsheet files, and so on, contain 
eight significant data bits per byte, as in 10011011. 

binary file Any file, such as an executable or graphic, that cannot be read as 
text, usually containing characters that have eight rather than seven significant 
data bits and are therefore beyond the range of ASCII. In some cases binary files 
need to be encoded as seven-bit files in order to be transmitted across certain 
systems (see attachment encoding). 

BIND Berkeletj Internet Name Domain server. This is the DNS server on BSD and 
related UNIX systems. See also DNS. 

BinHex A file format, used mainly in the Macintosh world, for storing and 
transmitting binary data as ASCII text. This format is useful for transferring 8-bit 
data over 7-bit networks or data paths, or for including binary files as part of 
mail messages. Among UNIX and PC users, UUENCODING is more common. 

bit A binary digit, the smallest piece of information that a computer can hold. A 
bit is always one of two values, written as 1 or 0 and corresponding to the on/ off 
state of a digital switch or the high/low state of electrical impulses. Combina
tions of bits are used to represent more complex information, such as ASCII text 
or commands to the computer. 

bitmap A representation of an image as an array of bits. 

bit rate The rate at which bits are transmitted, usually expressed as a certain 
number of bits per second, or bps. See also baud rate. 

bits per second See bit rate. 

bookmarks In Netscape browsers, a means of permanently storing the URLs 
for sites you want to revisit. 
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bridge (1) A device, or a combination of hardware and software, for connecting 
networks together. (2) Something that goes over troubled water. See also internet. 

browser A software program, such as Netscape Navigator 4, that is designed 
for accessing documents on the World Wide Web, or HTML documents on an 
intranet. 

bulk cipher An encryption method used to encrypt large quantities of informa
tion. 

bulletin board system (BBS) An electronic version of the old cork bulletin 
board-a place to leave and collect messages and files. A modern BBS is really 
like a whole collection of bulletin boards, with different sections covering differ
ent areas of interest. Users can generally exchange public as well as private 
messages, and many BBSes include extensive areas for distributing shareware or 
public domain software. 

byte A combination of bits used to represent a. single character. In the world of 
personal computers, a byte is eight bits long. 

cable A bundle of wires or fiber strands wrapped with insulation and used to 
connect devices. 

cache An area of memory or a file used to store frequently accessed instructions 
or data. A memory cache is used to reduce hard disk access time. Memory and 
file caches are also used by Web browsers and other online programs to store 
images or data that rarely change; thus, a large home page does not have to be 
re-sent each time a connection is established. 

carrier A steady background signal on a communication channel used to indi
cate that the system is ready for the transmission of data. The carrier is then 
modified to represent the data transmitted. 

CC Short for carbon copy. A copy of a message sent to secondary or additional 
recipients. 

category In the context of Netsape Collabra discussion groups, a subdirectory 
used to organize similar groups. 

CCITT Consultive Committee on International Telegraphy and Telephony. This is an 
international standards-setting body that makes recommendations for interna
tional communications technologies. 

certificate See digital certificate. 

Certifying Authorities Organizations that distribute digital certificates. 
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CGI Common Gateway Interface. A standardized technique that lets Web clients 
pass information to Web servers, and then on to other programs that process the 
information. When a Web site accepts the information you enter into a form, it is 
usingCGI. 

channels Collections of information, usually including multimedia files, that 
are downloaded and then stored locally on your system. Subscribed-to channels 
may be updated on a regular basis so that they contain the latest information 
available from the provider. In Communicator, the Netcaster component is used 
to subscribe to, view, and configure channels. 

Channel Finder A Netcaster feature that lets you preview selected channels, 
which you may then subscribe to. 

character entities In HTML, special symbols that stand for other characters. 
Character entities begin with an ampersand(&) and end with a semicolon(;). For 
example, &gt; in an HTML document would appear on your screen as > (greater 
than). 

character set encoding The encoding methods that enable software to properly 
interpret characters and symbols from a variety of languages. To view Web pages 
that use the standard English alphabet, for instance, you choose the Latinl char
acter set. 

check box A Windows 95 and Wmdows NT control that lets you choose a 
particular option by clicking. Once you click, an X or checkmark appears in the 
check box; cl~ck again and it is cleared. 

CIX Commercial Internet Exchange. CDC is an agreement among Internet service 
providers allowing them to make the Internet available to commercial traffic. 

Clear To Send A signal from a DCE to a DTE indicating that circuits are ready 
for data transmission. See also DCE; DTE. 

clickable image In a Web page, an image you can click in order to access a 
different URL. See also image map. 

client A computer or a software program that can access particular services on 
a network. The machine or the software that provides the service for a client is 
called a server. For instance, an e-mail client would request received mail from 
an e-mail server. 

client pull A method specific to Netscape products whereby a Web client can 
request that the Web server send it a particular set of data. See also server push. 



~ 

Glossary 317 

client/server architecture A system in which a client program establishes a 
connection with a server and then requests information or services. See also 
client; server. 

client write key The software key used to encrypt data written or transmitted 
by the client in a client/server system. 

Clipboard or clipboard An area of memory where objects (data) are placed 
when a user carries out a Cut or Copy command or chooses a menu option. This 
data can then be passed to another program. 

Collabra The component of Netscape Communicator that lets you view and 
respond to intranet discussion groups as well as Usenet newsgroups. 

column heading A Windows 95 and Windows NT control that displays data in 
a multicolumn list. 

combo box A standard Windows 95 and Windows NT control that combines a 
text box and a list box. 

command button A control used to initiate a command; also known as a push 
button. 

command prompt A set of characters or a symbol that indicates where you type 
in commands. The DOS C: \ prompt is an example of a command prompt. 

Communicator The Netscape software suite that currently includes Navigator 
for Web browsing, Messenger for e-mail, Collabra for reading or participating in 
discussion groups, Composer for creating HTML documents, and Conference 
for interacting in real time with other individuals on the Net or on an intranet. 

Component bar The Communicator control that lets you access the various 
components of the program (Navigator, Collabra, etc.) by clicking on icons. The 
Component Bar may be anchored to the status line of the various Netscape 
programs, or it may "float" on your desktop. 

Composer The Communicator component that lets you create and edit HTML 
files. 

Conference The Communicator component that lets you interact in real time 
with other individuals across the Net or on an intranet. Features include full
duplex voice communication, chat, file transfer, a special graphical whiteboard 
for collaborative design and planning, and collaborative Web browsing. 

computer name On Microsoft networks, a unique name of up to 15 characters 
that identifies a particular computer on the network. 
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configuration registry In Windows 95 and Windows NT, a database that stores 
information about a computer's configuration as well as the configuration of 
various software. The registry may be edited by using the program regedit in 
Windows 95 or regedt32 in Windows NT. 

connect time The amount of time you're connected to a host or to a service 
provider. 

connection A link between two computers for the purpose of transferring or 
sharing information. 

container Any screen object that holds other objects; for instance, a folder. 

content-type The MIME name for particular types of files to be transferred by 
e-mail or the Web. For instance, the content-type for a GIF file is image/gif. See 
a/so MIME. 

control Any window object that lets you interact with a program by selecting 
an action, inputting data, and so on. 

Control menu The menu that pops up when you click the icon at the top left of 
a program's main window. It contains commands such as Move, Size, Maximize, 
Minimize, and Close. 

cookie A piece of system or configuration information transmitted between a 
Web server and the browser software and then often stored on the client ma
chine. Cookies enable a Web page to adjust its display or other configuration 
options for particular clients that connect. 

cross-platform Describes software that can be used on more than one operating 
system, such as Windows, Macintosh, and UNIX. 

CS LIP A common variant of the SLIP protocol that uses compressed IP head
ers. See also SLIP. 

cyberspace A slightly dated term referring to the entire world of online infor
mation and services. It was originally coined by the writer William Gibson. 

daemon UNIX-speak for a program that's always running on a server machine, 
waiting for requests for a particular service. For instance, an FTP server daemon 
sits and waits for an FTP client to connect and request files. 

data Information used or processed by a software program. 

data bits Bits that carry information as opposed to control information. For 
example, the bits in the middle of a byte might signify a text character and are, 
therefore, data bits, while the bits at the beginning and end of the byte merely 
mark the beginning and end of the data. 
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Data Carrier Detect (DCD or CD) A signal from a DCE, such as a modem, to a 
DTE, such as a PC, indicating that a commuhication channel has been estab
lished with a remote device. See also DCE; DTE. 

data-file object An object representing a data file (spreadsheet, document, 
image, sound clip, etc.) in the file system. 

Data Terminal Ready (DTR) A signal from a DTE to a DCE indicating that it's 
ready to receive and transmit data. Usually, a modem keeps DTR high as long as 
it's turned on. See also DCE; DTE. 

DCE Data Communication Equipment. A device used by a DTE to transmit and 
receive information. Your modem is a DCE. 

ODE See dynamic data exchange. 

decode To translate electronic information back into its original form. Unlike 
decrypting, decoding does not need any special key. See encoding. 

decrypt To translate electronic information back to its original form through the 
use of a special electronic key that insures privacy or security. See encryption. 

default In software, the "out of the box" value of a configuration option. The 
software will use this value unless the user explicitly indicates a different one in a 
setup program, property sheet, or .INI file. 

desktop The visual work area that fills your screen and holds the objects you 
interact with, such as icons, the task bar, and so on. The desktop is a container (or 
folder) that can also be used as a convenient place to access files. 

destination directory The directory to which you copy, move, or download a 
file or files. 

device driver A program used by the system to access devices such as video 
cards, printers, and mice. · 

dialog box In Windows 95 and Windows NT, a box that appears on your screen 
requesting your input; it engages you in a dialogue with the software. It may 
contain edit fields, check boxes, list boxes, radio buttons, and so on, and it stays 
on your screen until you click its Cancel or OK button. 

dial-up networking A facility built into Windows 95 that allows users to link to 
a network or to the Internet using phone lines. Similar to Remote Access Dialer 
in Windows NT. 

digital certificate A unique electronic key that identifies you and authorizes 
you to access secure Web sites. Also, a digital certificate may be included with an 
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e-mail message, identifying the originator of the message and allowing it to be 
encrypted. See also personal certificate, site certificate. 

digital signature The inclusion of a digital certificate (for instance with an 
e-mail message) that matches a key you hold, allowing decryption. 

dimmed A button, menu item, or other control is dimmed or grayed (displayed 
in light gray instead of black) to indicate it represents an option or command that 
is not currently available. 

dithered Images with a color depth greater than your display palette are dith
ered, resulting in a grainy effect. 

direct connection A permanent connection between a computer and the 
Internet as opposed to a temporary dial-up or SLIP/PPP connection. 

directory 1. A structure on a disk that contains files or other subdirectories. 
Also sometimes referred to as a folder. 2. A collection of names, addresses, and 
other contact information stored as part of a directory service, useful for looking 
up individuals for e-mail. 

directory service An Internet or intranet service used for looking up e-mail 
addresses or other contact information. 

directory tree A hierarchical display of a disk's directories and subdirectories. 

DLS server Dynamic Lookup Service server. A server that provides the e-mail 
addresses of, and other information for, people who want t0 be included in the 
list-in other words, a server that acts as a sort of phonebook. 

DNS Domain Name Service, an Int~rnet service that returns the appropriate IP 
address when queried with a domain-name address. 

dock To configure a toolbar so that it no longer floats, but lines up with the 
edge of a window or pane. 

document (World Wide Web) On the World Wide Web, a file or set of related 
files that can be transferred from a Web server to a Web client. The document 
may contain text, graphics, sound, or hyperlinks to other documents. 

document encoding See encoding. 

document window A window that lets you view the contents of a document. 

domain A collection of associated computers on the Internet, given a specific 
domain name that is used as part of the Internet address. For Windows NT 
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Server, a domain is also a uniquely named collection of computers that share a 
domain database and security policy. 

domain-name address The "plain English" address of a computer on the 
Internet, as opposed to its numeric IP address. For instance, www.echonyc.com 
is a domain-name address. 

download To get a file or files from a remote computer; the opposite of upload. 

draft A message that you're still working on, that is stored in a special holding 
area (the drafts folder in Netscape Messenger, for instance) until you're ready to 
send it. 

drag To move a mouse while pressing and holding one of its buttons. Dragging 
is used to move or resize objects on the screen. (Also known as "drag-and-drop.") 

droids See agents. 

drop-down combo box A Windows 95 and Windows NT control that combines 
a text box with a drop-down list box. 

drop-down list box A Windows 95 and Windows NT control that displays a 
current text selection, but that can be opened to display the entire list of choices. 

drop-down menu A menu that is displayed from a menu bar. 

DSU Digital Services Unit. The piece of equipment that enables transmission of 
data in synchronous digital connections to the Net. 

DTE Data Terminal Equipment. A device that serves as the originating point or 
the final destination of information. Typically, a computer or a terminal is a DTE. 

dynamic data exchange (DOE) The exchange of data between programs such 
that any change in the data in one program affects that same data in the other 
program. For instance, if spreadsheet data are shared via ODE by Word and Excel, 
any changes made to the data in Excel will also appear in the Word document. 

edit field See text box. 

electronic mail A network service for transmitting messages from one com
puter to another. Also called e-mail. 

ellipsis The " ... " added to a menu item or button label to show that the com
mand needs more information to be completed. When you choose a command 
with an ellipsis, a dialog box appears so you can enter additional information. 
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encoding The technique used for storing or expressing data. For instance, text 
may be stored via ASCII encoding or some form of encoding that uses compres
sion (such as ZIP). In Web browsers, document encoding refers to the translation 
of incoming characters into display fonts. For instance, you may set Netscape 
browsers to Japanese encoding so that information in a Japanese HTML docu
ment will be correctly displayed. 

encryption A method of encoding information for secure transmission. The 
data can be read in its original form only after it has been decoded. See also pub
lic-key encryption. 

environment variable A symbolic name associated with a string of characters 
used by an operating system or programs for its own informational purposes. 
For instance, the environment variable GIP _DIRECTORY could be set to C: \GIP 
so that a graphics program knows where to look for GIP files. Typically, you set 
an environment variable by using the Set command at a command prompt or in a 
batch file. In Windows NT, you can use the System option in the Control Panel to 
define environment variables. 

Ethernet A hardware system and a protocol that is commonly used to connect 
computers on a LAN. 

external viewer A separate program used by a World Wide Web browser to 
display graphics or to play sound or video files. After downloading a particular 
media file, the Web browser launches the external viewer program appropriate to 
the type of file. In order for this to work, you must configure your Web browser 
with the names of the external viewer programs you have on your system. An
other term for external viewer is helper application. 

extension The period and characters at the end of a file or directory name, often 
used to indicate the type of file or directory. For instance, INDEX.HTML includes 
the .HTML extension to indicate it is an HTML document. 

extranet A TCP /IP network that links businesses to customers, suppliers, etc.; 
part of an enterprise intranet that is made available to the outside world for 
marketing or other specific purposes. 

extrusion A term used in 3D rendering, especially 3D text. Adding an extru
sion makes a 30 object thicker, which typically enhances the 30 look of the 
finished object. 

e-zine A zine, or small non-mass-market magazine in electronic format. Some 
e-zines are text files distributed via electronic mail or posted on a BBS; others are 
Web pages with extensive graphics and even sounds. 
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FAQ Abbreviation for frequently asked question. FAQs are lists of frequently 
asked questions (and their answers) in a particular topic area. For instance, a 
Windows NT FAQ would help users understand the basics of using Windows 
NT by providing answers to common questions. Most mailing lists and network 
newsgroups regularly provide updated FAQs. It is important to read the FAQ for 
a particular newsgroup before beginning to post messages. 

file A named collection of ASCII or binary information stored on a disk or 
other storage device. Files include text, programs, databases, spreadsheets, 
graphics, and so on. 

file server A computer that provides storage space for files and applications 
that may be shared by network users. 

file system In an operating system such as Windows 95 or Windows NT, the 
structure used for storing, organizing, and naming files. 

file transfer protocol Any protocol for transferring files from one computer to 
another. A file transfer protocol usually includes provisions for making sure the 
data was transferred without errors and for resending any blocks of information 
that were corrupt. 

filter A facility for automatically organizing your received e-mail into separate 
folders. When your e-mail program retrieves messages that match criteria you've 
specified in a filter (for instance a particular name in the From header), it can 
automatically store those messages in a particular folder instead of your inbox. It 
can also delete the messages immediately. 

finger A UNIX program that lets you retrieve basic information about an 
Internet user or host. Finger is available via the Web at various sites. 

firewall Software and/ or hardware that places an electronic barrier between an 
internal network and the Net, allowing only controlled access. This protects the 
network from access by the outside world and may also be used to monitor or 
limit the Internet activities of employees in an organization. 

flag A characteristic of a file that may restrict its use in particular ways. A file 
may be flagged read-only, for instance. Also, a special designation for an e-mail 
message. Flagged messages may be found quickly in a list of messages. 

folder A container that holds and organizes objects, typically files or other 
folders. On the desktop, a folder may represent a directory in the file system; 
other folders within it are equivalent to subdirectories. 

font A particular style for displayed or printed characters, including the shape, 
weight, slant, and so on. 
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font size The size of a font; typically represented in units of measurement 
called points. 

FQDN Fully Qualified Domain Name. The full domain name of a computer on 
the Internet, including both the host name and the domain name. See also do
main-name address. 

frame A single image produced in a drawing package for use in animation; the 
subtle changes between frames create the movement in an animated GIF. 

frameset An HTML page that contains several frames. 

FTP Abbreviation for File Transfer Protocol. A particular file transfer protocol 
that is common on the Internet. It is also used as a verb, as in, "FTP me that file, 
wouldya?" 

full duplex A communications link in which both ends can transmit data 
simultaneously, as in a telephone conversation. In situations where you are 
working interactively online, full duplex communication lets a remote host echo 
back to you each character you type so that you can see what you're writing as 
you work. See also half duplex. 

FYI For Your Information. A series of technical documents on various Internet
related topics, available at many public FTP sites. See also RFC. 

gateway A device or the software that links networks that use different proto
cols. For instance, a Novell network might have an Internet gateway that "pack
ages" information into the TCP/IP packets required for Internet communication. 
The term gateway is also used in a very specialized sense to mean a program on a 
World Wide Web host that accepts and processes information sent by a Web 
client. For instance, a document on a Web server might display a form in which 
you can type your name; the gateway program would then enter your name in a 
database. 

GIF (Pronounced "jiff.") Abbreviation for Graphic Interchange Format. This is a 
format for compressed graphic files developed by CompuServe and Unisys. 

Gopher A menu-based client/ server system for exploring information re
sources on the Internet. A Gopher client is seamlessly built into Web browsers, so 
you don't need a separate Gopher client program. 

GopherSpace All of the information presented by a Gopher server, in the form 
of directory and file menus. 

grayed See dimmed. 
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half duplex A communications link in which both ends can transmit and re
ceive data, but not at the same time. Half duplex communication is like two-way 
radio or CB, where only one person speaks at a time. In situations where you are 
working interactively online in half duplex, you will not see characters you type 
echoed to the screen unless you set your communications program to echo them 
locally. See also full duplex. 

handle An interface element added to an object to enable the user to move, 
resize, or reshape it. 

handshaking The initial negotiation and the exchange of control information 
between a DCE and a DTE or between two DTEs in a communications link. 
Handshaking is necessary to make sure both devices are ready to transfer data 
and can "understand" each other. See also Data Carrier Detect; Data Terminal 
Ready; XOFF; XON. 

hardware handshake A protocol whereby a DTE tells the connected computer 
to start or stop sending data. Typically hardware handshaking is implemented by 
raising and lowering the voltage on the DTR (Data Terminal Ready) line in the 
cable that connects the DTE and DCE. See also XOFF; XON. 

header Text within a Web page that indicates the main point of the document 
. or of a section within it. Headers often use the specific HTML heading styles. See 

also message header. 

helper applications Programs that a Web browser such as Netscape Navigator 
3.0 uses to perform tasks such as displaying particular types of graphics, playing 
sounds, or initiating Telnet sessions. 

history list In Netscape Navigator 3.0, the list of Web documents you've dis
played during the current session. 

home page The HTML document you choose to display when you open a Web 
browser such as Netscape Navigator 3.0. It may be located on your own hard 
drive or on a remote Web server. Home page can also refer to the top-level docu
ment at a particular Web site. 

host computer A computer that a user can connect to in order to access infor
mation or run programs. A user may log in locally using a terminal or remotely 
using a computer and phone lines or the Internet. 

host b image map A graphic in a Web document that lets you click on certain 
portions in order to activate particular URLs. It has an associated map file that 
identifies these hot spots. See also clickable image. 
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IMAP Internet Message Access Protocol. A protocol that lets you access your 
e-mail messages on a remote server machine instead of retrieving them and 
viewing them on your own computer. The most common implementation of 
IMAP is IMAP4. It provides an alternative to POP3 e-mail servers. 

inactive window A window with which you are not currently interacting. Its 
title bar is not highlighted, and it receives no keyboard or mouse input. See also 
active window. 

inbox In Netscape Messenger, the folder where new e-mail messages are stored 
by default after retrieval from a POP3 or IMAP server. 

inline images Graphic images contained within World Wide Web documents. 
An inline image displays automatically as part of a document when it'is re
trieved; a non-inline image must be retrieved by clicking on a link. 

intelligent agents See agents. 

internet A larger network made up of two or more connected LANs (local area 
networks) or WANs (wide area networks). 

Internet The huge worldwide Internet made up of cooperative networks and 
using TCP/IP protocols to offer a variety of services. 

Internet access provider A business or organization that provides Internet 
access to consumers, often via dial-up SLIP or PPP connections. Also known as 
an ISP, or Internet service provider. 

Internet address See IP address. 

Internet presence provider An Internet-connected business that provides 
equipment and services to customers without equipment or technical expertise. 

intranet A network of connected computers that uses the same protocols and 
provides many of the same services as the Internet, but which cannot be accessed 
by the public. For instance, a corporation may have an intranet for its employees. 

IP address ·Also called Internet address. The unique address for each computer 
on the Internet. The IP address appears as a set of four numbers separated by 
periods. 

ISDN Integrated Services Digital Network. The telecommunications standard that 
supports digital transmission of voice, video, and data over phone lines. 

ISOC Internet Society. Organization that was formed to support a worldwide 
information network. 
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ISP Internet Service Provider. Another term for an Internet access provider. 

IPP See Internet Presence Provider. 

Java An object-oriented programming language developed by Sun 
Microsystems. It allows developers to create applications that may be run from 
within Web browsers such as Netscape Navigator 3.0. 

JavaScript A set of commands that can be added to HTML files to add func
tionality to Web documents. JavaScript is useful for scrolling text, data validation 
in forms, etc. 

JPEG A format for compressed graphics files. JPEG graphics are commonly 
used as part of World Wide Web documents. 

kbyte See kilobyte. 

kilobyte (K) 1024 (21°} bytes of data. Thus, a 64K file consists of 65,536 bytes. 

LAN See local area network. 

LDAP Lightweight Directory Access Protocol. A protocol that lets individuals 
search directories on the Net or an intranet. See also directory service. 

link A special hidden tag in an HTML document on the Web. It includes the 
URL for another file or document, or for another anchor point within the same 
document. When you click a word, phrase, or graphic that's tagged as a link, 
Netscape Navigator 3.0 automatically retrieves the appropriate target. 

list box A control that displays a scrollable list of choices. 

Live3D Netscape's VRML technology. 

LiveConnect Netscape technology that allows Navigator plug-ins, Java applets, 
and JavaScript to communicate with each other. 

local area network (LAN) A group of computers connected together by cable 
or wireless transceivers so that users can share resources such as database files, 
programs, printers, and so on. See also wide area network. 

log file A file that is automatically generated by software, indicating events 
that occurred such as errors, attempts to access your server, etc. 

log in To identify yourself to a remote system or network by typing in your 
login name and password. 

login name The name you use for security verification when you call into a 
remote system. 
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login prompt The prompt (usually login: or name:) a remote host uses to tell you 
it's ready for you to type in your login name. 

logon script A file containing simple commands that automate the process of 
logging on to a server, SLIP or PPP account, or other computer. In Windows NT, 
the files SWITCH.INF and MODEM.INF are logon scripts that automate the 
process of logging on to a remote machine using the Remote Access Dialer. In 
Windows 95, logon scripts generally have a .SCP extension and are associated 
with particular Dial-Up Networking connections using Microsoft's Dial-Up 
Scripting utility. 

log off To tell a remote host system or a network, using the appropriate com
mands, that you are terminating interaction. In many cases, logging off will also 
break the communications link to the remote machine. 

log on To tell a remote system or network, using the appropriate commands, 
that you are initiating a session. 

mail headers The informational fields at the beginning of every e-mail mes
sage, indicating sender, recipient, time and date sent, etc. Mail headers may not 
be visible in an e-mail program, but they are used by the program to organize 
messages. 

mail host An Internet or intranet server that sends e-mail for you and/ or 
temporarily stores your incoming messages. A client program like Messenger 
sends e-mail via a mail host and retrieves new e-mail from a mail ·host. 

mailing list A list of e-mail addresses. Messages sent to the list are actually sent 
to every member of the list individually. Mailing lists are useful for disseminat
ing information to established groups of individuals, or to subscribers who want 
ongoing information in a particular area of interest. 

mailto link A special kind of HTML link whose URL includes an e-mail ad
dress. When you click a mailto link, Communicator pops up a New Message 
window with the recipient's address already filled in. Mail to links are useful for 
soliciting response to a Web page. 

maximize To expand a window to its maximum size. See also minimize. 

maximize button The button used to maximize a window. In Windows 95 and 
Windows NT 4.0, it is the second button from the right in the title bar. 

megabyte (MB) 1024 kilobytes, or 1,048,576 bytes. 

menu bar A horizontal bar at the top of a window (between the title bar and 
the rest of the window) that contains menu choices. See also drop-down menu. 
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menu button A command button that displays a menu. 

menu item A choice on a menu. 

message box A window that appears to inform you of something, for instance 
that a connection has been established or that an error has occurred. 

message area The part of the main Messenger window that displays the actual 
contents of the currently selected e-mail message. 

message body The main content portion of an e-mail message, distinguished 
from the mail headers. 

Message Center In Communicator, the window that displays a list of e-mail 
and discussion group folders. 

message flag See flag. 

Message List window In Communicator, the window that displays a list of 
received e-mail and discussion group messages. 

message status How a message has been handled so far by the e-mail software 
and an individual recipient. For instance, a message's status may be new, unread, 
read, replied to, or forwarded. 

message thread See thread. 

Message window In Netscape Messenger and Collabra, the window that 
displays the actual contents of an e-mail or discussion message. 

Messenger The Communicator component that lets you send, retrieve, and 
organize e-mail messages. 

MIME Multipurpose Internet Mail Extensions. MIME is a convention for identify
ing different types of binary information, such as images or sounds, and thereby 
indicating the appropriate programs for viewing or playing this information. 
MIME is used in attaching binary files to e-mail messages so that they can be 
displayed or played automatically when received. 

minimize To minimize the size of a window; in some cases, this means to hide 
the window. See also maximize. 

minimize button The button used to minimize a window. 

modem Short for modulator I demodulator. A hardware device that connects 
your computer to other computers using analog telephone lines. 
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modem command An instruction, typed from the keyboard or transmitted 
automatically by a software program, that tells a modem to perform some action. 
For instance, the command ATHO tells a modem to hang up the line. 

moderator An individual responsible for viewing and approving discussion 
group postings before they are made available to the group as a whole. 

morph A computer visual effect where one image appears to gradually change 
into another. 

MOV QuickTime video format developed by Apple and often used for digital 
video on the Web. Most Netscape browsers require a plugin to view QuickTime 
movies. 

Mozilla This word stands for "Mosaic meets Godzilla." It is the name for the 
early Netscape products and for the Security Advisor. 

MPEG Moving Pictures Expert Group. MPEG is a standard format for com
pressed video files, sometimes known as "desktop movies." MPEG files may be 
part of World Wide Web documents, but they require a special helper applica
tion for viewing. 

multiple selection list box A special list box that's used for multiple indepen
dent selections. 

multiuser system An operating system, such as UNIX, that lets more than one 
user at a time access services. 

My Computer A Windows 95 and Windows NT 4.0 object (icon) that repre-
sents all of your local data storage. 

Navigator The Communicator component that lets you browse the Web or 
HTML documents on an intranet. 

NCSA National Center for Supercomputing Applications. NCSA is the department 
of the University of Illinois where the Web browser Mosaic was developed. 
Mosaic was the forerunner of all modern graphically based Web browsers. 

Netcaster The Communicator component that lets you display and configure 
channels. 

netiquette Proper behavior on the Net (derived from etiquette). 

Netscape Security Advisor A Communicator feature that helps you maintain 
and organize your digital keys and certificates, as well as showing you the secu
rity status of documents you access. 
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Netsite The label for Navigator's Netsite/Location field when you are access
ing a Web site that uses one of Netscape's server programs. 

network A collection of interconnected computers. Each attached computer 
runs its own software processes, whereas in an unnetworked multiuser system, 
users run all processes on the central host computer and use terminals simply to 
interact. A network lets users share information as well as devices such as print
ers, disks, and modems. 

network administrator In an organization, the individual who is responsible 
for configuring and maintaining the network. This is the person to talk to if you 
have problems with a direct "hard-wired" connection to the Internet. 

Network Neighborhood A Windows 95 and Windows NT 4.0 folder that in
cludes objects stored on a network file system. 

New Message window In Messenger, the window that lets you compose, edit, 
and send e-mail and Collabra discussion group messages. 

newsgroup A special forum that allows users to exchange messages (postings) 
in a particular area of interest. These messages are accessible by all members of 
the group. Some newsgroups, like the Usenet newsgroups, are accessible to the 
public; others, like those on Collabra servers, may be private. 

news host The computer that stores discussion group messages and makes 
them available to all memebers of the group. 

NFS Network File System. NFS is a set of protocols developed by Sun 
Microsystems for allowing computers running different operating systems to 
share files and disk storage. 

NIC Network Information Center. The organization responsible for supplying 
information about the Internet. 

NNTP Network News Transport Protocol. The protocol used by news hosts and 
client programs like Collabra to transfer discussion group messages over the Net 
or an intranet. 

NNTP host See news host. 

NOC Network Operations Center. The organization in charge of th~ day-to-day 
operations of a network on the Internet. 

node Any computer or other device on a network that has its own unique 
network address. 
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NTFS A file system that can be used under Windows NT. It supports a variety 
of advanced features including system recovery. 

object An entity that you manipulate in some way to perform a task. (Is that 
vague enough?) Typical objects are icons or folders on the desktop. 

offline Not currently connected to a remote computer or a network; not cur
rently on the Internet or an office intranet. 

online Currently connected to a remote computer or network. 

option button A control that allows a user to select one choice from a set of · 
mutually exclusive choices (also known as a radio button). Compare check box. 

outbox In Messenger and similar e-mail client programs, the folder that stores 
outgoing messages before they are actually delivered. For instance, when you 
work offline any messages you compose are stored in the outbox until you go 
online. 

packet A block of information that has been "packaged" with address informa
tion, error-checking information, and so on, for transmission on a network or on 
the Internet. 

parameter A variable that affects the results of a command. For instance, in the 
command dir /p, Ip is a parameter. 

parity A crude system of error-checking used in data communications. For 
most scenarios these days, your communications software should be set to "no 
parity." 

parsed HTML HTML files that are read and manipulated by separate soft-
ware on a server machine after the server software has answered a client request 
for the document. Using parsed HTML, for instance, a program could customize 
a Web document based on who requested it. Parsed HTML is also known as 
server-parsed HTML and SHTML. Often HTML files that will be parsed end with 
the extension .SHTML instead of .HTML. 

personal certificate A digital encryption certificate for which only you hold the 
decryption key. If you "sign" an e-mail message with your personal certificate, 
the recipient can then encrypt messages he or she sends you. See also digital 
certificate, site certificate. 

pixel The smallest unit of graphic information on a computer screen. Graphic 
images are usually measured in pixels, and a pair of pixel coordinates can indi
cate an exact point within an image. 
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plain text Text that doesn't contain any special formatting such as HTML tags. 

plain-text message In Messenger, an e-mail message that contains HTML tags 
and that hasn't been encrypted or encoded. 

plug-in Software program that extends the capabilities of Netscape Navigator. 
For instance, a plug-in may let you view PostScript files right within the browser 
window. 

PNG Portable Network Graphics. A standard for highly compressed graphics files 
that may include trillions of colors, multiple layers of transparency, and search
able text information. 

POP Point of Presence. The local dial-up node an Internet access provider makes 
available for its customers. 

POP3 Post Office Protocol, version 3. The protocol used by Netscape Navigator 
3.0 and other e-mail programs to retrieve messages from your e-mail server. See 
also SMTP, IMAP. 

pop-up menu A menu that appears right at the location of a selected object 
(sometimes called a shortcut menu). The menu contains items related to the 
selection. 

pop-up window A window with no title bar that appears next to an object and 
provides information about that object. 

port (1) A hardware connector on the back panel of a computer where you can 
plug in a serial, parallel, or network cable. (2) A unique number assigned to a 
particular Internet service on a host machine. For instance, most MUDs and 
MOOs require that you Telnet to a host using a specific port different from the 
standard Telnet port number. You can usually specify a port number as part of an 
Internet address, as in lambda.pare.xerox.com 8888. 

POTS Plain Old Telephone Service. What it sounds like; the current analog phone 
system, as distinguished from ISON and other digital technologies. 

PPP Point-to-Point Protocol. This is a protocol that lets a computer link to the 
Internet by calling in to a service provider using a modem and a standard tele
phone line. 

properties Characteristics of an object defining its state, appearance, or value. 
Often used to mean a program's settings. 

property inspector A viewer that displays the properties of the current selection. 
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protocol A set of rules for interaction between software programs on a network. 
Protocols may include requirements for formatting data, for passing control 
information back and forth, and for error checking. 

proxy A server that allows communication with the outside world (for instance 
the Internet) through a firewall. When a client behind a firewall requests a specific 
Internet service, the request actually goes to the proxy, which then relays it on. 

public-key encryption An encryption method that requires two unique soft
ware keys (one public and one private) for decrypting the data, making it secure 
across public networks. Pretty Good Privacy (PGP) is a well-known public-key 
encryption system. 

query sh'ing The word or phrase you pass to a Web search engine. 

QuickTime A multimedia file format developed by Apple. It is often used for 
video clips or "movies." 

quoted-printable A MIME type for binary data that has been specially en
coded to seven-bit ASCII text so it can be transmitted across a variety of net
works. The recipient's software must then decode it back to binary data. 

radio button See option button. 

random access memory (RAM) Computer memory that temporarily stores 
information; for instance, software code that you've loaded by launching a pro
gram or data that you're processing. Generally, the more of it, the better! 

raytracing An advanced feature offered by some 30 rendering programs where 
the path of light rays are accurately calculated. Raytracing is used to add shad
ows, mist, and other lighting effects to a rendered image. 

read-only memory (ROM) Computer memory containing data that cannot be 
changed by the user and that remains even when the computer is turned off. 
ROM is used for storing your computer's BIOS, for instance, which is the code 
that lets you boot up and that performs a variety of low-level functions. 

refresh In Netscape Web browsers such as Navigator 3.0, the command that 
reloads a document into the browser window from a disk or memory cache. 

regedit A program in Windows 95 for editing the configuration registry. In 
Windows NT this program is called regedt32. 

registry See configuration registry. 
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reload In Netscape Web browsers such as Navigator 3.0, the command that 
reloads a document into the browser window from its original local or remote 
source. 

remote Any system that you can connect to by using only communications 
devices rather than just local wiring. 

Remote Access Dialer A Windows NT program for connecting via ordinary 
phone lines or ISON to a remote computer, often used for SLIP or PPP connec
tivity. 

remote computer A computer you link to via telephone lines, satellite, or other 
communication links. 

rendering The creation of a 30 image on a computer, usually from a 30 model. 

resolution The density of an image, expressed in dots per inch. 

restore button The button that replaces the maximize button once a window 
has been maximized. It lets you return the window to the size it was before 
maximizing. 

reverse lookup The process of looking up the domain name of an Intemet
connected computer when all that's known is the numeric IP address. For in
stance, you may have a numeric IP address assigned by a SLIP or PPP access 
provider, but no associated domain name. When you try to log in to certain 
security-conscious FfP sites, the host software looks up your domain name via 
ONS reverse lookup. If it can't find one, you are not allowed on the system. See 
also domain-name address. 

RFC Request for Comments. An RFC is a proposal or report electronically distrib
uted via the Internet, usually for the purpose of elucidating or helping to define a 
new Internet technical standard. 

rich text Text that contains HTML or other special formatting. See also plain 
text. 

rich-text message A message that includes encoded, encrypted, or HTML
formatted content. See also plain text message. 

root directory The top-level directory on a disk such as your hard drive. For 
example, C: \ would be the root directory of your C: drive. 

RS-232 The standard used by your serial port. RS-232 lines are the individual 
pins and wires that make up the hardware interface, such as the send data line, 
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the receive data line, and the various hardware handshaking (or hardware flow 
control) lines. 

RTF Rich Text Format. A file format that can be read by many word processing 
programs across all platforms. 

RTS/CTS Ready to Send/Clear to Send. In an RS-232 serial port, the two lines that 
allow two devices to signal each other when they are ready to send or receive 
data. This process is known as hardware handshaking or hardware flow control. 
See also RS-232. 

script A software program that.doesn't need to be compiled. It is run by an
other program "as is," in human-readable form. See also logon script. 

scroll bar The control that lets you move the image or text within a window 
either horizontally or vertically to view data that is not currently visible. 

search engine A program on the Net that lets users search for online informa
tion. Typical search engines include lnfoseek and Alta Vista, both available from 
Netscape's Search page. 

security key A special file that is needed in order to access a secure document. 
See also public key encryption. 

server A computer or a program that provides a particular service on a network 
or on the Internet. Typical services include file access, printing, e-mail, FfP, and 
so on. The computers and software that access servers are called clients. 

server push A technique specific to Netscape products whereby a Web server 
can initiate the transmission of data to the Web client. Server push is often used 
for animation or sound. See also client pull. 

server write key The software key used to encrypt data written or transmitted 
by the server in a client/server system. See also client write key. 

service A specialized function or utility provided by a server. 

service provider An organization, usually commercial, that provides connec-
tions to the Internet. · 

session A connection between two machines on a network or on the Internet. 

SGML Standard Generalized Markup Language. A high-level standard for the 
electronic publication of information. HTML is a subset of SGML. 

shell account An account with an access provider that lets you access a text
based system for performing routine Internet tasks. You connect to a shell ac-



~ 

Glossary 337 

count via Telnet or a dial-up terminal emulation program. Some Internet access 
providers let you put your own Web pages on their server using a shell account. 

shortcut A desktop icon that can be used as a quick way to launch a program or 
document. Another word for hotlink in a WWW document. 

SHTML See parsed HTML. 

signature A text file that contains any information that you want to attach 
regularly to your e-mail messages and network news posts. A signature is 
usually less than five lines long and contains contact information. 

single selection list box A list box .that lets you choose only a single item 
from a list. 

site certificate A digital certificate that lets you send an encrypted message to 
all recipients at a particular site. See digital certificate, personal certificate. 

slider A control that displays a continuous range of values and lets you 
choose one. 

SLIP Serial Line Internet Protocol. Like PPP, this is a protocol that lets a computer 
link to the Internet by calling in to a service provider using a modem and a 
standard telephone line. 

S-MIME Secure Multipurpose Internet Mail Extension. A secure version of MIME, 
useful for insuring e-mail privacy. 

SMTP Simple Mail Transfer Protocol. The most common protocol for sending e
mail messages over the Internet. See also POP3. 

snail mail A form of messaging that utilizes carbon-based materials to create and 
address human-readable data, which is then transmitted over a complex network 
of streets and air routes by human entities known as "postal employees." 

snews Part of a domain address indicating a secure news (discussion group) 
server. For example, snews. whatever.com would be a secure news server, while 
messages on news.whatever.com would not be automatically encrypted. 

sockets A software mechanism that allows programs to communicate locally 
or remotely by setting up endpoints for sending and receiving data. The appli
cation programmer does not have to worry about the nuts-and-bolts details of 
how the data travels from one point to the other, as that is taken care of by the 
operating system or other resident software. The Wmdows Sockets API 
(Winsock) uses this concept. 
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SOCKS A protocol that lets a host server on an internal network access the Web 
through a firewall. 

spam Unsolicited messages that are sent to many e-mail recipients or posted in 
several discussion groups. Spam is an aggressive electronic version of junk mail 
and is considered an egregious violation of netiquette. 

spin box A control that displays a limited range of values and lets you choose 
one. 

SSL Secure Sockets Layer. A version of the HTTP protocol that includes encryp
tion. SSL allows for the secure transfer of sensitive information across the Net, as 
in financial transactions. 

string Geek-speak for a set of characters. Your name, for instance, is a string. 

symbolic link A name that does not refer to an actual object but points to 
another name. For instance, on an FTP site, a directory list might include the 
entry WINDOWS, even though there is no WINDOWS directory at this level. The 
WINDOWS entry could be a symbolic link to a directory buried much deeper in 
the file system, such as /pub/micro/pc/GUI/windows. Symbolic links provide 
convenient shortcuts to actual objects. 

synchronous transmission A method of transmitting data that uses a special 
timing signal to ensure a set time interval between any two characters. See also 
asynchronous transmission. 

tag A special code used in an HTML document to indicate how a piece of text 
or a graphic should be displayed by a Web browser; it may also establish a link 
to another document. 

target The reference the browser "jumps to" when a user clicks on a link. The 
word is usually used for references within the same document. 

TCP/IP Transmission Control Protocoinnternet Protocol. TCP /IP is a set of proto
cols that applications use for communicating across networks or over the 
Internet. These protocols specify how packets of data should be constructed, 
addressed, checked for errors, and so on. 

Telnet A program that lets you log in to a remote host computer and access its 
data and services as if you were using a text-based terminal attached locally. 

terminal A keyboard and display screen used to access a host computer. 

terminal emulation A software program that lets you use a personal computer 
to communicate with a host computer. It transmits special commands and inter
prets incoming data as if it were a terminal directly connected to the host. 



text box A control that lets you enter and edit text. 

text file See ASCII file. 
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text-only Containing no visual information other than human-readable ASCII 
text. When you Telnet into a UNIX system, for instance, your user interface is 
text-only, as distinguished from the graphical user interface of systems like 
Windows. 

thread A software process or task. Operating systems like Windows 95 and 
Windows NT allow for many threads to occur simultaneously. 

title bar The horizontal bar at the top of a window that includes the window 
name. The title bar also acts as a handle that can be used to drag the window. 

title bar icon The small icon at the top-left comer of the title bar. You can use it 
to display the pop-up menu. Double-clicking this icon closes the program. 

toolbar A control that provides a defined area for a set of other controls such as 
icon buttons, drop-down list boxes, and so on. 

traffic Data traveling across a network or across the Internet. 

tree control A control that lets you display a set of hierarchical objects in an 
expandable outline format. 

upload To send a file to a remote system; the opposite of download. 

URL Uniform Resource Locator. A URL is a specially formatted address that a 
Web browser uses to locate, retrieve, and display a document. The URL includes 
the Internet address of the data, where it is located on the Web server machine, 
and what kind of transport protocol is required to retrieve it. URLs are contained 
in the hotlinks within HTML documents; they may also be specified by the user 
of a Web browser "on the fly." 

Usenet A large collection of networked users who communicate using the 
UNIX-to-UNIX Copy Protocol (UUCP) rather than TCP/IP. Usenet is connected 
to the Internet by gateways, and many Internet users are familiar with its broad 
range of discussion forums known as newsgroups. 

UUCP UNIX to UNIX Copy. An older set of network commands for sending 
and receiving data on dial-up networks. 

Uuencoding A standard for encoding binary data that allows it to be transmit
ted as 7-bit ASCII information; it is then uudecoded into its original binary form. 

VCard See Address Book Card. 
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virtual server A server that appears like a separate server to clients, but which 
actually runs on the same machine and uses the same server software as other 
servers. For instance, the Netscape FastTrack server lets you set up 
www.serverl.com, www.server2.com, and www.server3.com all at once. Some
body logging onto www.server2.com would access different information from 
somebody logging onto www.serverl.com. 

VRML Virtual Reality Modeling Language. VRML is a specialized language that 
allows for the creation of three-dimensional user interfaces that can be accessed 
via Web browsers such as Netscape Navigator 3.0. 

WAIS Wide-Area Information Server. WAIS is a specialized Internet client/ server 
system for researching information in Internet databases. 

WAN See wide area network. 

Web Short for World Wide Web. 

Web browser A program for retrieving and viewing HTML documents on the 
World Wide Web. Also known as a Web client. 

Web document Any document available on the World Wide Web. 

Webmaster The individual in charge of developing or administering a Web site. 

Web server A computer that stores Web documents and allows Web browsers 
to retrieve them over the Internet using the HITP protocol. Also, the software 
that makes this possible. 

Webtop ANetcaster channel that's anchored to the desktop and often used as a 
primary user interface. Other channels may appear within the Webtop. 

wide area network A group of computers and/ or networks connected to one 
another by means of long-distance communication devices, such as telephone lines 
and satellites, rather than just through local wiring. See also local area network. 

widget In HTML geek-speak, an object in a Web document that accepts user 
input. Examples are check boxes, radio buttons, drop-down lists, and so on. 

wildcard character A character used when you specify a filename; it is a vari
able that stands for any other valid character or characters. The question mark (?) 
stands for a single character, while the asterisk (*) stands for any string of charac
ters in the filename. For instance, *.txt means "any file that has the .TXT exten
sion"; ??.txt means "any file that has a two-letter name and the .TXT extension." 



~ 

Glossary 341 

Windows NT Server The version of the Windows NT operating system that 
provides centralized network management and security as well as additional 
connectivity options. 

Windows NT Workstation The version of the Windows NT operating system 
that provides operating and networking functionality, but without centralized 
management. 

Winsock Windows Sockets API. A software "toolkit" that lets Windows program
mers access TCPnP services using a standard interface. Any Internet programs 
that use this standard, such as e-mail clients, Web browsers, and so on, will work 
under Windows 95 and Windows NT. 

workgroup On Microsoft networks, a collection of grouped computers with a 
. unique name. 

workstation In Windows NT, a computer running the Windows NT Worksta
tion software. 

World Wide Web (WWW) An Internet service used for browsing hypermedia 
documents; the "Internet within the Internet" formed by all the Web servers and 
HTML documents currently online. 

WYSIWYG What You See Is What You Get. A description of data that already 
looks like the final output as you work on it. For instance, a WYSIWYG HTML 
editor like Composer lets you move graphic elements around the page rather 
than typing in HTML code. 

XOFF A special character that's used to control the flow of information between 
a DCE and a DTE. When one device receives an XOFF character from the other, it 
stops transmitting until it receives an XON. 

XON A special character used to control the flow of data between a DCE and a 
DTE. See also XOFF. 
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Color Texture and Surface dialog box (Sculpt 30) 228 
command blocks (GIF Construction Set) 117 

COMMENT 117 
CONTROL 117, 121, 125 
IMAGE 117, 121 
LOOP 117, 123 
PLAIN TEXT 117 

COMMENT block (GIF Construction Set) 117 
commercial clip art files 51-52 
compression 

for digital video 295-296 
of image files 63, 82-85 

contrast (of images), editing 62-68 
CONTROL block (GIF Construction 

Set) 117, 121, 125 
Cool Button applets, creating (with Hot Chilli) 

282-283 
Copy command (Paint Shop Pro) 63, 75 
copyrights (for images) 24-27, 25 
Corel 

Professional Photos CD-ROM series 52 
Web.Graphics Suite 52 

cropping (images) 63, 72-75 
cross-fading 100 
Crystallize filter (Adobe Photoshop) 164 
Cut command (Paint Shop Pro) 63, 75 

D 
daisy-chaining 55 
DCSIFontF/X 230-232 
Decrease Color Depth dialog box 70 
delays, adding to animation (with GIF Construction 

Set) 125 
depth (of color) 12 

editing 70 

True Color 70 
dialog boxes 

Add Borders (Paint Shop Pro) 64 
Add Text (Paint Shop Pro) 25 

Index 

Batch Conversion (Paint Shop Pro) 80 
Brightness/Contrast (Paint Shop Pro) 67 
Build Logo (Pixel 30) 212 
Build Text (Pixel 30) 211 
Capture Setup (Paint Shop Pro) 41 

Activate Capture Using setting 41 
Capture setting 41 
Options settings 41 

Color Texture and Surface (Sculpt 3D) 228 
Decrease Color Depth (Paint Shop Pro) 70 
Duplicate Layer (Adobe Photoshop) 177 
Edit Banner (GIF Construction Set) 125 
Edit Header (GIF Construction Set) 118 
Edit Loop Block (GIF Construction Set) 112 
Edit Transition (GIF Construction Set) 131 
GIF File Preferences (Paint Shop Pro) 92 
Glass filter (Adobe Photoshop) 170 
JPEG File Preferences (Paint Shop Pro) 83 
Motion Blur filter (Adobe Photoshop) 163 
Output Options (HiJaak Morph) 248 
Output Size (Kai's Power Goo) 263-264 
Paint Daubs filter (Adobe Photoshop) 162 
Posterize (Adobe Photoshop) 158 
Red/Green/Blue (Paint Shop Pro) 68 
Resample (Paint Shop Pro) 86 

Maintain aspect ratio field 87 
Rotate (Paint Shop Pro) 89 

~ 
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Select Bitmap Background Color (Pixel 3D) 220 
Shear filter (Adobe Photoshop) 171 
Smooth Converted Bitmap Object (Pixel 30) 221 
Specify Axes (Pixel 30) 218 
SuperCompress (GIF Construction Set) 145 
Texturizer filter (Adobe Photoshop) 167 
Threshold (Adobe Photoshop) 156 
Transition Effects (Animagic GIF) 142 
Wmd filter (Adobe Photoshop) 166 
ZigZag filter (Adobe Photoshop) 173 

Digigami CineWeb 302 
digital cameras 14, 57-58, 294 
digital capture boards 294 
digital clip art 294 
digital video 57-59, 294-298 

adding to Web page 297-298 
audio 298 
color depth considerations 298 
frame rate 298 
frame size 297 

.AVI format 294 
camera5 57-58, 294 
capture hardware 58-59, 294 
client pull 299 
clip art 294 
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codecs (compression software) 296 
Cinepak 296 
Indeo 296 
MPEG 296 

compression 295-296 
exporting 294 
external 296-297 
inline 296-297 
MPEG format 295 
plug-ins 300-303 

CineWeb (Digigami) 302 
Flash (Macromedia) 301 
Shockwave (Macromedia) 301 
Sizzler 302 
Stream Works (Xing Technology) 302 

QuickTune 294 
server push 299-300 
streaming 295-296 

dirty rectangle compression 146 
Distort filter family (Adobe Photoshop) 168-187 

Glass filter 169-171 
Glass filter dialog box 170-171 

Ocean Ripple filter 169-171 
Pinch filter 168-169 
Ripple filter 169-171 
Shear filter 171...:.172 

Shear filter dialog box 171-172 
Twirl filter 174-176 
ZigZag filter . 172-174 

ZigZag filter dialog box 173-174 
dissolves (in animation) 100 
distorting (images) 

foranimation 168-187 
object distortion 168 
surface distortion 168 

dithering 10 
DOS, image acquisition with 40 
dpi ratings (for scanners) 55 
driver programs (for scanners) 56 
Duplicate Layer dialog box (Adobe Photoshop) 177 

E 
Edit Banner dialog box (GIF Construction Set) 125 
Edit Header dialog box (GIF Construction Set) 118 
Edit Loop Block dialog box (GIF Construction 

Set) 112 
Edit Transition dialog box (GIF Construction Set) 131 
editing (images) 61 

brightness 62 
contrast 62 

Egor Animator (Java animation tool) 287, 306 
EPS (encapsulated PostScript) 51 
Excite search engine 31 
externalvideo 296-297 
extrusion (30 rendering) 203 

F 
Fading Scroll Messages, creating (with Hot 

Chilli) 278-280 
File Transfer Protocol, see FTP 
files 

converting (with Paint Shop Pro) 63 
multiple files 80-81 
single files 79 

GIF 89a format 82 
metafiles 50 
.PNG format 82 
.TIF 50 

Filter Sample Gallery (Adobe Photoshop) 159 
filters 

Adobe Photoshop 159-176 
applying 160-161 
Crystallize 164 
dialog box example 160-161 
Distort 168-187 
Filter Sample Gallery 159 
Glass 169-171 
Motion Blur 163 
Ocean Ripple 169-171 
Paint Daubs 161-162 
Pinch 168-169 
Ripple 169-171 
Sharpen Edges 164-165 
Shear 171-172 
Texturizer 166-168 
Twirl 174-176 
Wind 165-166 
ZigZag 172-174 

installing 160 
Flash plug-in (Macromedia) 301 
flatbed scanners 54 
flipping (images) 63, 81 
Font FIX (DCSI) 230-232, 306 
fonts 

30 rendering (object creation from) 200-205 
footer graphics 18 
Forward Design Pixel 30 190 
frames 

animation 99 
frame rate 99 
limitation on number of 102 

digital video 
frame rate 298 
frame size 297 

Free Web Graphics site 47-48 
Freehand Selection tool (Paint Shop Pro) 77 
FTP (File Transfer Protocol) 

Archie 32-35 
Veronica 35-37 

Fusion room (Kai's Power Goo) 264-267 



G 
Gamelan site 291 
Games Domain site 8 
GIF animation 

color depth 12 
file size considerations 198 
rendering 197-198 

GIF Construction Set (Alchemy Mindworks) 108-132 
animation with 

blocks 117 
manual 116 

Animation Wizard 110-116, 124 
compared to manual animation 124 

command blocks 
COMMENT 117 
CONTROL 117, 121, 125 
IMAGE 117, 121 
LOOP 117, 123 
PLAIN TEXT 117 

delays 125 
Edit Banner dialog box 125 
Edit Header dialog box 118 
Edit Loop Block dialog box 112 
Edit Transition dialog box 131 
Insert Object toolbar 119 
LED signs 128-130 

previewing 130 
looping with 112 
palette options 119-121 
previewing animation with 115 
sectional animation with 182-186 
SuperCompress dialog box 145 
text banners 125-128 

previewing 127-128 
transitions 130-132 
user interface 109 

GIF File Preferences dialog box 92 
GIF files 

adding transparency to 91-93 
animating 99 

manually 116-124 
file compression 63, 82-85 
GIF 89a format 82 
interlacing 63, 85 

GIF Wizard online compression page 147 
Giffiuilder 133-135, 307 

animating with 134-135 
adding transitions 135-136 

user interface 133 
Graphic Converter 307 
graphics, see images 
gray scale conversion (images) 63, 82 
Grow /Shrink button (Kai's Power Goo) 255 
Guided Activities (PhotoDeluxe) 94 
guidelines (for images) 6-7 

Index 

H 
hand scanners 54 
high-contrast images, creating with Adobe 

Photoshop 155-157 
HiJaak Morph 241-250 

mesh 246 
Output Options dialog box 248 
transitional animation with 242-250 
user interface 241 

Hot Chilli Oava) 271-283, 307 
Cool Button applet creation with 282-283 
Fading Scroll Message creation with 278-280 
LED display creation with 272-275 
Pull Menu applet creation with 283-285 
Status Scroll Message creation with 280-281 
Super Scroll Message creation with 275-278 
support site 272 

HTML 
Official HTML Publishing for Netscape 9 
standard color palette 10-12 

icon bars, borders for 65-66 
IMAGE block (GIF Construction Set) 117, 121 
images 

acquiring 
acquisition programs (for scanners) 56 
availability considerations 14 
clip art 46-53 
digital video 57-59 
DOS 40 
Free Web Graphics site 47-48 
from commercial clip art 24 
from digital photographs 24 
from electronic documents 43-45 
from film photographs 24 
from Internet 27-40 
from other electronic documents 23 
from other programs 23, 40-43 
from other Web pages 23, 37-40 
from videotape 24 
legal issues 24-27 
searching for 28-37 
with Archie 32-35 
with Microsoft Word 43-45 
with Paint Shop Pro 41-43 
with separate save method 45 
with Veronica 35-37 
with Windows Clipboard 43-45 
with Yahoo! 28-32 

adding text to (with Paint Shop Pro) 25-27 
Adobe Photoshop 

image adjustment effects 154-158 

~ 
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Inversion command 154-155 
Posterize function 157-158 
Threshold command 155-157 

Animagic GIF 140-142 
animating 

command blocks 117 
manually 116-124 
preparation for 103-108 
process overview 98-108 
usability testing 142-144, 143-144 

appearance considerations 3-6 
as text separators 17 
background textures 17 
borders 

editing 64-66 
for icon bars 65-66 

brightness, editing 66-68 
browser compatibility considerations 8-9 
clip art 

from CD-ROMs 49 
professional collections of 51-52 

color 
alterations 101 
depth editing 70--72 
gray scale conversion 82 
gray scaling 63 
level editing 68-69 
posterizing 148-149 
True Color 70 

contrast editing 66-68 
copyrights for 25 
cross-fading 100 
digital cameras 14 
dissolves 100 
distorting 168-187 

object distortion 168 
surface distortion 168 

editing 61 
borders 62 
brightness 62 
color 62 
color depth 62 
contrast 62 
cropping 63, 72-75 
Freehand Selection tool (Paint Shop Pro) 77 
Magic Wand tool (Paint Shop Pro) 78-79 
Select Shape tool (Paint Shop Pro) 76 

files 
compressing 63, 82-85 
converting (with Paint Shop Pro) 63, 79-81 

filters (Adobe Photoshop) 159-176 
applying 160--161 
Crystallize 164 
dialog box example 160--161 
Distort 168-187 
Filter Sample Gallery 159 

Glass 169-171 
installing 160 
Motion Blur 163 
Ocean Ripple 169-171 
Paint Daubs 161-162 
Pinch 168-169 
Ripple 169-171 
Sharpen Edges 164-165 
Shear 171-172 
Texturizer 166-168 
Twirl 174-176 
Wmd 165-166 
ZigZag 172-174 

flipping 63, 81 
footer graphics 18 
frames, creating with Paint Shop Pro 104-106 
GIF Construction Set 108-132 

Animation Wizard 110--116 
user interface 109 

GifBuilder 133-135 
animating with 134-135 
transitions with 135-136 
user interface 133 

guidelines for 6-7 
high-contrast 

Threshold command (Adobe Photoshop) 
155-157 

icons 
bars, borders for 65-66 
buttons 17 

included with application CD-ROMs 52-53 
interlacing 63, 85 
Langley Computer Services site 49 
layered 176-181 

creating 177-181 
Layer Option item (Adobe Photoshop) 180 

loading time considerations 6-8 
mirroring 63, 81 
morphing 101, 138, 238-241 

alternation 238 
HiJaak Morph 241-250 
image selection 239-241 
Kai's Power Goo 252-267 
transitional 238 
transitional animation (with HiJaak 

Morph) 242-250 
movement cycle 99-103 
OCR (Optical Character Recognition) 

programs 56 
optimizing 145-149 

compression 145-148 
dirty rectangle compression 146 
GIF Wizard online compression page 147 
palette compression 146 
transparency compression 146 

Over the Rainbow site 48 



Photolmpact GIF Animator 136-138 
Optimization feature 137 
user interface 136 

Professional Photos CD-ROM series (Corel) 52 
rendering (Sculpt 3D) 192 
resampling 63, 8~ 
resizing 63, 86-88 
rotating 63, 88-90 
"royalty free" 46 
scanning 54-57 

color depth considerations 55 
dpi rating considerations 55 
with flatbed scanner 54 
with hand scanner 54 
with photo scanner 55 
with sheetfed scanner 54 

sectional animation (Adobe Photoshop) 181-186 
transparency 182-184 

single source 103 
size considerations 19-20 
subject matter considerations 12-15 
3D 

design elements 198-210 
raytracing 192-193 
rendering 13, 190-191 
Sculpt 3D 225-229 

thumbnails 21 
title graphics 15 
transitions 

Transition Editor (VideoCraft GIF 
Animator) 139 

transparencies in 63, 90-93, 183-184 
usability testing 8 
user interaction considerations 5 
VideoCraft GIF Animator 138-140 

PhotoMorph and 138 
Transition Editor 139 

Web.Graphics Suite (Corel) 52 
wipes 100 

Indeo (digital video compression) 296 
inline video 296-297 
Insert Object toolbar (GIF Construction Set) 119 
interlacing (images) 63, 85 
Internet 

image acquisition 27-40 
searching for 28-37 

Inversion command (Adobe Photoshop) 154-155 

J 
Java 270-286 

animation tools 287-290 
Egor Animator 287 
WebBurst 287-288 
WebPainter (Totally Hip Software) 288-290 

applets 269 
adding to page 285-286 
Hot Chilli and 271 

Hot Chilli 271 

,.,.-...... 
Index 349 

Cool Button applet creation with 282-283 
Fading Scroll Message creation with 278-280 
LED display creation with 272-275 
Pull Menu applet creation with 283-285 
Status Scroll Message creation with 280-281 
Super Scroll Message creation with 275-278 
support site 272 

Java Boutique site 291 
Java Source Web site 291 
JavaScript 270 
Johnson, Jelane (Free Web Graphics site) 47-48 
JPEG File Preferences dialog box 83 
JPEG files 

as image standard 12 
file compression 63, 82-85 
progressive encoding 85 

K 
Kai's Power Goo 252-267 

animation frame creation 261-264 
Bulge transition 258 
Fusion room 264-267 
Grow /Shrink button 255 
image resizing 254 
Mirror Toggle button 258 
Move button 256 
Nudge button 257 
Output Size dialog box 263-264 
Rotate transition 259 
Smear button 257 
Smooth button 258 
Smudge button 257 
Spike transition 261 
Squeeze transition 260 
Static transition 261 
Stretch transition 260 
Twirl transition 259 

Kai's Power Tools 307 

L 
Langley Computer Services site 49 
layered images 176-181 

creating 177-181 
Layer Options item (Adobe Photoshop) 180 

LED (Light Emitting Diode) displays 
adding with GIF Construction Set 128-130 
creating (with Hot Chilli) 272-275 
previewing with GIF Construction Set 130 
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legal issues (for image acquisition) 24-27 
Light Emitting Diode displays, see LED displays 
lighting 

in 3D image rendering 197 
raytracing 205 
selecting for 30 image rendering 205-209 

guidelines 207-208 
shadows 209 

Little Men Studios site 51 
loading time (for images), testing 144 
Logo Wizard (Pixel 3D) 210-217 

Build Logo dialog box 212 
Build Text dialog box 211 
multiple animation frames 218-219 
Specify Axes dialog box 218 

logos (30 images) 
beveled faces on 223 
creating with Pixel 30 210-217 

LOOP block (GIF Construction Set) 117, 123 
looping (images) 100 

with GJF Construction Set 112 
Lycos search engine 31 

M 
Macintosh 

Adobe PhotoOeluxe 93-95 
filter installation 160 
GifBuilder 133-135 

animating with 134-135 
transitions with 135-136 
user interface 133 

Kai's Power Goo 253 
Persistence of Vision (3D rendering 

freeware) 233-235 
QuickTime digital video 294 
Sculpt 30 225-229 

object hierarchies 226 
user interface 226 

. TJF files 50 
WebBurst Gava animation tool) 287-288 
WebPainter (Totally Hip Software) 288-290 
Word (Microsoft), image acquisition with 43-45 

Macromedia 
Flash plug-in 301 
Shockwave plug-in 301 

Magic Wand tool (Paint Shop Pro) 78-79 
Media Center Gase) 307 
Merge Layers command (Adobe Photoshop) 176 
metafiles (Windows) 50 
Microsoft Word, image acquisition with (Clip

board) 43-45 
Mirror Toggle button (Kai's Power Goo) 258 
mirroring (images) 63, 81 

morphing 101, 138, 238-241 
alternation 238 
HiJaak Morph 241-250 

mesh 246 
Output Options dialog box 248 
transitional animation with 242-250 
user interface 241 

image selection 239-241 
Kai's Power Goo 252-267 

animation frame creation with 261-264 
Bulge transition 258 
Fusion room 264-267 
Grow /Shrink button 255 
image resizing 254 
Mirror Toggle button 258 
Move button 256 
Nudge button 257 
Output Size dialog box 263-264 
Rotate transition 259 
Smear button 257 
Smooth button 258 
Smudge button 257 
Spike transition 261 
Squeeze transition 260 
Static transition 261 
Stretch transition 260 
Twirl transition 259 

PhotoMorph 138 
transitional 238 

Motion Blur filter (Adobe Photoshop) 163 
motion cycle 98 
Move button (Kai's Power Goo) 256 
movement cycle 99-103 
MPEG 

digital video format 295 
MPEG Archive site 295 

N 
Netscape 

JavaScript 270 
Navigator 

image acquisition with 38-40 
Website 290 

Nudge button (Kai's Power Goo) 257 

a 
object distortion 168 
OCR (Optical Character Recognition) programs 56 
Official HTML Publishing for Netscape 9 
Open Text Index search engine 31 
optimizing (animation) 145-149 

compression 145-148 



dirty rectangle 146 
GIF Wizard online compression page 147 
palette 146 
transparency 146 

Output Options dialog box (HiJaak Morph) 248 
Output Size dialog box (Kai's Power Goo) 263-264 
Over the Rainbow site 48 

p 
Paint Daubs filter (Adobe Photoshop) 161-162 
Paint Shop Pro OASC Inc.) 25-27, 62-63, 79-92, 308 

Add Borders dialog box 64 
Add Text dialog box 25 
adding text to images with 25-27 
Batch Conversion dialog box 80 
Brightness/Contrast dialog box 67 
Capture Setup dialog box 41 

Activate Capture Using setting 41 
Capture setting 41 
Options settings 41 

color counting with 71-72 
Decrease Color Depth dialog box 70 
file compression with 63, 82-85 
file conversion with 63 

multiple files 8Q-81 
single files 79 

GIF File Preferences dialog box 92 
icon bars, adding borders to 65-66 
image acquisition with 41-43 
image editing with 

borders 62, 64-66 
brightness 66-68 
color 62 
color depth 62, 70-72 
color level 68-69 
contrast 66-68 
Copy command 63, 75 
cropping 63, 72-75 
Cut command 63, 75 
flipping 63, 81 
Freehand Selection tool 77 
gray scale conversion 82 
gray scaling 63 
interlacing 63, 85 
Magic Wand tool 78-79 
mirroring 63, 81 
Paste command 63, 76 
resampling 63, 86-88 
resizing 63, 86-88 
rotating 63, 88-90 
Select Shape tool 76 
transparencies 63, 90-93 

image frame creation with 104-106 
JPEG File Preferences dialog box 83 

Red/Green/Blue dialog box 68 
Resample dialog box 86 

Maintain aspect ratio field 87 
Rotate dialog box 89 
Undo command 88 

palettes 
Adobe Photoshop 152 
color 10-12 

dithering 10 
compression 146 

Index 

GIF Construction Set options 119-121 
morphing palette (Kai's Power Goo) 255 

parallel port interface (for scanners) 55 
Paste command (Paint Shop Pro) 63, 76 

~ 
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Peel transitions, adding with Giffiuilder 135-136 
Persistence of Vision (3D rendering freeware) 

233-235 
photo scanners 55 
PhotoDeluxe (Adobe) 93-95 

exporting files with 95 
Guided Activities 94 
selection tools 95 

Photolmpact GIF Animator 136-138, 308 
Optimization feature 137 
user interface 136 

Photolmpact GIF Optimizer 308 
Photoshop (Adobe) 152-153 

Duplicate Layer dialog box 177 
image filters 159-176 

applying 160-161 
Crystallize 164 
dialog box example 160-161 
Distort 168-187 
Filter Sample Gallery 159 
Glass 169-171 
installing 160 
Motion Blur 163 
Ocean Ripple 169-171 
Paint Daubs 161-162 
Pinch 168-169 
Ripple 169-171 
Sharpen Edges 164-165 
Shear 171-172 
Texturizer 166-168 
Twirl 174-176 
Wind 165-166 
ZigZag 172-17 4 

layered images 176-181 
creating 177-181 
Layer Options item 180 

Merge Layers command 176 
Posterize dialog box 158 
sectional animation with 181-186 

transparency 182-184 
Threshold dialog box 156 
user interface 
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menu system 152 
palettes 152 
Toolbox 152 

Pixar Typestry 192 
Pixel 30 (Forward Design) 190, 308 

30 logo creation with 210-217 
Logo Wizard 210-217 

Build Logo dialog box 212 
Build Text dialog box 211 
multiple animation frames 218-219 
Specify Axes dialog box 218 

multiple animation frames 218-219 
rendering with 193 

external objects 219-225 
Select Bitmap Background Color dialog box 220 
Smooth Converted Bitmap Object dialog box 221 

PLAIN TEXT block (GIF Construction Set) 117 
plug-ins 

for digital video 300-303 
CineWeb (Digigami) 302 
Flash (Macromedia) 301 
Shockwave (Macromedia) 301 
Sizzler 302 
Stream Works (Xing Technology) 302 

.PNG files 82 
Posterize dialog box (Adobe Photoshop) 158 
Posterize function (Adobe Photoshop) 157-158 
posterizing 148-149 
primitives (30 rendering) 195 

object creation from 199-200 
Professional Photos CD-ROM series (Corel) 52 
progressive encoding (for JPEG files) 85 
Pull Menu applets, creating (with Hot Chilli) 

283-285 

QuickTrme digital video 294 

R 
raytracing (30 images) 192-193 

lighting 205 
Sculpt 30 192 

realism (shading) 205 
Red/Green/Blue dialog box (Paint Shop Pro) 68 
rendering (30 images) 190-191 

anti-aliasing 198 
camera angle selection 203-205 
design elements 198-210 

object selection 199-205 
extrusions 203 
Font FIX (DCSI) 230-232 
fonts, object creation from 200-205 

GIF animation 197-198 
lighting selection 197, 205-209 

guidelines 207-208 
shadows 209 

Persistence of Vision 233-235 
Pixel 30 193 
primitives 195 

object creation from 199-200 
realism (shading) 205 
texture selection 196, 209-210 
trueSpace (Caligari) 232-233 
Typestry (Pixar) 192 
wireframe models 190 

Resample dialog box 86 
Maintain aspect ratio field 87 

resampling (images) 63, 86-88 
resizing (images) 63, 86-88 
Rotate dialog box 89 
Rotate transition (Kai's Power Goo) 259 
rotating (images) 63, 88-90 
"royalty free" images 46 

s 
scanners 54-57 

color depth considerations 55 
dpi rating considerations 55 
flatbed 54 
hand 54 
OCR (Optical Character Recognition) 

programs 56 
parallel port interface 55 
photo 55 
SCSI interface 56 
sheetfed 54 
software for 56-57 

driver programs 56 
image acquisition programs 56 

SCSI interface (for scanners) 56 
Sculpt 30 (Byte by Byte) 192, 225-229, 308-309 

Color Texture and Surface dialog box 228 
object hierarchies 226 
user interface 226 

search engines 
Alta Vtsta 31 
Excite 31 
Lycos 31 
Open Text Index 31 
WebCompass (Web search program) 32 
WebCrawler 31 
Yahoo! 

acquiring clip art with 47 
image acquisition with 28-32 
narrowing searches 30 



sectional animation (Adobe Photoshop) 103, 181-186 
transparency 182-184 

Select Bitmap Background Color dialog box (Pixel 
30) 220 

Select Shape tool (Paint Shop Pro) 76 
server push (for digital video) 299-300 
Sharpen Edges filter (Adobe Photoshop) 164-165 
sheetfed scanners 54 
Shockwave plug-in (Macromedia) 301 
signs (LED) 

adding with GIF Construction Set 128-130 
previewing with GIF Construction Set 130 

single source images 103 
SiteFX 309 
sites (Web) 

Alchemy Mindworks Web site 108 
Free Web Graphics site 47-48 
Gamelan 291 
Games Domain 8 
GIF Wizard online compression page 147 
Hot Chilli support site 272 
image acquisition from 37-40 
Java Boutique 291 
Java Source 291 
Langley Computer Services 49 
Little Men Studios 51 
MPEG Archive 295 
Netscape 290 
Over the Rainbow 48 
Persistence of Vision 234 
usability testing 8 
see also search engines 

Sizzler plug-in 302 
Smear button (Kai's Power Goo) 257 
Smooth button (Kai's Power Goo) 258 
Smooth Converted Bitmap Object dialog box (Pixel 

30) 221 
Smudge button (Kai's Power Goo) 257 
Soft F /X Pro 309 
software 

for scanners 56-57 
driver programs 56 
image acquisition programs 56 

Specify Axes dialog box (Pixel 30) 218 
Spike transition (Kai's Power Goo) 261 
Squeeze transition (Kai's Power Goo) 260 
Static transition (Kai's Power Goo) 261 
Status Scroll Messages, creating (with Hot 

Chilli) 280-281 
streaming (for digital video) 295-296 
Stream Works plug-in (Xing Technology) 302 
Stretch transition (Kai's Power Goo) 260 
Sun Microsystems 

Java 270-286 
JavaScript 270 

Index 

Super Scroll Messages, creating (with Hot 
Chilli) 275-278 

SuperCompress dialog box (GIF Construction 
Set) 145 

surface distortion 168 

T 
Terminate and Stay Resident programs, see TSR 

programs 
text 

,,,.-...... 
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adding to images (with Paint Shop Pro) 25-27 
banners 

adding with GIF Construction Set 125-128 
previewing with GIF Construction Set 127-128 

mirrors 6-7 
separators 17 

textures 
in 30 image rendering 196 
selecting for 3D image rendering 209-210 
Ultimate Texture 309 

Texturizer filter (Adobe Photoshop) 166-168 
dialog box 167-168 

30images 
logos 

beveled faces on 223 
creating with Pixel 30 210-217 

multiple animation frames 218-219 
raytracing 192-193 

Sculpt 30 192 
rendering 13, 190-191 

camera angle selection 203-205 
design elements 198-210 
external objects 219-225 
extrusion 203 
Font FIX (DCSI) 230-232 
fonts 200-205 
lighting 197, 205-209 
object selection 199-205 
Persistence of Vision 233-235 
Pixel30 193 
primitives 195, 199-200 
tealism (shading) 205 
textures 196, 209-210 
trueSpace (Caligari) 232-233 
Typestry (Pixar) 192 
wireframe models 190 

Sculpt 30 225-229 
object hierarchies 226 
user interface 226 

Threshold command (Adobe Photoshop) 155-157 
Threshold dialog box (Adobe Photoshop) 156 
thumbnail images 21 · 
.TIF files 50 
title graphics 15 
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toolbars 
Insert Object (GIF Construction Set) 119 

Toolbox (Adobe Photoshop) 152 
Totally Hip Software WebPainter 288-290 
Transition Editor (VideoCraft GIF Animator) 139 
Transition Effects dialog box (Animagic GIF) 142 
transitional animation (with HiJaak Morph) 238, 

242-250 
transitions 

adding with GIF Construction Set 130-132 
Transition Editor (VideoCraft GIF Animator) 139 
with Kai's Power Goo 

Bulge 258 
Rotate 259 
Spike 261 
Squeeze 260 
Static 261 
Stretch 260 
Twirl 259 

transparencies 
compression 146 
in images 63, 90-93 

True Color images 70 
trueSpace (Caligari) 232-233, 309 
TSR (Terminate and Stay Resident) programs 40 
Twirl transition (Kai's Power Goo) 259 
Typestry (Pixar) 192 

u 
.Ulead 

Photolmpact GIF Animator 136-138 
Optimization feature 137 
user interface 136 

Ultimate Texture 309 
Undo command (Paint Shop Pro) 88 
usability testing 8, 142-144 

animation quality 144 
loading time 144 
positioning 144 
test machine selection 143-144 
test page creation 143 

v 
Veronica 

image acquisition with 35-37 
Search Form 35 

video, see digital video 
VideoCraft GIF Animator 138-140, 309 

PhotoMorph and 138 
Transition Editor 139 

w 
Web.Graphics Suite (Corel) 52 
WebBurst ijava animation tool) 287-288 
WebCompass (Web search program) 32 
WebCrawler 31 
WebPainter ijava animation tool) 288-290 
Wind filter (Adobe Photoshop) 165-166 

dialog box 166 
Windows 

Animagic GIF 140-142 
Egor Animator ijava animation tool) 287 
filter installation 160 
Font F /X (3D rendering software) 230-232 
GIF Construction Set 108-132 

Animation Wizard 110-116 
user interface 109 

HiJaak Morph 241-250 
mesh 246 
Output Options dialog box 248 
transitional animation with 242-250 
user interface 241 

images, Clipboard and 43-45 
metafiles 50 
Microsoft .AVI digital video format 294 
Persistence of VISion (3D rendering 

freeware) 233-235 
Pixel 3D (Forward Design) 190-197 
trueSpace (Caligari) 232-233 
VideoCraft GIF Animator 138-142 

PhotoMorph and 138 
Transition Editor 139 

WebBurst ijava animation tool) 287-288 
WebPainter (Totally Hip Software) 288-290 
Word (Microsoft), image acquisition with 43-45 

wipes (in animation) 100 
wireframe models (for 30 image rendering) 190 
Word (Microsoft), image acquisition with (Clip-

board) 43-45 

x 
Xing Technology Stream Works plug-in 302 

y 
Yahoo! 

acquiring clip art with 47 
image acquisitions with 28-32 

narrowing searches 30 

z 
Zmijewski, Peter (Hot Chilli) 271 
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Offidal Netscape Communicator Book 
$39. 99, 800 pages 
Beginning lo Intermediate 
Windows Edition: part#: 1-56604-617-3 
Macintosh Edition: part#: 1-56604-620-3 

The sequel to Ventana's blockbuster international bestseller Official 
Netscape Navigawr Booh! Discover the first suite to integrate key 
intranet and Internet communications services into a single, sman 
interface. From simple e-mail to workgroup collaboration, from 
casual browsing to Web publishing, from reading text to receiving 
multimedia Netcaster channels-learn to do it all without leaving 
Communicator! Covers: 
• All Communicator components: Navigator, Netcaster, Messenger, 

Collabra, Composer and Conference. 
• Complete, step-by-step instructions for both intranet and Internet 

task. 
• Tips on using plug-ins, JavaScript and Java applets. 

The CD-ROM includes a fully-supponed version of Netscape 
Communicator plus hyperlinked listings. 

Offidal Netscape Communicator 
Prokssional ldition Book 
$39.99, 608 pages, part#: 1-56604-739.0 

Windows Edition • Intermediate 

Your Guide to Business Communications Over the 
Intranet &: the Web! Unlock the immeasurable potential of 
Web technologies for improving and enhancing day-to-day 
business tasks. Netscape Communicator and your office 
intranet provide the tools and the environment. This easy-to
use, step-by-step guide opens the door to each key mod
ule-and its most elTective use. Covers: 
• Navigator 4, Messenger, Collabra, Conference, Composer, 

Calendar, Netcaster and AutoAdmin. 
• Key business tasks: e-mail, workgroups, conferencing and 

Web publishing. 
• Step-by-step instructions, tips and guidelines for working 

elTectively. 
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Official Online Marketing With Netscape Book 
$34. 99, 544 pages, illustrated, port #: 1-56604-453-7 

The perfect marketing tool for the Internet! Learn how 
innovative marketers create powerful, effectove electronic 
newsletters and promotional materials. Step-by-step 
instructions show you how to plan, deisgn and distribute 
professional-quality pieces. With this easy-to-follow guide, 
you'll soon be flexing Netscape Navigator's marketing 
muscle to eliminate paper and printing costs, automate 
market research and customer service, and much more. 

Netscape Guide 
-ro 19nline Inves~~~ 

Official Netscape Guide to Online Investments 
$24. 99, 528 pages, illustrated, port#: 1-56604-452-9 

Gain the Internet investment edge! Here's everything you 
need to make the Internet a full financial partner. Features 
an overview of the Net and Navigator; in-depth reviews of 
stock and bond quote services, analysts, brokerage houses, 
and mutual fund reports. Plus a full listing of related 
financial services such as loans, appraisals, low-interest 
credit cards, venture capital , entrepreneurship, insurance, 
tax counseling, and more. 

Official Netscape 'uide to Internet Research 
$29. 99, 480 pages, illustrated, port #: 1-56604-604-1 

Tum the Internet into your primary research tool. More than 
just a listing of resources, this official guide provides 
everything you need to know to access, organize, cite and 
post information on the Net. Includes research strategies, 
search engines and information management. Plus timesaving 
techniques for finding the best, most up-to-date data. 
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Offidal Netscape Messenger & Collabro Book 
$39.99, 408 pages, port#: 1-56604-085-8 

Windows, Macintosh • Intermediate to Advanced 

The Power of Web-based Communications-Without a Web Site! 

............ 4. 

Netscape -@~ 
.Messenger & Coilabra Stay in touch with customers; promote products and services visually; share the 

latest market t rends-with simple Internet dial-up access! This step-by-step guide 
helps you harness Netscape Communicator's e-mail, newsreader, HTML authoring 
and real-time conference tools to achieve faster, more powerful business 
communications-without the effon or expense of a Web site. Learn how to: 

8001<-

• Integrate Messenger, Collabra, Conference and Composer for efficient business 
communications. 

• Distribute eye-catching, HTML-based marketing materials without a Web site. -• Use the Net to gather, organize and share information effi ciently . 

• 
Official Netscape Composer Book 
$39.99, 600 pages, port#: 1-56604-074-2 

Windows • Beginning to Intermediate 

Forget about tedious tags and cumbersome code! Now you can create sophisticated, 
interactive Web pages using simple, drag-and-drop techniques. Whether you want to 
create your personal home page, promote your hobby, or launch your business on 
the Web, here's everything you need to know to get staned: 
• Step-by-step instructions for designing sophisticated Web sites with no previous 

experience. 
• JavaScript basics and techniques for adding multimedia, including animation and 

interactivity. 
• Tips for businesses on the Web, including creating forms, ensuring security and 

promoting a Web site. 
The CD-ROM features a wide selection of Web tools for designing Web pages, adding 
multimedia, creating forms and building image maps. 

Official Netscape Plug-in Book, Second ldition 
$39. 99, 7 00 pages, port #: 1-56604-6 12·2 

Windows, Macintosh • All Users 

Your One-Stop Plug-in Resource & Desktop Reference! 
Why waste expensive online time searching the Net for the plug-ins you 
want? This handy one-stop reference includes in-depth reviews, easy-to· 
understand instructions and step-by-step tutorials. And you avoid costly 
download time-the honest plug-ins are included! Includes: 
• In-depth reviews & tutorials for most Netscape plug-ins. 
• Professional tips on designing pages with plug-ins. 
• Fundamentals of developing your own plug-ins. 

The CD-ROM includes all the featured plug-ins available at press time. 



~--------ll V ENTANA It-------.. 
Microsott Windows NT 4 Workttotion Desktop Companion 
$39. 99, 1016 pages, illustrated, part#: 1-56604-472-3 

Workstation users become masters of their own universe with 
this step-by-step guide. Covers file management, customizing 
and optimizing basic multimedia, OLE, printing and network
ing. Packed with shortcuts, secrets, productivity tips and 
hands-on tutorials. The CD-ROM features dozens of valuable 
utilities and demos for Windows NT. Innovative web-site 
designs, reference information, wallpaper textures, animated 
cursors, custom utilities and more. 

Microsott Office 9~ Companion 
$34 .95, 1136 pages, illustrated, part#: 1-56604-188-0 

The all-in-one reference to Microsoft$ red-hot suite is a 
worthy sequel to Ventana's bestselling Windows, Word & 
Excel Office Companion. Covers basic commands and 
features, and includes a section on using Windows 95. 
The companion disk features examples, exercises, soft
ware and sample files from the book. 

~martSuite Desktop Companion 
$24. 95, 784 pages, illustrated, part#: 1-56604-184-8 

Heres "Suite success" for newcomers to the critics' choice 
of business packages. This introduction to the individual 
tools and features of Lotus' star software packages-1-2-3, 
Ami Pro, Approach, Freelance Graphics and Organizer
has been updated for the latest versions. Features new 
enhancements for Windows 95. The companion disk 
features sample exercises and files that follow the lessons 
in the book. 
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The Comprehensive Guide to ~mort~uite 91 
James Meade 
$34. 99, 528 pages, illustrated, part#: 1-56604-651-3 

Heres Suite relief for business users at all levels. Step 
by step, learn to use applications together, work 
collaboratively, and maximize Internet and intranet 
connectivity. Packed with tips and shortcuts. 

For Windows 95/ NT • Beginning to Intermediate 

The Comprehen~ive Guide to Micro~ott Ottice 91 
Ned Snell 
$39. 99, 848 pages, illustrated, part #: 1-56604-646-7 

The "right-size" guide to the world's hottest suite! Easy 
enough for beginners, yet in-depth enough for power 
users. Covers all five applications, plus tips, shortcuts, 
Internet techniques and more. 

For Windows 95/ NT • Beginning to Intermediate 
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Official HT Ml Publishing for Netscape, Second (dition 
$39. 99, 800 pages, part #: 1-56604-650-5 

Windows 95/NT, Macintosh • Intermediate 

Make the Most of the Latest Netscape Features! 
Learn how the latest developments in Netscape Navigator and HTML 
enhance your ability to deliver eye-catching, interactive Web pages to a 
broad audience, and how to harness new technologies to create a com
pelling site. Includes: 
• Playing to Navigator's hottest features, including tables, frames, plug-ins 

and support for Java applets. 
• Guidelines for designing great Web pages. 
• New material on style sheets, sound, multimedia and databases. 

The CD-ROM contains an example Web site on the Net, sample JavaScript 
clip objects, backgrounds and more. 

• al 
Netscape 
J~~~ript .1:# 

Official Netscape JavaScript 1.1 Book, Sernnd (dition 
$29. 99, 520 pages, part #: 1-56604-675-0 

All platforms • Beginning to Intermediate 

Brew up instant scripts-even if you're not a programmer! 
Learn all the skills you need to perk up your Web pages with multirredia 
and interactivity. Fully updated for Netscape Communicator, this bestseller 
now includes: 
• Basic programming techniques. 
• Tips for using existing scripts and building your own from scratch. 
• Nearly 200 script samples and interactive tutorials online. 

Official Netscape fattTmck Server Book 
$39.99, 600 pages, part#: 1-56604-483-9 

Windows NT • Intermediate to Advanced 

Turn your PC into an lnternet/intranet powerhouse! 
This step-by-step guide to the hottest server software on the Net 
provides all the instructions you need to launch your Internet or 
intranet site, from technical requirements to content creation and 
administration. Learn how to exploit FastTrack Servers high
performance server architecture to easily create and manage cus
tomized web sites. Plus, enhance your site with FTP and Telnet; 
ensure security for online transactions; and import and convert 
documents. 

~,::::::: ..... ...._ 
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,___----VENTANA ,______.. 
To ORDER ANY VENTANA TITLE, COMPLETE THIS ORDER FORM AND 
MAIL OR FAX IT TO US, WITH PAYMENT, FOR QUICK SHIPMENT. 
TITLE PART # QTY PRICE TOTAL 

SHIPPING 
For orders shipping within the United Stutes, please odd $4.95 for the first book, $1 .50 for each additional book. 
For 0 tw&doy air,· add $7.95 for the first book, $3.00 for each additionol book. 
Emm1: vorders@kdc.com for exact shipping charges. 
Note: Please indude your local sales tax. 

SUBTOTAL = 

SHIPPING = 

TAX = 

TOTAL = 

s 
s 
s 
s 

Medi to: International Thomson Publishing• 7625 Empire Drive• Florence, KY 41042 
'If US orders 800/332·7450 •fax 606/283-0718 

'II' International orders 606/282-5786 •Canadian orders 800/268-2222 
Name __________________________ _ 

E-mail ------------ Ooylime phone __________ _ 
Company _________________________ _ 
Address (No PO Box) _______________________ _ 
Oty __________________ State ___ Zip ___ _ 

Payment enclosed _VISA _MC_ Acc't # Exp. date __ _ 
Signature Exact name on card----------

Check your local bookstore or software retailer for 8 O 0/3 3 2 7 4 5 0 
these and other bestselling titles, or call toll free: • 

8:00 am - 6:00 pm EST 



Technical support for installation related issues only provided by Ventana. 
The Ventana technical support office is open from 8:00 A.M. to 6:00 P.M. (EST) 
Monday through Friday and can be reached via the following methods: 

World Wide Web: http:/ /www.netscapepress.com/ support 

E-mail: help@vmedia.com 

Phone: (919) 544-9404 extension 81 

FAX: (919) 544-9472 

America Online: keyword Ventana 
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Dozens of software 
demos and shareware 
utilities! 
• Graphic Converter (shareware) 
• Paint Shop Pro (shareware) 
• Kai's Power Tools (demo) 
• Sculpt 30 (demo) 
• GifBuilder (shareware) 
• Photolmpact GIF Animator (demo) 

and more! 

N;at. 
Award-winning 
Online Magazine! 
For Netscape Navigator 
users at all levels. 

ht1p://www.nm pep11a.OQ111lzine 

Make Your Web Site 
a Moving Experienct! 
T o arrracr more visirors to your sire or spice up your 

home page, animation offers fresh, compell ing 
opportunities. Bur effective animation requires a solid 
basis in graphic design. T his step-by-srep guide offers it: 
a quick course in image editing, graphics formars, and page 
layout-along with instructions for using the tools on the 
CO-ROM. 

Learn to: 
• Start with the right image-use Paint Shop Pro (\X'indows) or 

PhotoDeluxe (Mac) ro capture screens and copy images from orher 
sources, such as Web pages, clip arr, and videos; learn basic image
editing techniques, including resizing, re-coloring, compression, and 
adding rranspart:~. 

.:f.-' .·"-"~P···'.'''.:.:·· ,' <·:···'.· _. J R·I r . 

• Create animated GIFs quickly and easily-master GIF 
Construction Ser (Windows) or GifBuilder (Mac) for preparing 
images properly, building a movement cycle, inserting delays; and 
resting and optimizing animations. 

WITH F>,,Jf,(H.ASl . . 
- - - - -

For more lhan a decade, Mark L Chambers 
has been an amhor, compucer consulcanc, 
technical wriccr, BBS sysop, and game 
programmer. A concriburor to Venrana's 
bescselling Official Neuc11pe Navig11tor Book 
and Official Net.scape lntm1et Starrer Kit., 
he wrote Running a Peifect BBS and 
contribuced ro Web Publishing Unlemhed, 
Microsoft lmemet Explorer Unlemhed, 
and FrontPage 97 Un/embed 

VEN TANA 
INTERNET/WEB DESIGN 
ISBN: 1-56604-725-0 

U.S. 539.99 
CANADA 555.99 

• Master advanced techniques-get to know Adobe Phoroshop's 
image filters and special effects rools; learn about Push & Pull 
animation; feature digital video on your Web page. 

• Add a new dimension to your animations-master the basics 
of creating 30 Web graphics, including proportion, Lighting, and 
texcure; use 30 objects in your animations; generate multiple frames; 
use PowerGOO to create morphing animations. 

• Take a taste of Java-find our what's so hot about Java; add Java 
and JavaScript effects wirhour programming; use HotChilli to create 
moving banners, button effects, and status line effects. 

USER LEVEL: I NTERMEDIATE 

ISBN 1-56604-725-0 ISBN 1-56604- 725 -0 
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